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Welcome to Tenable Security Center

This user guide describes how to install, configure, and manage Tenable Security Center™(Formerly

Tenable.sc) 5.20.x.

Tenable Security Center is a comprehensive vulnerability management solution that provides com-

plete visibility into the security posture of your distributed and complex IT infrastructure. Tenable

Security Center consolidates and evaluates vulnerability data from across your entire IT infra-

structure, illustrates vulnerability trends over time, and assesses risk with actionable context for

effective remediation priorit ization.

To get started, see Get Started With Tenable Security Center.
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Get Started With Tenable Security Center

Use the following gett ing started sequence to configure and mature your Tenable Security Center

deployment.

1. Prepare

2. Install

3. Configure Scans

4. Refine

5. Expand

Prepare

Before you begin, learn about Tenable Security Center and establish a deployment plan and analysis

workflow to guide your configurations.

l Access Tenable Support and training resources for Tenable Security Center, including:

l the Tenable University training courses

l the Tenable Scan Strategy guide

l Design a deployment plan by identifying your organization's objectives and analyzing your net-

work topology. Consider Tenable-recommended best practices for your environment. For

more information about environment requirements, see Requirements. For information about

scan types, see Scanning Overview.

l Design an analysis workflow. Identify key stakeholders in your management and operational

groups, considering the data you intend to share with each stakeholder.

For more information about planning a large enterprise deployment of Tenable Security Center, see

the Tenable Security Center Large Enterprise Deployment Guide.

For more information about the basic architecture of a Tenable Security Center deployment, see

Tenable Security Center Architecture.

Install
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Install Tenable Security Center and perform init ial configuration.

1. Depending on your environment, install in your environment or deploy or install with Tenable

Core.

For complete information about Tenable Core + Tenable Security Center, see the Tenable

Core User Guide.

2. Perform quick setup, as described in Quick Setup. You can:

l Upload licenses

l Configure one Tenable Nessus scanner

l Configure one Tenable Nessus Network Monitor scanner (requires a Tenable Nessus Net-

work Monitor activation license)

l Configure one Tenable Log Correlation Engine server (requires an Tenable Log Cor-

relation Engine®activation license)

l Create one repository

l Create one organization

l Configure one LDAP server

l Create one administrator user account and one security manager account

l Configure usage statist ic collection

Tenable recommends following the quick setup wizard, but you can configure these features

later. For example, do not configure LDAP until you have easy access to all necessary LDAP

parameters.

3. Configure SMTP sett ings, as described in Mail Sett ings.

4. Configure scan zones, as described in Add a Scan Zone.

5. Configure addit ional repositories, if necessary, as described in Repositories.

6. Configure addit ional scanners, if necessary, as described in Tenable Nessus Scanners, Ten-

able Nessus Network Monitor Instances, and Tenable Log Correlation Engines.

7. Configure security sett ings (e.g., password complexity requirements and custom banners), as

described in Security Sett ings.
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Configure Scans

Configure and run basic scans to begin evaluating the effectiveness of your deployment plan and

analysis workflow.

1. Configure credentials, as described in Credentials.

2. Create static assets, as described in Add a Custom Asset. For more information about asset

types, see Assets.

3. Configure a Host Discovery policy and a Basic Network Scan policy from Tenable-provided

scan policy templates, as described in Add a Scan Policy.

4. Configure and run scans for those policies, as described in Add an Active Scan and Add an

Agent Scan.

5. Confirm that the scans can access all areas of your network with no credential issues.

6. Configure Tenable Nessus Network Monitor scanners, as described in Tenable Nessus Net-

work Monitor Instances.

7. When the scans complete, create template-based dashboards and reports, as described in

Dashboards and Reports.

Tenable recommends frequently reviewing your scan results and scan coverage. You may need to

modify your scan configurations to suit your organization's objectives and reach all areas of your

network.

Refine

Configure other features, if necessary, and refine your existing configurations.

l Configure audit files, as described in Audit Files.

l Create addit ional scan policies, as described in Add a Scan Policy.

l Configure scan freeze windows, as described in Add a Freeze Window.

l Configure groups, as described in Add a Group.

l Create a custom user role, as described in Create a User Role.

l Create addit ional user accounts and share objects with users, as described in User Accounts.
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l Create dynamic assets and combination assets, as described in Add a Custom Asset. For

more information about asset types, see Assets.

l Review the plugin update schedule, as described in Edit Plugin and Feed Settings and Sched-

ules. Consider edit ing the schedules to suit your needs. For example, you may want to sched-

ule plugin and feed updates to run a few hours before your scheduled scans.

l Add queries and use filters, as described in Add or Save a Query and Apply a Filter.

l Create custom dashboards and reports, as described in Dashboards and Reports.

l Create Assurance Report Cards (ARCs), as described in Assurance Report Cards.

l Configure alerts, t icketing, accept risk rules, and recast risk rules, as described in Workflow

Actions.

l View vulnerability data and use the built-in analysis tools, as described in Vulnerability Ana-

lysis.

Expand

Review and mature your deployment plan and analysis workflow.

l Conduct weekly meetings to review your organization's responses to identif ied vulnerabilit ies.

l Conduct weekly management meetings to oversee your teams executing the analysis work-

flow.

l Review scan automation sett ings and consider revising.

l Review your scan results and scan coverage. You may need to modify your scan con-

figurations to suit your organization's objectives and reach all areas of your network.

l Optimize and operationalize your custom dashboards to meet the needs of individual user

account holders.

l Optimize and operationalize your custom reports to prepare them for distribution.

l Consider configuring API integrations, as described in the Tenable Security Center API Guide

and the Tenable Security Center API Best Practices Guide.

l Consider synchronizing Tenable Security Center with Tenable Vulnerability Management Ten-
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able Lumin to take advantage of Cyber Exposure features, as described in Tenable Lumin Syn-

chronization.
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Tenable Security Center Architecture

Physical Architecture

At a high level, a Tenable Security Center deployment has two parts:

l A central Tenable Security Center console to manage scans, reports, user access, and other

application tools.

l One or more scanners to collect data and report results to the Tenable Security Center con-

sole.

Logical Architecture

Tenable Security Center is divided into organizations. Each organization has access to one or more

repositories that store scan data. For example, users in Organization 1can only see repositories

that are assigned to Organization 1, however, a repository can be assigned to more than one organ-

ization.

The highest-level user in an organization is the Security Manager. For more information about user

permissions, see User Roles.

Very broadly, the logical layout / architecture of Tenable Security Center looks like this:
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Many environments have just one organization. The following are some common use cases for mul-

t iple organizations:

l Environments where there are mult iple departments or entit ies in a business that are logically

independent, but that are all governed by the same structure.

l Acquisit ions – there may be a reason to keep the acquiring company and acquired company

separate.
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Considerations for Air-Gapped Environments

Consider the following when deploying Tenable Security Center in an air-gapped (offline) envir-

onment.

Architecture

You must deploy a Tenable Security Center and a set of scanners within each air-gapped network.

If you want to consolidate data from other networks with the data generated in your air-gapped net-

work, you can use offline repositories to export data from your air-gapped Tenable Security Center

to your other instance of Tenable Security Center. This supports both consolidated and federated

reporting structures.

Upgrades and Updates

Tenable recommends performing Tenable Security Center upgrades at least once a year (quarterly

preferred) and plugin/ feed updates at least once a month. After you perform a plugin update, run

comprehensive scans to take advantage of the new vulnerability data and generate current scan res-

ults.

Note: A few plugins require internet access and cannot run in an air-gapped environment. For example,
Tenable Nessus plugin 52669 checks to see if a host is part of a botnet.

After you perform a plugin update or feed update, verify the files as described in the knowledge

base article.

To perform a Tenable Security Center upgrade or a plugin/ feed update offline:

Tip: You can use the API to automate some Tenable Security Center upgrade and plugin update
process.

1. Download the files in a browser or via the API.

2. Verify the integrity of the files.
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l Tenable Security Center upgrade: Compare the download checksum with the checksum

on the Tenable downloads page

l Plugin/ feed update: Download and compare the checksums.

3. Move the files to your Tenable Security Center instance.

4. Upload the files to Tenable Security Center.

l Tenable Security Center upgrade: via the CLI.

l Plugin/ feed update: in a browser or via the API.

Tenable Nessus Agents

If you deployed Tenable Nessus Manager to manage Tenable Nessus Agents in an air-gapped envir-

onment, perform an offline software update (nessus-agent-updates-X.X.X.tar.gz on the Ten-

able Downloads site) on your Tenable Nessus Manager. Tenable Nessus Manager pushes the update

to the managed Tenable Nessus Agents.

For more information, see the knowledge base article.
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Requirements

You can run Tenable Security Center in the following environments.

Environment More Information

Tenable Core Virtual VMware Requirements in the Tenable Core

User Guide
Microsoft Hyper-V

Cloud Amazon Web Services 

(AWS)

Hardware

Other plat-

forms

Cloud Amazon Web Services 

(AWS)

Cloud Requirements

Hardware Hardware Requirements

For general information about other requirements to run Tenable Security Center, see:

l System Requirements

l License Requirements

l Port Requirements

l Browser Requirements

l Tenable Integrated Product Compatibility

For detailed information about running Tenable Security Center in a large enterprise deployments,

see Large Enterprise Deployments.
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Hardware Requirements

You can run Tenable Security Center on hardware, with or without Tenable Core. For more inform-

ation about Tenable Core, see the Tenable Core User Guide.

Note:Tenable strongly discourages running Tenable Security Center or Tenable Core + Tenable Security
Center in an environment shared with other Tenable applications.

Storage Requirements

Tenable recommends installing Tenable Security Center on direct-attached storage (DAS) devices

(or storage area networks [SANs], if necessary) with a storage latency of 10 milliseconds or less.

Tenable does not support installing Tenable Security Center on network-attached storage (NAS).

Disk Space Requirements

Enterprise networks can vary in performance, capacity, protocols, and overall activity. Resource

requirements to consider for deployments include raw network speed, the size of the network being

monitored, and the configuration of the application. Processors, memory, and network cards will be

heavily based on the former. Disk space requirements will vary depending on usage based on the

amount and length of t ime data is stored on the system.

An important consideration is that Tenable Security Center can be configured to save a snapshot of

vulnerability archives each day. In addit ion, the size of the vulnerability data stored by Tenable

Security Center depends on the number and types of vulnerabilit ies, not just the number of hosts.

For example, 100 hosts with 100 vulnerabilit ies each could consume as much data as 1,000 hosts

with 10 vulnerabilit ies each. In addit ion, the output for vulnerability check plugins that do directory

list ings, etc. is much larger than Open Port plugins from discovery scans.

For networks of 35,000 to 50,000 hosts, Tenable has encountered data sizes of up to 25 GB. That

number is based on storage of 50,000 hosts and approximately 500 KB per host.

Addit ionally, during active scanning sessions, large scans and multiple smaller scans have been

reported to consume as much as 150 GB of disk space as results are acquired. Once a scan has com-

pleted and its results are imported, that disk space is freed up.

Requirements When Running Basic Network Scans + Local Checks
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# of Hosts Managed by Tenable

Security Center

CPU

Cores
Memory

Disk Space used for Vul-

nerability Trending

2,500 active IPs 4 2GHz

cores

8 GB RAM 90 days: 125 GB

180 days: 250 GB

10,000 active IPs 8 3GHz

cores

16 GB RAM 90 days: 450 GB

180 days: 900 GB

25,000 active IPs 16 3GHz

cores

32 GB RAM 90 days: 1.2 TB

180 days: 2.4 TB

100,000 active IPs 32 3GHz

cores

64 GB RAM 90 days: 4.5 TB

180 days: 9 TB

Requirements When Running Basic Network Scans + Local Checks + 1Configuration Audit

# of Hosts Managed by Tenable

Security Center

CPU

Cores
Memory

Disk Space used for Vul-

nerability Trending

2,500 active IPs 4 2GHz

cores

8 GB RAM 90 days: 225 GB

180 days: 450 GB

10,000 active IPs 8 3GHz

cores

16 GB RAM 90 days: 900 GB

180 days: 1.8 TB

25,000 active IPs 16 3GHz

cores

32 GB RAM 90 days: 2.25 TB

180 days: 4.5 TB

100,000 active IPs 32 3GHz

cores

128

GB RAM

90 days: 9 TB

180 days: 18 TB

Disk Partit ion Requirements
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Tenable Security Center installs into /opt/sc. Tenable highly recommends that you create the /opt
directory on a separate disk partit ion. If you want to increase performance, consider using two

disks: one for the operating system and one for the system deployed to /opt.

Tenable strongly recommends using high performance disks. Tenable Security Center is a disk-

intensive application and using disks with high read/write speeds, such as SSDs, results in the best

performance.

If required disk space exists outside of the /opt f ile system, mount the desired target directory

using the command mount –-bind <olddir> <newdir>. Make sure that the file system is auto-

matically mounted on reboot by edit ing the /etc/fstab f ile appropriately.

Note: Tenable Security Center does not support using symbolic links for /opt/sc/. You can use symbolic
links within /opt/sc/ subdirectories if instructed by Tenable Security Center documentation or Tenable
Support.

Deploying Tenable Security Center on a server configured with RAID disks can also dramatically

boost performance.

Tip:Tenable does not require RAID disks for even our largest customers. However, in one instance,
response times for queries with a faster RAID disk for a customer with more than 1million managed vul-
nerabilit ies moved from a few seconds to less than a second.

Network Interface Requirements

You can install Tenable Security Center in externally connected or air-gapped environments. For

more information about special considerations for air-gapped environments, see Considerations for

Air-Gapped Environments.

Gigabit or faster network cards are recommended for use on the Tenable Security Center server.

This is to increase the overall performance of web sessions, emails, Tenable Log Correlation Engine

queries, and other network activit ies.
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Cloud Requirements

The primary method to deploy Tenable Security Center in a cloud environment is with Tenable Core

+ Tenable Security Center. For more information, see the Tenable Core User Guide.

However, you can install Tenable Security Center in vendor-supported version of your cloud envir-

onment that meets the operating system requirements to run Tenable Security Center.

The following guidelines can help you install Tenable Security Center in an Amazon Elastic Compute

Cloud (Amazon EC2) cloud-based environment or an Azure Virtual Machine (Azure Virtual Image)

cloud-based environment, but they do not cover all deployment scenarios or cloud environments.

For assistance with a different cloud environment, contact Tenable Professional Services.

l Supported Amazon EC2 Instance Types

l Supported Amazon Machine Images (AMIs)

l Supported Azure Instance Types

l Supported Azure Machine Images

Supported Amazon EC2 Instance Types

You can install Tenable Security Center in an Amazon Elastic Compute Cloud (Amazon EC2) cloud-

based environment that meets all of the following requirements.

Tenable Security Center uses a balance of networking and compute resources and requires per-

sistent storage for proper operation. To meet these requirements, Tenable supports installing Ten-

able Security Center on M5 instances with General Purpose SSD (gp2) EBS storage.

Tenable recommends the following Amazon EC2 instance types based on your Tenable Security

Center deployment size.

Requirements When Running Basic Network Scans + Local Checks

# of Hosts Managed by

Tenable Security Center
EC2 Instance Type

Disk Space Used for Vul-

nerability Trending

1to 2,500 m5.2xlarge 90 days: 125 GB

180 days: 250 GB
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2,501to 10,000 m5.4xlarge 90 days: 450 GB

180 days: 900 GB

10,001to 25,000 m5.8xlarge 90 days: 1.2 TB

180 days: 2.4 TB

25,001to 50,000 m5.12xlarge 90 days: 4.5 TB

180 days: 9 TB

50,001or more For assistance with large enterprise deployments greater than

50,000 active IP addresses, contact your Tenable representative.

Requirements When Running Basic Network Scans + Local Checks + 1Configuration Audit

# of Hosts Managed by

Tenable Security Center
EC2 Instance Type

Disk Space Used for Vul-

nerability Trending

1to 2,500 m5.4xlarge 90 days: 225 GB

180 days: 450 GB

2,501to 10,000 m5.8xlarge 90 days: 900 GB

180 days: 1.8 TB

10,001to 25,000 m5.8xlarge 90 days: 2.25 TB

180 days: 4.5 TB

25,001to 50,000 m5.12xlarge 90 days: 9 TB

180 days: 18 TB

50,001or more For assistance with large enterprise deployments greater than

50,000 active IP addresses, contact your Tenable representative.

Supported Amazon Machine Images (AMIs)
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Tenable provides an AMI for Tenable Core, but not for other cloud deployments without Tenable

Core. Tenable supports using the following Amazon Marketplace AMI for Tenable Security Center

without Tenable Core:

AMI Required Configuration Changes

CentOS 7 (x86_

64) - with

Updates HVM

l This AMI does not include Java, but Tenable Security Center requires

OpenJDK or the Oracle Java JRE to export PDF reports.

You must install OpenJDK or the Oracle Java JRE onto your AMI before

hosting Tenable Security Center. For more information, see Depend-

encies.

l This AMI configures an SELinux enforcing mode policy, which requires

customization to be compatible with Tenable Security Center.

You must use the SELinux sealert tool to identify errors and solu-

t ions. For more information, see Customize SELinux Enforcing Mode

Policies for Tenable Security Center.

l You must confirm this AMI meets all other standard requirements for

operating systems. For more information, see Operating System

Requirements.

Supported Azure Instance Types

You can install Tenable Security Center in an Azure Virtual Machine (Azure Virtual Image) cloud-

based environment that meets all of the following requirements.

Tenable recommends the following virtual machine instance types based on your Tenable Security

Center deployment size. You may need to increase the storage allocated to the virtual machine

instance depending on usage.

Requirements When Running Basic Network Scans + Local Checks

# of Hosts Managed by

Tenable Security Center
Virtual Machine Instance

Disk Space Used for Vul-

nerability Trending

1to 2,500 D3V2 90 days: 125 GB
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180 days: 250 GB

2,501to 10,000 D4V2 90 days: 450 GB

180 days: 900 GB

10,001to 25,000 F16 90 days: 1.2 TB

180 days: 2.4 TB

25,001to 50,000 F32SV2 90 days: 4.5 TB

180 days: 9 TB

50,001or more For assistance with large enterprise deployments greater than

50,000 active IP addresses, contact your Tenable representative.

Requirements When Running Basic Network Scans + Local Checks + 1Configuration Audit

# of Hosts Managed by

Tenable Security Center
EC2 Instance Type

Disk Space Used for Vul-

nerability Trending

1to 2,500 D3V2 90 days: 225 GB

180 days: 450 GB

2,501to 10,000 D4V2 90 days: 900 GB

180 days: 1.8 TB

10,001to 25,000 F16 90 days: 2.25 TB

180 days: 4.5 TB

25,001to 50,000 D32SV3 90 days: 9 TB

180 days: 18 TB

50,001or more For assistance with large enterprise deployments greater than

50,000 active IP addresses, contact your Tenable representative.

Supported Azure Machine Images
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Tenable provides an Azure image for Tenable Core, but not for other cloud deployments without Ten-

able Core. Tenable supports using the following Azure image for Tenable Security Center:

AMI Required Configuration Changes

CIS CentOS

Linux 7 Bench-

mark L1

l This image does not include Java, but Tenable Security Center requires

OpenJDK or the Oracle Java JRE to export PDF reports.

You must install OpenJDK or the Oracle Java JRE onto your image

before hosting Tenable Security Center. For more information, see

Dependencies.

l This image configures an SELinux enforcing mode policy, which

requires customization to be compatible with Tenable Security Center.

You must use the SELinux sealert tool to identify errors and solu-

t ions. For more information, see Customize SELinux Enforcing Mode

Policies for Tenable Security Center.

l You must confirm this image meets all other standard requirements for

operating systems. For more information, see Operating System

Requirements.
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System Requirements

l Operating System Requirements

l SELinux Requirements

l Secure Environment Requirements

l Dependencies

l Tenable Security Center Communications and Directories

Operating System Requirements

This version of Tenable Security Center is available for:

l Red Hat Enterprise Linux 7 (RHEL 7), 64-bit

l Red Hat Enterprise Linux 8 (RHEL 8), 64-bit

l CentOS 7, 64-bit

l Oracle Linux 8, 64-bit

SELinux Requirements

Tenable Security Center supports disabled, permissive, and enforcing mode Security-Enhanced

Linux (SELinux) policy configurations.

l Disabled and permissive mode policies typically do not require customization to interact with

Tenable Security Center.

l Enforcing mode policies require customization to interact with Tenable Security Center. For

more information, see Customize SELinux Enforcing Mode Policies for Tenable Security

Center.

Note: Tenable recommends testing your SELinux configurations before deploying on a live network.

Secure Environment Requirements

Tenable recommends adhering to security best practices, including:
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l Configure the operating system to ensure that security controls cannot be bypassed.

l Configure the network to ensure that the Tenable Security Center system resides in a secure

network segment that is not accessible from the Internet.

l Configure network time synchronization to ensure that accurate time stamps are recorded in

reports and log files.

Note: The time zone is set automatically during the installat ion process with no user interaction. The
time zone configured in php.ini must be synchronized with the system time zone in /etc/sy-
sconfig/clock.

l Configure access control to ensure that only authorized users have access to the operating

system platform.

l Monitor system resources to ensure that adequate disk space and memory are available, as

described in Hardware Requirements. If system resources are exhausted, Tenable Security

Center may not log audit data during system administrator troubleshooting or other activit ies.

For more information about troubleshooting resource exhaustion, see General Tenable Secur-

ity Center Troubleshooting.

For information about secure administration of a Red Hat installat ion, see the Red Hat Enterprise

Linux Security Guide for your version.

Note: Even though the security concepts from this guide are written for RHEL 6, most of the concepts and
methodologies apply to earlier versions of RHEL that are supported with Tenable Security Center.

Note: As with any application, the security and reliability of the installat ion is dependent on the envir-
onment that supports it. It is strongly recommended that organizations deploying Tenable Security Center
have an established and applied IT management policy that covers system administration integrity,
resource monitoring, physical security, and disaster recovery.

Dependencies

Note: Either OpenJDK or the Oracle Java JRE along with their accompanying dependencies must be
installed on the system along with any addit ional Java installat ions removed for reporting to function prop-
erly.

Note: If you are running Tenable Security Center 5.20.0, you must upgrade pyTenable to version 1.4.2 or
later.
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Note: Tenable does not recommend forcing the installat ion without all required dependencies. If your ver-
sion of Red Hat or CentOS is missing certain dependencies, it will cause problems that are not readily
apparent with a wide variety of functions. Tenable Support has observed different types of failure modes
for Tenable Security Center when dependencies are missing.

All dependencies must be installed on the system prior to installing the Tenable Security Center

package. While they are not all required by the installat ion RPMfile, some functionality of Tenable

Security Center may not work properly if the packages are not installed.

Note: Tenable recommends using the latest stable production version of each package.

For a list of required packages, run the following command against the Tenable Security Center

RPMfile:

# yum deplist SecurityCenter-x.x.x-el6.x86_64.rpm

- or -

# dnf deplist SecurityCenter-x.x.x-el8.x86_64.rpm

To determine which version of a dependency is installed on your system, run the following com-

mand for each of the packages (replace “libtool” with the appropriate package):

# yum list installed | grep libtool

- or -

# dnf list installed | grep libtool

If one of the prerequisite packages is missing, it can be installed using the “yum” or “dnf” package

managers. For example, install Java 1.8.0 with “yum” using the command below:

# yum -y install java-1.8.0-openjdk.x86_64

Tenable Security Center Communications and Directories

The following table summarizes the components’ primary directories and communication methods.

- 40 -



Note: Tenable Security Center does not support using symbolic links for /opt/sc/. You can use symbolic
links within /opt/sc/ subdirectories if instructed by Tenable Security Center documentation or Tenable
Support.

Tenable Security Center Directories

Installat ion Dir-

ectory

/opt/sc

User Data /opt/sc/orgs/<Organization Serial Number>

Repositories /opt/sc/repositories/<Repository Number>

Admin Logs /opt/sc/admin/logs/

Organization Logs /opt/sc/orgs/<Organization Number>/logs/

Communication

Interfaces

l User Access —HTTPS

l Feed Updates —Acquired over SSL from Tenable servers directly

to Tenable Security Center or for offline installat ion. Plugin pack-

ages are secured via 4096-bit RSA digital signatures.

For more information, see Port Requirements.

For information about data encryption in Tenable Security Center, see Encryption Strength.
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Customize SELinux Enforcing Mode Policies for Tenable Security
Center

Security-Enhanced Linux (SELinux) enforcing mode policies require customization to interact with

Tenable Security Center.

Tenable Support does not assist with customizing SELinux policies, but Tenable recommends mon-

itoring your SELinux logs to identify errors and solutions for your policy configuration.

Before you begin:

l Install the SELinux sealert tool in a test environment that resembles your production envir-

onment.

To monitor your SELinux logs to identify errors and solutions:

1. Run the sealert tool, where /var/log/audit/audit.log is the location of your SELinux

audit log:

sealert -a /var/log/audit/audit.log

The tool runs and generates a summary of error alerts and solutions. For example:

SELinux is preventing /usr/sbin/sshd from write access on the sock_file /dev/log
SELinux is preventing /usr/libexec/postfix/pickup from using the rlimitinh access
on a process.

2. Execute the recommended solution for each error alert.

3. Restart Tenable Security Center, as described in Start, Stop, or Restart Tenable Security

Center.

Tenable Security Center restarts.

4. Run the sealert tool again to confirm you resolved the error alerts.
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Use /dev/ random for Random Number Data Generation

Required User Role: Root user

If your organization requires Tenable Security Center to use /dev/random instead of /dev/ur-
andom to generate random number data for secure communication functions, modify the random

data source using an environment variable.

Unlike /dev/urandom, /dev/random blocks HTTPS and SSL/TLS functions if there is not enough

entropy to perform the functions. The functions resume after the system generates enough

entropy.

Note: If /dev/random blocks during an installat ion or upgrade, the system waits up to 10 minutes for more
entropy to be generated before halt ing the operation.

Tenable does not recommend using /dev/random unless required by your organization.

To use /dev/random for random number data generation in Tenable Security Center:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. In the CLI in Tenable Security Center, run the following command:

export TSC_ENTROPY_CHECK=true

Tenable Security Center recognizes the environment variable and uses /dev/random.

What to do next:

l Install or upgrade Tenable Security Center in order for your changes to take effect, as

described in Install Tenable Security Center or Upgrade Tenable Security Center.
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Tenable Security Center Database Journaling Modes

By default, Tenable Security Center databases use DELETE journaling mode. For installat ions that

meet the requirements, Tenable Security Center also supports converting some databases to write-

ahead logging (WAL) mode.

For Tenable Security Center installat ions where WAL is not enabled, enabling WAL may resolve

issues with excessive database locks. If your Tenable Security Center does not experience database

locking issues, Tenable recommends leaving your Tenable Security Center databases in the default

DELETE journaling mode.

Tenable strongly recommends performing a backup before converting database journaling modes

and performing regular backups after converting database journaling modes. For more information,

see Backup and Restore.

For general information about SQLite3 database journaling modes, see the SQLite3 documentation.

For more information, see:

l Enable Write-Ahead Logging

l Disable Write-Ahead Logging

Note: If you previously converted one or more Tenable Security Center databases to WAL journaling mode
without using the convertDatabaseMode.php script, you must use the convertDatabaseMode.php
script to ensure your Tenable Security Center databases are fully converted to WAL journaling mode.

WAL Requirements

In addit ion to the requirements to run Tenable Security Center, your Tenable Security Center install-

ation must be running Tenable Security Center 5.19.x or later.

Databases Affected

Enabling or disabling WAL converts the database journaling mode for the following Tenable Security

Center databases:

l /opt/sc/application.db

l /opt/sc/hosts.db
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l /opt/sc/jobqueue.db

l /opt/sc/plugins.db

l /opt/sc/remediationHierarchy.db

l /opt/sc/orgs/<orgID>/organization.db (for each organization in your Tenable Security

Center)

l /opt/sc/orgs/<orgID>/assets.db (for each organization in your Tenable Security Center)

The convertDatabaseMode.php script only converts the database journaling mode for Tenable

Security Center databases that can significantly impact performance.
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Enable Write-Ahead Logging

Required User Role: Root user

Note: This topic assumes a basic understanding of Linux.

You can use the convertDatabaseMode.php script to enable write-ahead logging (WAL) journaling

mode for Tenable Security Center databases. Enabling WAL may resolve issues with excessive data-

base locks. If your Tenable Security Center does not experience database locking issues, Tenable

recommends leaving your Tenable Security Center databases in the default DELETE journaling

mode.

For more information, see Tenable Security Center Database Journaling Modes.

Before you begin:

l Confirm your Tenable Security Center installat ion meets the requirements to enable WAL. For

more information, see WAL Requirements.

l Perform a backup of Tenable Security Center, as described in Perform a Backup.

To enable WAL:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. Stop Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

3. In the CLI in Tenable Security Center, run the following command to start the con-
verDatabaseMode.php script:

/opt/sc/support/bin/php /opt/sc/src/tools/convertDatabaseMode.php -m WAL

The script runs.

4. If the script detects any running tns user processes, repeat the following steps for each tns
user process detected:
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a. Follow the prompts in the error output to halt the tns user process.

Example error output:

Error! The Tenable.sc process with PID '10135' is still running and needs to
be halted before this script can be executed successfully.

Command: /opt/sc/support/bin/php -f /opt/sc/daemons/Jobd.php
Bailing with 146.

b. Run the following command to restart the converDatabaseMode.php script:

/opt/sc/support/bin/php /opt/sc/src/tools/convertDatabaseMode.php -m WAL

The script restarts.

Tenable Security Center converts supported databases to WAL journaling mode. For more

information, see Databases Affected.

5. Start Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

What to do next:

l Perform regular backups of Tenable Security Center, as described in Perform a Backup.
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Disable Write-Ahead Logging

Required User Role: Root user

Note: This topic assumes a basic understanding of Linux.

If you experience issues with write-ahead logging (WAL), disable WAL by reverting your Tenable

Security Center databases to DELETE journaling mode. For more information, see Tenable Security

Center Database Journaling Modes.

Before you begin:

l Perform a backup of Tenable Security Center, as described in Perform a Backup.

To disable WAL:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. Stop Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

3. In the CLI in Tenable Security Center, run the following command to start the con-
verDatabaseMode.php script:

/opt/sc/support/bin/php /opt/sc/src/tools/convertDatabaseMode.php -m DELETE

The script runs.

4. If the script detects any running tns user processes, repeat the following steps for each tns
user process detected:

a. Follow the prompts in the error output to halt the tns user process.

Example error output:

Error! The Tenable.sc process with PID '10135' is still running and needs to
be halted before this script can be executed successfully.

Command: /opt/sc/support/bin/php -f /opt/sc/daemons/Jobd.php
Bailing with 146.
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b. Run the following command to restart the converDatabaseMode.php script:

/opt/sc/support/bin/php /opt/sc/src/tools/convertDatabaseMode.php -m DELETE

The script restarts.

Tenable Security Center converts supported databases to DELETE journaling mode. For more

information, see Databases Affected.

5. Start Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

What to do next:

l Perform regular backups of Tenable Security Center, as described in Perform a Backup.
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License Requirements

Tenable Security Center does not support an unlicensed demo mode. License keys are required for

Tenable Security Center and for all attached Tenable products. You first configure your Tenable

Security Center license and addit ional Tenable product licenses during quick start, as described in

Quick Setup.

You can update your Tenable Security Center license in an externally connected or air-gapped envir-

onment, as described in Update an Existing License.

Tenable Security Center requires an internet connection to validate addit ional Tenable product

licenses. To apply a license for an addit ional Tenable product, see Apply a New License. To update a

license for an addit ional Tenable product, see Update an Existing License.

Tip: For information about Tenable Security Center-Tenable product registration server communications
encryption, see Encryption Strength.

Your Tenable Security Center License

Tenable Security Center licenses are valid for a specific hostname and for a maximum number of

active assets (identif ied by IP address or UUID). Assets are counted towards your license limit

depending on how Tenable Security Center discovers, or sees, the asset. In general, an asset does

not count against your license limit unless it has been assessed for vulnerabilit ies.

For example, if you purchase a 500 asset Tenable Security Center license, you can perform host dis-

covery on your network but you cannot assess more than 500 assets. For more information about

discovery and assessment scanning, see Scanning Overview.

Tenable Security Center generates a warning in the web interface when you approach or exceed the

license limit. To monitor your license limit, use the Licensing Status widget, as described in Over-

view Dashboard. To upgrade your license, contact your Tenable representative.

Counted Toward License Not Counted Toward License

l IP addresses from active scans

l IP addresses from Tenable Log Cor-

relation Engine instances

l IP addresses present only from imports to

offline repositories

l IP addresses present only from Tenable

Nessus Network Monitor instances in dis-
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Counted Toward License Not Counted Toward License

l IP addresses from Tenable Nessus

Network Monitor instances not in dis-

covery mode

l UUIDs from Tenable OT Security

instances

l IP addresses in offline repositories

that you downloaded using the same

Tenable Security Center instance or

license

A single IP address or UUID counts once

toward your license, even if it was scanned

by mult iple methods or stored in mult iple

repositories.

Note: If you use an alternative port scanner,
Tenable Security Center counts the detec-
ted IP addresses against your license.

covery mode

l IP addresses in offline repositories that

you downloaded using the same Tenable

Security Center instance with a different

license

l IP addresses in offline repositories that

you downloaded using a different Tenable

Security Center instance and license

l The following excluded plugins:

Tenable Nessus —10180, 10287, 10335,

11219, 11933, 11936, 12053, 14272, 14274,

19506, 22964, 33812, 33813, 34220, 34277,

45590, 54615, 87413, and 112154.

Tenable Nessus Network Monitor —0, 12,

18, 19, 20, 113, and 132.

LCE —800000 through 800099.

Your Tenable Security Center+ Product Licenses

Tip: Tenable rebranded Tenable Security Center Continuous View as Tenable Security Center+.

If you want to use Tenable Security Center with other Tenable products, you must add their activ-

ation codes to Tenable Security Center. For more information, see Apply a New License.

Your Tenable Lumin License

If you want to view and analyze your data in Tenable Vulnerability Management using Tenable Lumin,

you must acquire a Tenable Lumin license for use with your Tenable Security Center deployment.

Tip: Synchronized assets that count toward your Tenable Security Center license also count toward your
Tenable Vulnerability Management license.
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For more information, contact your Tenable representative.
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Apply a New License

Required User Role: Administrator

To apply a license for an addit ional Tenable product, add the license activation code. To update a

license for an existing Tenable product, see Update an Existing License.

For general information about licensing, see License Requirements. For information about adding a

license during quick setup, see Quick Setup.

To download Tenable Security Center, see the Tenable Security Center Downloads page.

To apply a new Tenable Nessus, Tenable Nessus Network Monitor, or Log Correlation

Engine license:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Configuration.

The Configuration page appears.

3. Click the License t ile.

The License Configuration page appears.

4. Click the product box for the license you want to apply.

5. In the box, type the activation code for the product.

6. Click Register.

Tenable Security Center updates the page to reflect the activation code status:

l Valid Code: A green box with a check mark.

l Invalid Code: A red box with an X.

If the code is valid, Tenable Security Center init iates a plugin download.
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Update an Existing License

Required User Role: Administrator

Tip: Tenable rebranded Tenable Security Center Continuous View as Tenable Security Center+.

If you need to replace your Tenable Security Center or Tenable Security Center+ license or the

license activation code for your Tenable Nessus, Tenable Nessus Network Monitor, or Tenable Log

Correlation Engine license, update the license.

To apply a new license for another Tenable product for the first t ime, see Apply a New License.

You can update your Tenable Security Center license in an externally connected or air-gapped envir-

onment. Tenable Security Center requires an internet connection to validate product licenses for

Tenable Nessus, Tenable Nessus Network Monitor, or Log Correlation Engine.

For instructions on how to install a Tenable Security Center patch, see the patch release notes.

To download Tenable Security Center, see the Tenable Security Center Downloads page.

For general information about licensing, see License Requirements.

To update a license:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Configuration.

The Configuration page appears.

3. Click the License t ile.

The License Configuration page appears.

4. To replace your Tenable Security Center license, in the Tenable Security Center License sec-

tion:

a. Click Update License.

b. Click Choose File and browse to the license file you want to upload.

Tenable Security Center applies the new license.
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5. To replace an activation code for an integrated product license, in the Activation Codes sec-

tion:

a. Click the green check mark.

b. Click Reset Activation Code.

c. In the box, paste your product license activation code.

d. Click Register.

Tenable Security Center communicates with the Tenable product registration server to

validate your license activation code.

If the code is valid, Tenable Security Center applies the new license and init iates a plu-

gin download.
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Tenable Security Center+ License Expiration

Tip: Tenable rebranded Tenable Security Center Continuous View as Tenable Security Center+.

This topic describes the behavior of Tenable Security Center+ if you allow your software main-

tenance license to expire. Software maintenance licenses can be either perpetual or subscription-

based.

Tenable Security Center Console

l Perpetual license —The software remains fully functional. All user data is accessible.

l Subscription license —You can no longer access the console unless you enter a new license

key. Normal operation resumes once you replace the license key.

Tenable Nessus

When the software maintenance period expires, Tenable Nessus stops receiving plugin updates.

After a period of 90 days, Tenable Nessus stops working and cannot perform new scans. Because

Tenable Security Center stops receiving feeds once the maintenance period expires, the Tenable

Nessus scanners managed by Tenable Security Center no longer receive updates and stop working

after the 90 day period.

Tenable Nessus Network Monitor

After 30 days with no updates, Tenable Nessus Network Monitor stops processing new data.

Log Correlation Engine

Log Correlation Engine stops processing new logs on the day of license expiration.
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Port Requirements

Tenable Security Center port requirements include Tenable Security Center-specific and applic-

ation-specific requirements.

l Tenable Security Center

l Tenable Nessus Scanner

l Tenable Nessus Agent

l Tenable Nessus Network Monitor

l Tenable Log Correlation Engine

Tenable Security Center

Your Tenable Security Center instances require access to specific ports for inbound and outbound

traffic.

Inbound Traffic

You must allow inbound traffic to the following ports.

Port Traffic

TCP 22 Performing remote repository synchronization with another Tenable Security

Center.

TCP

443

Accessing the Tenable Security Center interface.

Communicating with Tenable Security Center Director instances.

Communicating with Tenable OT Security instances.

Performing the init ial key push for remote repository synchronization with another

Tenable Security Center.

Interacting with the API.

Outbound Traffic

You must allow outbound traffic to the following ports.
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Port Traffic

TCP 22 Communicating with Log Correlation Engine for event query.

TCP 25 Sending SMTP email notif ications.

TCP 443 Communicating with Tenable Vulnerability Management.

Communicating with Tenable Lumin for synchronization.

Communicating with the plugins.nessus.org server for plugin updates.

TCP 1243 Communicating with Tenable Log Correlation Engine.

TCP 8834 Communicating with Tenable Nessus.

TCP 8835 Communicating with Tenable Nessus Network Monitor.

UDP 53 Performing DNS resolution.

Tenable Nessus Scanner

Your Tenable Nessus instances require access to specific ports for inbound and outbound traffic.

Inbound Traffic

You must allow inbound traffic to the following ports.

Port Traffic

TCP 8834 Accessing the Tenable Nessus interface.

Communicating with Tenable Security Center.

Interacting with the API.

Outbound Traffic

You must allow outbound traffic to the following ports.

Port Traffic

TCP 25 Sending SMTP email notif ications.
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Port Traffic

TCP 443 Communicating with Tenable Vulnerability Management.

Communicating with the plugins.nessus.org server for plugin updates.

UDP 53 Performing DNS resolution.

Tenable Nessus Agent

Your Tenable Nessus Agents require access to specific ports for outbound traffic.

Outbound Traffic

You must allow outbound traffic to the following ports.

Port Traffic

TCP 443 Communicating with Tenable Vulnerability Management.

TCP

8834

Communicating with Tenable Nessus Manager.

Note: The default Tenable Nessus Manager port is TCP 8834. However, this port is con-
figurable and may be different for your organization.

UDP 53 Performing DNS resolution.

Tenable Nessus Network Monitor

Your Tenable Nessus Network Monitor instances require access to specific ports for inbound and

outbound traffic.

Inbound Traffic

You must allow inbound traffic to the following ports.

Port Traffic

TCP 8835 Accessing the Tenable Nessus Network Monitor interface.

Communicating with Tenable Security Center.
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Outbound Traffic

You must allow outbound traffic to the following ports.

Port Traffic

TCP 443 Communicating with Tenable Vulnerability Management.

Communicating with the plugins.nessus.org server for plugin updates.

TCP 601 Communications for reliable TCP syslog forwarding.

UDP 53 Performing DNS resolution.

UDP 514 Communications for UDP syslog forwarding.

Tenable Log Correlation Engine

Your Log Correlation Engine and Log Correlation Engine client instances require access to specific

ports for inbound and outbound traffic.

Inbound Traffic

You must allow inbound traffic to the following ports.

Port Traffic

Log Correlation Engine

TCP 22 Communicating with Tenable Security Center for Log Correlation Engine event

query.

TCP 601 Communications for reliable TCP syslog forwarding.

TCP 1243 Communicating with Tenable Security Center for Log Correlation Engine event vul-

nerability import.

TCP 8836 Accessing the Log Correlation Engine interface.

TCP

31300

Communicating with Log Correlation Engine clients.
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Port Traffic

UDP 162 Communicating with SNMP server for receiving SNMP traps.

UDP 514 Communications for UDP syslog forwarding.

Log Correlation Engine Client

TCP 1468 Communications between network devices and the Tenable Network Monitor.

TCP 9800 Communications between Splunk and the Log Correlation Engine Splunk Client.

TCP 18185 Communications between Check Point firewalls and the Log Correlation Engine

OPSEC Client.

UDP 514 Communications between network devices and the Tenable Network Monitor.

UDP 2055 Communications between routers and the Tenable NetFlow Monitor.

Outbound Traffic

You must allow outbound traffic to the following ports.

Port Traffic

Log Correlation Engine

TCP 25 Sending SMTP email notif ications.

TCP 443 Communicating with Tenable Vulnerability Management.

Communicating with the plugins.nessus.org server for plugin updates.

TCP 601 Communications for reliable TCP syslog forwarding.

UDP 53 Performing DNS resolution.

UDP 514 Communications for UDP syslog forwarding.

Log Correlation Engine Client

TCP 135 Communicating with the targets of the Log Correlation Engine WMI Monitor Cli-

ent.

TCP 443 Communicating with the web host of the Log Correlation Engine Web Query Cli-

- 61-



Port Traffic

ent.

TCP 445 Communicating with the targets of the Log Correlation Engine WMI Monitor Cli-

ent.

TCP 31300 Communicating with Log Correlation Engine.
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Browser Requirements

Note: Tenable recommends using the newest available version of your browser.

You can access the Tenable Security Center user interface using the following browsers:

l Microsoft Internet Explorer 11or later

Tip: Tenable Security Center versions 5.22 and later do not support Internet Explorer.

l Microsoft Edge 99 or later

l Mozilla Firefox 32 or later

l Google Chrome 37 or later

l Mac OS Safari 7.1or later
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Tenable Integrated Product Compatibility

The release notes list the versions of Tenable products tested with Tenable Security Center 5.20.x.

For more information, see the Tenable Security Center Release Notes for your version.
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Large Enterprise Deployments

You may have a number of unique technical and business requirements to consider when planning a

large enterprise deployment of Tenable Security Center. If your organization scans 100,000 or more

IP addresses, consider the information in the Tenable Security Center Large Enterprise Deployment

Guide when planning, configuring, and operationalizing your Tenable Security Center deployment.
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Installation and Upgrade

To perform a fresh installat ion of Tenable Security Center, see Before You Install and Install Tenable

Security Center.

To perform an upgrade of Tenable Security Center, see Before You Upgrade and Upgrade Tenable

Security Center.

To uninstall Tenable Security Center, see Uninstall Tenable Security Center.
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Before You Install

Note: A basic understanding of Linux is assumed throughout the installat ion, upgrade, and removal pro-
cesses.

Understand Tenable Security Center Licenses

Confirm your licenses are valid for your Tenable Security Center deployment. Tenable Security

Center does not support an unlicensed demo mode.

For more information, see License Requirements.

Disable Default Web Servers

Tenable Security Center provides its own Apache web server listening on port 443. If the installat ion

target already has another web server or other service listening on port 443, you must disable that

service on that port or configure Tenable Security Center to use a different port after installat ion.

Identify which services, if any, are listening on port 443 by running the following command:

# ss -pan | grep ':443 '

If there are any services listening on port 443, you must either disable or run them on a different

port.

Modify Security Sett ings

Tenable Security Center supports disabled, permissive, and enforcing mode Security-Enhanced

Linux (SELinux) policy configurations. For more information, see SELinux Requirements.

Perform Log File Rotation

The installat ion does not include a log rotate utility; however, the native Linux logrotate tool is

supported post-installat ion. In most Red Hat environments, logrotate is installed by default. The

following logs are rotated if the logrotate utility is installed:

l All files in /opt/sc/support/logs matching *log

l /opt/sc/admin/logs/sc-error.log
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During an install/upgrade, the installer drops a file named SecurityCenter into

/etc/logrotate.d/ that contains log rotate rules for the files mentioned above.

Log files are rotated on a monthly basis. This file is owned by root/root.

Allow Tenable Sites

To allow Tenable Security Center to communicate with Tenable servers for product updates and plu-

gin updates, Tenable recommends adding Tenable sites to an allow list at the perimeter firewall. For

more information, see the knowledge base article.
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Install Tenable Security Center

Required User Role: Root user

Note: A basic understanding of Linux is assumed throughout the installat ion, upgrade, and removal pro-
cesses.

Caution: When performing sudo installs, use sudo –i to ensure the proper use of environmental variables.

Caution: During the installat ion process, Tenable Security Center produces a log file in a temporary loc-
ation: /tmp/sc.install.log. Once the installat ion process finishes, the file is stored here:
/opt/sc/admin/logs/install.log. Do not remove or modify these files; they are important for debug-
ging in case of a failed installat ion.

For information about new features, resolved issues, third-party product updates, and supported

upgrade paths, see the release notes for Tenable Security Center 5.20.x.

Before you begin:

l Complete system prerequisites, as described in Before You Install.

l Download the installat ion RPMfile from the Tenable downloads page. If necessary, depending

on the operating system of the host, move the installat ion RPMfile onto the host.

l Confirm the integrity of the installat ion RPMfile by comparing the download checksum with

the checksum on the Tenable downloads page, as described in the knowledge base article.

l If your organization requires Tenable Security Center to use /dev/random instead of /dev/ur-
andom to generate random number data for secure communication functions, modify the ran-

dom data source as described in Use /dev/ random for Random Number Data Generation.

To install Tenable Security Center:

1. On the host where you want to install Tenable Security Center, open the command line inter-

face (CLI).

2. Run one of the following commands to install the RPM:

# yum install SecurityCenter-x.x.x-el6.x86_64.rpm
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- or -

# dnf install SecurityCenter-x.x.x-el8.x86_64.rpm

Output similar to the following is generated:

# dnf install SecurityCenter-6.x.x-es6.x86_64.rpm
Preparing...                ########################################### [100%]

1:SecurityCenter         ########################################### [100%]
Installing Nessus plugins ... complete
Applying database updates ... complete.
By default, SecurityCenter will listen for HTTPS requests on ALL available
interfaces. To complete your installation, please point your web browser to one of
the following URL(s):
https://x.x.x.x
Starting SecurityCenter services
[  OK  ] SecurityCenter services: [  OK  ]
#

The system installs the package into /opt/sc and attempts to start all required daemons and

web server services.

Tip: In rare cases, a system restart is required after installat ion in order to start all services. For
more information, see Start, Stop, or Restart Tenable Security Center.
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Quick Setup

The Tenable Security Center Quick Setup Guide walks through the following configurations:

l License

l Tenable Nessus Scanner

l Tenable Nessus Network Monitor

l Log Correlation Engine

l Repository

l Organization

l LDAP

l User

l Addit ional Sett ings

After configuring, Review and confirm.

License

Upload your Tenable Security Center license and apply addit ional product licenses.

Tenable Security Center License

1. Click Choose File to upload the Tenable Security Center license file you received from

Tenable.

The file should follow the format:

<CompanyName>_SC<IP Count>-<#>-<#>.key

2. Click Activate.

The page confirms successful upload and activation of a valid license.

Activation Codes

Consider adding addit ional license activation codes:
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l Tenable Security Center license activation code —required before adding any Tenable Nessus

scanners. The Tenable Security Center license activation code allows Tenable Security Center

to download plugins and update Tenable Nessus scanner plugins.

In the Tenable Nessus section, type the Tenable Security Center activation code and click

Register.

l Tenable Nessus Network Monitor license activation code —required before using and man-

aging attached Tenable Nessus Network Monitor scanners.

In the Tenable Nessus Network Monitor section, type the Tenable Nessus Network Monitor

activation code and click Register.

l Log Correlation Engine Activation Code —required before downloading Log Correlation Engine

Event vulnerability plugins to Tenable Security Center. The Log Correlation Engine Activation

Code allows Tenable Security Center to download event plugins, but it does not manage plugin

updates for Log Correlation Engine servers.

In the Log Correlation Engine section, type the Tenable Log Correlation Engine activation

code and click Register.

Click Next to continue.

A plus (+) sign indicates that no license is applied for the product. A box with an X indicates an

invalid activation code. Click on the plus (+) or X to add or reset a license activation code.

A box with a checkmark indicates a valid license is applied and that Tenable Security Center ini-

t iated a plugin download in the background.

The download may take several minutes and must complete before init iat ing any Tenable Nessus

scans. After the download completes, the Last Updated date and time update on the Plugins page.

Tenable Nessus Scanner

Configure your first Tenable Nessus scanner. For information about the options you can configure,

see Tenable Nessus Scanners. There are some limitations on the scanner options you can configure

during Quick Start:
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l Agent Capable: If you use a Tenable Vulnerability Management or Tenable Nessus Manager

scanner for Tenable Nessus Agent scan imports, do not configure that scanner during the

Quick Start.

l Zones: If you want to grant scan zones access to this scanner, you must configure the Zones

option after the Quick Start.

Tenable Nessus Network Monitor

If you added an Tenable Nessus Network Monitor license activation code, you can configure your

first Tenable Nessus Network Monitor scanner. For information about the options you can con-

figure, see Tenable Nessus Network Monitor Instances. There are some limitations on the scanner

options you can configure during Quick Start:

l Repositories: If you want to select repositories to store the scanner's data, you must con-

figure the Repositories option after the Quick Start.

Log Correlation Engine

If you added an Log Correlation Engine Activation Code, you can configure your first Tenable Log

Correlation Engine scanner. For information about the options you can configure, see Tenable Log

Correlation Engines. There are some limitations on the scanner options you can configure during

Quick Start:

l Organizations: If you want to select organizations that can access the scanner's data, you

must configure the Organizations option after the Quick Start.

l Repositories: If you want to select repositories to store the scanner's data, you must con-

figure the Repositories option after the Quick Start.

Repository

You can configure your first local IPv4 or IPv6 repository.

Caution: When creating repositories, note that IPv4 and IPv6 addresses must be stored separately. Addi-
t ional repositories may be created once the init ial configuration is complete.

A repository is essentially a database of vulnerability data defined by one or more ranges of IP

addresses. When the repository is created, a selection for IPv4 or IPv6 addresses must be made.
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Only IP addresses of the designated type may be imported to the designated repository. The organ-

ization created in steps that follow can take advantage of one or more repositories. During install-

ation, a single local repository is created with the ability to modify its configuration and add others

post-install.

Caution: When creating Tenable Security Center repositories, Tenable Log Correlation Engine event source
IP address ranges must be included along with the vulnerability IP address ranges or the event data is not
accessible from the Tenable Security Center UI.

Local repositories are based on the IP addresses specified in the IP Ranges option on this page dur-

ing the init ial setup. Remote repositories use addressing information pulled over the network from a

remote Tenable Security Center. Remote repositories are useful in mult i-Tenable Security Center

configurations where security installat ions are separate but reports are shared. Offline repositories

also contain addressing information from another Tenable Security Center. However, the inform-

ation is imported to the new installat ion via a configuration file and not via a direct network con-

nection. For information about how this works in air-gapped environments, see Considerations for

Air-Gapped Environments.

For information about the options you can configure, see Local Repositories. There are some lim-

itations on the repositories and repository options you can configure during Quick Start:

l You cannot configure a local mobile repository during Quick Start.

l You cannot configure a local agent repository during Quick Start.

l You cannot configure an external repository during Quick Start.

l Organizations: If you want to select organizations that can access the repository's data, you

must configure the Organizations option after the Quick Start.

l Log Correlation Engine Correlation: If you want to select Log Correlation Engine servers

where you want Tenable Security Center to retrieve data, you must configure the Log Cor-

relation Engine Correlation option after the Quick Start.

Organization

An organization is a set of distinct users and groups and the resources they have available to them.

For information about the options you can configure, see Organizations.
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You can configure one organization during init ial setup. If you want to use mult iple organizations,

you must configure other organizations after the Quick Start.

LDAP

Configuring LDAP allows you to use external LDAP servers for the Tenable Security Center user

account authentication or as LDAP query assets. Type all required LDAP server sett ings and click

Next. Click Skip if you do not want to configure LDAP during init ial configuration.

You can configure one LDAP server connection during init ial setup. If you want to use mult iple

LDAP servers, or if you want to configure addit ional options, you must continue configuring

LDAP after the Quick Start.

For information about the options you can configure, see LDAP Authentication.

User

You must create one administrator and one security manager during init ial setup. For more inform-

ation, see User Roles.

l Security manager —a user to manage the organization you just created. After you finish init ial

setup, the security manager can create other user accounts within the organization.

l Administrator —a user to manage Tenable Security Center. After you finish init ial setup, the

administrator can create other organizations and user accounts.

If you already configured an LDAP server, you have the option to create an LDAP user account. For

more information about user account options, see User Accounts.

After creating the security manager user and sett ing the administrator password, click Next to fin-

ish init ial setup. The Admin Dashboard page appears, where you can review login configuration

data.

Addit ional Sett ings

The Enable Usage Statistics option specifies whether Tenable collects anonymous telemetry data

about your Tenable Security Center deployment.

When enabled, Tenable collects usage statist ics that cannot be attributed to a specific user or cus-

tomer. Tenable does not collect personal data or personally identifying information (PII).
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Usage statist ics include, but are not limited to, data about your visited pages, your used reports and

dashboards, your Tenable Security Center license, and your configured features. Tenable uses the

data to improve your user experience in future Tenable Security Center releases. You can disable

this option at any time to stop sharing usage statist ics with Tenable.

For more information about enabling or disabling this option after init ial setup, see Configuration

Settings.

Review

The review page displays your currently selected configurations. If you want to make further

changes, click the links in the left navigation bar.

When you are finished, click Confirm.
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Before You Upgrade

Note: A basic understanding of Linux is assumed throughout the installat ion, upgrade, and removal pro-
cesses.

l Tenable Security Center Upgrade Path

l Java Version Requirements

l Halt or Complete Running Jobs

l Perform a Tenable Security Center Backup

l Rename Your Mount Point

Tenable Security Center Upgrade Path

For more information about the upgrade paths to Tenable Security Center version 5.20.x, see the

Tenable Security Center Release Notes.

Java Version Requirements

If you have not installed the Oracle Java JRE or OpenJDK, Tenable Security Center displays the fol-

lowing warning:

[WARNING] SecurityCenter has determined that Oracle Java JRE and OpenJDK is not
installed. One of two must be installed for SecurityCenter reporting to func-
tion properly.

You must install the latest version of Oracle Java JRE or OpenJDK to take full advantage of Tenable

Security Center reporting.

Halt or Complete Running Jobs

Tenable recommends stopping all running Tenable Security Center processes before beginning an

upgrade. If processes are running (for example, Tenable Nessus scans), Tenable Security Center dis-

plays the following message along with the related process names and their PIDs:
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SecurityCenter has determined that the following jobs are still running. Please
wait a few minutes before performing the upgrade again. This will allow the run-
ning jobs to complete their tasks.

Stop the processes manually or retry the upgrade after the processes complete.

Perform a Tenable Security Center Backup

Perform a backup of Tenable Security Center before beginning your upgrade. For more information,

see Backup and Restore.

Rename Your Mount Point

If the existing /opt/sc directory is or contains a mount point to another location, rename the

mount point. During the RPMupgrade process, a message appears with information about the dis-

covered mount point. Contact your system administrator for assistance.
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Upgrade Tenable Security Center

Required User Role: Root user

Note: This topic assumes a basic understanding of Linux.

Caution: During the upgrade process, Tenable Security Center produces a log file in a temporary location:
/tmp/sc.install.log. Once the installat ion process finishes, the file is stored here:
/opt/sc/admin/logs/install.log. Do not remove or modify these files; they are important for debug-
ging in case of a failed upgrade.

For information about new features, resolved issues, third-party product updates, and supported

upgrade paths, see the release notes for Tenable Security Center 5.20.x.

Before you begin:

1. Complete system prerequisites, as described in Before You Upgrade.

Note: Tenable recommends creating a backup of your Tenable Security Center data before upgrad-
ing, as described in Perform a Backup.

2. Download the upgrade RPMfile from the Tenable downloads page. If necessary, depending on

the operating system of the host, move the upgrade RPMfile onto the host.

3. Confirm the integrity of the upgrade RPMfile by comparing the download checksum with the

checksum on the Tenable downloads page.

4. If your organization requires Tenable Security Center to use /dev/random instead of /dev/ur-
andom to generate random number data for secure communication functions, modify the ran-

dom data source as described in Use /dev/ random for Random Number Data Generation.

To upgrade to Tenable Security Center 5.20.x:

1. Log in to Tenable Security Center via the user interface.

2. Pause all running scans, as described in Start or Pause a Scan.

3. Prepare the upgrade command you intend to run:
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l Use yum or dnf with the upgrade switch from the command-line of the Tenable Security

Center server.

l Use “sudo -i” when performing sudo upgrades of Tenable Security Center to ensure

the proper use of environmental variables.

For example:

# yum upgrade SecurityCenter-x.x.x-el6.x86_64.rpm

- or -

# dnf upgrade SecurityCenter-x.x.x-el8.x86_64.rpm

The upgrade begins. Tenable Security Center is not available until the upgrade finishes.

# dnf upgrade SecurityCenter-x.x.x-el6.x86_64.rpm
Preparing...                ########################################### [100%]
Shutting down SecurityCenter services: [  OK  ]
Backing up previous application files ... complete.

1:SecurityCenter         ########################################### [100%]

Applying database updates ... complete.
Beginning data migration.
Starting plugins database migration...complete.
(1 of 4) Converting Repository 1 ...  complete.
(2 of 4) Converting Repository 2 ...  complete.
(3 of 4) Converting Repository 3 ...  complete.
(4 of 4) Converting Repository 4 ...  complete.
Migration complete.
Starting SecurityCenter services: [  OK  ]
~]#

What to do next:

l (Optional) If you used custom Apache SSL certif icates before upgrading Tenable Security

Center, restore the custom SSL certif icates, as described in Restore Custom SSL Certif icates.
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Restore Custom SSL Certificates

Required User Role: Root user

If you used custom Apache SSL certif icates before upgrading Tenable Security Center, you must

restore the custom Apache SSL certif icates after you upgrade Tenable Security Center.

Tenable Security Center creates a backup of the certif icates during the upgrade process. Tenable

Security Center copies the existing custom SSL certif icates to the Apache configuration backup dir-

ectory that the upgrade process creates in the /tmp/[version].apache.conf-######## dir-

ectory. The exact name of the directory varies, but the system displays the name during the

upgrade process and reports it in the /opt/sc/admin/log/install.log f ile.

Before you begin:

l Upgrade to a new version of Tenable Security Center, as described in Upgrade Tenable Secur-

ity Center.

To restore custom SSL certif icates after upgrading Tenable Security Center:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. In the CLI in Tenable Security Center, run the following command:

# cp /tmp/[version].apache.conf-########/SecurityCenter.cert
/opt/sc/support/conf/SecurityCenter.crt

3. Select yes to overwrite the existing file.

4. In the CLI in Tenable Security Center, run the following command:

# cp /tmp/[version].apache.conf-########/SecurityCenter.pem
/opt/sc/support/conf/SecurityCenter.key

5. Select yes to overwrite the existing file.

Caution: Ensure that the newly copied files have permissions of 0640 and ownership of tns:tns.
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6. Modify the servername parameter in /opt/sc/support/conf/servername to match the

Common Name (CN) of the SSL certif icate.

Tip: To obtain the CN, run the following command and note the CN= portion of the result.

# /opt/sc/support/bin/openssl verify /opt/sc/support/conf/SecurityCenter.crt

7. In the CLI in Tenable Security Center, run one of the following commands to restart the

Apache server:

# /opt/sc/support/bin/apachectl restart

-or-

# service SecurityCenter restart

The Apache server restarts.
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Uninstall Tenable Security Center

Required User Role: Root user

To uninstall Tenable Security Center:

1. On the host where you want to uninstall Tenable Security Center, open the command line inter-

face (CLI).

2. In the CLI, run the following command to stop Tenable Security Center:

service SecurityCenter stop

3. Run the following command to remove Tenable Security Center:

dnf remove SecurityCenter

4. Run the following command to remove user-created and user-modified files:

rm -rf /opt/sc

Tenable Security Center is removed.
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User Access

The Users page provides the ability to add, edit, delete, or view the details of Tenable Security

Center user accounts. When you view the Users page, you see a list of users and actions, limited by

your account privileges. Your user role, organization membership, and/or group membership

determine your account privileges. For more information, see User Roles and Organizations and

Groups.

There are two categories of user accounts:

l Administrator users have the system-provided administrator role and do not belong to organ-

izations.

l Organizational users have the system-provided security manager, auditor, credential manager,

executive, security analyst, security manager, or vulnerability analyst role, or a custom role,

and belong to an organization.

Tenable Security Center supports three types of user account authentication: TNS, LDAP, and

SAML. For more information, see User Accounts.

To log in to the Tenable Security Center web interface with a user account, see Log In to the Web

Interface or Log in to the Web Interface via SSL Client Certif icate.
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Log In to the Web Interface

Required User Role: Any

To log in to the Tenable Security Center configuration interface:

1. Open a supported web browser on a system that has access to the system’s network address

space.

Note: You must access the Tenable Security Center web interface using a secure web con-
nection (HTTPS) with SSL/TLS 1.2 enabled. Tenable Security Center recommends con-
figuring the strongest encryption supported by your browser.

For more information, see Encryption Strength.

2. Clear your web browser's cache.

3. Navigate to the URL for your Tenable Security Center: https:/ /<SERVER ADDRESS OR

NAME>/ .

Where <SERVER ADDRESS OR NAME> is the IPv4 or IPv6 address or hostname for your Ten-

able Security Center.

The Tenable Security Center web interface appears.

4. Log in using the supported method for your account configuration.

Note: If you are the first administrator user logging in to Tenable Security Center, see Inital Login
Considerations.

l To log in via a username and password, type your Tenable Security Center credentials

and click Log In.

l To log in via SAML authentication, click Sign In Using Identity Provider. When presented

with your identity provider login page, type your identity provider credentials.

For more information about SAML authentication, see Configure SAML Authentication

Manually via the User Interface.

l To log in via certif icate, see Log in to the Web Interface via SSL Client Certif icate.
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Tenable Security Center logs you in and displays the dashboard with different elements

depending on your user role.

Inital Login Considerations

When you log in to Tenable Security Center for the first t ime, Tenable Security Center displays the

Quick Setup Guide welcome page to begin a mult i-step setup process for init ial configuration. For

more information about quick setup, see Quick Setup.

If you prefer to configure the system manually, click Exit Quick Setup Guide. For more information

about gett ing started with Tenable Security Center, see Get Started With Tenable Security Center.
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Log in to the Web Interface via SSL Client Certificate

Required User Role: Any

Before you begin:

l Confirm your Tenable Security Center administrator fully configured Tenable Security Center

for cert if icate authentication, as described in Certif icate Authentication.

To perform a certif icate-based Tenable Security Center login:

Note: The following information is provided with the understanding that your browser is configured for SSL
certif icate authentication. Please refer to your browser’s help files or other documentation to configure
this feature.

1. Open a browser window and navigate to Tenable Security Center.

The browser presents a list of available certif icate identit ies.

For information about Tenable Security Center-browser communications encryption, see

Encryption Strength.

2. Select a certif icate.
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3. Click OK.

An authentication prompt appears (if required to access your certif icate).

4. (Optional) If prompted, type a PIN or password.

5. Click OK.

The Tenable Security Center login page appears.

6. Log in using the username to be associated with the selected certif icate.

Caution: Only one Tenable Security Center user may be associated with a single certif icate. If one
user holds mult iple user names and roles, a unique certif icate must be provided for each login name.

The Certificate Authentication window appears.

7. When prompted, specify whether the current cert if icate is to be used to authenticate the cur-

rent user.

l Click Yes to always use the certif icate for authentication.

l Click No to ignore the certif icate and log in via TNS authentication.

Tenable Security Center logs you in.

Subsequent Logins

After you log out of Tenable Security Center, the login page appears. If you want to log in again with

the same certif icate, refresh your browser window. If you want to use a different cert if icate, you

must start a new browser session.
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After you perform your second certif icate login, edit your account from the Profile page to view

your certif icate details. If your cert if icate changes or you need to revoke it, click the Clear Cer-

tification Details button to disassociate the certif icate from your account.
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User Roles

Roles determine what a user can or cannot access from their account. Tenable Security Center

comes with eight system-provided roles, but you can also create custom roles to satisfy complex

security policy needs. You can customize the permissions on some, but not all, system-provided

user roles.

If you configure linked user accounts, an Administrator can switch to one or more Security Manager

user accounts without logging out and logging back in to Tenable Security Center. For more inform-

ation, see Linked User Accounts.

For more information about user roles in Tenable Security Center, see Create a User Role, Edit a

User Role, View User Role Details, and Delete a User Role.

Roles

User Role
Customizable

Permissions?
Description

Administrator No An account that manages Tenable Security Center as

a whole. The primary task of the Administrator is to

install and configure each organization. In addit ion,

the Administrator adds components to Tenable Secur-

ity Center such as Tenable Nessus Network Monitor,

Tenable Log Correlation Engine, and Tenable Nessus

to extend its capabilit ies. The Administrator is auto-

matically assigned the “Manage Application” role.

Because administrators do not belong to an organ-

ization, they do not have access to the data collected

by Tenable Security Center.

Organizational User Roles

Security Manager No An account that manages an individual organization.

This is the role assigned to the init ial user that is

assigned when a new organization is created. They

can launch scans, configure users (except for admin-
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istrator user roles), vulnerability policies, and other

objects belonging to their organization.

A Security Manager is the account within an organ-

ization that has a broad range of security roles within

the defined organization. This is the init ial user that

is created when a new organization is created, and

the user can launch scans, configure users (except

for the Administrator user), vulnerability policies, and

other objects that belong to their organization. This

init ial Security Manager account cannot be deleted

without deleting the entire organization.

Security Managers have complete access to all data

collected by their organization.

Auditor Yes An account that can access summary information to

perform third-party audits. An Auditor can view dash-

boards, reports, and logs, but cannot perform scans

or create tickets.

Credential Man-

ager

Yes An account that can be used specifically for handling

credentials. A Credential Manager can create and

share credentials without revealing the contents of

the credential. This can be used by someone outside

the security team to keep scanning credentials up to

date.

Executive Yes An account intended for users who are interested in a

high-level overview of their security posture and risk

profile. Executives would most likely browse dash-

boards and review reports, but would not be con-

cerned with monitoring running scans or managing

users. Executives would also be able to assign tasks

to other users using the ticketing interface.

Security Analyst Yes An account that has permissions to perform all
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actions at the Organizational level except managing

groups and users. A Security Analyst is most likely an

advanced user who can be trusted with some sys-

tem-related tasks such as sett ing freeze windows or

updating plugins.

Vulnerability Ana-

lyst

Yes An account that can perform basic tasks within the

application. A Vulnerability Analyst is allowed to view

security data, perform scans, share objects, view

logs, and work with tickets.

No Role No An account with virtually no permissions. No Role is

assigned to a user if their designated role is deleted.

Custom Role Yes A custom role that you create by enabling or disabling

individual permissions.

Role Options

Permissions Option Description

General

Name Custom role name

Description Custom role description

Scan Permissions

Create Scans Allows the user to create policy-based scans. Disabling Create Policies

while enabling this permission allows you to lock user into specific set

of policies for scanning.

Create Plugin

Scans

Allows the user to create single plugin remediation scans.

Create Agent Syn-

chronization Jobs

Allows the user to add agent synchronization jobs that fetch agent scan

results from Tenable Vulnerability Management or Tenable Nessus Man-

ager.

- 92 -



Permissions Option Description

Create Agent Scans Allows the user to add agent scans that create and launch parallel scans

in Tenable Nessus Manager, then import the scan results to Tenable

Security Center.

Create Audit Files Allows the user to upload audit files, which can be used for con-

figuration audit scans.

Create Policies Allows the user to set scan parameters and select plugins for scanning.

Upload Nessus

Scan Results

Allows the user to import results from an external Nessus scanner. Res-

ult upload will be limited to user’s repositories and restricted by user’s IP

address ranges.

Manage Freeze Win-

dows

Allows the user to add, edit, and delete organization-wide freeze win-

dows. Freeze windows prevent scans from launching and stop any scans

in progress.

Asset Permissions

Create LDAP Query

Assets

Allows the user to create LDAP Query Assets, which update a list of

hosts based on a user-defined LDAP query.

Analysis Permissions

Accept Risks Allows the user to accept risks for vulnerabilit ies, which removes them

from the default view for analysis, dashboards, and reports.

Recast Risks Allows the user to change the severity for vulnerabilit ies.

Organizational Permissions

Share Objects

Between Groups

Allows the user to share assets, audit files, credentials, queries, and

policies with any group. Users in groups to which these objects have

been shared can use the objects for filtering and scan creation.

View Organization

Logs

Allows the user to view logs for entire organization.

User Permissions
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Permissions Option Description

Manage Roles Allows the user to create new roles and edit and delete organizational

roles. Any roles added must have permissions equal to or lesser than the

user’s role.

Manage Groups Allows the user to add, edit, and delete groups. Users with this per-

mission are allowed to create groups with access to any vulnerability

and event data available to the organization.

Manage Group Rela-

t ionships

Allows the user to set other user’s relationship with any other groups.

Group relationships allow for a user to view and manage objects and

users in other groups.

Report Permissions

Manage Images Allows the user to upload images, so anyone in the organization can use

the images in reports.

Manage Attribute

Sets

Allows the user to add, edit, and delete attribute sets.

System Permissions

Update Feeds Allows the user to request a plugin update or a Tenable Security Center

feed update.

Workflow Permissions

Create Alerts Allows the user to create alerts which are used to trigger actions (e.g.,

launch scans, run reports, send emails) when specified vulnerability or

event condit ions occur.

Create Tickets Allows the user to create tickets, which are typically used to delegate

work to other users.
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Create a User Role

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about user role options, see User Roles.

To create a custom user role:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Roles.

The Roles page appears.

3. Click Add.

The Add Role page appears.

4. In the Name box, type a name for the role.

5. (Optional) In the Description box, type a description for the role.

6. Set the following permissions, as described in User Roles:

l Scanning Permissions

l Asset Permissions

l Analysis Permissions

l Organization Permissions

l User Permissions

l Reporting Permissions

l System Permissions

l Workflow Permissions

7. Click Submit.

Tenable Security Center saves your configuration.
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Edit a User Role

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about user role options, see User Roles.

To edit the permissions of a custom or system-provided role:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Roles.

The Roles page appears.

3. In the row for the user role you want to edit, click the menu.

The actions menu appears.

4. Click Edit.

The Edit Role page appears.

5. (Optional) Modify the Name

6. (Optional) Modify the Description.

7. (Optional) Modify the following permissions, as described in User Roles:

l Scanning Permissions

l Asset Permissions

l Analysis Permissions

l Organization Permissions

l User Permissions

l Reporting Permissions

l System Permissions

l Workflow Permissions
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8. Click Submit.

Tenable Security Center saves your configuration.
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View User Role Details

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can view details for any user role. For more information, see User Roles.

To view role details:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Roles.

The Roles page appears.

3. In the row for the user role, click the menu.

The actions menu appears.

4. Click View.

The View Role page appears.

Section Action

General View general information for the user role.

l Name —The user role name.

l Description —The user role description.

l User Count —The number of users with this role.

l Created —The date the user role was created.

l Last Modified —The date the user role was last modified.

l ID —The user role ID.

Scanning Per-

missions

View a summary of permissions for the role. For more information,

see User Roles.

Asset Permissions
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Section Action

Analysis Per-

missions

Organization Per-

missions

User Permissions

Reporting Per-

missions

System Per-

missions

Workflow Per-

missions
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Delete a User Role

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see User Roles.

To delete a custom or system-provided user role:

Note: Deleting a role will cause all users with that role to lose all assigned permissions.

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Roles.

The Roles page appears.

3. In the row for the user role you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the role.
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Organizations and Groups

An organization is a set of distinct users and groups and the resources they have available to them.

These users are assigned repositories and zones within one or more specified IP address networks.

Users refers to any non-administrator user account on Tenable Security Center. Groups refers to

collections of users with the same permissions within an organization.

For more information, see Organizations and Groups.
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Organizations

An organization is a set of distinct users and groups and the resources (for example, scanners,

repositories, and LDAP servers) they have available to them.

The organization is managed primarily by the administrator users and security manager users. The

administrator user creates the organization and creates, assigns, and maintains the security man-

ager user account. The security manager user (or any organizational user with appropriate per-

missions) creates other users within the organization. Groups allow you to manage users and share

permissions to resources and objects among the group. For more information, see User Access.

Mult iple organizations can share the same repositories, and the vulnerability data associated with

the overlapping ranges is shared between each organization. Conversely, organizations can be con-

figured with their own discrete repositories to facilitate situations where data must be kept con-

fidential between different organizational units.

Creation of an organization is a mult i-step process. After you create an organization, Tenable Secur-

ity Center prompts you to create the init ial security manager user. For more information, see Add

an Organization and Delete an Organization.

To view details for any organization, see View Organization Details.

To view the users in an organization, filter by the organization on the Users page. For more inform-

ation about filters, see Apply a Filter.

Organization Options

Option Description

General

Name (Required) The organization name.

Description A description for the organization.

Contact Information The relevant contact information for the organization including

address, city, state, country, and phone number.

Scanning

Distribution Method The scan distribution mode you want to use for this organ-
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Option Description

ization:

l Automatic Distribution Only: Tenable Security Center

chooses one or more scan zones to run the scan. Organ-

izational users cannot choose a scan zone when con-

figuring a scan.

Tenable Security Center distributes targets for scans

based on your configured scan zone ranges. This facil-

itates optimal scanning and is useful if an organization

has devices placed behind a firewall or NAT device or has

conflict ing RFC 1918 non-internet-routable address

spaces.

l Locked Zone: Tenable Security Center uses the one Avail-

able Zone you specify to run the scan. Organizational

users cannot modify the scan zone when configuring a

scan.

l Selectable Zones: Tenable Security Center allows organ-

izational users to select a scan zone when configuring a

scan.

This mode allows organizational users to use scanners to

run internal and external vulnerability scans and analyze

the vulnerability stance from a new perspective. For

example, an organizational user can choose an external

scanner to see the attack surface from an external

attacker’s perspective.

For more information about scan zones, see Scan Zones.

Available Zones One or more scan zones that you want organizational users to

have access to when configuring scans.

Allow for Automatic Dis-

tribution

Enable or disable this option to specify whether you want Ten-

able Security Center to select one or more scan zones auto-
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Option Description

matically if an organizational user does not specify a scan zone

when configuring a scan.

l When enabled, Tenable Security Center chooses one or

more scan zones as specified by your Restrict to Selec-

ted Zones sett ing.

l When disabled, Tenable Security Center requires the

organizational user to specify a scan zone when con-

figuring a scan.

Restrict to Selected Zones If Allow for Automatic Distribution is enabled, enable or disable

this option to specify the zones you want Tenable Security

Center to choose from when automatically distributing zones.

l When enabled, Tenable Security Center chooses from the

Available Zones shared with the organization.

l When disabled, Tenable Security Center chooses from all

zones on Tenable Security Center.

Restricted Scan Ranges The IP address ranges you do not want users in this organ-

ization to scan.

Analysis

Accessible LCEs The Log Correlation Engines that you want this organization to

have access to. You can search for the Log Correlation Engines

by name or scroll through the list.

Accessible Repositories The repositories that you want this organization to have

access to. You can search for the repositories by name or

scroll through the list.

Accessible Agent Capable

Scanners

The Tenable Nessus scanners (with Tenable Nessus Agents

enabled) that you want this organization to have access to.

Select one or more of the available scanners to allow the organ-

ization to import Tenable Nessus Agent results from the selec-
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Option Description

ted scanner.

Accessible LDAP Servers The LDAP servers that you want this organization to have

access to. An organization must have access to an

LDAP server to perform LDAP authentication on user accounts

within that organization, and to configure LDAP query assets.

Note: If you revoke access to an LDAP server, users in the organ-
ization cannot authenticate and LDAP query assets cannot run.

Custom Analysis Links

A list of custom analysis links provided to users within the host vulnerability details when ana-

lyzing data outside of Tenable Security Center is desired. Click Add Custom Link to create a new

option to type the link name and URL to look up addit ional data external to Tenable Security

Center.

For example: http:/ /example.com/ index.htm?ip=%ip%

The %ip% reference is a variable that inserts the IP address of the current host into the spe-

cified URI.

Vulnerability Weights

Low The vulnerability weighting to apply to Low crit icality vul-

nerabilit ies for scoring purposes. (Default: 1)

Medium The vulnerability weighting to apply to Medium crit icality vul-

nerabilit ies for scoring purposes. (Default: 3)

High The vulnerability weighting to apply to High crit icality vul-

nerabilit ies for scoring purposes. (Default: 10)

Critical The vulnerability weighting to apply to Critical crit icality vul-

nerabilit ies for scoring purposes. (Default: 40)

Vulnerability Scoring System

Scoring System The scoring system Tenable Security Center uses to assess the
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Option Description

severity of vulnerabilit ies: CVSS v2 or CVSS v3.

Note: Changing the Scoring System while Tenable Security Center
is running certain operations, such as preparing reports or dash-
board data, results in data using mixed CVSS v2 and CVSS v3
scores.

Note: Changing the Scoring System does not impact historical
dashboard trend data. For example, if you change the Scoring Sys-
tem from CVSS v2 to CVSS v3, dashboard trend data before the
change displays CVSS v2 scores while dashboard trend data after
the change displays CVSS v3 scores.
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Add an Organization

Required User Role: Administrator

For more information about organization options, see Organizations.

To add an organization:

1. Log in to Tenable Security Center via the user interface.

2. Click Organizations.

The Organizations page appears.

3. Click Add.

The Add Organization page appears.

4. Configure the following sett ings:

l General

l Scanning

l Analysis

l Custom Analysis Links

l Vulnerability Weights

l Vulnerability Scoring System

5. Click Submit.

Tenable Security Center saves your configuration.
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View Organization Details

Required User Role: Administrator

You can view details for any organization. For more information, see Organizations.

To view organization details:

1. Log in to Tenable Security Center via the user interface.

2. Click Organizations.

The Organizations page appears.

3. In the row for the organization, click the menu.

The actions menu appears.

4. Click View.

The View Organization page appears.

Section Action

General View general information for the organization.

l Name —The organization name.

l Description —The organization description.

l Address / City / State / Country / Phone —The contact inform-

ation for the organization.

l Created —The date the organization was created.

l Last Modified —The date the organization was last modified.

l ID —The organization ID.

Scanning View a summary of your scanning sett ings for the organization. For

more information about a sett ing, see Organizations.

Analysis View a summary of your analysis sett ings for the organization. For

more information about a sett ing, see Organizations.
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Section Action

Custom Ana-

lysis Links

View a summary of your custom analysis link sett ings for the organ-

ization. For more information about a sett ing, see Organizations.

Vulnerability

Weights

View a summary of your vulnerability weights sett ings for the organ-

ization. For more information about a sett ing, see Organizations.

Vulnerability

Scoring System

View the vulnerability scoring system selected for the organization.

For more information, see Organizations.
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Delete an Organization

Required User Role: Administrator

For more information, see Organizations.

To delete an organization:

Note: Deleting an organization deletes all of the users in that organization.

1. Log in to Tenable Security Center via the user interface.

2. Click Organizations.

The Organizations page appears.

3. In the row for the organization you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

A confirmation window appears.

6. Click Delete.

Tenable Security Center deletes the organization.
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Groups

User groups are a way to group rights to objects within an organization, and then quickly assign

these rights to one or more users. A user's group membership determines their access to security

data. When a user creates various objects such as reports, scan policies, dashboards, and other sim-

ilar items, these objects are automatically shared among the group members if the group per-

missions allow view and control.

For more information, see Add a Group, View Group Details, and Delete a Group.

Group Options

Option Description

General tab

Name The name for the group.

Description A description for the group (e.g., security team at the central office or exec-

utives on the east coast).

Viewable Hosts The IP addresses and agent IDs that are viewable by the group. The selec-

t ion is made by all defined assets or the selection of one or more asset

lists.

Repositories The repositories you want to share with the group.

Log Correlation

Engines

The Log Correlation Engines you want to assign to the group.

Sample Content When enabled, Tenable provides sample content objects to users in the

group:

l sample dashboards (Executive 7 Day, Executive Summary, and Vul-

nerability Overview)

l sample reports (Critical and Exploitable Vulnerabilities, Monthly Exec-

utive, and Remediation Instructions by Host)

l sample ARCs (CCC 1: Maintain an Inventory of Software and Hardware,

CCC 2: Remove Vulnerabilities and Misconfigurations, CCC 3: Deploy a
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Option Description

Secure Network, CCC 4: Authorize Users, and CCC 5: Search for Mal-

ware and Intruders)

l sample assets required for the sample ARCs

After enabling Sample Content, you must add a new user to the group

before all users in the group can access the sample content.

Note: If a user in a group deletes a sample content object, the object is deleted
for all other users in that group.

Note: If you move a sample content object owner (e.g., move the first
user in group A to group B), Tenable Security Center:

1. Assigns their dashboards and ARCs to a new sample content
object owner in group A. Tenable Security Center does not reas-
sign reports or assets.

2. Recreates their dashboards, ARCs, and assets required for ARCs
in group B. Tenable Security Center does not recreate reports.

Share to Group tab

Available

Objects

The list of available objects to be shared with the group on creation or edit

in a bulk operation.
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Add a Group

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information about group options, see Groups.

To add a group:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Groups.

The Groups page appears.

3. Click Add.

The Add Group page appears.

4. Configure the General options.

5. Configure the Share to Group options.

6. Click Submit.

Tenable Security Center saves your configuration.
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View Group Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can view details for any group. For more information, see Groups.

To view group details:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Groups.

The Groups page appears.

3. In the row for the group, click the menu.

The actions menu appears.

4. Click View.

The View Group page appears.

Section Action

General View general information for the group.

l Name —The group name.

l Description —The group description.

l Created —The date the group was created.

l Last Modified —The date the group options were last modified.

l ID —The group ID.

Access View the lists of Viewable Hosts, Repositories, and LCEs users in the

group can access. For more information, see Group Options.

Preferences View whether you enabled Sample Content for the group. For more

information, see Group Options.

Users View the list of users associated with the group.
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Delete a Group

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To delete a group:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Groups.

The Groups page appears.

3. In the row for the group you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the group.
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User Accounts

The Users page displays the user accounts on Tenable Security Center, limited by your account priv-

ileges. You can sort the columns or apply filters to locate specific user accounts. You can also add a

user (Add a TNS-Authenticated User, Add an LDAP-Authenticated User, or Add a SAML-Authentic-

ated User) or Delete a User.

You can create one or more administrator accounts on Tenable Security Center. You can create one

or more organizational users (security managers and custom roles) per organization. Tenable recom-

mends you make at least one TNS-authenticated administrator and security manager user per

organization so that you can still log in if the LDAP or SAML service becomes unavailable. For more

information about user account types, see User Access.

For more information about options available when configuring user accounts, see User Account

Options.

Linked User Accounts

You can create linked user accounts to allow an Administrator user to switch to one or more Secur-

ity Manager accounts without logging out and logging back in to Tenable Security Center. For more

information, see Linked User Accounts.

API Keys

You can generate API keys to authenticate as a specific user for Tenable Security Center API

requests. For more information, see API Key Authentication.
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Add a TNS-Authenticated User

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about user account configuration options, see TNS User Account Options.

To add a TNS-authenticated user account as an administrator user:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. Click Add.

The Add User page appears.

4. Select a Role.

5. If you selected Security Manager as the Role, select an Organization.

6. (Optional) Type a First Name and Last Name.

7. Type a Username and Password for the user.

8. If the Type drop-down box is visible, select TNS.

9. (Optional) Enable User Must Change Password.

10. Select a Time Zone.

11. (Optional) Select a Scan Result Default Timeframe.

12. (Optional) Enable Cached Fetching.

13. (Optional) Enable Dark Mode for the user.

14. (Optional) Type Contact Information for the user.

15. Click Submit.

Tenable Security Center saves your configuration.

To add a TNS-authenticated user account as an organizational user:
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1. Log in to Tenable Security Center via the user interface. You must log in with a user account

belonging to the organization where you want to create a new user.

2. Click Users > Users.

The Users page appears.

3. Click Add.

The Add User page appears.

4. (Optional) Type a First Name and Last Name for the user.

5. If the Type drop-down box is visible, select TNS.

6. Type a Username and Password for the user.

7. (Optional) Enable User Must Change Password.

8. Select a Time Zone.

9. (Optional) Select a Scan Result Default Timeframe.

10. (Optional) Enable Cached Fetching

11. Select a Role. For more information, see User Roles.

12. Select a Group. For more information, see Organizations and Groups.

13. (Optional) If you want to customize the group-related permissions for the user, modify the

Group Permissions as described in Custom Group Permissions.

14. (Optional) If you want to share an asset list with the user, select an Asset. For more inform-

ation, see Assets.

15. (Optional) Enable Dark Mode for the user.

16. (Optional) Type Contact Information for the user.

17. Click Submit.

Tenable Security Center saves your configuration.
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Add an LDAP-Authenticated User

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about user account configuration options, see User Accounts To auto-

matically add LDAP-authenticated users by importing users from your LDAP identity provider, see

Configure LDAP User Provisioning.

To add an LDAP-authenticated user account as an administrator user:

1. Log in to Tenable Security Center via the user interface.

2. Configure an LDAP server, as described in LDAP Authentication. If you want the new user to

be a member of an organization, associate the LDAP server with an organization.

3. Click Users > Users.

The Users page appears.

4. Click Add.

The Add User page appears.

5. Select a Role for the user account.

6. If you selected Security Manager as the Role, select an Organization for the user account. You

must select an organization with an associated LDAP server.

7. (Optional) Type a First Name and Last Name for the user.

8. In the Type drop-down list, select LDAP. If LDAP does not appear in the drop-down list, add an

LDAP server as described in Add an LDAP Server.

9. Select the LDAP Server where you want to authenticate the user.

10. Type a Search String to find existing users on the LDAP server.

11. Click Search.

The page displays the LDAP Users Found by the LDAP search string.

12. Select an LDAP user from the LDAP Users Found drop-down box.
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The page populates the Username option with your selection.

13. View the Username. Tenable does not recommend modifying the Username since it must

match the username on the LDAP server.

14. Select a Time Zone.

15. (Optional) Select a Scan Result Default Timeframe.

16. (Optional) Enable Cached Fetching.

17. (Optional) Enable Dark Mode for the user.

18. (Optional) Type Contact Information for the user.

19. Click Submit.

Tenable Security Center saves your configuration.

To add an LDAP-authenticated user account as an organizational user:

1. Log in to Tenable Security Center via the user interface. You must log in with a user account

belonging to the organization where you want to create a new user.

2. Confirm that an administrator user configured an LDAP server, and that the LDAP server was

associated with the organization where you want to create a user account.

3. Click Users > Users.

The Users page appears.

4. Click Add.

The Add User page appears.

5. (Optional) Type a First Name and Last Name for the user.

6. In the Type drop-down list, select LDAP. If LDAP does not appear in the drop-down list, add an

LDAP server as described in Add an LDAP Server.

7. Select the LDAP Server where you want to authenticate the user.

8. Select an LDAP user from the LDAP Users Found drop-down box.

The page populates the Username option with your selection.
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9. View the Username. Tenable does not recommend modifying the Username since it must

match the username on the LDAP server.

10. Select a Time Zone.

11. (Optional) Select a Scan Result Default Timeframe.

12. (Optional) Enable Cached Fetching.

13. Select a Role. For more information, see User Roles.

14. Select a Group. For more information, see Organizations and Groups.

15. (Optional) If you want to customize the group-related permissions for the user, modify the

Group Permissions as described in Custom Group Permissions.

16. (Optional) If you want to share an asset list with the user, select an Asset. For more inform-

ation, see Assets.

17. (Optional) Enable Dark Mode for the user.

18. (Optional) Type Contact Information for the user.

19. Click Submit.

Tenable Security Center saves your configuration.
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Add a SAML-Authenticated User

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about user account configuration options, see SAML User Account Options.

To automatically add SAML-authenticated users by importing users from your SAML identity pro-

vider, see Configure SAML User Provisioning.

Before you begin:

l Configure SAML authentication, as described in Configure SAML Authentication Manually via

the User Interface.

To add a SAML-authenticated user account as an administrator user:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. Click Add.

The Add User page appears.

4. (Optional) Type a First Name and Last Name for the user.

5. In the Type drop-down box, select SAML. If SAML does not appear in the drop-down box, con-

figure SAML authentication as described in Configure SAML Authentication Manually via the

User Interface.

6. In the Username box, type the user's SAML username exactly as it appears in your identity pro-

vider SAML configuration for this user.

7. Select a Time Zone.

8. (Optional) Select a Scan Result Default Timeframe.

9. (Optional) Enable Cached Fetching.

10. (Optional) Enable Dark Mode for the user.
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11. (Optional) Type Contact Information for the user.

12. Click Submit.

Tenable Security Center saves your configuration.

To add a SAML-authenticated user account as an organizational user:

1. Log in to Tenable Security Center via the user interface. You must log in with a user account

belonging to the organization where you want to create a new user.

2. Click Users > Users.

The Users page appears.

3. Click Add.

The Add User page appears.

4. (Optional) Type a First Name and Last Name for the user.

5. In the Type drop-down list, select SAML. If SAML does not appear in the drop-down list, con-

figure SAML authentication as described in Configure SAML Authentication Manually via the

User Interface.

6. In the Username box, type the user's SAML username exactly as it appears in your identity pro-

vider SAML configuration for this user.

7. Select a Time Zone.

8. (Optional) Select a Scan Result Default Timeframe.

9. (Optional) Enable Cached Fetching.

10. Select a Role. For more information, see User Roles.

11. Select a Group. For more information, see Organizations and Groups.

12. (Optional) To customize the user's object and user account management permissions, modify

the Group Permissions as described in Custom Group Permissions.

13. (Optional) To share an asset list with the user, select an Asset. For more information, see

Assets.

14. (Optional) Enable Dark Mode for the user.
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15. (Optional) Type Contact Information for the user.

16. Click Submit.

Tenable Security Center saves your configuration.
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Manage User Accounts

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about user accounts, see User Accounts.

To view or edit a user account:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Users > Users.

The Users page appears.

3. To filter the users that appear on the page, apply a filter as described in Apply a Filter.

Note: If you are logged in with an administrator account, the Organization f ilter is set to System by
default. To view users from other organizations, select a different organization for the Organization
f ilter.

4. To view details for a user, see View User Details.

5. To edit a user:

a. In the row for the user you want to edit, click the menu.

The actions menu appears.

b. Click Edit.

The Edit User page appears.

c. Modify the user details.

Note: If you want to edit a Tenable Security Center user that was created via user provisioning
and you enabled User Data Sync, edit the user in your SAML or LDAP identity provider. Other-
wise, the Tenable Security Center user data synchronization overwrites your changes the next
t ime the user logs in to Tenable Security Center using your SAML or LDAP identity provider.
For more information about User Data Sync, see SAML Authentication Options or LDAP
Authentication Options.

d. Click Submit.
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Tenable Security Center saves your configuration.

6. To delete a user, see Delete a User.
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Edit Your User Account

Required User Role: Any

You can edit your user account to update your password, contact information, display preferences,

and other sett ings depending on your user role.

To edit your user account as an administrator:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. Click the row for your user account.

The Edit User page appears.

4. Modify your user account sett ings. For more information, see User Account Options.

5. Click Submit.

Tenable Security Center saves your configuration.

To edit your user account as an organizational user:

1. Log in to Tenable Security Center via the user interface.

2. Click Username > Profile.

The Edit User Profile page appears.

3. Modify your user account sett ings. For more information, see User Account Options.

4. Click Submit.

Tenable Security Center saves your configuration.
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View User Details

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about user accounts, see User Accounts.

To view details for a user:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. In the row for the user, click the menu.

The actions menu appears.

4. Click View.

The View User page appears.

5. View the following information for the user:

Section Action

General View general information for the user.

l Created —The date the user was created.

l Last Modified —The date the user was last modified.

l ID —The user ID.

Membership View role and organization information for the user. For more inform-

ation, see User Account Options.

Display Options View dark mode sett ings for the user. For more information, see User

Account Options.

Contact Inform-

ation

View contact information for the user. For more information, see User

Account Options.
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API Key If the user has API keys, view the access key for the user. For more

information, see Enable API Key Authentication.

Linked User

Details
Required User Role: Administrator

View linked user accounts associated with the user:

l Linked Users —If the user is an Administrator, view the linked

Security Manager users.

l Primary User —If the user is a linked Security Manager, view the

associated Administrator user.

For more information, see Linked User Accounts.
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Delete a User

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

If you want to migrate a user's objects, you must use a Security Manager account in the user's organ-

ization to delete the user. Other roles cannot migrate user objects.

Note: You cannot delete the first user created in any of your organizations. For more information, contact
Tenable Support.

Note: If you want to delete an Administrator with linked user accounts, you must delete the linked
accounts associated with the Administrator before deleting the Administrator, as described in Delete a
Linked User Account. For more information about linked user accounts, see Linked User Accounts.

Note: If you want to delete a Tenable Security Center user that was created via user provisioning, delete
the user from your SAML or LDAP identity provider. If you delete a user in Tenable Security Center that was
created via user provisioning without deleting the user in your SAML or LDAP identity provider, Tenable
Security Center automatically re-creates the user in Tenable Security Center the next t ime they log in
using your SAML or LDAP identity provider. For more information, see SAML User Provisioning or LDAP
User Provisioning.

To delete a user:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. In the row for the user you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. (Optional) If you want to migrate the user's objects, click the toggle to migrate the user's

objects to another user. Tenable Security Center supports migrating:
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l Active scans, agent scans, and scan results

l Custom assets, credentials, audit files, and scan policies

l Freeze windows

l Queries

l Tickets and alerts

l ARCs

l Dashboards

l Reports, report images, report attributes, and report results

If you do not migrate the user's objects, Tenable Security Center deletes the user's objects.

Note: You cannot migrate objects when deleting an Administrator user because all Administrator-
created objects are shared across Tenable Security Center and remain accessible after user dele-
t ion.

6. Click Delete.

Tenable Security Center deletes the user.
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Linked User Accounts

If a user needs to perform administrator and non-administrator tasks in Tenable Security Center,

you can configure linked user accounts to allow an Administrator user to switch to one or more

Security Manager users without logging out and logging back in to Tenable Security Center.

Users with linked user accounts can use a single set of login credentials to log in to Tenable Secur-

ity Center as an Administrator, then switch to a linked Security Manager, from one linked Security

Manager to another, or from a linked Security Manager to the linked Administrator. You do not need

to re-authenticate to switch between linked user accounts after logging in as the linked Admin-

istrator.

The following restrict ions apply to linked user accounts:

l Each Administrator can have one linked Security Manager per organization.

l Each linked Security Manager can be associated with only one Administrator user account.

l Linked Security Managers cannot log in to Tenable Security Center directly. You must log in to

the Administrator account associated with the linked Security Manager, then switch users.

l You cannot convert a standalone user account to a linked user account.

l You cannot convert a linked user account to a standalone user account. To unlink a Security

Manager user from an Administrator user, delete the linked Security Manager, then create a

standalone Security Manager.

For more information about user accounts in Tenable Security Center, see User Access and User

Roles.

For more information about linked user accounts, see:

l Add a Linked User

l Switch to a Linked User Account

l Edit a Linked User Account

l Delete a Linked User Account
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Add a Linked User

Required User Role: Administrator

To allow an Administrator user to switch to one or more Security Manager users without logging out

and logging back in to Tenable Security Center, add a linked user account to the Administrator. The

following restrict ions apply to linked user accounts:

l You cannot convert a standalone user account to a linked user account.

l Each Administrator can have one linked Security Manager per organization.

l Each linked Security Manager user can be associated with only one Administrator user

account.

For more information about linked user accounts, see Linked User Accounts. For more information

about user account configuration options, see User Account Options.

To add a linked Security Manager to an Administrator:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. In the row for the Administrator for which you want to add a linked user, click the menu.

The actions menu appears.

4. Click Add Linked User.

The Add User page appears. Tenable Security Center pre-populates the First Name, Last

Name, and Contact Information f ields with values from the Administrator user account.

5. Select an Organization.

6. (Optional) Modify the First Name and Last Name for the user.

7. Type a Username for the user.

8. Select a Time Zone.

9. (Optional) Select a Scan Result Default Timeframe.
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10. (Optional) Enable Cached Fetching.

11. (Optional) Enable or disable Dark Mode for the user.

12. (Optional) Modify the Contact Information for the user.

13. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Switch between linked Administrator and Security Manager user accounts, as described in

Switch to a Linked User Account.
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Switch to a Linked User Account

Required User Role: Administrator with linked user accounts or a Security Manager linked to an Admin-
istrator. For more information, see User Roles and Linked User Accounts.

Linked users can switch from the linked Administrator to a linked Security Manager, from one linked

Security Manager to another, or from a linked Security Manager to the linked Administrator user.

For more information about linked user accounts, see Linked User Accounts.

Before you begin:

l Configure one or more linked user accounts, as described in Add a Linked User.

To switch to a linked user account:

1. Log in to Tenable Security Center via the user interface.

Note: You must log in to the Administrator account associated with the linked Security Manager,
then switch between linked users. Linked Security Managers cannot log in to Tenable Security
Center directly.

2. Click Username > Switch User. This option appears only if the current logged-in user already

has a linked user account.

The Switch To Linked Account window appears.

3. Click the name of the linked user you want to switch to.

4. Click Switch.

Tenable Security Center logs you in as the selected user.

The username menu updates to show the linked user account name and associated organ-

ization.
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Edit a Linked User Account

Required User Role: Administrator or a Security Manager linked to an Administrator. For more information,
see User Roles and Linked User Accounts.

You can edit a linked user account as an administrator or while logged in as the linked user. For

more information, see Linked User Accounts.

To edit a linked user account as an Administrator:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. Filter the Users page to show user accounts for the linked user's organization, as described in

Apply a Filter.

4. Click the row for the linked user account you want to edit.

The Edit User page appears.

5. Modify the user account sett ings. For more information, see User Account Options.

6. Click Submit.

Tenable Security Center saves your configuration.

To edit your linked user account as a linked user:

1. Log in to Tenable Security Center via the user interface.

2. Switch to a linked user account, as described in Switch to a Linked User Account.

3. Click Username > Profile.

The Edit User Profile page appears.

4. Modify the user account sett ings. For more information, see User Account Options.

5. Click Submit.

Tenable Security Center saves your configuration.
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Delete a Linked User Account

Required User Role: Administrator

If you want to remove a linked user account, you must delete the linked account. You cannot con-

vert a linked user account into a standalone user account. For more information about linked user

accounts, see Linked User Accounts.

Note: If you want to delete an Administrator with linked user accounts, you must delete the linked
accounts associated with the Administrator before deleting the Administrator.

To delete a linked user account:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. Apply a filter to view the organization for the user you want to delete, as described in Apply a

Filter.

4. In the row for the linked user account you want to delete, click the menu.

The actions menu appears.

5. Click Delete.

A confirmation window appears.

6. (Optional) If you want to migrate the user's objects, click the toggle to migrate the user's

objects to another user. Tenable Security Center supports migrating:

l Active scans, agent scans, and scan results

l Custom assets, credentials, audit files, and scan policies

l Freeze windows

l Queries

l Tickets and alerts
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l ARCs

l Dashboards

l Reports, report images, report attributes, and report results

If you do not migrate the user's objects, Tenable Security Center deletes the user's objects.

Note: You cannot migrate objects when deleting an Administrator user because all Administrator-
created objects are shared across Tenable Security Center and remain accessible after user dele-
t ion.

7. Click Delete.

Tenable Security Center deletes the user.
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Custom Group Permissions

When creating or edit ing a user account, you can customize a user's group permissions.

l Your selection in the Group f ield assigns the user to a group.

l Your selections in the Group Permissions section grant the user resource (user and object)

permissions in their assigned group and other groups.

For more information about organizations and groups, see Organizations and Groups.

In the Group Permissions section, the Manage All Users and Manage All Objects sliders enable or dis-

able all of the sett ings in the User Permission and Object Permission columns, respectively. By

default, the system enables all permissions for all groups. You can clear the check boxes in each

group row to restrict the user's ability to perform the following actions on the resources within a

group.

Resources Controlled by Man-

age Users/User Permissions
Resources Controlled by Manage Objects/Object Permissions

l Users (edit and delete)

l Groups (edit and delete)

l Reports (launch, stop, copy, delete, and sometimes

edit)

Note: A user can only edit reports within their assigned
group, even if you grant them Object Permissions for
another group.

l Report results (publish, email, copy, and delete)

l Report images (delete)

l Report attributes (delete)

l Scan results (launch, import, copy, send to report, stop,

pause, and delete)

l Policies (edit, copy, and delete)

l Assets (edit, share, and delete)

l Alerts (edit and delete)

l Audit files (edit, share, and delete)
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Resources Controlled by Man-

age Users/User Permissions
Resources Controlled by Manage Objects/Object Permissions

l Credentials (edit, share, and delete)

l Tickets (edit, resolve, and close)

l Risk rules (delete)

l Queries (edit, share, and delete)

l ARCs (edit, share, copy, and delete)

l Dashboards (edit, share, copy, and delete)

Examples

Consider the following examples for a user assigned to Group1.

Control Permissions to Resources in the User's Assigned Group

l If you select the User Permissions and/or Object Permissions check boxes in the Group1row,

the user can perform actions for all resources in Group1, including the resources owned by

other users.

l If you clear the User Permissions and/or Object Permissions check boxes in the Group1row,

the user cannot perform actions on resources owned by other users in Group1.

Control Permissions to Resources in Other Groups

l If you select the User Permissions and/or Object Permissions check boxes in the Group2 row,

the user can perform actions for all resources in Group2, including the resources owned by

other users.

Note: Although the user receives many permissions for resources in Group2, the user cannot edit
reports owned by Group2 users. Users must be assigned to Group2 and have Object Permissions
selected in order to edit reports, active scans, and agent scans.

l If you clear the User Permissions and/or Object Permissions check boxes in the Group2 row,

the user cannot perform actions on resources owned by other users in Group2.
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Generate API Keys

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

API keys allow you to authenticate as a specific user for Tenable Security Center API requests.

Administrators can generate API keys for any user account. Other roles can generate API keys for

user accounts with the same role. For more information, see API Key Authentication.

Note: If you generate API keys for a user that already has API keys, the old keys will be replaced. If you
delete existing keys or generate new API keys for a user, Tenable Security Center deauthorizes API
requests attempted with the old keys.

Before you begin:

l Enable API keys to allow users to perform API key authentication, as described in Enable

API Key Authentication.

To generate API keys:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. In the row for the user for which you want to generate an API key, click the menu.

The actions menu appears.

4. Click Generate API Key.

A confirmation window appears.

5. Click Generate.

The Your API Key window appears, displaying the access key and secret key for the user.

6. Save the API keys in a safe location.

Note: You cannot view API secret keys in the Tenable Security Center interface after init ial gen-
eration. If you lose your existing secret key, you must generate new API keys.
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What to do next:

l Use the API keys to perform API requests, as described in API Key Authorization in the Ten-

able Security Center API Best Practices Guide.
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Delete API Keys

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

After you delete a user's API keys, the deleted keys cannot be used for authentication in Tenable

Security Center API requests. To generate new API keys for a user, see Generate API Keys. For more

information, see API Key Authentication.

To delete API keys:

1. Log in to Tenable Security Center via the user interface.

2. Click Users > Users.

The Users page appears.

3. In the row for the user for which you want to delete API keys, click the menu.

The actions menu appears.

4. Click Delete API Key.

A confirmation window appears.

5. Click Delete.

The system deletes the API keys.
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User Account Options

You can configure the following options for Tenable Security Center user accounts. The available

options depend on the user type, the user's role, and the role of the user adding or edit ing the user.

l TNS User Account Options

l LDAP User Account Options

l SAML User Account Options

For more information about user accounts in Tenable Security Center, see User Accounts.

TNS User Account Options

To add a TNS-authenticated user, see Add a TNS-Authenticated User.

Option Description

First Name The user's first name.

Last Name The user's last name.

Type (If LDAP or SAML are configured) The type of authentication you want to

perform on the user:

l Tenable (TNS)

l Lightweight Directory Access Protocol (LDAP)

l Security Assertion Markup Language (SAML)

You must configure an LDAP server or SAML authentication in order to

select LDAP or SAML from the Type drop-down box.

Username (Required) The username for the user account.

Note: The username value is case-sensit ive.

Password (Required) The password for the user account.

Tip:Tenable recommends using passwords that meet stringent length and com-
plexity requirements.

- 144 -



For information about Tenable Security Center password data encryption,

see Encryption Strength.

When edit ing a user, type a new password to change the password for the

user account.

Confirm Pass-

word

(Required) When creating a user or changing a user's password, re-type the

password for the user account.

Password

Change

Click Change Password to change the password for the user account.

To change a user password:

1. Begin edit ing a user account, as described in Manage User Accounts

or Edit Your User Account.

2. Click Change Password.

3. In the Current Password box, type the user's current password.

4. In the Password box, type a new password.

5. In the Confirm Password box, type the new password again.

6. Click Submit.

Tenable Security Center saves your configuration.

Current Pass-

word

(If you click Change Password) Type the current password for the user

account.

User Must

Change Pass-

word

When enabled, the user must change their password upon init ial login.

Account Locked When enabled, the user cannot log in to Tenable Security Center. An admin-

istrator must unlock the user's account to allow them to log in.

Time Zone (Required) The time zone for the user.

Scan Result

Default Time-

frame

The default Completion Time f ilter applied when the user accesses or

refreshes the scan results page.
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Cached Fetch-

ing

When enabled, Tenable Security Center caches plugin policy information

and performs plugin policy downloads once per page load.

Membership

Role (Required) The role assigned to the user. For more information, see User

Roles.

Administrator users can create Administrator or Security Manager user

accounts. Organizational users can create Auditor, Credential Manager,

Executive, No Role, Security Analyst, Security Manager, or Vulnerability Ana-

lyst accounts at their own privilege level or lower. For example:

l If a user is an Auditor, they can create new Auditors or lesser roles.

l If a custom user has the Create Policies privilege but not the Update

Feeds privilege, that user can create users with the Create Policies

privilege, but not the Update Feeds privilege.

Organization (Required) The organization where you want to assign the user account.

Group (Required) The group where you want to assign the user account. A user's

group determines their access to Tenable Security Center resources. For

more information about groups, see Groups.

To grant a user limited privileges to other groups' resources, see Custom

Group Permissions.

Group Permissions

Manage All

Users

When enabled, allows the user to manage users in all of the user's assigned

groups. For more information, see Custom Group Permissions.

Manage All

Objects

When enabled, allows the user to manage objects in all of the user's

assigned groups. For more information, see Custom Group Permissions.

Responsibility

Asset Assigns a user to an asset list for which the user is responsible. Assigning a

user to an asset list makes it easier to determine who in a group or organ-

ization should be assigned tickets, notif ications, and other tasks to resolve
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particular issues. Selecting an asset updates the User Responsibility Sum-

mary in the Vulnerability Analysis section.

Display Options

Dark Mode When enabled, sets the Tenable Security Center user interface to dark

mode for the user.

Contact Information

Title

The contact information for the user.

Address

City

State

Country

Email

Phone

LDAP User Account Options

You must configure an LDAP server to add LDAP-authenticated users. For more information, see

LDAP Authentication.

To add an LDAP-authenticated user, see Add an LDAP-Authenticated User.

Option Description

First Name The user's first name.

Last Name The user's last name.

Type (If LDAP or SAML are configured) The type of authentication you want to

perform on the user:

l Tenable (TNS)

l Lightweight Directory Access Protocol (LDAP)
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l Security Assertion Markup Language (SAML)

You must configure an LDAP server or SAML authentication in order to

select LDAP or SAML from the Type drop-down box.

LDAP Server The LDAP server you want to use to authenticate the user.

Search String The LDAP search string you want to use to filter your user search. Use the

format: attribute=<filter text>. You can use wildcards, and the option

accepts up to 1024 characters.

Examples

sAMAccountName=*

mail=a*

displayName=C*

LDAP Users

Found

A filtered list of LDAP user accounts retrieved by the Search String. Your

selection in this option populates the Username option.

The Username

for this account

must match a

user on the LDAP

server in order to

authenticate.

If the user was created via LDAP user provisioning, the username on the

LDAP server associated with the Tenable Security Center user account. If

you select a username in the drop-down, Tenable Security Center over-

writes the Tenable Security Center user account using information from

the new LDAP user you selected. By default, this option is blank.

You do not need to configure this option to enable user provisioning or

automatic synchronization of user data between your LDAP server and

Tenable Security Center.

For more information, see LDAP User Provisioning.

Username (Required) The username, populated by your LDAP Users Found selection.

This username must match a user on the LDAP server in order to authen-

ticate successfully.

Time Zone (Required) The time zone for the user.

Scan Result

Default Time-

The default Completion Time f ilter applied when the user accesses or

refreshes the scan results page.
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frame

Cached Fetching When enabled, Tenable Security Center caches plugin policy information

and performs plugin policy downloads once per page load.

Membership

Role (Required) The role assigned to the user. For more information, see User

Roles.

Administrator users can create Administrator or Security Manager user

accounts. Organizational users can create Auditor, Credential Manager,

Executive, No Role, Security Analyst, Security Manager, or Vulnerability

Analyst accounts at their own privilege level or lower. For example:

l If a user is an Auditor, they can create new Auditors or lesser roles.

l If a custom user has the Create Policies privilege but not the Update

Feeds privilege, that user can create users with the Create Policies

privilege, but not the Update Feeds privilege.

Organization (Required) The organization where you want to assign the user account.

Group (Required) The group where you want to assign the user account. A user's

group determines their access to Tenable Security Center resources. For

more information about groups, see Groups.

To grant a user limited privileges to other groups' resources, see Custom

Group Permissions.

Group Permissions

Manage All Users When enabled, allows the user to manage users in all of the user's

assigned groups. For more information, see Custom Group Permissions.

Manage All

Objects

When enabled, allows the user to manage objects in all of the user's

assigned groups. For more information, see Custom Group Permissions.

Responsibility

Asset Assigns a user to an asset list for which the user is responsible. Assigning
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a user to an asset list makes it easier to determine who in a group or

organization should be assigned tickets, notif ications, and other tasks to

resolve particular issues. Selecting an asset updates the User Respons-

ibility Summary in the Vulnerability Analysis section.

Display Options

Dark Mode When enabled, sets the Tenable Security Center user interface to dark

mode for the user.

Contact Information

Title

The contact information for the user.

Address

City

State

Country

Email

Phone

SAML User Account Options

You must configure SAML authentication to add SAML-authenticated users. For more information,

see SAML Authentication.

To add a SAML-authenticated user, see Add a SAML-Authenticated User.

Option Description

First Name The user's first name.

Last Name The user's last name.

Type (If LDAP or SAML are configured) The type of authentication you want to

perform on the user:
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l Tenable (TNS)

l Lightweight Directory Access Protocol (LDAP)

l Security Assertion Markup Language (SAML)

You must configure an LDAP server or SAML authentication in order to

select LDAP or SAML from the Type drop-down box.

Username (Required) The user's SAML username. Type the username exactly as it

appears in your identity provider SAML configuration for this user.

Time Zone (Required) The time zone for the user.

Scan Result

Default Time-

frame

The default Completion Time f ilter applied when the user accesses or

refreshes the scan results page.

Cached Fetch-

ing

When enabled, Tenable Security Center caches plugin policy information

and performs plugin policy downloads once per page load.

Membership

Role (Required) The role assigned to the user. For more information, see User

Roles.

Administrator users can create Administrator or Security Manager user

accounts. Organizational users can create Auditor, Credential Manager,

Executive, No Role, Security Analyst, Security Manager, or Vulnerability Ana-

lyst accounts at their own privilege level or lower. For example:

l If a user is an Auditor, they can create new Auditors or lesser roles.

l If a custom user has the Create Policies privilege but not the Update

Feeds privilege, that user can create users with the Create Policies

privilege, but not the Update Feeds privilege.

Organization (Required) The organization where you want to assign the user account.

Group (Required) The group where you want to assign the user account. A user's

group determines their access to Tenable Security Center resources. For

more information about groups, see Groups.
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To grant a user limited privileges to other groups' resources, see Custom

Group Permissions.

Group Permissions

Manage All

Users

When enabled, allows the user to manage users in all of the user's assigned

groups. For more information, see Custom Group Permissions.

Manage All

Objects

When enabled, allows the user to manage objects in all of the user's

assigned groups. For more information, see Custom Group Permissions.

Responsibility

Asset Assigns a user to an asset list for which the user is responsible. Assigning a

user to an asset list makes it easier to determine who in a group or organ-

ization should be assigned tickets, notif ications, and other tasks to resolve

particular issues. Selecting an asset updates the User Responsibility Sum-

mary in the Vulnerability Analysis section.

Display Options

Dark Mode When enabled, sets the Tenable Security Center user interface to dark

mode for the user.

Contact Information

Title

The contact information for the user.

Address

City

State

Country

Email

Phone
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LDAP Authentication

Adding LDAP servers allows you to use one or more external LDAP servers for Tenable Security

Center user account authentication. LDAP authentication enhances the security of Tenable Security

Center by inherit ing password complexity requirements from environments mandated by security

policy.

After you configure an LDAP server, create Tenable Security Center user accounts for each

LDAP user you want to grant access.

l To manually add LDAP-authenticated users in Tenable Security Center, see Add an LDAP-

Authenticated User.

l To automatically add LDAP-authenticated users by importing users from your LDAP identity

provider, see LDAP User Provisioning.

Then, users with LDAP-authenticated accounts can log in to Tenable Security Center using the Sign

In Using Identity Provider button, as described in Log In to the Web Interface.

You can also use configured LDAP servers as LDAP query assets. For more information, see Assets.

Note: Tenable Security Center does not support Microsoft Active Directory Lightweight Directory Services
(AD LDS) servers for LDAP authentication.

Note: Tenable Security Center cannot retrieve more than one page of LDAP results. If Tenable Security
Center asset list or user authentication queries are not retrieving all expected results, consider modifying
your LDAP pagination control sett ings to increase the results per page.

For more information, see Add an LDAP Server and Delete an LDAP Server.

LDAP Authentication Options

Configure the LDAP settings as directed by your LDAP server administrator. Click Test LDAP Set-

tings to validate the connection.

Option Description

Server Sett ings

Name (Required) A unique name for the LDAP server.
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Option Description

Description A description for the LDAP server.

Hostname (Required) The IP address or DNS name of the LDAP server.

Port (Required) The remote LDAP port. Confirm the selection with your LDAP

server administrators.

l When Encryption is None, Port is typically 389.

l When Encryption is TLS or LDAPS, Port is typically 636.

Encryption If the LDAP server encrypts communications, the encryption

method: Transport Layer Security (STARTTLS) or LDAP over SSL (LDAPS).

Username / Pass-

word

(Required) The username and password for an account on the LDAP server

with credentials to search for user data. For example, Active Directory

servers require an authenticated search.

Format the username as provided by the LDAP server.

Tip: It is recommended to use passwords that meet stringent length and com-
plexity requirements.

User Pro-

visioning

You can enable user provisioning to automatically create LDAP-authen-

ticated users in Tenable Security Center by importing user accounts from

your LDAP identity provider. When user provisioning is enabled, users who

log in to your LDAP identity provider are automatically created in Tenable

Security Center.

Tenable Security Center supports the following LDAP authentication sys-

tems for user provisioning:

l Active Directory on Microsoft Server 2016 (on-premises)

l Active Directory on Microsoft Server 2019 (on-premises)

For more information, see LDAP User Provisioning.

Note: If you want to delete a Tenable Security Center user that was created via
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Option Description

LDAP user provisioning, delete the user from your LDAP identity provider. If
you delete a user in Tenable Security Center that was created via LDAP user
provisioning without deleting the user in your LDAP identity provider, Tenable
Security Center automatically re-creates the user in Tenable Security Center
the next t ime they log in using your LDAP identity provider.

User Data Sync If you enable User Provisioning, you can enable User Data Sync to allow

Tenable Security Center to automatically synchronize contact information

(first name, last name, email address, and phone number) from your LDAP

identity provider for Tenable Security Center users created via LDAP user

provisioning. For more information, see LDAP User Provisioning.

Note: If you want to edit a Tenable Security Center user that was created via
LDAP user provisioning and you enabled User Data Sync, edit the user in your
LDAP identity provider. Otherwise, the Tenable Security Center user data syn-
chronization overwrites your changes the next t ime the user logs in to Tenable
Security Center using your LDAP identity provider.

LDAP Schema Settings

Base DN (Required) The LDAP search base used as the start ing point to search for

the user data.

User Object Fil-

ter

The string you want to use to create a search based on a location or filter

other than the default search base or attribute.

User Schema Settings (Optional, if you plan to use the LDAP server only as an LDAP query

asset.)

Username Attrib-

ute

The attribute name on the LDAP server that contains the username for the

account. This is often specified by the string sAMAccountName in Active

Directory servers that may be used by LDAP. Contact your LDAP server

administrator for the correct value.

E-mail Attribute The attribute name on the LDAP server that contains the email address for

the account. This is often specified by the string mail in Active Directory

servers that may be used by LDAP. Contact your LDAP server admin-
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Option Description

istrator for the correct value.

Phone Attribute The attribute name on the LDAP server that contains the telephone num-

ber for the account. This is often specified by the string telephoneNumber

in Active Directory servers that may be used by LDAP. Contact your LDAP

server administrator for the correct value.

Name Attribute The attribute name on the LDAP server that contains the name associated

with the account. This is often specified by the string CN in Active Dir-

ectory servers that may be used by LDAP. Contact your LDAP admin-

istrator for the correct value.

Access Settings

Organizations The Tenable Security Center organizations you want to authenticate using

this LDAP server.

Advanced Settings

Lowercase When enabled, Tenable Security Center modifies the usernames sent by

the LDAP server to use only lowercase characters.

Tenable recommends keeping this option disabled.

DNS Field The LDAP server parameter used in LDAP server requests to filter the

returned asset data.

Tenable recommends using the default value provided by Tenable Security

Center.

Time Limit The number of seconds you want Tenable Security Center to wait for

search results from the LDAP server.

Tenable recommends using the default value provided by Tenable Security

Center.

Note: Access to Active Directory is performed via AD’s LDAP mode. When using mult iple AD domains, LDAP
access may be configured to go through the Global Catalog. Port 3268 is the default non-SSL/TLS sett ing,
while port 3269 is used for SSL/TLS connections by default. More general information about LDAP
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searches via the Global Catalog may be found at: http:/ / technet.microsoft.com/en-us/ library/cc728188

(v=ws.10).aspx.
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Add an LDAP Server

Required User Role: Administrator

For more information about LDAP server options, see LDAP Authentication.

To add an LDAP server connection:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > LDAP Servers.

3. Click Add.

4. Configure the following sett ings as described in the Options table:

l Server Settings

l LDAP Schema Settings

l User Schema Settings

l Access Settings

5. If necessary, modify the default Advanced Settings.

6. Click Test LDAP Settings to validate the LDAP server connection.

7. Click Submit.

What to do next:

l Add LDAP-authenticated user accounts.

l To manually add LDAP-authenticated users in Tenable Security Center, see Add an

LDAP-Authenticated User.

l To automatically add LDAP-authenticated users by importing users from your LDAP iden-

tity provider, see Configure LDAP User Provisioning.
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LDAP User Provisioning

You can enable user provisioning to automatically create LDAP-authenticated users in Tenable

Security Center by importing user accounts from your LDAP identity provider. When user pro-

visioning is enabled, users who log in to your LDAP identity provider are automatically created in

Tenable Security Center.

Tenable Security Center supports the following LDAP authentication systems for user provisioning:

l Active Directory on Microsoft Server 2016 (on-premises)

l Active Directory on Microsoft Server 2019 (on-premises)

For more information about LDAP authentication in Tenable Security Center, see LDAP Authentic-

ation.

If you enable user provisioning and a user who does not have a Tenable Security Center user

account logs in using your LDAP identity provider, Tenable Security Center automatically creates a

user account for them in Tenable Security Center.

Tenable Security Center creates users using data from attribute fields you map to the cor-

responding fields in your LDAP identity provider. If you enable User Data Sync for an LDAP server,

each time a user logs into Tenable Security Center using your LDAP identity provider, Tenable Secur-

ity Center updates any mapped attribute fields in Tenable Security Center with values from the

fields in your LDAP identity provider. For more information about User Data Sync, see LDAP

Authentication Options.

Note: If you want to edit a Tenable Security Center user that was created via LDAP user provisioning and
you enabled User Data Sync, edit the user in your LDAP identity provider. Otherwise, the Tenable Security
Center user data synchronization overwrites your changes the next t ime the user logs in to Tenable Secur-
ity Center using your LDAP identity provider.

Note: If you want to delete a Tenable Security Center user that was created via LDAP user provisioning,
delete the user from your LDAP identity provider. If you delete a user in Tenable Security Center that was
created via LDAP user provisioning without deleting the user in your LDAP identity provider, Tenable Secur-
ity Center automatically re-creates the user in Tenable Security Center the next t ime they log in using your
LDAP identity provider.

For more information, see Configure LDAP User Provisioning.
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Configure LDAP User Provisioning

Required User Role: Administrator

You can enable user provisioning to automatically create LDAP-authenticated users in Tenable

Security Center by importing user accounts from your LDAP identity provider. When user pro-

visioning is enabled, users who log in to your LDAP identity provider are automatically created in

Tenable Security Center.

Tenable Security Center supports the following LDAP authentication systems for user provisioning:

l Active Directory on Microsoft Server 2016 (on-premises)

l Active Directory on Microsoft Server 2019 (on-premises)

For more information, see LDAP User Provisioning.

To manually create LDAP-authenticated users in Tenable Security Center, see Add an LDAP-

Authenticated User.

For more information about user account configuration options, see LDAP User Account Options.

Before you begin:

1. (Recommended) Create a backup of your user directory in your LDAP identity provider.

2. In Tenable Security Center, add an LDAP server, as described in Add an LDAP Server.

3. In your LDAP identity provider, create the following custom user attributes: tenableRoleID, ten-

ableGroupID, and tenableOrgID.

4. In your LDAP identity provider, specify the role, group, and organization you want to assign the

user in Tenable Security Center:

a. In the tenableRoleID attribute field, type the ID for the Tenable Security Center role you

want to assign to the user. To locate the ID for a role, see View User Role Details.

b. In the tenableGroupID attribute field, type the ID for the Tenable Security Center group

you want to assign to the user. To locate the ID for a group, see View Group Details.
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c. In the tenableOrgID attribute field, type the ID for the Tenable Security Center organ-

ization you want to assign to the user. To locate the ID for an organization, see View

Organization Details.

To enable LDAP user provisioning for an LDAP server:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Resources > LDAP Servers.

The LDAP Servers page appears.

3. In the row for the LDAP server where you want to enable user provisioning, click the menu.

The actions menu appears.

4. Click Edit.

The Edit LDAP Server page appears.

5. In the Server Settings section, click the toggle to enable User Provisioning.

6. (Optional) To automatically update contact information (first name, last name, email address,

and phone number) for users created via LDAP user provisioning, click the User Data Sync

toggle. For more information about User Data Sync, see LDAP Authentication Options.

7. (Optional) In the User Schema Settings section, type the names of the attributes in your LDAP

identity provider you want to use to populate the Username, Email, Phone, First Name, and

Last Name for users created via LDAP user provisioning. For more information about user

account options, see LDAP User Account Options.

Note: If you enable User Data Sync and configure the options in the User Schema Settings section,
Tenable Security Center automatically updates the attributes in the User Schema Settings section
with values from your LDAP identity provider. For more information, see LDAP Authentication
Options.

8. Click Submit.

Tenable Security Center saves your configuration.
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Delete an LDAP Server

Required User Role: Administrator

For more information, see LDAP Authentication.

To delete an LDAP server connection:

Note: If you delete a connection to an LDAP server, the users associated with that server cannot log in to
Tenable Security Center. Tenable recommends reconfiguring associated user accounts before deleting
LDAP server connections.

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > LDAP Servers.

3. In the row for the server connection you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the LDAP server.
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LDAP Servers with Multiple OUs

Tenable’s Tenable Security Center LDAP configuration does not support the direct addit ion of mul-

t iple Organizational Units (OUs) in the LDAP configuration page. Two deployment options are pos-

sible for those with mult iple OUs.

For general information about LDAP Servers, see LDAP Authentication.

Option 1(Recommended)

When you complete these changes, new users who are members of this group can log in imme-

diately. No restart is required.

Before you begin:

l In LDAP, add a new group for Tenable Security Center users.

l In LDAP, allow existing Active Directory users to become members of the new group.

To configure LDAP with mult iple OUs (Option 1):

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > LDAP Servers.

3. Add the LDAP server, as described in Add an LDAP Server.

Note: Use the Distinguished Name (DN) of the new group as the Search Base (e.g., CN=Te-
enablesc,DC=target,DC=example,DC=com).

4. Log out of Tenable Security Center.

5. Log in to Tenable Security Center as the organizational user you want to manage the users.

6. Create a user account for each Active Directory user in the new group, as described in Add an

LDAP-Authenticated User.

In the Search String box, type =*.

Option 2
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Use a high level Search Base in the LDAP configuration. For example: DC=ta-

arget,DC=example,DC=com.

The example above could be used along with a Search String for global usage. As another example,

you might use this search string, when used in the configuration, applies to all LDAP searches:

memberOf=CN=nested1,OU=cftest1,DC=target,DC=example,DC=com

Note: This option is limited to 128 characters.

To configure LDAP with mult iple OUs (Option 2):

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > LDAP Servers.

3. Begin configuring the LDAP server, as described in Add an LDAP Server.
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4. Click Test LDAP Settings to test configurations.

5. Log out of Tenable Security Center.

6. Log in to Tenable Security Center as the organizational user you want to manage the users.

7. Create a user account for each Active Directory user, as described in Add an LDAP-Authentic-

ated User.

In the Search String box, type =*.
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SAML Authentication

You can configure SAML authentication so that Tenable Security Center users can use identity pro-

vider-init iated single sign-on (SSO) when logging in to Tenable Security Center. Tenable Security

Center supports SAML 2.0-based authentication (for example, Okta, OneLogin, Microsoft ADFS, or

Shibboleth 2.0).

For more information, see:

l Configure SAML Authentication Automatically via the User Interface

l Configure SAML Authentication Manually via the User Interface

l Configure SAML Authentication via the SimpleSAML Module

After you configure SAML authentication, create Tenable Security Center user accounts for each

SAML user you want to grant access.

l To manually add SAML-authenticated users in Tenable Security Center, see Add a SAML-

Authenticated User.

l To automatically add SAML-authenticated users by importing users from your SAML identity

provider, see SAML User Provisioning.

Then, users with SAML-authenticated accounts can log in to Tenable Security Center using the Sign

In Using Identity Provider button, as described in Log In to the Web Interface.

Considerations for Advanced SAML Features

Because Tenable Security Center cannot accept private keys to decrypt SAML assertions, Tenable

Security Center does not support SAML assertion encryption. If you want to configure SAML authen-

tication in Tenable Security Center, choose an identity provider that does not require assertion

encryption and confirm that assertion encryption is not enabled.

For information about Tenable Security Center communications encryption, see Encryption

Strength.

Note: Tenable Support does not assist with configuring or troubleshooting advanced SAML features.

SAML Authentication Options
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Option Description

SAML Specifies whether SAML authentication is enabled or disabled.

If you disable SAML, the system clears your SAML configuration sett ings

and prevents SAML-authenticated user accounts from accessing Tenable

Security Center.

Source Specifies your SAML configuration method: 

l Import —Configure SAML authentication by uploading the metadata

file provided by your identity provider, as described in Configure

SAML Authentication Automatically via the User Interface.

l Entry —Configure SAML authentication by manually configuring SAML

options using data from the metadata file provided by your identity

provider, as described in Configure SAML Authentication Manually via

the User Interface.

Type Specifies the identity provider you are using: SAML 2.0 (e.g., Okta, OneLo-

gin, Shibboleth 2.0, etc.).

Entity ID The name of the Entity ID attribute. Type the attribute exactly as it appears

in your identity provider SAML configuration.

Tip: This is the Federation Service Identifier value in Microsoft ADFS.

Identity Pro-

vider (IdP)

The identity provider identif ier string.

For example:

l The Identity Provider Issuer value in Okta.

l The Federation Service Identifier value in Microsoft ADFS.

Username

Attribute

The name of the SAML username attribute. Type the attribute exactly as it

appears in your identity provider SAML configuration.

For example, if your SAML username attribute is NameID, specify NameID to

instruct Tenable Security Center to recognize users who match the format

NameID=username.
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Option Description

Single Sign-on

Service

The identity provider URL where users log in via single sign-on. Type the

URL exactly as it appears in your identity provider SAML metadata.

Single Logout

Service

The identity provider URL where users log out. Type the URL exactly as it

appears in your identity provider SAML metadata.

Certificate Data The text of the identity provider's X.509 SSL certif icate, without the

===BEGIN CERT=== and the ===END CERT=== strings.

User Pro-

visioning

You can enable user provisioning to automatically create SAML-authen-

ticated users in Tenable Security Center by importing user accounts from

your SAML identity provider. When user provisioning is enabled, users who

log into your SAML identity provider are automatically created in Tenable

Security Center. For more information, see SAML User Provisioning.

Note: If you want to delete a Tenable Security Center user that was created via
SAML user provisioning, delete the user from your SAML identity provider. If you
delete a user in Tenable Security Center that was created via SAML user pro-
visioning without deleting the user in your SAML identity provider, Tenable
Security Center automatically re-creates the user in Tenable Security Center the
next t ime they log in using your SAML identity provider.

User Data Sync If you enabled User Provisioning, you can enable User Data Sync to allow

Tenable Security Center to automatically synchronize contact information

from your SAML identity provider for Tenable Security Center users created

via SAML user provisioning. For more information, see SAML User Pro-

visioning.

Note: If you want to edit a Tenable Security Center user that was created via
SAML user provisioning and you enabled User Data Sync, edit the user in your
SAML identity provider. Otherwise, the Tenable Security Center user data sync
overwrites your changes the next t ime the user logs in to Tenable Security
Center using your SAML identity provider.

Note: Tenable Security Center does not update required fields (Organization ID,
Group ID, and Role ID). To change the organization, group, or role for a user cre-
ated via SAML user provisioning, see Manage User Accounts.
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Configure SAML Authentication Automatically via the User Inter-
face

Required User Role: Administrator

You can use this method to configure most types of SAML authentication via the Tenable Security

Center user interface. If you encounter issues with this method (for example, when configuring

Microsoft ADFS), try the module method described in Configure SAML Authentication via

the SimpleSAML Module.

For more information about SAML authentication and SAML authentication options, see

SAML Authentication.

Before you begin:

l Save your identity provider SAML metadata file to a directory on your local computer.

To automatically configure SAML authentication for Tenable Security Center users:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the SAML button.

The SAML Configuration page appears.

4. In the General section, confirm the SAML toggle is enabled.

If you want to disable SAML authentication for Tenable Security Center users, click the toggle.

5. In the Source drop-down box, select Import.

The page updates to display addit ional options.

6. In the Type drop-down box, select SAML 2.0 (e.g., Okta, OneLogin, Shibboleth 2.0, etc.).

7. Click Choose File and browse to the SAML metadata file from your identity provider.
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Note: The metadata file must match the Type you selected. If Tenable Security Center rejects the
file, contact your identity provider for assistance.

8. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Click Download SAML Configuration XML, save the .xml f ile locally, and use it to configure

your identity provider SAML configuration. For more information, see SAML Authentication

XML Configuration Examples.

l Add SAML-authenticated user accounts.

l To manually add SAML-authenticated users in Tenable Security Center, see Add a SAML-

Authenticated User.

l To automatically add SAML-authenticated users by importing users from your SAML iden-

tity provider, see Configure SAML User Provisioning.

l Instruct users to log in to Tenable Security Center using the Sign In Using Identity Provider but-

ton, as described in Log In to the Web Interface.
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Configure SAML Authentication Manually via the User Interface

Required User Role: Administrator

You can use this method to configure most types of SAML authentication via the Tenable Security

Center interface. However, you may prefer a more streamlined method:

l To configure SAML Authentication automatically, use the method described in Configure

SAML Authentication Automatically via the User Interface.

l If you encounter issues with either method (for example, when configuring Microsoft ADFS),

try the module method described in Configure SAML Authentication via

the SimpleSAML Module.

For more information about SAML authentication and SAML authentication options, see

SAML Authentication.

Before you begin:

l Save your identity provider SAML metadata file to a directory on your local computer.

To configure SAML authentication for Tenable Security Center users:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the SAML button.

The SAML Configuration page appears.

4. In the General section, confirm the SAML toggle is enabled.

If you want to disable SAML authentication for Tenable Security Center users, click the toggle.

5. In the Source drop-down box, select Entry.

The page updates to display addit ional options.

6. In the SAML Settings section, configure the options:
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a. In the Type drop-down box, select SAML 2.0 (e.g., Okta, OneLogin, Shibboleth 2.0, etc.).

b. In the Entity ID box, type the name of the Entity ID attribute exactly as it appears in your

identity provider SAML configuration.

c. In the Identity Provider (IdP) box, type identity provider identif ier string.

d. In the Username Attribute box, type the SAML username attribute exactly as it appears

in your identity provider SAML configuration.

e. In the Single Sign-on Service box, type the identity provider URL where users log in via

single sign-on exactly as it appears in your identity provider SAML metadata.

f. In the Single Logout Service box, type the identity provider URL where users log out

exactly as it appears in your identity provider SAML metadata.

g. In the Certificate Data box, paste the text of the identity provider's X.509

SSL certif icate, without the ===BEGIN CERT=== and the ===END CERT=== strings.

7. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Click Download SAML Configuration XML, save the .xml f ile locally, and use it to configure

your identity provider SAML configuration. For more information, see SAML Authentication

XML Configuration Examples.

l Add SAML-authenticated user accounts.

l To manually add SAML-authenticated users in Tenable Security Center, see Add a SAML-

Authenticated User.

l To automatically add SAML-authenticated users by importing users from your SAML iden-

tity provider, see Configure SAML User Provisioning.

l Instruct users to log in to Tenable Security Center using the Sign In Using Identity Provider but-

ton, as described in Log In to the Web Interface.
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Configure SAML Authentication via the SimpleSAML Module

Tip: The recommended method for configuring SAML authentication is via the Tenable Security
Center interface:

l Configure SAML Authentication Automatically via the User Interface

l Configure SAML Authentication Manually via the User Interface

Required User Role: Administrator

If you encounter issues configuring SAML via the Tenable Security Center interface, you can use a

hidden SimpleSAML module to automatically configure SAML authentication.

For general information, see SAML Authentication.

Before you begin:

l Save your identity provider SAML metadata file to a directory on your local computer.

To configure SAML authentication via the SimpleSAML module:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the SAML button.

The SAML Configuration page appears.

4. Type placeholder values into all SAML configuration options. You do not need to configure

valid values.

5. Click Submit.

Tenable Security Center saves your configuration.

6. Log in to Tenable Security Center via the command line interface (CLI).

7. Navigate to and open the /opt/sc/support/etc/SimpleSAML/config/authsources.php
f ile.

- 173 -



8. Copy and paste the following text into the file, between the ), line and the ); line:

// This is a authentication source which handles admin authentication.
'admin' => array(
// The default is to use core:AdminPassword, but it can be replaced with
// any authentication source.

'core:AdminPassword',
),

9. Save the file.

10. In a browser, navigate to https:/ /<Tenable Security Center IP address or hostname>/sam-

l/module.php/core/ frontpage_config.php.

The SimpleSAML.php installation page appears.

11. On the Configuration tab, click Login as administrator.

The Enter your username and password page appears.

12. In the Username box, type admin.

13. In the Password box, type admin.

14. Click Login.

15. On the Federation tab, in the Tools section, click XML to SimpleSAML.php metadata

converter.

The Metadata parser page appears.

16. Click Choose File and select your identity provider SAML metadata file.

17. Click Parse.

Tenable Security Center validates the identity provider SAML metadata file. If the metadata

file is supported, Tenable Security Center populates the XML metadata box with content from

your metadata file. If the metadata file is not supported, you cannot use it for

SAML authentication in Tenable Security Center.

18. In the saml20-idp-remote section, copy the text in the box.
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19. Log in to Tenable Security Center via the command line interface (CLI).

20. Navigate to and open the /opt/sc/support/etc/SimpleSAML/metadata/saml20-idp-
remote.php f ile (for SAML 2.0 or Shibboleth 2.0).

21. Paste the text into the file, after the <?php line.

22. Save the file.

23. Navigate to and open the /opt/sc/support/etc/SimpleSAML/config/authsources.php
f ile again.

24. Confirm the idp URL in the authsources.php f ile matches the $metadata URL in the

saml20-idp-remote.php or shib13-idp-remote.php f ile:

Valid authsources.php syntax example:

'idp' => 'http://www.okta.com/abcdefghijKLmnopQr0s1'

Valid saml20-idp-remote.php or shib13-idp-remote.php syntax example:

$metadata['http://www.okta.com/abcdefghijKLmnopQr0s1']

25. In a browser, navigate to https:/ /<Tenable Security Center IP address or hostname>/sam-

l/module.php/core/ frontpage_config.php.

The SimpleSAML.php installation page appears.

26. On the Authentication tab, click Test configured authentication sources.

The Test authentication sources page appears.

27. Click 1.

Your identity provider login page appears.

28. Log in to your identity provider.

The SAML 2.0 SP Demo Example page appears. If this page does not appear, the configuration

did not succeed.

What to do next:
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l In the Tenable Security Center interface, on the SAML Configuration page, click Download

SAML Configuration XML, save the .xml f ile locally, and use it to configure your identity pro-

vider SAML configuration. For more information, see SAML Authentication XML Configuration

Examples.

l Add SAML-authenticated user accounts.

l To manually add SAML-authenticated users in Tenable Security Center, see Add a SAML-

Authenticated User.

l To automatically add SAML-authenticated users by importing users from your SAML iden-

tity provider, see Configure SAML User Provisioning.

l Instruct users to log in to Tenable Security Center using the Sign In Using Identity Provider but-

ton, as described in Log In to the Web Interface.
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SAML User Provisioning

You can enable user provisioning to automatically create SAML-authenticated users in Tenable

Security Center by importing user accounts from your SAML identity provider. When user pro-

visioning is enabled, users who log into your SAML identity provider are automatically created in

Tenable Security Center. For more information about SAML authentication in Tenable Security

Center, see SAML Authentication.

If you enable user provisioning and a user who does not have a Tenable Security Center user

account logs in using your SAML identity provider, Tenable Security Center automatically creates a

user account for them in Tenable Security Center.

Tenable Security Center creates users using data from attribute fields you map to the cor-

responding fields in your SAML identity provider. If you enable User Data Sync, each time a user logs

into Tenable Security Center using your SAML identity provider, Tenable Security Center updates

any mapped attribute fields in Tenable Security Center with values from the fields in your SAML

identity provider. For more information about User Data Sync, see SAML Authentication Options.

Note: If you want to edit a Tenable Security Center user that was created via SAML user provisioning and
you enabled User Data Sync, edit the user in your SAML identity provider. Otherwise, the Tenable Security
Center user data sync overwrites your changes the next t ime the user logs in to Tenable Security Center
using your SAML identity provider.

Note: If you want to delete a Tenable Security Center user that was created via SAML user provisioning,
delete the user from your SAML identity provider. If you delete a user in Tenable Security Center that was
created via SAML user provisioning without deleting the user in your SAML identity provider, Tenable Secur-
ity Center automatically re-creates the user in Tenable Security Center the next t ime they log in using your
SAML identity provider.

For more information, Configure SAML User Provisioning.
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Configure SAML User Provisioning

Required User Role: Administrator

You can enable user provisioning to automatically create SAML-authenticated users in Tenable

Security Center by importing user accounts from your SAML identity provider. When user pro-

visioning is enabled, users who log into your SAML identity provider are automatically created in

Tenable Security Center. For more information, see SAML User Provisioning.

To manually create SAML-authenticated users in Tenable Security Center, see Add a SAML-

Authenticated User.

For more information about user account configuration options, see SAML User Account Options.

Before you begin:

l Configure SAML authentication, as described in Configure SAML Authentication Manually via

the User Interface.

To import SAML-authenticated user accounts from your SAML identity provider:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the SAML button.

The SAML Configuration page appears.

4. In the SAML Settings section, click the toggle to enable User Provisioning.

5. (Optional) To automatically update contact information for imported SAML-authenticated

users, click the User Data Sync toggle. For more information about User Data Sync, see SAML

Authentication Options.

6. Click Submit.

Tenable Security Center saves your configuration.

What to do next:
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l In your SAML identity provider, map the required Tenable Security Center user attribute fields

to the corresponding fields for users in your identity provider: Organization ID, Group ID, and

Role ID.

Note: Tenable Security Center uses the fields listed in the Attribute Mapping section to create and
update users in Tenable Security Center. Any Tenable fields that you map to corresponding fields in
your SAML identity provider populate when Tenable Security Center imports SAML users into Ten-
able Security Center. If you enable User Data Sync, each time a user logs into Tenable Security
Center using your SAML identity provider, Tenable Security Center updates any mapped attribute
fields in Tenable Security Center with values from the corresponding fields in your SAML identity pro-
vider.
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SAML Authentication XML Configuration Examples

Identity provider SAML configurations vary widely, but you can use the following examples to guide

your SAML-side configurations.

l OneLogin Example

l Okta Example

l Microsoft ADFS Example

OneLogin Example

In the OneLogin SAML configuration, paste data from your .xml download file.

OneLogin Field Description

Relay State Leave this field blank.

Audience Type tenable.sc.

Recipient Type https://<Tenable Security Center host>/sam-
l/module.php/saml/sp/saml2-acs.php/1, where <Tenable Secur-
ity Center host> is the IP address or hostname for Tenable Security

Center.

ACS (Consumer)

URL Validatior

Type -*.

ACS (Consumer)

URL

Type https://<Tenable Security Center host>/sam-
l/module.php/saml/sp/saml2-acs.php/1, where <Tenable Secur-
ity Center host> is the IP address or hostname for Tenable Security

Center.

Single Logout

URL

Type https://<Tenable Security Center host>/sam-
l/module.php/saml/index.php?sls, where <Tenable Security
Center host> is the IP address or hostname for Tenable Security Center.

Okta Example

In the Okta SAML configuration, paste data from your .xml download file.
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Okta Field Description

General

Single Sign On URL Type https://<Tenable Security Center host>/sam-
l/module.php/saml/sp/saml2-acs.php/1, where <Tenable
Security Center host> is the IP address or hostname for Ten-

able Security Center.

Recipient URL Type https://<Tenable Security Center host>/sam-
l/module.php/saml/sp/saml2-acs.php/1, where <Tenable
Security Center host> is the IP address or hostname for Ten-

able Security Center.

Destination URL Type https://<Tenable Security Center host>/sam-
l/module.php/saml/sp/saml2-acs.php/1, where <Tenable
Security Center host> is the IP address or hostname for Ten-

able Security Center.

Audience Restrict ion Type tenable.sc.

Default Relay State Leave this field blank.

Name ID Format Set to Unspecified.

Response Set to Signed.

Assertion Signature Set to Signed.

Signature Algorithm Set to RSA_SHA256.

Digest Algorithm Set to SHA256.

Assertion Encryption Set to Unencrypted.

SAML Single Logout Set to Disabled.

authnContextClassRef Set to PasswordProtectedTransport.

Honor Force Authentic-

ation

Set to Yes.
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Okta Field Description

SAML Issuer ID Type http://www.okta.com/${org.externalKey}.

Attribute Statements

FirstName Set to Name Format: Unspecified and Value: user.firstName.

LastName Set to Name Format: Unspecified and Value: user.lastName.

Email Set to Name Format: Unspecified and Value: user.email.

username Set to Name Format: Unspecified and one of the following:

l Value: user.displayName, if your Tenable Security Center

user account usernames are full names (e.g., Jill Smith).

l Value: user.email, if your Tenable Security Center user

account usernames are email addresses (e.g., jsmith@web-

site.com).

l Value: user.login, if your Tenable Security Center user

account usernames are name-based text strings (e.g.,

jsmith).

Microsoft ADFS Example

In the Microsoft ADFS configuration, paste data from your .xml download file.

Microsoft ADFS

Configuration
Description

Edit Authentication Methods window

Extranet Select, at minimum, the Forms Authentication check box.

Intranet Select, at minimum, the Forms Authentication check box.

Add Relying Party Trust wizard

Welcome section l Select Claims aware.
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Microsoft ADFS

Configuration
Description

l Select Import data about the relying party from a file.

l Browse to and select the SAML configuration .xml f ile you down-

loaded from Tenable Security Center.

Note: If you see a warning that some content was skipped, click Ok to
continue.

Specify Display

Name section

In the Display Name box, type your Tenable Security Center FQDN.

Configure Cer-

t if icate section

Browse to and select the encryption certif icate you want to use.

Choose Access

Control Policy sec-

t ion

Select the Permit everyone policy.

Ready to Add

Trust section

l On the Advanced tab, select SHA256 or the value dictated by your

security policy.

l On the Identifiers tab, confirm the information is accurate.

l On the Endpoints tab, confirm the information is accurate.

Finish section Select the Configure claims issuance policy for this application check

box.

Edit Claim Issu-

ance Policy win-

dow

Add one or more claim rules to specify the ADFS value you want Tenable

Security Center to use when authenticating SAML users. For example:

To transform an incoming claim:

1. In Incoming claim type, select Email address or UPN.

2. In Outgoing claim type, select Name ID.

3. In Outgoing name ID format, select Transient Identifier.

4. Select the Pass through all claim values check box.
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Microsoft ADFS

Configuration
Description

To send LDAP attributes as claim:

1. In Attribute store, select Active Directory.

2. In LDAP Attribute, select E-Mail Addresses.

3. In Outgoing Claim Type, select E-Mail Addresses.

Note:Tenable Support does not assist with claim rules.
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Certificate Authentication

You can use configure SSL client cert if icate authentication for Tenable Security Center user

account authentication. Tenable Security Center supports:

l SSL client cert if icates

l smart cards

l personal identity verification (PIV) cards

l Common Access Cards (CAC)

Configuring certif icate authentication is a mult i-step process.

To fully configure SSL client cert if icate authentication for Tenable Security Center user

accounts:

1. Configure Tenable Security Center to allow SSL client cert if icate authentication, as described

in Configure Tenable Security Center to Allow SSL Client Certif icate Authentication.

2. Configure Tenable Security Center to trust cert if icates from your CA, as described in Trust a

Custom CA.

3. Add TNS-authenticated user accounts for the users you want to authenticate via certif icate,

as described in Add a TNS-Authenticated User.

4. (Optional) If you want to validate client cert if icates against a certif icate revocation list (CRL),

configure CRLs or OCSP in Tenable Security Center, as described in Configure a CRL in Ten-

able Security Center or Configure OCSP Validation in Tenable Security Center.

What to do next:

l Instruct users to log in to Tenable Security Center via certif icate, as described in Log in to the

Web Interface via SSL Client Certif icate.
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Configure Tenable Security Center to Allow SSL Client Certificate
Authentication

You must configure the Tenable Security Center server to allow SSL client cert if icate connections.

For complete information about cert if icate authentication, see Certif icate Authentication.

To allow SSL client cert if icate authentication:

1. Open the /opt/sc/support/conf/sslverify.conf f ile in a text editor.

2. Edit the SSLVerifyClient sett ing:

Value Description

none

(default)

Tenable Security Center does not accept SSL certif icates for user authen-

tication.

require Tenable Security Center requires a valid SSL certif icate for user authen-

tication.

optional Tenable Security Center accepts but does not require a valid SSL cer-

t if icate for user authentication.

If a user does not present a certif icate, they can log in via username and

password.

Note: Some browsers may not connect to Tenable Security Center when you
use the optional sett ing.

optional_no_

ca

Tenable Security Center accepts valid and invalid SSL certif icates for

user authentication.

Tip: This sett ing does not configure reliable user authentication, but you can
use it to troubleshoot issues with your SSL connection and determine
whether there is an issue with the key or the CA.

3. Edit the SSLVerifyDepth sett ing to specify the length of the certif icate chain you want Ten-

able Security Center to accept for user authentication. For example:
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l When set to 0, Tenable Security Center accepts self-signed certif icates.

l When set to 1, Tenable Security Center does not accept intermediate certif icates. Ten-

able Security Center accepts self-signed certif icates or cert if icates signed by known

CAs.

l When set to 2, Tenable Security Center accepts up to 1intermediate certif icate. Tenable

Security Center accepts self-signed certif icates, cert if icates signed by known CAs, or

cert if icates signed by unknown CAs whose certif icate was signed by a known CA.

4. Save the file.

Tenable Security Center saves your configuration.
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Configure a CRL in Tenable Security Center

Required User Role: Root user

You can enable a cert if icate revocation list (CRL) in Tenable Security Center to prevent users from

authenticating to Tenable Security Center if their cert if icate matches a revocation in the CRL.

Note: Tenable Support does not assist with CRL creation or configuration in Tenable Security Center.

Before you begin:

l Confirm that you have the mod_ssl Apache module installed on Tenable Security Center.

l Back up the /opt/sc/data/CA/ directory in case you encounter issues and need to restore

the current version.

To configure a CRL in Tenable Security Center:

1. In a text editor, open the /opt/sc/support/conf/sslverify.conf f ile.

a. Set the SSLVerifyClient sett ing to Require or Optional, as described in SSLVerifyClient.

b. Set the SSLVerifyDepth sett ing, as described in SSLVerifyDepth.

c. Save the file.

Tenable Security Center saves your configuration.

2. Restart Tenable Security Center, as described in Start, Stop, or Restart Tenable Security

Center.

Tenable Security Center restarts.

3. Confirm that your CA root configuration file contains the following parameters:

l crl_dir

l database

l crl
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l clr_extensions

l default_crl_days

For example:

...
# Directory and file locations.
dir = /opt/sc/data/CA
crl_dir = /opt/sc/support/conf/crl
database = /opt/sc/support/conf/index.txt
# The root key and root certificate.
private_key = /opt/sc/support/conf/TenableCA.key
certificate = /opt/sc/data/CA/TenableCA.crt
# For certificate revocation lists.
crl = /opt/sc/support/conf/crl/ca.crl
crl_extensions = crl_ext
default_crl_days = 30
...

4. Save your CA root configuration file as YourCAname.conf in a subdirectory of /op-
t/sc/support/conf/.

5. Confirm the directories and files referenced in your YourCAname.conf f ile are present on Ten-

able Security Center in a subdirectory of /opt/sc/support/conf/.

6. Configure Tenable Security Center to trust your CA, as described in Trust a Custom CA.

Tenable Security Center processes your CA.

7. In the command line interface (CLI), run the following command to enable the CRL in Tenable

Security Center:

$ openssl ca -config <CA root configuration file directory> -gencrl -out
<crl parameter value in the YourCAname.conf file>

For example:
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$ openssl ca -config /opt/sc/support/conf/ca-root.conf -gencrl -out /op-
t/sc/support/conf/crl/ca.crl

Tenable Security Center creates the CRL file.

8. In a text editor, open the /opt/sc/support/conf/vhostssl.conf f ile.

a. Add the following content at the end of the file:

SSLCARevocationCheck <value>
SSLCARevocationFile "<filepath>"

Where <value> and <f ilepath> are:

Content Description

SSLCARevocationCheck <value>

chain Tenable Security Center checks all cert if icates in

a chain against the CRL.

leaf Tenable Security Center checks only the end-

entity cert if icate in a chain against the CRL.

SSLCARevocationFile <f ilepath>

Specifies the file path for the CRL file in Tenable Security Center. For example, /op-
t/sc/support/conf/crl/ca.crl.

b. Save the file.

Tenable Security Center saves your configuration.

9. In the CLI, run the following command to create a symbolic link for the CRL file:

$ ln -s <crl parameter value in the YourCAname.conf file> `openssl crl -
hash -noout -in <crl parameter value in the YourCAname.conf file>`.r0

For example:
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$ ln -s /opt/sc/support/conf/crl/ca.crl `openssl crl -hash -noout -in
/opt/sc/support/conf/crl/ca.crl`.r0

Caution: Do not use a single quote character (') instead of a backtick character (̀ ); this command
requires the backtick.

Tenable Security Center creates a symbolic link for the CRL file.

10. Restart Tenable Security Center, as described in Start, Stop, or Restart Tenable Security

Center.

Tenable Security Center restarts.
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Configure OCSP Validation in Tenable Security Center

Required User Role: Root user

You can configure Online Certif icate Status Protocol (OCSP) validation in Tenable Security Center to

prevent users from authenticating to Tenable Security Center if their cert if icate matches a revoc-

ation on your OCSP server.

Note: Tenable Support does not assist with OCSP configuration in Tenable Security Center.

Before you begin:

l Confirm that you have an OCSP server configured in your environment.

To configure OCSP validation in Tenable Security Center:

1. In a text editor, open the /opt/sc/support/conf/sslverify.conf f ile.

a. Set the SSLVerifyClient sett ing to Require or Optional, as described in SSLVerifyClient.

b. Set the SSLVerifyDepth sett ing, as described in SSLVerifyDepth.

c. Save the file.

Tenable Security Center saves your configuration.

2. In a text editor, open the /opt/sc/support/conf/vhostssl.conf f ile.

a. Add the following content at the end of the file:

SSLOCSPEnable on
SSLOCSPDefaultResponder <URI>
SSLOCSPOverrideResponder on

Where <URI> is the URI for your OCSP server.

b. Save the file.

Tenable Security Center saves your configuration.

3. Restart Tenable Security Center, as described in Start, Stop, or Restart Tenable Security
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Center.

Tenable Security Center restarts.
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Certificates and Certificate Authorities in Tenable Security Center

Tenable Security Center includes the following defaults:

l a default Tenable Security Center server cert if icate (SecurityCenter.crt)

l a Tenable Security Center cert if icate authority (CA), which signs SecurityCenter.crt

l a DigiCert High Assurance EV Root CA

However, you may want to upload your own CAs or certif icates for advanced configurations or to

resolve scanning issues. For more information, see:

l Tenable Security Center Server Certif icates

l Trust a Custom CA

l Certif icate Authentication

l Custom Plugin Packages for NASL and CA Certif icate Upload

l Manual Tenable Nessus SSL Certif icate Exchange
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Tenable Security Center Server Certificates

Tenable Security Center ships with a default Tenable Security Center server cert if icate and key:

SecurityCenter.crt and SecurityCenter.key. In some cases, you must replace it or regenerate

it.

If you replace the server cert if icate with a self-signed certif icate, you may need to upload the

CA for your server cert if icate to Tenable Nessus or your browser.

Problem Solution

The default cert if icate

for Tenable Security

Center is untrusted.

Upload a certif icate for theTenable Security Center server, as

described in Upload a Server Certif icate for Tenable Security Center.

If the new server cert if icate is self-signed, plugin 51192 may report

that the Tenable Security Center server cert if icate is untrusted. To

configure Tenable Nessus to trust the server cert if icate, upload the

CA certif icate to Tenable Nessus.

Your browser reports

that the Tenable Secur-

ity Center server cer-

t if icate is untrusted.

Upload a CA certif icate for the Tenable Security Center server cer-

t if icate to your browser.

Plugin 51192 reports

that the Tenable Secur-

ity Center server cer-

t if icate expired.

Regenerate the Tenable Security Center server cert if icate, as

described in Regenerate the Tenable Security Center Server Cer-

t if icate.
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Upload a Server Certificate for Tenable Security Center

Required User Role: Root user

For information about Tenable Security Center server cert if icates, see Tenable Security Center

Server Certif icates.

Tip: The custom certif icate email address must not be SecurityCenter@SecurityCenter or subsequent
upgrades cannot retain the new certif icate.

Before you begin:

l Save your new server cert if icate and key files as host.crt and host.key.

To upload a server cert if icate for Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. Back up the existing SecurityCenter.crt and SecurityCenter.key f iles located in the

/opt/sc/support/conf directory.

For example:

# cp /opt/sc/support/conf/SecurityCenter.crt /tmp/SecurityCenter.crt.bak
# cp /opt/sc/support/conf/SecurityCenter.key /tmp/SecurityCenter.key.bak

3. To rename the host.crt and host.key f iles and copy them to the /opt/sc/support/conf
directory, run:

# cp host.crt /opt/sc/support/conf/SecurityCenter.crt
# cp host.key /opt/sc/support/conf/SecurityCenter.key

If prompted, type y to overwrite the existing files.

4. To confirm the files have the correct permissions (640) and ownership (tns), run:

# ls -l /opt/sc/support/conf/SecurityCenter.crt
-rw-r---- 1 tns tns  4389 May 15 15:12 SecurityCenter.crt
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# ls -l /opt/sc/support/conf/SecurityCenter.key
-rw-r---- 1 tns tns   887 May 15 15:12 SecurityCenter.key

Note: If an intermediate certif icate is required, it must also be copied to the system and given the
correct permissions (640) and ownership (tns). Addit ionally, you must remove the # from the line in
/opt/sc/support/conf/vhostssl.conf that begins with #SSLCertificateChainFile to enable
the sett ing. Modify the path and filename to match the uploaded certif icate.

If necessary, change the ownership or permissions.

a. To change the ownership, run:

# chown tns:tns /opt/sc/support/conf/SecurityCenter.crt\

# chown tns:tns /opt/sc/support/conf/SecurityCenter.key

b. To change the permissions, run:

# chmod 640 /opt/sc/support/conf/SecurityCenter.crt
# chmod 640 /opt/sc/support/conf/SecurityCenter.key

5. Restart the Tenable Security Center service:

# service SecurityCenter restart

6. In a browser, log in to the Tenable Security Center user interface as a user with administrator

permissions.

7. When prompted, verify the new certif icate details.

What to do next:

l If you uploaded a self-signed server cert if icate and plugin 51192 reports that the CA for your

self-signed certif icate is untrusted, upload the custom CA certif icate to Tenable Nessus.
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Regenerate the Tenable Security Center Server Certificate

Required User Role: tns user

Required User Role: Root user

Tenable Security Center ships with a default server cert if icate that is valid for two years. After the

certif icate expires, you must regenerate the SSL certif icate.

To regenerate the Tenable Security Center SSL cert if icate:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. In the CLI in Tenable Security Center, run the following command to switch to the tns user:

su - tns

3. As the tns user, run the following command:

/opt/sc/support/bin/php /opt/sc/src/tools/installSSLCertificate.php

(Optional) If you want to suppress the self-signed warning or specify a Common Name, include

an optional argument.

Argument Description

-q Suppresses the warning: This script generates a self-
signed SSL certificate, which is not recommended for

production.

-h <IP|host

name>

Specifies an IP address or hostname that will be used as the Common

Name for the certif icate.

Tenable Security Center generates a new certif icate.

4. Run the following command to exit the tns user:

exit
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5. As the root user, run the following command to restart the Tenable Security Center service:

# service SecurityCenter restart

The service restarts and Tenable Security Center applies the new certif icate.

- 199 -



Trust a Custom CA

Required User Role: tns user

You can configure Tenable Security Center to trust a custom CA for cert if icate authentication or

other uses.

To configure Tenable Security Center to trust a custom CA:

1. Log in to Tenable Security Center via the user interface.

2. Copy the required PEM-encoded CA certif icate (and intermediate CA certif icate, if needed) to

the Tenable Security Center server’s /tmp directory.

In this example, the file is named ROOTCA2.cer.

3. Run the installCA.php script to create the required files for each CA in /opt/sc/data/CA:

# /opt/sc/support/bin/php /opt/sc/src/tools/installCA.php /tmp/ROOTCA2.cer

Tenable Security Center processes all the CAs in the file.

4. Restart Tenable Security Center, as described in Start, Stop, or Restart Tenable Security

Center.
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System Settings

The System and Username menus in the top navigation bar contain several options to configure Ten-

able Security Center system settings. Administrator users can configure more options than organ-

izational users.

l Configuration Settings

l Tenable Lumin Data

l Diagnostics Sett ings

l Job Queue Events

l System Logs

l Publishing Sites Sett ings

l Keys Settings

l Username Menu Settings
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Configuration Settings

The configuration menu includes the following sett ings:

l Data Expiration Settings

l External Schedules Settings

l Tenable Lumin Settings

l Mail Sett ings

l Miscellaneous Settings

l License Settings

l Plugins/Feed Settings

l SAML Settings

l Security Sett ings

Data Expiration Settings

Data expiration determines how long Tenable Security Center retains closed tickets, scan results,

and report results.

Option Description

User Generated Object Lifetime

Closed

Tickets

The number of days you want Tenable Security Center to retain closed tickets.

The default value of this option is 365 days.

Scan Res-

ults

The number of days you want Tenable Security Center to retain scan results. The

default value of this option is 365 days.

Report Res-

ults

The number of days you want Tenable Security Center to retain report results.

The default value of this option is 365 days.

Tip: You can configure vulnerability data expiration for individual IPv4, IPv6, and agent repositories. For
more information, see IPv4/ IPv6 Repositories and Agent Repositories.
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External Schedules Settings

The Tenable Security Center external schedule sett ings determine the update schedule for the com-

mon tasks of pulling Tenable Nessus Network Monitor data, IDS signature updates, and IDS cor-

relation updates.

Option Description

Tenable Nessus Network Monitor

Pull Interval This option configures the interval that Tenable Security Center uses to

pull results from the attached Tenable Nessus Network Monitor

instances. The default sett ing is 1hour. The timing is based from the

start of the Tenable Security Center service on the host system.

Tenable Log Correlation Engine

IDS Signatures Specifies the frequency to update Tenable Security Center IDS sig-

natures via third-party sources. The schedule appears along with the spe-

cified time zone.

IDS Correlation

Databases

Specifies the frequency to push vulnerability information to the Log Cor-

relation Engine for correlation. The schedule appears along with the spe-

cified time zone.

You can also configure each of the update schedule times to occur by time in a particular t ime zone

using the Time Zone link next to each hour selection.

Tenable Lumin Settings

If you have a Tenable Vulnerability Management license to use Tenable Lumin with Tenable Security

Center, you can configure your Tenable Security Center data to synchronize to Tenable Vulnerability

Management for Tenable Lumin analysis.

For more information, see Tenable Lumin Synchronization.

Mail Sett ings

The Mail option designates SMTP settings for all email-related Tenable Security Center functions.

Available options include SMTP host, port, authentication method, encryption, and return address.
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In addit ion, you can use the Test SMTP Settings in the upper left corner of the page to validate the

sett ings.

Note: The Return Address defaults to noreply@localhost . Use a valid return email address for this option. If
this option is empty or the email server requires emails from valid accounts, the email server cannot send
the email.

Note: Type the Username in a format supported by your SMTP server (for example, user-
name@domain.com or domain\username).

Miscellaneous Settings

The Miscellaneous Configuration section offers options to configure sett ings for web proxy, syslog,

notif ications, and enable or disable some report types.

Web Proxy

From this configuration page, you can configure a web proxy by entering the host URL (proxy host-

name or IP address), port, authentication type, username, and password. The hostname used must

resolve properly from the Tenable Security Center host.

Syslog

In the Syslog section, you can configure options to allow Tenable Security Center to send log events

to the local syslog service.

Option Description

Enable For-

warding

Enables log forwarding options.

Facility Type the facility you want to receive the log messages.

Severity Specifies which syslog message levels you want to forward: Informational,

Warning, or Critical.

Scanning
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The IP Randomization option specifies how you want Tenable Security Center to send active scan

target lists to Tenable Nessus and Tenable Vulnerability Management scanners.

You enable or disable IP randomization for all configured active scans; you cannot configure

IP randomization on a per-scan basis.

l When enabled, Tenable Security Center randomizes the targets in the active scan before send-

ing the target list to the scanners to reduce strain on network devices during large active

scans.

Scan Randomization

1,000 or fewer

targets

Tenable Security Center randomizes all the IP addresses in the target

list.

1,001or more

targets

Tenable Security Center randomizes all the IP addresses in the target

list by:

1. Ordering the IP addresses numerically and split t ing them into 100

groups.

2. Randomly selecting a group and choosing the lowest IP address

from that group.

3. Selecting groups and IP addresses until all IP addresses in all

groups are randomized in the target list.

If the active scan includes a Tenable Vulnerability Management scanner, Tenable Security

Center breaks the target list into smaller lists (256 IP addresses each) before sending to Ten-

able Vulnerability Management.

Note: Some randomized target lists (such as small target lists) may still contain sequences of
increasing IP addresses. This is a possible outcome of randomization, not an indication that ran-
domization failed.

l When disabled, Tenable Security Center organizes the target list by increasing IP address.

Then, scanners scan targets, start ing with the lowest IP address and finishing with the highest

IP address.
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Tip: The Max simultaneous hosts per scan scan policy option specifies how many IP addresses Tenable
Security Center sends to each scanner at a time. For more information, see Scan Policy Options.

Notifications

The Notifications section defines the Tenable Security Center web address used when alerts and

tickets generate notif ications.

Report Generation

If your organization requires specialized reporting formats, such as DISA or CyberScope, you can

enable Report Generation options based on your organization's needs.

l Defense Information Systems Agency (DISA) reporting standards include the Assessment Sum-

mary Results (ASR), Assessment Results Format (ARF), and Consolidated Assessment Results

Format (CARF) styles.

l CyberScope reports utilize Lightweight Asset Summary Results Schema (LASR) style reports,

which are used by some segments of governments and industry.

To allow users to choose these reports during report creation, you must enable the corresponding

toggles. For more information about reports in Tenable Security Center, see Reports.

Option Description

Enable DISA ARF Enable the DISA ARF report format, which meets the standards of the

Defense Information Systems Agency Assessment Results Format.

Enable

DISA Consolidated

ARF

Enable the DISA consolidated ARF report format, which meets the

standards of the Defense Information Systems Agency Consolidated

Assessment Results Format.

Enable DISA ASR Enable the DISA ASR report format, which meets the standards of the

Defense Information Systems Agency Assessment Summary Results.

Enable CyberScope Enable the CyberScope report format, which meets CyberScope

reporting standards to support FISMA compliance.

Privacy
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The Enable Usage Statistics option specifies whether Tenable collects anonymous telemetry data

about your Tenable Security Center deployment.

When enabled, Tenable collects usage statist ics that cannot be attributed to a specific user or cus-

tomer. Tenable does not collect personal data or personally identifying information (PII).

Usage statist ics include, but are not limited to, data about your visited pages, your used reports and

dashboards, your Tenable Security Center license, and your configured features. Tenable uses the

data to improve your user experience in future Tenable Security Center releases. You can disable

this option at any time to stop sharing usage statist ics with Tenable.

After you enable or disable this option, all Tenable Security Center users must refresh their browser

window for the changes to take effect.

License Settings

The License Configuration section allows you to configure licensing and activation code sett ings for

Tenable Security Center and all attached Tenable products.

For information about the Tenable Security Center license count, see License Requirements. To

add or update a license, see Apply a New License or Update an Existing License.

Plugins/Feed Settings

The Plugins/Feed Configuration page displays the Plugin Detail Locale for Tenable Security Center

and the feed and plugin update (scanner update) schedules.

For more information, see Edit Plugin and Feed Settings and Schedules.

Update Description

Tenable

Security

Center

Feed

Retrieves the latest Tenable Security Center feed from Tenable. This feed

includes data for general use, including templates (for example, dashboards,

ARCs, reports, policies, assets, and audit files), template-required objects,

some general plugin information, and updated VPR values.

Active Plu-

gins

Retrieves the latest active plugins feed (for Tenable Nessus and Tenable Vul-

nerability Management scanners) from Tenable. Tenable Security Center pushes

the feed to Tenable Nessus and Tenable Vulnerability Management scanners.
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Update Description

Passive Plu-

gins

Retrieves the latest passive plugins feed from Tenable. Tenable Security Center

pushes the feed to Tenable Nessus Network Monitor instances.

Event Plu-

gins

Retrieves the latest event plugins feed from Tenable. Tenable Security Center

uses the feed locally with Log Correlation Engine data but does not push the

feed to Log Correlation Engine; Log Correlation Engine retrieves the feed dir-

ectly from Tenable.

For information about Tenable Security Center-Tenable plugins server communications encryption,

see Encryption Strength.

Plugin Detail Locale

The local language plugin feature allows you to display portions of plugin data in local languages.

When available, translated text displays on all pages where plugin details appear.

Select Default to display plugin data in English.

Note: Tenable Security Center cannot translate text within custom files. Upload a translated Active
Plugins.xml f ile to display the file content in a local language.

For more information, see Configure Plugin Text Translation.

Schedules

Tenable Security Center automatically updates Tenable Security Center feeds, active plugins, pass-

ive plugins, and event plugins. If you upload a custom feed or plugin file, the system merges the cus-

tom file data with the data contained in the associated automatically updating feed or plugin.

You can upload tar.gz f iles with a maximum size of 1500 MB.

For more information, see Edit Plugin and Feed Settings and Schedules.

SAML Settings

Use the SAML section to configure SAML 2.0-based SAML authentication (for example, Okta, OneLo-

gin, Shibboleth 2.0, etc.) for Tenable Security Center users. For more information, see

SAML Authentication.
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Security Sett ings

Use the Security section to define the Tenable Security Center user interface login parameters and

options for account logins. You can also configure banners, headers, and classification headers and

footers.

Option Description

Authentication Settings

Session Timeout The web session timeout in minutes (default: 60).

Maximum Login

Attempts

The maximum number of user login attempts Tenable Security Center

allows before locking out the account (default: 20). To disable this fea-

ture, set the value to 0.

Minimum Password

Length

This sett ing defines the minimum number of characters for passwords

of accounts created using the local TNS authentication access

(default: 3).

Password Com-

plexity

When enabled, user passwords must be at least 4 characters long and

contain at least one of each of the following:

l An uppercase letter

l A lowercase letter

l A numerical character

l A special character

Note: After you enable Password Complexity, Tenable Security Center
prompts all users to reset their passwords the next t ime they log in to Ten-
able Security Center.

Note: If you enable Password Complexity and set the Minimum Password
Length to a value greater than 4, Tenable Security Center enforces the
longer password requirement.

Startup Banner Text Type the text banner that appears before to the login interface.

Header Text Adds custom text to the top of the Tenable Security Center user inter-
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Option Description

face pages. You can use the text to identify a company, group, or other

organizational information (maximum 128 characters).

Classification Type Adds a header and footer banner to Tenable Security Center to indicate

the classification of the data accessible via the software. Current

options are None, Unclassified, Confidential, Secret, Top Secret, and

Top Secret – No Foreign.

Sample header:

Sample footer:

Note: If you set Classification Type to an option other than None, users can
only see the plain report styles. The Tenable report styles do not support
the classification banners.

Allow API Keys When enabled, allows users to generate API keys as an authentication

method for Tenable Security Center API requests. For more inform-

ation, see Enable API Key Authentication.

Allow Session Man-

agement

This sett ing is disabled by default. When enabled, the Session Limit

option appears. This feature displays the option that allows admin-
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Option Description

istrators to set a session limit for all users.

Disable Inactive

Users

When enabled, Tenable Security Center disables user accounts after a

set period of inactivity. You cannot use a disabled user account to log

in to Tenable Security Center, but other users can use and manage

objects owned by the disabled user account.

Days Users Remain

Enabled

When you enable Disable Inactive Users, specify the number of inactive

days you want to allow before automatically disabling a user account.

Session Limit Specifies the maximum number of sessions a user can have open at

once.

If you log in and the session limit has already been reached, Tenable

Security Center notif ies you that the oldest session with that username

will be logged out automatically. You can cancel the login or proceed

with the login and end the oldest session.

Note: This behavior is different for Common Access Cards (CAC) logins.
Tenable Security Center does not check active sessions for
CAC authentication.

Login Notifications Sends notifications for each time a user logs in.

WebSeal Allows you to enable or disable WebSEAL. WebSEAL supports mult iple

authentication methods, provides Security Access Authorization ser-

vice, and single sign-on capabilit ies.

Caution: Before the user that enabled WebSEAL logs out of Tenable Secur-
ity Center, Tenable Security Center strongly recommends confirming, in a
separate session, that at least one user (preferably an administrator user)
is able to log in successfully via WebSEAL. Otherwise, if there is an issue,
no one will be able to access Tenable Security Center to turn off WebSEAL.

Caution: Any user created while WebSEAL is enabled will not have a pass-
word. An administrator must update the user account to establish a pass-
word. Any user that existed before enabling WebSEAL must revert to their
old password.
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Option Description

PHP Serialization

Operational Status Summarizes your current sett ing.

PHP Serialization

Mode

Specifies whether you want to allow or prevent PHP serialization in Ten-

able Security Center.

l PHP Serialization ON —Tenable Security Center performs

PHP serialization and Tenable Security Center features operate

as expected.

l PHP Serialization OFF —Tenable Security Center does not per-

form PHP serialization and prevents users from importing or

exporting the following objects.

l Assets

l Scan policies

l Assurance Report Cards

l Reports

l Audit files

l Dashboards

Scanners

Picture in Picture When enabled, allows administrators to view and manage Tenable Nes-

sus scanner configurations from the Tenable Security Center user inter-

face. For more information, see Enable Picture in Picture.

Note: You cannot use Picture in Picture with a Tenable Nessus scanner if
you enabled Use Proxy for the scanner or if the scanner's Authentication
Type is SSL Certificate. For more information, see Tenable Nessus Scan-
ner Sett ings.
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Edit Plugin and Feed Settings and Schedules

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Configuration Settings.

To view and edit plugin and feed sett ings and schedules as an administrator user:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the Plugins/Feed t ile.

The Plugins/Feed Configuration page appears.

4. View the Plugin Detail Locale section to see the local language configured for Tenable Secur-

ity Center.

5. Expand the Schedules section to show the sett ings for the Tenable.sc Feed, Active Plugins,

Passive Plugins, or Event Plugins schedule.

6. If you want to update a plugin or feed on demand, click Update. You cannot update feeds with

invalid activation codes.

7. If you want to upload a custom feed file, click Choose File.

8. Click Submit.

Tenable Security Center saves your configuration.

To view and edit plugin and feed sett ings and schedules as an organizational user:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Username > Feeds.

The Plugins/Feed Configuration page appears.
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3. View the Plugin Detail Locale section to see the local language configured for Tenable Secur-

ity Center.

4. Expand the Schedules section to show the sett ings for the Tenable.sc Feed, Active Plugins,

Passive Plugins, or Event Plugins schedule.

5. If you want to update a plugin or feed on demand, click Update. You cannot update feeds with

invalid activation codes.

6. If you want to upload a custom feed file, click Choose File.

7. Click Submit.

Tenable Security Center saves your configuration.

- 214 -



Configure Plugin Text Translation

Required User Role: Administrator

For more information, see Configuration Settings.

To configure plugin text translation:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the Plugins/Feed t ile.

The Plugins/Feed Configuration page appears.

4. If you want plugin text to display in a local language, select a language from the Locale List

box.

5. Click Apply.

Tenable Security Center saves your configuration.

6. In the Schedules section, in the Active Plugins row, click Update.

Tenable Security Center updates active plugins to obtain available translations.
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API Key Authentication

You can enable API key authentication to allow users to use API keys as an authentication method

for Tenable Security Center API requests. Without API keys, users must use the /token endpoint to

log in to the Tenable Security Center API and establish a token for subsequent requests, as

described in Token in the Tenable Security Center API Guide.

Tenable Security Center attributes actions performed with API keys to the user account associated

with the API keys. You can only perform actions allowed by the privileges granted to the user

account associated with the API keys.

You can enable the Allow API Keys toggle in your Security Sett ings to allow users to perform API key

authentication. Then, users can generate API keys for themselves or for other users. API keys

include an access key and secret key that must be used together for API key authentication. For

more information, see Enable API Key Authentication and Generate API Keys.

A user can use API keys for Tenable Security Center API request authentication by including the x-

apikey header element in your HTTP request messages, as described in API Key Authorization in the

Tenable Security Center API Best Practices Guide.

Deleting API keys prevents users from authenticating Tenable Security Center API requests with the

deleted keys. For more information, see Delete API Keys.

For more information about the Tenable Security Center API, see the Tenable Security Center API

Guide and the Tenable Security Center API Best Practices Guide.
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Enable API Key Authentication

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can enable API key authentication to allow users to use API keys as an authentication method

for Tenable Security Center API requests. For more information, see API Key Authentication.

To allow users to authenticate to the Tenable Security Center API using API keys:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the Security t ile.

The Security Configuration page appears.

4. In the Authentication Settings section, click Allow API Keys to enable the toggle.

5. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Generate API keys for a user, as described in Generate API Keys.
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Disable API Key Authentication

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

Caution: Disabling API keys prevents users from authenticating API requests with API keys. Disabling
API keys does not delete existing API keys. If you re-enable API keys, Tenable Security Center reauthorizes
any API keys they were active before you disabled API key authentication.

For more information, see API Key Authentication.

To disable API key authentication:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Configuration.

The Configuration page appears.

3. Click the Security t ile.

The Security Configuration page appears.

4. In the Authentication Settings section, click Allow API Keys to disable the toggle.

5. Click Submit.

Tenable Security Center saves your configuration.
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Enable Picture in Picture

Required User Role: Administrator

You can enable Picture in Picture to allow administrators to view and manage Tenable Nessus scan-

ner configurations from the Tenable Security Center user interface.

Note: You cannot use Picture in Picture with a Tenable Nessus scanner if you enabled Use Proxy for the
scanner or if the scanner's Authentication Type is SSL Certificate. For more information, see Tenable Nes-
sus Scanner Sett ings.

To enable Picture in Picture:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Configuration.

The Configuration page appears.

3. Click the Security t ile.

The Security Configuration page appears.

4. In the Scanners section, click Picture in Picture to enable the toggle.

5. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l View and manage your Tenable Nessus instances in Tenable Security Center, as described in

View Tenable Nessus Instances in Tenable Security Center.
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Disable Picture in Picture

Required User Role: Administrator

For more information, see Tenable Nessus Scanners.

To disable Picture in Picture:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Configuration.

The Configuration page appears.

3. Click the Security t ile.

The Security Configuration page appears.

4. In the Scanners section, click Picture in Picture to disable the toggle.

5. Click Submit.

Tenable Security Center saves your configuration.
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Tenable Lumin Data

After you configure Tenable Security Center data synchronization to Tenable Lumin in Tenable Vul-

nerability Management, you can monitor information about your Tenable Lumin metrics and past

synchronizations. For general information about Tenable Lumin synchronization, see Configure Ten-

able Lumin Synchronization.

Tenable Security Center retrieves your latest Cyber Exposure Score (CES), Assessment Maturity

grade, and Remediation Maturity grade daily from Tenable Lumin in Tenable Vulnerability Man-

agement. For more information about the metrics and timing, see View Tenable Lumin Metrics.

Tenable Security Center logs all Tenable Lumin synchronization activity. For more information about

the log contents, see View Tenable Lumin Data Synchronization Logs.
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View Tenable Lumin Metrics

Required Additional License: Tenable Lumin

Required User Role: Administrator

After you configure Tenable Security Center data synchronization to Tenable Lumin in Tenable Vul-

nerability Management, you can view information about your Tenable Lumin metrics.

Every day at 11:00 PMUTC, Tenable Security Center retrieves data from Tenable Lumin in Tenable

Vulnerability Management.

Note: Newly transferred data does not immediately impact your Tenable Lumin metrics (for
example, your CES). Tenable requires up to 48 hours to recalculate your metrics. Recalculated
metrics appear in Tenable Security Center after the next daily retrieval.

For more information, see How long does synchronization take to complete?.

Tip: To view all Tenable Lumin data and take advantage of full Tenable Lumin functionality, see Get Started

with Tenable Lumin in the Tenable Vulnerability Management User Guide.

To view Tenable Lumin metrics in Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. To view your Cyber Exposure Score, Assessment Maturity grade, and Remediation Maturity

grade, do the following:

a. In the top navigation bar, click System > Tenable Lumin Data.

The Tenable Lumin Data page appears.

b. In the Metrics section, view data about your Tenable Lumin metrics.

l An updated Cyber Exposure Score (CES) for the data you synchronized to Tenable

Lumin. High CES values indicate higher risk.

l An updated Assessment Maturity grade for the data you synchronized to Tenable

Lumin. A high grade indicates you are assessing your assets frequently and
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thoroughly.

l An updated Remediation Maturity grade for the data you synchronized to Tenable

Lumin. A high grade indicates you are remediating the vulnerabilit ies on your

assets quickly and thoroughly.

If a metric changed since the last retrieval, Tenable Security Center identif ies if the
value increased ( ) or decreased ( ).

Tip: If you performed an init ial synchronization, Tenable requires up to 48 hours to
calculate your Tenable Lumin metrics. Then, metrics appear in Tenable Security
Center after the next daily retrieval.

For more information, see How long does synchronization take to complete?.

3. (Requires Tenable Security Center+ license) To view the Asset Crit icality Rating for a host,

view details for the host, as described in View Hosts. For more information, see Asset Crit-

icality Rating in the Tenable Vulnerability Management User Guide.
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View Tenable Lumin Data Synchronization Logs

Required Additional License: Tenable Lumin

Required User Role: Administrator

After you configure Tenable Security Center data synchronization to Tenable Lumin in Tenable Vul-

nerability Management, you can view the logs for past synchronizations.

For information about monitoring Tenable Lumin synchronization status, see View Tenable Lumin

Synchronization Status.

To view Tenable Lumin synchronization logs:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Tenable Lumin Data.

The Tenable Lumin Data page appears.
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3. In the History section, view data about your logged activity.

Column Description

Timestamp The date and time of the logged activity.

Object Type The synchronization data type: asset or repository.

Sync Type The repository or asset synchronization type:

l Cumulative repository synchronization —The init ial syn-

chronization of this repository, which included all cumulative data-

base data from the repository.

l Active repository synchronization —A subsequent syn-

chronization of this repository, which included only the new or

modified scan result data imported to the repository.

l Static asset —A synchronization of Static Assets.

l Dynamic asset —A synchronization of Dynamic Assets.

l Unknown —Indicates an error occurred.

Object ID The repository ID or asset ID. To locate the ID for an object, see View

Repository Details or View Asset Details.

Transfer Dur-

ation

For repository or asset synchronizations, the length of t ime it took Ten-

able Security Center to transfer your repository or asset data to Ten-

able Vulnerability Management.

Note: The transfer duration does not include the time required for all data
and recalculated metrics to appear in Tenable Lumin. For more inform-
ation, see How long does synchronization take to complete?.

Status The status of the repository or asset synchronization: 

l Error —Tenable Security Center failed to transfer your data to

Tenable Vulnerability Management.
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Column Description

l Synchronized —Tenable Security Center successfully transferred

your data to Tenable Vulnerability Management, but all data and

recalculated metrics are not yet visible in Tenable Lumin.

l Visible in Tenable Lumin —Tenable Security Center successfully

transferred your data to Tenable Vulnerability Management and all

data and recalculated metrics are visible in Tenable Lumin.

For more information about the time required for all data and recal-

culated metrics to appear in Tenable Lumin, see How long does syn-

chronization take to complete?.

4. To view addit ional details about your logged activity, click a row in the table.

Column Description

Repository or asset Mes-

sage

A message explaining the reason for the synchronization

Error status.

Repository or asset

Organization ID

The organization ID. To locate the ID for an organization, see

View Organization Details.

Repository Scan Result

ID

The scan result ID. To locate the ID for a scan result, see View

Scan Result Details.
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Edit an ACR Manually

Required License: Tenable Security Center+

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can customize an individual host's Asset Crit icality Rating (ACR) value to reflect the unique infra-

structure or needs of your organization.

For more information about ACR values, see Asset Crit icality Rating in the Tenable Vulnerability Man-

agement User Guide.

Tip: Changes to an ACR value (and recalculations for your ACR values) take effect within 24 hours.

To edit the ACR for a host:

1. Log in to Tenable Security Center via the user interface.

2. Click Assets > Host Assets.

The Host Assets page appears.

3. Click the row for the host.

The Host Asset Details page appears.

4. In the Asset Criticality Rating section, click the button.

The Edit Asset Criticality Rating plane appears.

5. Do one of the following:

l To modify the ACR value, click the Asset Crit icality Rating slider to increase or decrease

the ACR.

l To reset an existing ACR value to the Tenable-provided ACR value, click Reset to Ten-

able ACR.

6. In the Overwrite Reasoning section, select one or more options to include a justif ication for

your ACR change. For example, if a host in your development lab environment received a
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Tenable-assigned ACR appropriate for a public host but not the development host, you can

select Dev Only. If you modify the ACR from the Tenable-provided value, this option is

required.

7. In the Notes box, type a note about your ACR change. If you select Other in the Overwrite

Reasoning section, you must type a note for the change.

8. Click Submit.

Tenable Security Center saves the ACR.

What to do next:

l View the ACR for each host, as described in View Hosts.
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Diagnostics Settings

This page displays and creates information that assists in troubleshooting issues that may arise

while using Tenable Security Center.

System Status

You can use this section to view the current status of system functions.

System Function Description

Correct Java Ver-

sion

Indicates whether the minimum version of Java required to support Ten-

able Security Center functionality is installed.

For more information, see Before You Upgrade.

Sufficient Disk

Space

Indicates whether you have enough disk space to support Tenable Security

Center functionality. A red X indicates the disk is at 95% capacity or

higher.

For more information, see Hardware Requirements.

Correct

RPM Package

Installed

Indicates whether you have the correct Tenable Security Center RPM

installed for your operating system.

For more information, see System Requirements.

Touch Debug-

ging

Indicates whether touch debugging is enabled. You may experience per-

formance and storage issues if you leave touch debugging enabled for

extended periods of t ime.

For more information, see Touch DebuggingTouch Debugging.

Migration Errors Indicates whether an error occurred during a recent Tenable Security

Center update.

PHP Integrity

Errors

Indicates whether any PHP files have been modified from the original ver-

sion included in the Tenable Security Center RPM.

Diagnostics File
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You can use this section to generate a diagnostics file for troubleshooting with Tenable Support.

For more information, see Generate a Diagnostics File.

Touch Debugging

You can use this section to enable or disable touch debugging logs for troubleshooting with Tenable

Support. For more information, see Enable Touch Debugging and Disable Touch Debugging.

Note: Tenable does not recommend leaving touch debugging enabled on Tenable Security Center after you
send the log files to Tenable Support. You may experience performance and storage issues if you leave
touch debugging enabled for extended periods of t ime.
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Generate a Diagnostics File

Required User Role: Administrator

Tenable Support may ask you to generate a diagnostics file to assist with troubleshooting. The

debug.zip diagnostics file contains files related to the selected chapters. For more information

about diagnostics file options, see Diagnostics File Options.

For more information about Tenable Security Center diagnostics, see Diagnostics Sett ings.

To generate a diagnostics file for Tenable Support:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Diagnostics.

The Diagnostics page appears.

3. In the Diagnostics File section, click Create Diagnostics File.

The page updates with options to configure the diagnostics file.

4. In the General section, if you want to omit IP addresses from the diagnostics file, click to

enable the Strip IPs from Chapters toggle.

5. In the Chapters section, click the toggles to enable or disable the chapters you want to

include in the diagnostics file.

6. Click Generate File.

Tenable Security Center generates the diagnostics file.

7. Click Download Diagnostics File.

The debug.zip f ile downloads.

What to do next:

l Share the debug.zip f ile with Tenable Support for troubleshooting.
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Diagnostics File Options

For more information, see Diagnostics Sett ings and Generate a Diagnostics File.

Option Description Default

General

Strip IPs from

Chapters

When enabled, Tenable Security Center omits IP addresses

from the following files:

l sc-configuration.txt

l sc-scans.txt

l sc-setup.txt

l sc-logs.txt

l sc-error.log

l cert.log

l install.log

l upgrade.log

l schemaUpdates*.log

l sc-environment.txt

l sc-telemetry.txt

l /opt/sc/support/error_Log

l /opt/sc/support/*.conf

Disabled

Chapters

System Inform-

ation

Include information about the Tenable Security Center host

system in the diagnostic file (sc-systeminfo.txt).

Enabled

Scan Inform-

ation

Include information about scans, scan results, and freeze

windows in the diagnostic file (sc-sscaninfo.txt).

Enabled
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Option Description Default

For more information, see Active Scans, Agent Scanning,

and Freeze Windows.

Setup Include information about the following Tenable Security

Center resources in the diagnostic file (sc-setup.txt):

l Active users

l Tenable Nessus Scanners

l Tenable Nessus Network Monitor Instances

l Tenable Log Correlation Engines

l Scan Zones

l Schedules

l Job Queue Events

l Assets

l Repositories

l Organizations

l User Roles

l Reports

l Report results

l Audit Files

Enabled

Logs Include administrator logs, organization logs, Tenable

Security Center error logs, and the certif icate log in the dia-

gnostic file (sc-logs.txt, sc-error.log, and cert.log).

Enabled

Environment Include information about the tns user environment in the

diagnostic file (sc-environment.txt).

Enabled

Directory List- Include a directory list ing in the diagnostic file (sc-dirl- Enabled
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Option Description Default

ing isting.txt).

For more information, see Tenable Security Center Com-

munications and Directories.

Dependency Include information about Tenable Security Center depend-

encies in the diagnostic file (sc-depsinfo.txt).

For more information, see Dependencies.

Enabled

Upgrade Log Include a log of Tenable Security Center upgrade events in

the diagnostic file (upgrade.log).

Enabled

Install Log Include a log of Tenable Security Center installat ion events

in the diagnostic file (install.log).

Enabled

Apache Log Include a log of web server requests in the diagnostic file

(/opt/sc/support/error_Log).

Enabled

Application Conf Include Tenable Security Center configuration details in the

diagnostic file (sc-configuration.txt).

Enabled

Server Conf Include server configuration details in the diagnostic file

(/opt/sc/support/*.conf).

Enabled

User Inform-

ation

Include a list of users in the diagnostic file (sc-
users.txt). The list includes the following details:

l For administrators, the user ID and role ID

l For organizational users, the user ID, role ID, and

group ID

For more information about ID values, see View User

Details, View User Role Details, and View Group Details.

Enabled

Include Names (If User Information is enabled) Include usernames and user

display names for each user in the diagnostic file.

For more information, see User Account Options.

Disabled
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Option Description Default

Tip: The display name combine's the user's First Name and
Last Name.
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Enable Touch Debugging

Required User Role: Administrator

You can enable touch debugging to generate logs for troubleshooting with Tenable Support.

To enable touch debugging:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Diagnostics.

The Diagnostics page appears.

3. In the Touch Debugging section, select one or more touch debugging logs Tenable Support

asked you to enable.

4. Click Enable/Disable Touch Debugging.

Tenable Security Center enables the touch debugging logs you selected and saves the cor-

responding log files to /opt/sc/admin/logs.

What to do next:

l Share the touch debugging log files with Tenable Support.

l Disable any unneeded touch debugging logs, as described in Disable Touch Debugging.

Note: Tenable does not recommend leaving touch debugging enabled on Tenable Security Center
after you send the log files to Tenable Support. You may experience performance and storage issues
if you leave touch debugging enabled for extended periods of t ime.

Note: Collected debug logs contained in the debug archive are automatically deleted during the
scheduled nightly cleanup.
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Disable Touch Debugging

Required User Role: Administrator

Tenable does not recommend leaving touch debugging enabled on Tenable Security Center after

you send the log files to Tenable Support. You may experience performance and storage issues if

you leave touch debugging enabled for extended periods of t ime.

For more information about touch debugging logs, see Touch Debugging.

To disable touch debugging:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click System > Diagnostics.

The Diagnostics page appears.

3. In the Touch Debugging section:

l To disable individual touch debugging logs, deselect the logs.

l To disable all touch debugging logs, click Deselect All.

4. Click Enable/Disable Touch Debugging.

Tenable Security Center disables the touch debugging logs you deselected.

What to do next:

l Follow Tenable Support 's instructions to manually remove old touch debugging log files from

/opt/sc/admin/logs.
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Job Queue Events

Path: System > Job Queue

Job Queue is a Tenable Security Center feature that displays specified events in a list for review.

You can view and sort Job Queue notifications in several ways by clicking on the desired sort
column. Using the menu next to an item, that item may be viewed for more detail or, if the job is

running, the process may be killed. Killing a process should be done only as a last resort, as killing a

process may have undesirable effects on other Tenable Security Center processes.
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System Logs

Tenable Security Center logs contain detailed information about functionality to troubleshoot

unusual system or user activity. You can use the system logs for debugging and for maintaining an

audit trail of users who access Tenable Security Center or perform basic functions (for example,

changing passwords, recasting risks, or running Nessus scans).

To view system logs:

1. Log in to Tenable Security Center via the user interface.

2. Click System > System Logs (Administrator users) or Username > System Logs (Organizational

users).

The System Logs page appears.

3. To filter the logs, see Apply a Filter.

The page updates to reflect the filter you applied.
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View System Logs

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see System Logs.

To view system logs:

1. Log in to Tenable Security Center via the user interface.

2. Click System > System Logs (Administrator users) or Username > System Logs (Organizational

users).

The System Logs page appears.

3. To filter the logs, see Apply a Filter.

The page updates to reflect the filter you applied.
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Publishing Sites Settings

Path: System > Publishing Sites

Organizations may configure publishing sites as targets to send report results to a properly con-

figured web server or a Defense Information Systems Agency (DISA) Continuous Monitoring and Risk

Scoring (CMRS) site.

Option Description

Name Type a name for the publishing site.

Description Type a description of the publishing site.

Type The method Tenable Security Center uses to publish to the site. Available

options are HTTP Post or CMRS. Use the selection appropriate for the

configuration of the publishing site.

Max Chunk Size

(MB)

If the target is a CMRS site, Tenable sends the report in chunks sized

according to this value.

URI The target address to send the report to when completed.

Authentication There are two methods of authentication available: SSL Certificate and

Password.

Username / Pass-

word

If you select Password as the Authentication method, the credentials to

authenticate to the target publishing server.

Certificate If you selected SSL Certificate as the Authentication method, the cer-

t if icate you want to use for authentication.

Organizations Select the organization(s) that are allowed to publish to the configured

site.

Verify Host When enabled, Tenable Security Center verifies that the target address

specified in the URI option matches the CommonName (CN) in the

SSL certif icate from the target publishing server.
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Keys Settings

Keys allow administrator users to use key-based authentication with a remote Tenable Security

Center (remote repository) or between a Tenable Security Center and a Tenable Log Correlation

Engine server. This also removes the need for Tenable Security Center administrators to know the

administrator login or password of the remote system.

Note: The public key from the local Tenable Security Center must be added to the Keys section of the Ten-
able Security Center from which you wish to retrieve a repository. If the keys are not added properly, the
remote repository add process prompts for the root username and password of the remote host to per-
form a key exchange before the repository add/sync occurs.

For more information, see Add a Key, Delete a Key, and Download the Tenable Security Center

SSH Key.

Remote Tenable Log Correlation Engine Key Exchange

A manual key exchange between the Tenable Security Center and the Tenable Log Correlation

Engine is normally not required; however, in some cases where remote root login is prohibited or

key exchange debugging is required, you must manually exchange the keys.

For the remote Tenable Log Correlation Engine to recognize the Tenable Security Center, you need

to copy the SSH public key of the Tenable Security Center and append it to the

/opt/lce/.ssh/authorized_keys f ile. The /opt/lce/daemons/lce-install-key.sh script per-

forms this function. For more information, see Manual Log Correlation Engine Key Exchange.
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Add a Key

Required User Role: Administrator

For more information, see Keys Settings.

To add a new key:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Keys.

The Keys page appears.

3. Click Add.

The Add Key page appears.

4. In the Type drop-down, select DSA or RSA.

5. In the Comment box, add a description or note about the key.

6. In the Public Key box, type the text of your public key from your remote Tenable Security

Center.

7. Click Submit.

Tenable Security Center saves your configuration.

- 243 -



Delete a Key

Required User Role: Administrator

For more information, see Keys Settings.

To delete a key:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Keys.

3. In the row for the key you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the key.
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Download the Tenable Security Center SSH Key

Required User Role: Administrator

For more information, see Keys Settings.

To download the Tenable Security Center SSH key:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Keys.

3. In the Options drop-down, click Download SC Key.

The Tenable Security Center SSH key downloads.
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Notifications

In Tenable Security Center, certain events can display a pop-up in the lower right-hand corner of

the Tenable Security Center user interface. When you click on a notification, the Notifications page

appears.

The Notifications page displays a list of notif ications for your Tenable Security Center instance. You

can filter these notifications by time frame. For general information about using filters, see Filters.

To view your Tenable Security Center notif ications, in the top navigation bar, click Username > Noti-

fications.
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Username Menu Settings

The username menu in the top navigation bar contains pages to manage your user account.

Note: Depending on the screen resolution, the username may not appear next to the user icon in the top
navigation bar.

About

Path: Username > About

The About menu item displays the Tenable Security Center version, Server Build ID, and copyright

information.

System Logs (Organizational Users Only)

Path: Username > System Logs

For a complete discussion about system logs, see System Logs.

Profile (Organizational Users Only)

Path: Username > Profile

The Profile option launches the Edit User Profile page, where you can modify some of your user

account information and permissions. For more information about user account options, see User

Account Options.

Feeds (Organizational Users Only)

Path: Username > Feeds

The Feeds option displays information about the Tenable Security Center feeds and plugin sets and,

if permitted, a link to update the plugins either through Tenable Security Center or by manually

uploading plugins. The displayed feeds are for Tenable Security Center Feed, Active Plugins,

Passive Plugins, and Event Plugins. Only feeds with valid Activation Codes are updatable.

Plugins are scripts used by the Tenable Nessus, Tenable Nessus Network Monitor, and Log Cor-

relation Engine servers to interpret vulnerability data. For ease of operation, Tenable Security

Center centrally manages Tenable Nessus and Tenable Nessus Network Monitor plugins and pushes
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the plugins out to their respective scanners. Log Correlation Engine servers download their own

event plugins and Tenable Security Center downloads event plugins for its local reference. Tenable

Security Center does not currently push event plugins to Log Correlation Engine servers.

For more information about plugin/ feed sett ings, see Configuration Settings and Edit Plugin and

Feed Settings and Schedules.

Notifications

Path: Username > Notifications

In Tenable Security Center, specified events can display a pop-up in the lower right-hand corner of

the Tenable Security Center user interface.

You can view current notif ications by clicking on the notif ications menu item.

For more information, see Notifications.

Plugins

Path: Username > Plugins

Plugins are scripts used by the Tenable Nessus, Tenable Nessus Network Monitor, and Log Cor-

relation Engine servers to interpret vulnerability data. For ease of operation, Tenable Nessus and

Tenable Nessus Network Monitor plugins are managed centrally by Tenable Security Center and

pushed out to their respective scanners. Log Correlation Engine servers download their own event

plugins and Tenable Security Center downloads event plugins for its local reference. Tenable Secur-

ity Center does not currently push event plugins to Log Correlation Engine servers.

Within the Plugins interface, click the information icon next to the Plugin ID and search for specific

plugins utilizing the filtering tools to view plugin details/source.

For more information about custom plugins, see Custom Plugin Packages for NASL and CA Cer-

t if icate Upload.

Help

Path: Username > Help

The Help option opens the Tenable Security Center User Guide section for your page. To access

other Tenable documentation, see https:/ /docs.tenable.com/ .
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Logout

To end your session in Tenable Security Center, click Username > Logout. Tenable recommends

closing your browser window after logging out.
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Custom Plugin Packages for NASL and CA Certificate Upload

You can upload a custom plugin package as a .tar.gz or .tgz f ile. Depending on your needs, you

must include a combination of the following files:

l A custom_feed_info.inc f ile. Always include this file to time stamp your upload to Tenable

Security Center.

l (Optional) A custom_nasl_archive.tar.gz or custom_nasl_archive.tgz f ile. Include this

file if you are uploading one or more custom plugins.

l (Optional) A custom_CA.inc f ile. Include this file if you are uploading one or more CA cer-

t if icates to solve a Tenable Nessus scanning issue.

After you Create the Custom Plugin Package and Upload the Custom Plugin Package, Tenable Secur-

ity Center pushes the package to Tenable Nessus for use when scanning.

Note: The system untars the files within your custom plugin package and overwrites any identically named
files already in Tenable Security Center or Tenable Nessus.

custom_feed_info.inc Guidelines

Always include this file to time stamp your upload to Tenable Security Center. This text file must

contain the following lines:

PLUGIN_SET = "YYYYMMDDHHMM";
PLUGIN_FEED = "Custom";

The PLUGIN_SET variable YYYYMMDDHHMM is the date and time 2 minutes in the future from when

you plan to upload the file to Tenable Security Center.

custom_nasl_archive.tar.gz or custom_nasl_archive.tgz
Guidelines

Include this file if you are uploading one or more custom plugins. This package must contain one or

more custom plugin NASL files.

All custom plugins must have unique Plugin ID numbers and have family associations based on exist-

ing Tenable Security Center families.
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Note: Tenable Support does not assist with creating custom plugin NASL files.

custom_CA.inc Guidelines

Include this file if you are uploading one or more CA certif icates to solve a Tenable Nessus scanning

issue. This text file must contain PEM-encoded (Base64) CA certif icate text.

For troubleshooting information, see Troubleshooting Issues with the custom_CA.inc File.

One CA Certif icate

If you need to include a single CA certif icate, paste the PEM-encoded (Base64) certif icate directly

into the file.

-----BEGIN CERTIFICATE-----
certificatetext
certificatetext
certificatetext
certificatetext
-----END CERTIFICATE-----

Multiple CA Certif icates

If you need to include two or more CA certif icates, include the PEM-encoded (Base64) certif icates

back-to-back.

-----BEGIN CERTIFICATE-----
certificate1text
certificate1text
certificate1text
certificate1text
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
certificate2text
certificate2text
certificate2text
certificate2text
-----END CERTIFICATE-----
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Create the Custom Plugin Package

Required User Role: Administrator

For complete information, see Custom Plugin Packages for NASL and CA Certif icate Upload.

To create the .tar.gz or .tgz custom plugin package:

1. Prepare the individual text files you want to include in the custom plugins package.

l custom_nasl_archive.tar.gz or custom_nasl_archive.tgz

l custom_feed_info.inc

l custom_CA.inc

Confirm the files meet the requirements described in Custom Plugin Packages for NASL and

CA Certif icate Upload.

Note: After upload, the system untars the files within your custom plugin package and overwrites
any identically named files already in Tenable Security Center or Tenable Nessus.

2. In the command line interface (CLI), tar and compress the files together. (7-Zip or running tar

on a Mac does not work for this.) For example:

# tar -zcvf upload_this.tar.gz custom_feed_info.inc custom_CA.inc

The system generates a .tar.gz or .tgz f ile.

What to do next:

l Upload the .tar.gz or .tgz f ile, as described in Upload the Custom Plugin Package.
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Upload the Custom Plugin Package

Required User Role: Administrator

For complete information, see Custom Plugin Packages for NASL and CA Certif icate Upload.

Before you begin:

l Create the .tar.gz or .tgz custom plugin file, as described in Create the Custom Plugin

Package.

Upload the .tar.gz or .tgz f ile to Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. Click Username > Plugins.

The Plugins page appears.

3. Click Upload Custom Plugins and select the .tar.gz or .tgz f ile.

4. Click Submit.

Tenable Security Center uploads the package and pushes it to Tenable Nessus.

What to do next:

l To verify the upload succeeded, click System > System Logs.

l To verify the upload resolved a validation issue, run another scan that includes plugin 51192.

Verify that Nessus has the custom plugin bundle by checking its plugin directory.
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Troubleshooting Issues with the custom_CA.inc File

If uploading a custom_CA.inc f ile does not resolve your issue, confirm your file meets the require-

ments described in custom_CA.inc Guidelines. Then, use these tips to continue troubleshooting.

The /opt/sc/data/customNasl/custom_CA.inc f ile

If the Tenable Security Center installat ion is not on the Appliance, check the uploaded custom_

CA.inc with the following command: # cat /opt/sc/data/customNasl/custom_CA.inc.

The output should match the custom_CA.inc f ile that you checked in a text editor in step T1above.

If the file does not exist, the upload was not successful. If the file does not match, the most recent

upload may not have been successful. Go over the steps above for creating and uploading upload_
this.tar.gz and ensure it is done correctly.

The /opt/nessus/lib/nessus/plugins/custom_CA.inc or \Pro-
gramData\Tenable\Nessus\nessus\plugins\custom_CA.inc f ile

If Nessus is not on the Appliance, navigate to the plugins folder and cat or type custom_CA.inc to

verify it exists and matches the custom_CA.inc file contents verified in steps 1and 2 above. If cus-

tom_CA.inc does not exist in the plugins folder, or does not match the most recent custom_CA.inc

in Tenable Security Center, it has not propagated to the scanner. Check Resources > Nessus Scan-

ners in Tenable Security Center to see if the scanner is still updating plugins. If it is in a Working

state, try updating the active plugins in Tenable Security Center to prompt a plugin push. If the plu-

gin feed version has not incremented and the customer must push plugins immediately, see the fol-

lowing article: Force plugin update on scanner managed by Tenable Security Center (Comparable to

nessus-update-plugins -f).

The plugin 51192 output details

Adding the custom CA certif icate to custom_CA.inc does not resolve the issue if the service is miss-

ing intermediate certif icate(s). If the service has a self-signed or default cert if icate (if not self-

signed with the server name, it may be issued by a vendor name like Nessus Certif ication Authority)

and not a certif icate signed by their custom CA at all, the certif icate is expired, etc.

Look at the detailed plugin output of 51192 to see exactly why the certif icate is untrusted. If cus-

tom_CA.inc can fix it, the output states that the certif icate at the top of the certif icate chain is
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unrecognized, and the certif icate it shows is either issued by the custom CA (matching the name

exactly) or the actual custom CA self-signed certif icate.
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Backup and Restore

Tenable recommends performing regular backups of the Tenable Security Center data in your /op-
t/sc directory. When you restore a backup, the file overwrites the content in your /opt/sc dir-

ectory.

Data backup requirements:

l You must restore a backup file to a Tenable Security Center running the same version. For

example, you cannot restore a backup file created on version 5.20.0 to a Tenable Security

Center running Tenable Security Center 5.21.0.

l You must restore a backup file to the same Tenable Security Center where you created the

backup file. The hostname associated with the backup file must match the hostname on the

receiving Tenable Security Center. For example, you cannot restore a backup file created on a

Tenable Security Center with the hostname Example1to a Tenable Security Center with the

hostname Example2.

For more information, see Perform a Backup and Restore a Backup.

Configuration Backups

Tenable recommends performing regular backups of your Tenable Security Center configuration in

addit ion to your Tenable Security Center data. You can restore a configuration backup to quickly

resume normal Tenable Security Center operation as part of your disaster recovery plan.

Configuration backups do not include data (such as vulnerability data, trend data, licenses, or

secure connection sett ings). When your repositories contain new vulnerability data, you can use

your dashboards, reports, and analysis tools to assess your network.

Note: After you restore a configuration backup, Tenable recommends performing discovery scans to re-
populate your repositories with vulnerability data. For more information, see Scanning Overview.

Configuration backup requirements:

l You must restore a backup file to a Tenable Security Center running the same version. For

example, you cannot restore a backup file created on version 5.20.0 to a Tenable Security

Center running Tenable Security Center 5.21.0.
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Note: For best performance, after restoring a configuration backup, ensure the hostname associated with
the configuration backup file matches the hostname on the receiving Tenable Security Center.

For more information, see Perform a Configuration Backup and Restore a Configuration Backup.

Configurations Included in a Configuration Backup

Category Configurations

Users User accounts, user roles, groups, and organizations

Resources Tenable Nessus scanners, Tenable Nessus Network Monitor instances, Log

Correlation Engines, LDAP servers, and scan zones

System Configuration sett ings (including data expiration sett ings, external schedules

sett ings, Tenable Lumin sett ings, mail sett ings, miscellaneous sett ings,

license sett ings, plugins/ feed sett ings, SAML sett ings, and security sett ings),

publishing sites sett ings, keys sett ings, and schedules

Scanning Active scans, agent synchronization jobs, agent scans, freeze windows, cre-

dentials, scan policies, audit files, assets, repositories, and compliance check

plugin entries

Reporting Dashboards, Assurance Report Cards, report definit ions, report images, and

CyberScope and DISA report attributes

Workflow Alerts

Analysis Queries

Automatic Backups

Tenable Security Center performs automatic nightly backups of the following databases:

l /opt/sc/application.db

l /opt/sc/hosts.db

l /opt/sc/jobqueue.db

l /opt/sc/plugins.db
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l /opt/sc/remediationHierarchy.db

l /opt/sc/orgs/<orgID>/organization.db (for each organization in your Tenable Security

Center)

l /opt/sc/orgs/<orgID>/assets.db (for each organization in your Tenable Security Center)

Automatic backups run nightly at 1:20 AM local t ime. This schedule cannot be changed.

Tenable Security Center stores backups in the same directory as the database.
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Perform a Backup

Required User Role: Root user

For more information about the backup and restore process, see Backup and Restore.

To perform a backup of Tenable Security Center data:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. Stop Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center stops.

3. In the CLI in Tenable Security Center, run the following command to view all running pro-

cesses:

# ps -fu tns

4. If any processes are listed, run the following commands to stop them:

# killall -u tns

# killall httpd

Note: These commands stop all jobs (including scans) running on Tenable Security Center.

5. If necessary, repeat step 4 to confirm all processes stopped.

6. Run the following command to create a .tar f ile for your /opt/sc directory:

# tar -pzcf sc_backup.tar.gz /opt/sc

Note: The.tar f ile switches are case-sensit ive.

Tenable Security Center creates the backup file.

7. Run the following command to confirm the backup file is not corrupted:
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# tar -tvf sc_backup.tar.gz

8. Move the backup file to a secure location.

9. Start Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center starts.

What to do next:

l (Optional) Restore the backup file, as described in Restore a Backup.
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Restore a Backup

Required User Role: Root user

For more information about the backup and restore process, see Backup and Restore.

Before you begin:

l Perform a backup of your Tenable Security Center, as described in Perform a Backup.

l Confirm your receiving Tenable Security Center meets the requirements described in Backup

and Restore.

l Move the backup file to your receiving Tenable Security Center's /tmp directory.

To restore a backup file:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. Stop Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center stops.

3. In the CLI in Tenable Security Center, run the following command to view all running pro-

cesses:

# ps -fu tns

4. If any processes are listed, run the following commands to stop them:

# killall -u tns

# killall httpd

Note: These commands stop all jobs (including scans) running on Tenable Security Center.

5. If necessary, repeat step 4 to confirm all processes are stopped.
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6. Run the following commands to decompress the .tar f ile and overwrite the existing /opt/sc

directory:

# cd /

# tar -xvf /tmp/sc_backup.tar.gz

Note: The.tar f ile switches are case-sensit ive.

The restore finishes.

7. Start Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center starts.
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Perform a Configuration Backup

Required User Role: Root user

For more information about the backup and restore process and the configurations included in a

configuration backup, see Backup and Restore.

Before you begin:

l If you uploaded custom plugins, save a copy of your custom plugins in a safe location.

To perform a backup of your Tenable Security Center configuration:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. Stop Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center stops.

3. In the CLI in Tenable Security Center, do one of the following:

l To save the configuration backup file to a local directory, run the following command,

where [local directory path] is the local directory where you want to save the

backup file:

/opt/sc/support/bin/php /opt/sc/src/tools/backupSCConfiguration.php -l [local
directory path]

For example:

/opt/sc/support/bin/php /opt/sc/src/tools/backupSCConfiguration.php -l /tmp/

l To save the configuration backup file to a remote directory, run the following command,

where [remote directory absolute path] is the absolute path to the remote dir-

ectory where you want to save the backup file:
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/opt/sc/support/bin/php /opt/sc/src/tools/backupSCConfiguration.php -r
[user]@[host]:[remote absolute path to configuration backups directory]

For example:

/opt/sc/support/bin/php /opt/sc/src/tools/backupSCConfiguration.php -r
tns@100.100.100.100:/tmp/

Tenable Security Center creates the configuration backup file and saves it to the specified dir-

ectory.

Tip: The configuration backup file name includes the backup date and time, the Tenable Security
Center hostname, and the Tenable Security Center version (for example, SC-config-20211101-
165111-sc-hostname-5_20_0.tar.gz).

4. Start Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center starts.

What to do next:

l (Optional) Restore the configuration backup file, as described in Restore a Configuration

Backup.
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Restore a Configuration Backup

Required User Role: Root user

For more information about the backup and restore process and the configurations included in a

configuration backup, see Backup and Restore.

Note: For best performance, after restoring a configuration backup, ensure the hostname associated with
the configuration backup file matches the hostname on the receiving Tenable Security Center.

Before you begin:

1. Perform a configuration backup of your Tenable Security Center, as described in Perform a

Configuration Backup.

2. Confirm your receiving Tenable Security Center meets the requirements described in Backup

and Restore.

To restore a configuration backup file:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. Stop Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center stops.

3. In the CLI in Tenable Security Center, run the following command to restore the configuration

backup, where [path to backup file] is the path to the backup file you want to restore:

/opt/sc/support/bin/php /opt/sc/src/tools/restoreSCConfiguration.php -l [path to
backup file]

For example:

/opt/sc/support/bin/php /opt/sc/src/tools/restoreSCConfiguration.php -l /tmp/SC-
config-20211101-165111-sc-hostname-5_20_0.tar.gz

Tenable Security Center restores the configuration backup.
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4. Start Tenable Security Center, as described in Start, Stop, or Restart Tenable Security Center.

Tenable Security Center starts.

What to do next:

1. If you uploaded custom plugins before restoring your Tenable Security Center configuration,

re-upload the custom plugins. For more information, see Custom Plugin Packages for

NASL and CA Certif icate Upload.

2. Perform discovery scans to re-populate your repositories with vulnerability data. For more

information, see Scanning Overview.
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Tenable Lumin Synchronization

You can use Tenable Lumin to quickly and accurately assess your Cyber Exposure risk and compare

your health and remediation performance to other Tenable customers in your Salesforce industry

and the larger population. Tenable Lumin correlates raw vulnerability data with asset business crit-

icality and threat context data to support faster, more targeted analysis workflows than tradit ional

vulnerability management tools. For more information about Tenable Lumin, see Tenable Lumin in

the Tenable Vulnerability Management User Guide.

After you acquire a Tenable Lumin license for use with Tenable Security Center, you can configure

Tenable Security Center synchronization to send limited Tenable Security Center data to Tenable

Vulnerability Management for use in Tenable Lumin analysis. Tenable Security Center com-

municates with Tenable Vulnerability Management using an encrypted connection, as described in

Encryption Strength.

When you send data to Tenable Vulnerability Management, the system does not remove the data

from your Tenable Security Center. You can continue normal operation of Tenable Security Center.

For more information, see:

l Plan Your Tenable Lumin Synchronization

l Configure Tenable Lumin Synchronization

l View Tenable Lumin Synchronization Status

l View Tenable Lumin Data Synchronization Logs

l View Tenable Lumin Metrics

l Disable Tenable Lumin Synchronization

Tenable Lumin Synchronization Options

Option Description

Access Key The Tenable Vulnerability Management API access key for a Tenable Vul-

nerability Management user with Administrator permissions.

Secret Key The Tenable Vulnerability Management API secret key for a Tenable Vul-
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Option Description

nerability Management user with Administrator permissions.

Network

Support

Supports accurate tracking of assets in repositories with overlapping IPv4

addresses.

Tip: The default sett ing for Network Support depends on the Tenable Secur-
ity Center version where you configured Tenable Lumin synchronization. For
the purpose of determining the default sett ing for Network Support, Ten-
able Lumin synchronization is configured if you have configured the Ten-
able.io Connection Settings and selected at least one repository to
synchronize.

l Tenable Security Center 5.18.x or earlier —Disabled by default if Ten-
able Lumin is already configured.

l Tenable Security Center 5.19.x or later —Enabled by default and can-
not be disabled.

l Enabled —Tenable Security Center synchronizes each IPv4 repository and

agent repository to its own network in Tenable Vulnerability Management,

named TSC-Repository Name. You do not need to resolve repository over-

laps if you enable Network Support.

Note: Once enabled, you cannot disable Network Support.

l Disabled —Tenable Security Center synchronizes all repository data to the

Default network in Tenable Vulnerability Management. You must resolve

all repository overlaps before synchronizing your Tenable Security Center

data to Tenable Vulnerability Management.

For more information, see Networks in the Tenable Vulnerability

Management User Guide.

Contact your Tenable representative to enable Network Support.
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Plan Your Tenable Lumin Synchronization

Tenable recommends planning your synchronization strategy to accommodate synchronization lim-

itations and limit data duplication in Tenable Vulnerability Management.

Can I communicate with Tenable Vulnerability Management through a

proxy?

To use the proxy configured for your Tenable Security Center instance for communications with

your Tenable Vulnerability Management instance, contact Tenable Support.

Can I synchronize mult iple Tenable Security Center instances?

You can synchronize data from one Tenable Security Center to one Tenable Vulnerability Man-

agement instance. You cannot synchronize data from multiple Tenable Security Center instances to

a single Tenable Vulnerability Management instance.

If you purchase mult iple Tenable Vulnerability Management instances, you can synchronize one Ten-

able Security Center to each Tenable Vulnerability Management instance.

What data does synchronization include?

Tenable Security Center supports synchronizing:

l IPv4 addresses within dynamic assets and IPv4 addresses within static assets.

Note: You cannot synchronize IPv6 addresses within static assets. If an asset contains a mix of IPv4
and IPv6 addresses, Tenable Security Center synchronizes only the IPv4 addresses.

Note: You cannot synchronize non-IPv4 assets within dynamic assets. If a dynamic asset contains
other asset types, Tenable Security Center synchronizes only the IPv4 addresses.

Note: You cannot synchronize DNS name list assets, LDAP query assets, combination assets, watch-
list assets, or import assets.

l Active or agent cumulative database and scan result vulnerability data stored in IPv4 and

agent repositories.
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The init ial synchronization includes all cumulative database data from the repository. All sub-

sequent synchronizations include only the new or modified scan result data imported to the

repository.

Note: You cannot synchronize passive scan result vulnerability data. Tenable Security Center iden-
tif ies vulnerability data by plugin family and excludes Tenable Nessus Network Monitor and LCE plu-
gin families from synchronization.

Caution: To avoid data merge issues in Tenable Vulnerability Management, Tenable recommends
enabling Network Support or resolving all repository overlaps before synchronizing data to Tenable
Vulnerability Management. You cannot resolve data merge issues after synchronizing a repository
with Tenable Vulnerability Management; you must enable Network Support or resolve overlapping
repositories in Tenable Security Center before synchronizing a repository for the first t ime. For more
information, see Network Support and Repository Overlap.

Do I need to synchronize both data types (repositories and assets)?

Yes. In order to accurately assess your Cyber Exposure risk with Tenable Lumin, you must syn-

chronize one or more asset lists and one or more repositories containing vulnerability data for those

assets.

Should I resolve repository overlaps or enable Network Support?

If you first configured Tenable Lumin synchronization in Tenable Security Center 5.19.x or later, Net-

work Support is enabled by default and cannot be disabled.

If you first configured Tenable Lumin synchronization in Tenable Security Center 5.18.x or earlier

and upgraded to Tenable Security Center 5.19.x or later, you can decide to enable Network Support

instead of resolving repository overlaps in the Tenable Security Center repositories you synchronize

with Tenable Vulnerability Management. Contact your Tenable representative to enable Network

Support.

Tip: For the purpose of determining the default sett ing for Network Support, Tenable Lumin syn-
chronization is configured if you have configured the Tenable.io Connection Settings and selected at least
one repository to synchronize.

For more information, see Network Support and Repository Overlap and Tenable Lumin Syn-

chronization Options.

- 270 -



How long does synchronization take to complete?

Vulnerability and asset data synchronize differently to Tenable Vulnerability Management.

Data Synchronization Method Timing

Vulnerability

data

l Manual init ial syn-

chronization.

l Automatic sub-

sequent syn-

chronizations when

new scan result data

imports to your syn-

chronized repos-

itories.

After you init iate a synchronization, Tenable

Security Center immediately begins trans-

ferring data to Tenable Vulnerability Man-

agement. After 10-15 minutes, data begins

appearing in Tenable Vulnerability Man-

agement.

Newly transferred data does not imme-

diately impact your Tenable Lumin metrics

(for example, your CES). Tenable requires up

to 48 hours to recalculate your metrics.

All data and recalculated Tenable Lumin met-

rics appear in Tenable Vulnerability Man-

agement within 48 hours.

Recalculated metrics appear in Tenable

Security Center after the next daily retrieval.

Asset data (tags

in Tenable Vul-

nerability Man-

agement)

l Manual init ial syn-

chronization.

l On-demand, auto-

matic, or scheduled

subsequent syn-

chronizations,

depending on your

synchronization con-

figuration.

To monitor the success or failure of synchronizations, see View Tenable Lumin Synchronization

Status and View Tenable Lumin Data Synchronization Logs.

Which of my synchronized assets count toward my Tenable Vul-

nerability Management license?

Synchronized assets that count toward your Tenable Security Center license also count toward your

Tenable Vulnerability Management license. For more information about Tenable Security Center

asset counting, see License Requirements.
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Where will I see synchronized data in Tenable Vulnerability Man-

agement?

Tip: Viewing vulnerability data is temporarily not possible in Tenable Vulnerability Management. You can
view asset and solutions data, but not vulnerability data. For more information, contact your Tenable rep-
resentative.

You can view your synchronized data in both the Vulnerability Management and Tenable Lumin

areas of Tenable Vulnerability Management.

Vulnerability Management

View your synchronized data on the Assets page. For more information, see View Assets in Tenable

Vulnerability Management.

Tenable Lumin

View your synchronized data on any Tenable Lumin page. For more information, see Get Started

with Tenable Lumin in the Tenable Vulnerability Management User Guide.

Tip: To view limited metrics Tenable Security Center retrieves from Tenable Lumin in Tenable Vulnerability
Management, see View Tenable Lumin Metrics.
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Network Support and Repository Overlap

Two or more IPv4 repositories overlap if their specified IP Ranges contain intersecting

IP addresses. To avoid data merge issues in Tenable Vulnerability Management, Tenable recom-

mends enabling Network Support or resolving all repository overlaps before synchronizing data to

Tenable Vulnerability Management.

While both methods avoid data merge issues, Tenable recommends enabling Network Support to

support accurate tracking of assets in repositories with overlapping IPv4 addresses without manu-

ally resolving repository overlaps.

Synchronize Repositories to Individual Tenable Vulnerability Man-

agement Networks

Tip: The default sett ing for Network Support depends on the Tenable Security Center version
where you configured Tenable Lumin synchronization. For the purpose of determining the
default sett ing for Network Support, Tenable Lumin synchronization is configured if you have
configured the Tenable.io Connection Settings and selected at least one repository to syn-
chronize.

l Tenable Security Center 5.18.x or earlier —Disabled by default if Tenable Lumin is already
configured.

l Tenable Security Center 5.19.x or later —Enabled by default and cannot be disabled.

Because Network Support synchronizes each IPv4 and agent repository to its own individual net-

work in Tenable Vulnerability Management, repositories with overlap do not cause data merge

issues in Tenable Vulnerability Management.

For more information, see Tenable Lumin Synchronization Options.

Resolve Repository Overlaps

If Network Support is disabled and you do not plan to enable it, you must resolve repository over-

laps before synchronizing new repositories to Tenable Vulnerability Management.

To resolve an overlap between two repositories, edit the repository configurations and reconfigure

the IP Ranges to avoid intersecting IP addresses, as described in IPv4/ IPv6 Repositories.
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Caution: You cannot resolve data merge issues after synchronizing a repository with Tenable Vulnerability
Management; you must enable Network Support or resolve overlapping repositories in Tenable Security
Center before synchronizing a repository for the first t ime.

If you cannot resolve all overlaps and you do not want to enable Network Support, plan to syn-

chronize a limited number of repositories to avoid conflicts. For example, to avoid a conflict

between two repositories, synchronize one repository but not the other repository.
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Configure Tenable Lumin Synchronization

Required Additional License: Tenable Lumin

Required Tenable Security Center User Role: Administrator

Required Tenable Vulnerability Management User Role: Administrator

You can configure Tenable Security Center to send limited Tenable Security Center data to Tenable

Vulnerability Management for use in Tenable Lumin analysis. For more information, see Tenable

Lumin Synchronization.

Before you begin:

l License and enable Tenable Lumin in Tenable Vulnerability Management, as described in

License and Enable Tenable Lumin in the Tenable Vulnerability Management User Guide.

l Plan your synchronization strategy and review known limitations and dependencies, as

described in Plan Your Tenable Lumin Synchronization.

l Note that Tenable Security Center repositories are not case-sensit ive, but networks in Ten-

able Vulnerability Management are case-sensit ive. When you synchronize a repository, ensure

that the name is unique from any existing Tenable Vulnerability Management networks.

l Plan your strategy for avoiding data merge issues and perform any required cleanup, as

described in Network Support and Repository Overlap.

Caution:You cannot resolve data merge issues after synchronizing a repository with Tenable Vul-
nerability Management; you must enable Network Support or resolve overlapping repositories in Ten-
able Security Center before synchronizing a repository for the first t ime.

l Generate Tenable Vulnerability Management API keys for a Tenable Vulnerability Management

user with Administrator permissions, as described in Generate API Keys in the Tenable Vul-

nerability Management User Guide.

l Share any assets you want to synchronize with the Full Access group, as described in Groups.

You cannot synchronize assets with more limited sharing.

To configure data synchronization between Tenable Security Center and Tenable Lumin in

Tenable Vulnerability Management:
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1. Log in to Tenable Security Center via the user interface.

2. Click System > Configuration.

The Configuration page appears.

3. Click the Tenable Lumin t ile.

The Tenable Lumin Configuration page appears.

4. In the Tenable Vulnerability Management Connection Settings section, type an Access Key and

Secret Key for the Tenable Vulnerability Management user you want to have full access to your

data in Tenable Vulnerability Management. For more information, see Tenable Lumin Syn-

chronization Options.

Tenable Security Center validates the connection to Tenable Vulnerability Management and

locks the key configuration.

5. (Optional) To test the connection to Tenable Vulnerability Management, click Test Connection.

Tenable Security Center tests the connection to Tenable Vulnerability Management using the

access key and secret key you provided.

Tenable Security Center displays a notif ication indicating the status of the connection to Ten-

able Vulnerability Management.

6. In the Vulnerability Data Synchronization section:

a. (Optional) If you did not enable Network Support and you want to synchronize each Ten-

able Security Center IPv4 and agent repository to its own network in Tenable Vul-

nerability Management, contact your Tenable representative to enable Network Support.

For more information, see Tenable Lumin Synchronization Options.

Note: Once enabled, you cannot disable Network Support.

b. Select one or more IPv4 or agent repositories that contain the scan result data you want

to synchronize with Tenable Vulnerability Management.

The init ial synchronization includes all cumulative database data from the repository. All

subsequent synchronizations include only the new or modified scan result data imported

to the repository.
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Note: You cannot synchronize passive scan result vulnerability data. Tenable Security Center
identif ies vulnerability data by plugin family and excludes Tenable Nessus Network Monitor
and LCE plugin families from synchronization.

Caution: To avoid data merge issues in Tenable Vulnerability Management, Tenable recom-
mends enabling Network Support or resolving all repository overlaps before synchronizing
data to Tenable Vulnerability Management. You cannot resolve data merge issues after syn-
chronizing a repository with Tenable Vulnerability Management; you must enable Network Sup-
port or resolve overlapping repositories in Tenable Security Center before synchronizing a
repository for the first t ime. For more information, see Network Support and Repository Over-
lap.

Tip: Hover over the to view details for a repository (including information about unresolved

repository overlaps).

c. Click Synchronize.

A confirmation window appears.

d. Click Synchronize.

Tenable Security Center begins synchronizing your vulnerability data to Tenable Vul-

nerability Management.

7. In the Asset to Tag Synchronization section:

a. If you want to synchronize asset data at a scheduled time:

i. Click to enable the Custom Schedule slider.

ii. Next to the schedule link, click the button.

iii. Modify the Time and Timezone options to specify when you want synchronizations

to occur.

Tip: You cannot modify the Frequency or Repeat Every options; all Tenable Lumin syn-
chronizations occur once daily.

If you do not schedule your asset synchronizations, Tenable Security Center auto-

matically synchronizes once daily, after business hours for your local t ime zone.
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b. If you want to filter the assets that appear in the Unstaged Assets section, do any of the

following:

l Select an organization from the Organization Filter drop-down list and click Apply

Filters.

l Select an asset type from the Asset Type Filter drop-down list and click Apply Fil-

ters.

l Type an asset name in the Search Name box and press Enter.

Note: You can synchronize any assets shared with the Full Access group. You cannot syn-
chronize assets with more limited sharing.

Tenable Security Center applies your filter to the Unstaged Assets section.

c. To stage one or more assets for synchronization, do one of the following:

l Click the Add All button to stage all visible assets for synchronization.

Tenable Security Center stages all visible assets for synchronization and displays

them in the Staged Assets section.

l In the rows for individual assets you want to stage for synchronization, click the

button.

Tenable Security Center stages your selected assets for synchronization and dis-

plays them in the Staged Assets section.

Note: You cannot synchronize IPv6 addresses within static assets. If an asset contains a mix
of IPv4 and IPv6 addresses, Tenable Security Center synchronizes only the IPv4 addresses.

Note: You cannot synchronize non-IPv4 assets within dynamic assets. If a dynamic asset con-
tains other asset types, Tenable Security Center synchronizes only the IPv4 addresses.

Note: You cannot synchronize DNS name list assets, LDAP query assets, combination assets,
watchlist assets, or import assets.

Tip: Click an asset row to view details for an asset.
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d. Click Synchronize Staged Assets.

A confirmation window appears.

e. Click Synchronize.

Tenable Security Center begins synchronizing your assets to Tenable Vulnerability Man-

agement.

8. Wait for data transfer and Tenable Lumin data calculations to complete. For more inform-

ation, see How long does synchronization take to complete?.

9. Monitor the synchronization and confirm there were no errors, as described in View Tenable

Lumin Synchronization Status or View Tenable Lumin Data Synchronization Logs.

What to do next:

l Begin using Tenable Vulnerability Management and Tenable Lumin, as described in Where will

I see synchronized data in Tenable Vulnerability Management?.

l View Tenable Lumin metrics information within Tenable Security Center, as described in View

Tenable Lumin Metrics.

l By default, synchronized data is visible to the Tenable Vulnerability Management Admin-

istrator account used for synchronization and to all other users in Tenable Vulnerability Man-

agement. If you want to restrict privileges for synchronized data, configure access groups as

described in Access Groups in the Tenable Vulnerability Management User Guide.
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View Tenable Lumin Synchronization Status

Required Additional License: Tenable Lumin

Required User Role: Administrator

After you configure Tenable Security Center data synchronization to Tenable Lumin in Tenable Vul-

nerability Management, you can view the status of your synchronizations.

For information about viewing logs for past synchronizations, see View Tenable Lumin Data Syn-

chronization Logs.

Before you begin:

l Configure Tenable Lumin synchronization, as described in Configure Tenable Lumin Syn-

chronization.

To monitor the status of your data synchronization between Tenable Security Center and

Tenable Lumin in Tenable Vulnerability Management:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Configuration.

The Configuration page appears.

3. Click the Tenable Lumin t ile.

The Tenable Lumin Configuration page appears.

4. In the Vulnerability Data Synchronization section:

l View the Last Successful Sync date and time for data from any repository.

l View details for a repository by hovering over the that appears when you hover over a

repository name:

Data Description

Name The repository name.
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Data Description

Format The repository type: IPv4/ IPv6 or Agent.

First Successful

Synchronization

The date and time of the first synchronization of this repos-

itory.

Last Successful

Synchronization

The date and time of the most recent synchronization of this

repository.

Error Status If the most recent synchronization of this repository failed, a

description of the failure.

Last Failed Syn-

chronization

The date and time of the most recent failed synchronization

of this repository.

Repositories Over-

lapping with

<Repository Name>

The names of other repositories with IP Ranges that overlap

this repository. For more information, see Network Support

and Repository Overlap.

5. In the Asset to Tag Synchronization section:
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l In the Unstaged Assets or Staged Assets section, click an asset row to view details for

an asset:

Data Description

Description The asset description.

First Sync Suc-

cess

The date and time of the first synchronization of this asset.

Last Sync Suc-

cess

The date and time of the most recent synchronization of this

asset.

Last Sync Fail-

ure

The date and time of the most recent failed synchronization of

this asset.

Sync Error If the most recent synchronization of this asset failed, a descrip-

t ion of the failure.

l View the Last Successful Sync date and time for any asset data.
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Disable Tenable Lumin Synchronization

Required Additional License: Tenable Lumin

Required User Role: Administrator

When you disable Tenable Lumin synchronization, Tenable Security Center stops synchronizing new

or updated scan result and asset data with Tenable Lumin in Tenable Vulnerability Management.

Existing Tenable Security Center data remains visible in Tenable Vulnerability Management.

To stop synchronizing data with Tenable Lumin in Tenable Vulnerability Management:

1. Log in to Tenable Security Center via the user interface.

2. Click System > Configuration.

The Configuration page appears.

3. Click the Tenable Lumin t ile.

The Tenable Lumin Configuration page appears.

4. In the Vulnerability Data Synchronization section:

a. Deselect all of your repositories.

b. Click Synchronize.

Tenable Security Center stops synchronizing vulnerability data to Tenable Vulnerability

Management. Existing Tenable Security Center data remains visible in Tenable Vul-

nerability Management.

5. In the Asset to Tag Synchronization section:

a. In the Staged Assets section, click Remove All.

All staged assets move to the Unstaged Assets section.

b. Click Synchronize Staged Assets.

Tenable Security Center stops synchronizing asset data to Tenable Vulnerability Man-

agement. Existing Tenable Security Center data remains visible in Tenable Vulnerability

Management.
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Configure Scans

See the following sections to configure Tenable Security Center scans.

l Scanning Overview

l Resources

l Repositories

l Active Scans

l Active Scan Objects

l Agent Scans

l Agent Scanning

l Freeze Windows

l Patch Management
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Scanning Overview

You can perform two types of scans using Tenable products: discovery scans and assessment

scans. Tenable recommends performing discovery scans to get an accurate picture of the assets

on your network and assessment scans to understand the vulnerabilit ies on your assets.

Configuring both methods provides a comprehensive view of the organization’s security posture and

reduces false posit ives. For more information about Tenable scanning strategies, see the Tenable

Scan Strategy Guide.

Scan Type Description Licensing

Discovery Scan Find assets on your network. For example:

l a scan configured with the Host Discovery tem-

plate.

l a scan configured to use only discovery plugins.

l an Tenable Nessus Network Monitor instance in

discovery mode.

Assets iden-

tif ied by dis-

covery scans

do not count

toward your

license.

Assessment

Scan

Find vulnerabilit ies on your assets. For example:

l an authenticated or unauthenticated active scan

using a Tenable Nessus or Tenable Vulnerability

Management scanner.

l an agent scan using an agent-capable Tenable Vul-

nerability Management or Tenable Nessus Manager

scanner.

Authenticated Active Scans

Configure authenticated scans, also known as cre-

dentialed scans, by adding access credentials to your

assessment scan configuration.

Credentialed scans can perform a wider variety of

checks than non-credentialed scans, which can result in

more accurate scan results. This facilitates scanning of

In general,

assets

assessed by

assessment

scans count

toward your

license.
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a very large network to determine local exposures or

compliance violations.

Credentialed scans can perform any operation that a

local user can perform. The level of scanning depends

on the privileges granted to the user account. The more

privileges the scanner has via the login account (e.g.,

root or administrator access), the more thorough the

scan results.

For more information, see Credentials.

Unauthenticated Active Scans

If you do not add access credentials to your assessment

scan configuration, Tenable Vulnerability Management

performs a limited number of checks when scanning

your assets.

For more information about how discovered and assessed assets are counted towards your license,

see License Requirements.
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Resources

Administrator users can configure supporting resources.

l Tenable Nessus Scanners

l Tenable Nessus Network Monitor Instances

l Tenable Log Correlation Engines

l Tenable Log Correlation Engine Clients

l Tenable Log Correlation Engine Client Policies

l Tenable OT Security Instances

Scan zone resources are considered active scan objects. For more information, see Active Scan

Objects and Scan Zones.

LDAP server resources are part of user account configuration. For more information, see User

Accounts and LDAP Authentication.
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Tenable Nessus Scanners

For high level information about active and agent scanning, see Active Scans and Agent Scans.

In the Tenable Security Center framework, the Tenable Nessus scanner behaves as a server, while

Tenable Security Center serves as a client that schedules and init iates scans, retrieves results,

reports results, and performs a wide variety of other important functions.

You can add Tenable Nessus or Tenable Vulnerability Management deployments to Tenable Security

Center as Tenable Nessus scanners in Tenable Security Center:

l Managed or unmanaged Tenable Nessus scanners

Note: Tenable Security Center cannot perform scans with or update plugins for scanners running
unsupported versions of Tenable Nessus. For minimum Tenable Nessus scanner version require-
ments, see the Tenable Security Center Release Notes for your version.

l Tenable Nessus Manager instances

Note: If you enabled clustering on Tenable Nessus Manager, add the parent node of the cluster to
Tenable Security Center. For more information, see Clustering in the Tenable Nessus User Guide.

l Tenable Vulnerability Management instances

For more information, see:

l Add a Tenable Nessus Scanner

l Add a Tenable Vulnerability Management Scanner

l Manage Nessus Scanners

l View Your Nessus Scanners

l View Details for a Nessus Scanner

l Delete a Nessus Scanner

l View Tenable Nessus Instances in Tenable Security Center

For information about Tenable Security Center-Tenable Nessus and Tenable Security Center-Ten-

able Vulnerability Management communications encryption, see Encryption Strength.

Tenable Nessus Scanner Sett ings

- 288 -

https://docs.tenable.com/releasenotes/Content/tenablesc/tenablesc.htm
https://docs.tenable.com/nessus/Content/Clustering.htm


Option Description

Name A descriptive name for the scanner.

Description A scanner description, location, or purpose.

Host The hostname or IP address of the scanner.

Port The TCP port that the scanner listens on for communications from Ten-

able Security Center. The default is port 8834.

Enabled A scanner may be Enabled or Disabled within Tenable Security Center to

allow or prevent access to the scanner.

Verify Hostname Adds a check to verify that the hostname or IP address entered in the

Host option matches the CommonName (CN) presented in the SSL cer-

t if icate from the Nessus server.

Note: Confirm that the correct CA certif icate is configured for use by Tenable
Security Center. If you are using a custom CA, configure Tenable Security
Center to trust your custom CA, as described in Trust a Custom CA. You do
not need to perform this step when using the default cert if icates for Tenable
Nessus servers.

Use Proxy Instructs Tenable Security Center to use its configured proxy for com-

munication with the scanner.

Authentication

Type

Select Password or SSL Certificate for the authentication type to con-

nect to the scanner.

For complete information about Tenable Nessus SSL certif icate authen-

tication, see Manual Tenable Nessus SSL Certif icate Exchange.

Username Username generated during the install for daemon to client com-

munications. This must be an administrator user in order to send plugin

updates to the scanner. If the scanner is updated by a different method,

such as through another Tenable Security Center, a standard user

account may be used to perform scans. This option is only available if the

Authentication Type is set to Password.

Password The login password must be entered in this option. This option is only
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Option Description

available if the Authentication Type is set to Password.

Certificate If you set Authentication Type to SSL Certificate, specifies the nes-
suscert.pem f ile you want to use for authentication to the scanner.

For complete information about Tenable Nessus SSL certif icate authen-

tication, see Manual Tenable Nessus SSL Certif icate Exchange.

Certificate Pass-

phrase

If you selected SSL Certificate as the Authentication Type and the private

key that decrypts your SSL certif icate is encrypted with a passphrase,

the passphrase for the private key.

Zones The scan zones that can use this scanner. For more information, see

Scan Zones.

Agent Capable Specifies whether you want this scanner to provide Tenable Nessus

Agent scan results to Tenable Security Center.

Agent capable scanners must be either Tenable Vulnerability Man-

agement or Nessus Manager 6.5 or later. When using Nessus Manager,

you must use an organizational user account to connect from Tenable

Security Center.

Organizations When the Agent Capable option is enabled, specifies one or more organ-

izations that you want to grant access to import Tenable Nessus Agent

data into Tenable Security Center.

API Keys When the Agent Capable option is enabled, specifies whether you want to

use secure API keys when importing agent scan data from Tenable Nes-

sus or Tenable Vulnerability Management scanners.

For more information about retrieving your access key and secret key

from Tenable Nessus and Tenable Vulnerability Management, see Gen-

erate a Nessus API Key in the Tenable Nessus User Guide and Generate a

Tenable Vulnerability Management API Key in the Tenable Vulnerability

Management User Guide.

Access Key When the API Keys option is enabled, specifies the access key for the
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Option Description

Tenable Nessus or Tenable Vulnerability Management scanner.

Secret Key When the API Keys option is enabled, specifies the secret key for the Ten-

able Nessus or Tenable Vulnerability Management scanner.
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Add a Tenable Nessus Scanner

Required User Role: Administrator

For more information, see Tenable Nessus Scanners.

Note: Tenable Security Center cannot perform scans with or update plugins for scanners running unsup-
ported versions of Tenable Nessus. For minimum Tenable Nessus scanner version requirements, see the
Tenable Security Center Release Notes for your version.

Note:Tenable Security Center does not send plugins to linked Nessus Managers. Nessus Manager pulls plu-
gins directly from Tenable's plugin sites. Therefore, to update plugin sets, Nessus Manager needs access
to the internet and Tenable's plugin sites (for more information, see the Which Tenable sites should I allow?

community art icle). If your Nessus Manager does not have internet access, you can manually update its ver-
sion and plugins offline (for more information, see Manage Nessus Offline in the Nessus User Guide).

To add a Tenable Nessus scanner to Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Tenable Nessus Scanners.

The Tenable Nessus Scanners page appears.

3. Click Add.

The Add Tenable Nessus Scanner page appears.

4. Configure Tenable Nessus scanner options, as described in Tenable Nessus Scanners.

a. In the Name box, type a name for the scanner.

b. In the Description box, type a description for the scanner.

c. In the Host box, type the hostname or IP address for the scanner.

d. In the Port box, view the default (8834) and modify, if necessary.

e. If you want to disable this scanner's connection to Tenable Security Center, click

Enabled to disable the connection.
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f. If you want to verify that the hostname or IP address entered in the Host option matches

the CommonName (CN) presented in the SSL certif icate from the Tenable Nessus scan-

ner, click Verify Hostname to enable the toggle.

g. If you want to use the proxy configured in Tenable Nessus for communication with the

scanner, click Use Proxy to enable the toggle.

h. In the Type drop-down box, select the authentication type.

i. If you selected Password as the Type:

i. In the Username box, type the username for the account generated during the Ten-

able Nessus installat ion for daemon-to-client client communications.

ii. In the Password box, type the password associated with the username you

provided.

j. If you selected SSL Certificate as the Type:

i. Click Choose File to upload the nessuscert.pem f ile you want to use for authen-

tication to the scanner. For more information, see Manual Tenable Nessus SSL Cer-

t if icate Exchange.

ii. (Optional) If the private key that decrypts your SSL certif icate is encrypted with a

passphrase, in the Certificate Passphrase box, type the passphrase for the private

key.

k. Check the box for all active scan zones you want to use this scanner.

l. If you want this scanner to provide Tenable Nessus Agent scan results to Tenable Secur-

ity Center:

i. Click Agent Capable to enable the toggle.

ii. Check the box for one or more Organizations that you want to grant access to

import Tenable Nessus Agent data into Tenable Security Center.

iii. If you want to use secure API keys when importing agent scan data from Tenable

Nessus scanners:
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a. Click API Keys to enable the toggle.

b. In the Access Key box, type the access key.

c. In the Secret Key box, type the secret key.

5. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Configure a scan zone, repository, and active scan objects, as described in Active Scans.
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Add a Tenable Vulnerability Management Scanner

The following feature is not supported in Tenable Vulnerability Management Federal Risk and Authorization
Management Program (FedRAMP) environments. For more information, see the FedRAMP Product Offering.

Required User Role: Administrator

Tenable Security Center supports the use of Tenable Vulnerability Management as a Tenable Nessus

scanner within Tenable Security Center. Tenable Vulnerability Management is an enterprise-class

remote vulnerability scanning service you can use to audit internet-facing IP addresses for both net-

work and web application vulnerabilit ies from the cloud. While Tenable Security Center does not

manage Tenable Vulnerability Management scanners (for example, Tenable Security Center does not

push plugins to the scanner), you can add Tenable Vulnerability Management scanners to Tenable

Security Center the same way you add internal, local, or remote Tenable Nessus scanners.

Before you begin:

l Confirm that you have a valid, active Tenable Vulnerability Management subscription.

To add Tenable Vulnerability Management to Tenable Security Center as a Tenable Nessus

scanner:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Tenable Nessus Scanners.

3. Click Add.
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4. Configure Tenable Nessus scanner options, as described in Tenable Nessus Scanners. You

use Tenable Vulnerability Management-specific values for some sett ings.
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Option Value for a Tenable Vulnerability Management Configuration

Host l Commercial Tenable Vulnerability Management: cloud.tenable.com

l Tenable Vulnerability Management FedRAMP: fed-

cloud.tenable.com

Port 443

Username The username for an active Tenable Vulnerability Management user

account.

Password The password for an active Tenable Vulnerability Management user

account.

Zones The zones within Tenable Security Center that use Tenable Vulnerability

Management as a scanner.

5. Click Submit.

Note: Existing scan reports from Tenable Vulnerability Management are not automatically available in Ten-
able Security Center. However, you can manually download and import them into Tenable Security Center.

Note: By default, Tenable Vulnerability Management selects the corresponding regional scanner. For
example, if you run a scan in the United States, Tenable Vulnerability Management selects the United
States scanner. If you run a scan in Germany, Tenable Vulnerability Management selects the Germany scan-
ner.

What to do next:

l Configure a scan zone, repository, and active scan objects, as described in Active Scans.
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Tenable Nessus Scanner Statuses

You can view the status for scanners, as described in View Your Nessus Scanners.

Status Description Recommended Action

Authentication

Error

Tenable Security Center could

not authenticate to the scanner

using the credentials you

provided.

Check your scanner configuration

sett ings and confirm the Username

and Password options specify valid

login credentials for the scanner.

Certificate Mis-

match

Tenable Security Center could

not confirm the validity of the

SSL certif icate presented by the

scanner.

Do one of the following:

l Edit your scanner con-

figuration and select a dif-

ferent authentication type.

l (Tenable Nessus scanners

only) Check your scanner con-

figuration sett ings and con-

firm the Certificate option

specifies the correct nes-
suscert.pem f ile. For more

information about managing

SSL certif icates in Nessus,

see Manage SSL Certif icates

in the Tenable Nessus User

Guide.

Connection Error Tenable Security Center cannot

connect to the scanner because

the scanner is unreachable or

does not exist at the IP address

or hostname provided.

Do one or both of the following:

l Check your scanner con-

figuration and confirm the

Host option specifies the cor-

rect IP address or hostname

for the scanner.

l Confirm the network devices

and firewalls between Tenable
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Security Center and the scan-

ner are configured to permit

network traffic.

Connection

Timeout

Tenable Security Center con-

nected to the scanner but t imed

out wait ing for a reply.

Contact your network administrator

for troubleshooting assistance.

Invalid Con-

figuration

The scanner attempted to con-

nect to a scanner on port 0.

Do one or both of the following:

l Check your scanner con-

figuration and confirm the

Port option specifies a valid

TCP port to connect to your

scanners. For more inform-

ation, see Port Requirements.

l Check your scanner con-

figuration and confirm the

Access Key and Secret Key

options specify valid keys for a

Tenable Nessus Manager or

cloud scanner.

Plugins Out of

Sync

The plugin sets on the scanner

do not match the plugin sets in

Tenable Security Center.

For troubleshooting assistance, see

the knowledge base article.

Protocol Error Tenable Security Center con-

nected to the scanner but the

scanner returned an HTTPS pro-

tocol negotiation error.

Contact your network administrator

for troubleshooting assistance.

Reloading Scan-

ner

The scanner is temporarily

unable to run scans because Ten-

able Nessus is restart ing on the

scanner.

None.

- 299 -

https://docs.tenable.com/security-center/Content/NessusScanners.htm
https://docs.tenable.com/security-center/Content/NessusScanners.htm
https://docs.tenable.com/security-center/Content/NessusScanners.htm
https://docs.tenable.com/security-center/Content/NessusScanners.htm
https://community.tenable.com/s/article/Tenable-sc-Plugins-Out-of-Sync-warning-explained-Formerly-SecurityCenter


Updating Plugins Tenable Security Center is per-

forming a plugin update on the

scanner.

You may want to schedule plugin

updates to run a few hours before

your scheduled scans. For more

information, see Edit Plugin and

Feed Settings and Schedules.

If a scanner has a persistent Updat-

ing Plugins status, the plugin update

have been interrupted. For

troubleshooting assistance, see the

knowledge base article.

Updating Status Tenable Security Center is

refreshing the status of the scan-

ner. Scanners can continue to

run scans while Tenable Security

Center refreshes the status.

Note: Tenable Security Center
automatically refreshes scanner
statuses every 15 minutes.

If you create a new scanner,
edit a scanner, or manually
refresh the status using the
Update Status option, Ten-
able Security Center
refreshes the status of the
scanner on demand.

None.

Upgrade Required The version of Tenable Nessus

on the scanner is unsupported

and requires an upgrade.

Tenable Security Center cannot

perform scans with or update plu-

gins for scanners running unsup-

ported versions of Tenable

Upgrade to a supported version of

Tenable Nessus, as described in

Upgrade Nessus in the Tenable Nes-

sus User Guide.
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Nessus. For minimum Tenable

Nessus scanner version require-

ments, see the Tenable Security

Center Release Notes for your

version.

User Disabled A Tenable Security Center user

disabled the scanner.

Edit your scanner configuration and

click the Enabled toggle to re-

enable the scanner.

For more information about scanner

options, see Tenable Nessus Scan-

ners.

Working The scanner is connected to Ten-

able Security Center and able to

run scans.

None.
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Manage Nessus Scanners

Required User Role: Administrator

For more information, see Tenable Nessus Scanners.

To manage your Tenable Nessus scanners:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Tenable Nessus Scanners.

The Tenable Nessus Scanners page appears.

3. To filter the scanners that appear on the page, apply a filter as described in Apply a Filter.

4. To view the list of configured scanners, see View Your Nessus Scanners.

5. To view details for a scanner, see View Details for a Nessus Scanner.

6. To edit a scanner:

a. In the row for the scanner, click the menu.

The actions menu appears.

b. Click Edit.

The Edit Tenable Nessus Scanner page appears.

c. Modify the scanner options. For more information about scanner options, see Tenable

Nessus Scanners.

d. Click Submit.

7. To download logs for a scanner, see Download Tenable Nessus Scanner Logs.

8. To delete a scanner, see Delete a Nessus Scanner.

- 302 -



View Your Nessus Scanners

Required User Role: Administrator

For more information, see Tenable Nessus Scanners.

To view a list of configured Tenable Nessus scanners:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Tenable Nessus Scanners.

The Tenable Nessus Scanners page appears.

3. View details about each Tenable Nessus scanner.

l Name —The name for the scanner.

l Features —Specifies whether the scanner is a Standard scanner or an Agent Capable

scanner. Agent capable scanners provide Tenable Nessus Agent scan results to Tenable

Security Center.

l Status —The status of the scanner. For more information, see Tenable Nessus Scanner

Statuses.

l Host —The IP address or hostname of the scanner.

l Version —The scanner's Tenable Nessus version.

l Type —The type of scanner connection.

Type Description

Unknown Tenable Security Center could not identify the scanner.

Nessus (Unman-

aged Plugins)

Tenable Security Center accesses the scanner using a Tenable

Nessus user account with Standard permissions.

Tenable Security Center cannot send plugin updates to the scan-

ner or manage the scanner's activation code.

Nessus (Man- Tenable Security Center manages the scanner and authen-
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Type Description

aged Plugins) t icates via a Tenable Nessus user account.

Tenable Security Center sends plugin updates to the scanner

and manages the scanner's activation code.

Tenable.io

(Unmanaged Plu-

gins)

Tenable Security Center accesses the instance using a Tenable

Vulnerability Management user account with Standard per-

missions.

Tenable Security Center cannot send plugin updates to the

instance or manage the instance's activation code.

l Uptime —The length of t ime, in days, that the scanner has been running.

l Last Modified —The date and time the scanner was last modified.

4. To view details of a specific Tenable Nessus scanner, see View Details for a Nessus Scanner.

5. To filter the scanners that appear on the page, apply a filter as described in Apply a Filter.

6. To manually refresh the Status data, in the Options drop-down box, click Update Status.

Tenable Security Center refreshes the Status data.
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View Details for a Nessus Scanner

Required User Role: Administrator

For more information, see Tenable Nessus Scanners.

To view details for a Tenable Nessus scanner:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Tenable Nessus Scanners.

The Tenable Nessus Scanners page appears.

3. In the row for the scanner for which you want to view details, click the menu.

The actions menu appears.

4. Click View.

The View Tenable Nessus Scanner page appears.

Section Action

Options drop-

down box

l To edit the scanner, click Edit.

l To delete the scanner, click Delete, as described in Delete a

Nessus Scanner.

l To download logs for the scanner, click Download Logs. For

more information, see Download Tenable Nessus Scanner

Logs.

General View general information about the scanner.

Authentication View authentication information for the scanner.

Active Scans View active scan information for the scanner.

Agents View agent information for the scanner.

l Agent Capable —Specifies whether the scanner is agent

capable: Yes or No.
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Section Action

l Organizations —If the scanner is agent capable, the organ-

ization configured for the scanner.

l API Keys Set —If the scanner is agent capable, specifies

whether API keys are configured for the scanner: Yes or No.

Data summary View metadata and performance metrics for the scanner.

Note: Tenable Security Center refreshes the load information every 15
minutes.

Nessus Scanner

Health

If you are viewing details for a managed Tenable Nessus scanner

running version 8.2.0 or later, view scanner health summary data:

l Running Scans —The number of scans currently running on

the scanner.

l Hosts Being Scanned —The number of hosts currently being

scanned by the scanner.

l CPU Load —The percent of the total CPU currently in use by

the scanner.

l Total Memory —The total memory installed on the scanner.

l Memory Used —The percent of the total memory currently in

use by the scanner.

l Total Disk Space —The total disk space installed on the scan-

ner.

l Disk Space Used —The percent of the total disk space cur-

rently in use by the scanner.

l Last Updated —The date and time Tenable Security Center

last updated the scanner data.

Tenable Security Center refreshes the data when you load the View
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Section Action

Nessus Scanner page. To force a manual refresh, click the but-

ton.
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View Tenable Nessus Instances in Tenable Security Center

Required User Role: Administrator

Administrators can view and manage Tenable Nessus scanner configurations from the Tenable

Security Center user interface. For more information about Tenable Nessus scanners in Tenable

Security Center, see Tenable Nessus Scanners.

Note: You cannot use Picture in Picture with a Tenable Nessus scanner if you enabled Use Proxy for the
scanner or if the scanner's Authentication Type is SSL Certificate. For more information, see Tenable Nes-
sus Scanner Sett ings.

Before you begin:

l Enable Picture in Picture, as described in Enable Picture in Picture.

To view Tenable Nessus instances inside the Tenable Security Center user interface:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Tenable Nessus Scanners.

The Tenable Nessus Scanners page appears.

3. In the row for the Tenable Nessus scanner, click the menu.

The actions menu appears.

4. Click Manage System.

The Tenable Nessus instance opens inside the Tenable Security Center user interface.

What to do next:

l Manage your Tenable Nessus scanner configurations using the picture in picture window in

Tenable Security Center. For more information about Tenable Nessus and Tenable Nessus set-

t ings, see the Tenable Nessus User Guide.
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Download Tenable Nessus Scanner Logs

Required User Role: Administrator

You can download a log file for Tenable Nessus scanners managed by Tenable Security Center. The

Tenable Nessus scanner must be running version 8.0.0 or later to send logs to Tenable Security

Center for download.

All Tenable Nessus scanner logs include:

l Recent Tenable Nessus log data

l System information (operating system version, CPU statist ics, available memory, available

disk space, etc.)

l Troubleshooting data

If you include extended logs, the system also downloads recent Tenable Nessus web server log

records, system log data, and network configuration information.

To download logs for a Tenable Nessus scanner:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Nessus Scanners.

The Nessus Scanners page appears.

3. In the row for the scanner for which you want to download logs, click the menu.

The actions menu appears.

4. Click Download Logs.

The Download Nessus Scanner Logs window appears.

5. To include recent Tenable Nessus web server log records, system log data, and network con-

figuration information, click to enable the Extended Logs toggle.

6. To hide the first two octets of IPv4 addresses within the logs, click to enable the Sanitize IPs

toggle.

7. Click Download.
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Tenable Security Center downloads the tar.gz f ile in your browser.

Tip: If you use 7-Zip to extract the tar.gz f ile, you may see the following error message: There are
some data after the end of the payload data. You can safely ignore this error.

- 310 -



Delete a Nessus Scanner

Required User Role: Administrator

For more information, see Tenable Nessus Scanners.

To delete a Tenable Nessus scanner:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Nessus Scanners.

The Nessus Scanners page appears.

3. In the row for the scanner you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the scanner.
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Tenable Nessus Network Monitor Instances

Tenable Nessus Network Monitor (Tenable Nessus Network Monitor) is a patented network dis-

covery and vulnerability analysis software solution that delivers real-t ime network profiling and mon-

itoring for continuous assessment of an organization’s security posture in a non-intrusive manner.

Tenable Nessus Network Monitor monitors network traffic at the packet layer to determine topo-

logy, services, and vulnerabilit ies. Where an active scanner takes a snapshot of the network in time,

Tenable Nessus Network Monitor behaves like a security motion detector on the network.

Tenable Security Center communicates with Tenable Nessus Network Monitor utilizing the XMLRPC

protocol on port 8835 by default. For information about Tenable Security Center-Tenable Nessus

Network Monitor communications encryption, see Encryption Strength.

Note: It is important for you to restrict the data Tenable Nessus Network Monitor collects to only the
desired IP address ranges. For example, if your attached Tenable Nessus Network Monitor collects inform-
ation on 1100 hosts and Tenable Security Center is licensed for 1000 hosts, Tenable Security Center
imports all of the Tenable Nessus Network Monitor data and indicates that you exceeded your host count.
For more information, see License Requirements.

Tenable Security Center will ask Tenable Nessus Network Monitor for the latest (if any) vulnerability

report once every hour by default. The pull interval may be changed under the System Configuration

page under the Update tab.

To fully configure passive scan data retrieval from Tenable Nessus Network Monitor:

1. Configure Tenable Nessus Network Monitor, as described in Get Started in the Tenable Nes-

sus Network Monitor User Guide.

2. Add your Tenable Nessus Network Monitor license to Tenable Security Center, as described in

Apply a New License.

3. Add an IPv4 or IPv6 repository for Tenable Nessus Network Monitor data in Tenable Security

Center, as described in Add a Repository.

4. Add an Tenable Nessus Network Monitor instance in Tenable Security Center, as described in

Add an Tenable Nessus Network Monitor Instance.

5. (Optional) Configure Tenable Nessus Network Monitor plugin import schedules, as described in

Edit Plugin and Feed Settings and Schedules. By default, Tenable Security Center checks for
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new passive vulnerability plugins every 24 hours and pushes them to your attached Tenable

Nessus Network Monitor instances.

What to do next:

l View vulnerability data filtered by your Tenable Nessus Network Monitor repository, as

described in Vulnerability Analysis.

Considerations for Licensing

If you want Tenable Security Center to push plugin updates to Tenable Nessus Network Monitor, you

must add the product activation code to Tenable Security Center. For more information, see Apply a

New License.

For detailed information about plugins counted toward the Tenable Security Center license count,

see License Requirements.

Considerations for Tenable Nessus Network Monitor Discovery Mode

Your Tenable Nessus Network Monitor instances can run in two modes: discovery mode disabled

and discovery mode enabled. For more information, see NNMSettings in the Tenable Nessus Net-

work Monitor User Guide.

If discovery mode is enabled on an Tenable Nessus Network Monitor instance, Tenable Security

Center stores discovery mode asset data to Tenable Security Center repositories. Since discovery

mode only discovers limited asset data, the repository data appears incomplete.

Tenable Security Center does not count IP addresses present only from Tenable Nessus Network

Monitor instances in discovery mode toward your license count.
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Add an Tenable Nessus Network Monitor Instance

Required User Role: Administrator

Before you begin:

l Confirm you understand the complete scanning configuration process, as described in Ten-

able Nessus Network Monitor Instances.

To add an Tenable Nessus Network Monitor instance to Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Tenable Nessus Network Monitors.

The Tenable Nessus Network Monitor Scanners page appears.

3. Click Add.

The Add Tenable Nessus Network Monitor Scanner page appears.

4. Configure the sett ings, as described in Tenable Nessus Network Monitor Instance Settings.

a. In the Name box, type a name for the scanner.

b. In the Description box, type a description for the scanner.

c. In the Host box, type the hostname or IP address for the scanner.

d. In the Port box, view the default (8835) and modify, if necessary.

e. If you want to disable this scanner's connection to Tenable Security Center, click

Enabled to disable the connection.

f. If you want to verify that the hostname or IP address entered in the Host option matches

the CommonName (CN) presented in the SSL certif icate from the Tenable Nessus Net-

work Monitor server, click Verify Hostname to enable the toggle.

g. If you want to use the proxy configured in Tenable Nessus Network Monitor for com-

munication with the scanner, click Use Proxy to enable the toggle.

h. In the Type drop-down box, select the authentication type.
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i. If you selected Password as the Type:

i. In the Username box, type the username for the account generated during the Ten-

able Nessus Network Monitor installat ion for daemon-to-client client com-

munications.

ii. In the Password box, type the password for the account generated during the Ten-

able Nessus Network Monitor installat ion for daemon-to-client client com-

munications

j. If you selected SSL Certificate as the Type, click Choose File to upload a certif icate.

k. If you selected SSL Certificate as the Type:

i. Click Choose File to upload a certif icate.

ii. (Optional) If the private key that decrypts your SSL certif icate is encrypted with a

passphrase, in the Certificate Passphrase box, type the passphrase for the private

key.

l. In the Repositories list, select one or more repositories where you want Tenable Secur-

ity Center to store the scanner data.

5. Click Submit.

Tenable Security Center saves your configuration.

- 315 -



View Your Tenable Nessus Network Monitor Instances

Required User Role: Administrator

For more information, see Tenable Nessus Network Monitor Instances.

To view your Tenable Nessus Network Monitor instances in Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Nessus Network Monitors.

The Nessus Network Monitor Scanners page appears.

3. View details about each Tenable Nessus Network Monitor instance.

l Name —The name for the instance.

l Status —The status of the instance.

l Host —The IP address of the instance.

l Version —The instance's Tenable Nessus Network Monitor version.

l Uptime —The length of t ime, in days, that the instance has been running.

l Last Report —The date and time Tenable Nessus Network Monitor most recently repor-

ted data to Tenable Security Center.

4. (Optional) To manually refresh the Status data, in the Options drop-down box, click Update

Status.

Tenable Security Center refreshes the Status data.
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Tenable Nessus Network Monitor Instance Settings

Use the following options to configure Tenable Nessus Network Monitor instances in Tenable Secur-

ity Center, as described in Add an Tenable Nessus Network Monitor Instance.

Option Description

Name Descriptive name for the Tenable Nessus Network Monitor instance.

Description Instance description, location, or purpose.

Host Hostname or IP address of the instance.

Port TCP port that the Tenable Nessus Network Monitor instance listens on

for communications from Tenable Security Center. The default is port

8835.

State A instance may be marked as Enabled or Disabled within Tenable Security

Center to allow or prevent access to the instance.

Authentication

Type

Select Password or SSL Certif icate for the authentication type to con-

nect to the Tenable Nessus Network Monitor instance.

Username Username generated during the Tenable Nessus Network Monitor install

for daemon to client communications. This must be an administrator user

in order to send plugin updates to the Tenable Nessus Network Monitor

instance. This option is only available if the Authentication Type is set to

Password.

Password The login password must be entered in this option. This option is only

available if the Authentication Type is set to Password.

Certif icate This option is available if the Authentication Type is SSL Certificate. Click

the Browse button, choose a SSL Certif icate file to upload, and upload to

the Tenable Security Center.

Certif icate Pass-

phrase

If you selected SSL Certificate as the Authentication Type and the private

key that decrypts your SSL certif icate is encrypted with a passphrase,

the passphrase for the private key.

Verify Hostname Adds a check to verify that the hostname or IP address entered in the
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Option Description

Host option matches the CommonName (CN) presented in the SSL cer-

t if icate from the Tenable Nessus Network Monitor server.

Use Proxy Instructs Tenable Security Center to use its configured proxy for com-

munication with the instance.

Repositories The repositories which this Tenable Nessus Network Monitor instance

will save its data to. If Tenable Nessus Network Monitor will be reporting

IPv4 and IPv6 data, at least two repositories (one for IPv4 and one for

IPv6 data) must be selected.
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Tenable Log Correlation Engines

Tenable Tenable Log Correlation Engine (Log Correlation Engine) is a software module that aggreg-

ates, normalizes, correlates, and analyzes event log data from the myriad of devices within the infra-

structure. Log Correlation Engine also has the ability to analyze logs for vulnerabilit ies.

Tenable Security Center performs vulnerability, compliance, and event management, but without

Log Correlation Engine integration it does not directly receive logs or IDS/ IPS events. With Log Cor-

relation Engine integration, Log Correlation Engine processes the events and passes the results to

Tenable Security Center.

Log Correlation Engine's close integration with Tenable Security Center allows you to centralize log

analysis and vulnerability management for a complete view of your organization’s security posture.

Note: If you add an Log Correlation Engine server to Tenable Security Center and enable Import Vul-
nerabilities, Log Correlation Engine data counts against your Tenable Security Center license. For more
information, see License Requirements.

For more information, see Add a Tenable Log Correlation Engine Server.

If remote root or root equivalent user login is prohibited in your environment, you can add the Log

Correlation Engine server using SSH key authentication. For more information, see Manual Log Cor-

relation Engine Key Exchange.

For information about Tenable Security Center-Tenable Log Correlation Engine communications

encryption, see Encryption Strength.

Tenable Log Correlation Engine Options

Option Description

Name Name for the integrated Tenable Log Correlation Engine.

Description Descriptive text for the integrated Tenable Log Correlation Engine.

Host IP address of the integrated Tenable Log Correlation Engine.

Check Authentic-

ation

Whether Tenable Security Center checks the status of authentication

between itself and the Log Correlation Engine server.

Organizations Organizations that can access data from the integrated Tenable Log Cor-
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Option Description

relation Engine.

Repositories The repositories where you want Tenable Security Center to store the

imported Log Correlation Engine data.

Port The port where the Log Correlation Engine reporter is listening on the

Log Correlation Engine server.

Username and

Password

The username and password you want Tenable Security Center to use for

authentication to the Log Correlation Engine server to retrieve vul-

nerability information.

This user account must be able to make changes on the remote system

to enable the SSH key exchange between Tenable Security Center and

Log Correlation Engine. The appropriate permissions level is typically

root, root equivalent, or other high-level user permissions on the Log Cor-

relation Engine system. Tenable Security Center uses these credentials a

single time to exchange SSH keys for secure communication between

Tenable Security Center and Log Correlation Engine.
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Add a Tenable Log Correlation Engine Server

Required User Role: Administrator

Tip: You can configure more than one Tenable Log Correlation Engine to work with Tenable Security
Center.

Before you begin:

l Confirm you understand the complete scanning configuration process, as described in Ten-

able Log Correlation Engines.

To add an Log Correlation Engine server to Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Log Correlation Engines.

The LCE Servers page appears.

3. Click Add.

The Add LCE Server window appears.

4. Configure the General options, as described in Tenable Log Correlation Engines.

a. In the Name box, type a name for the Log Correlation Engine server.

b. In the Description box, type a description for the Log Correlation Engine server.

c. In the Host box, type the hostname or IP address for the Log Correlation Engine server.

d. In the Port box, view the default (1243) and modify, if necessary.

5. (Optional) To allow Tenable Security Center to log in to the Log Correlation Engine server and

retrieve vulnerability information:

a. Enable Import Vulnerabilities.

Note: If you use an Log Correlation Engine server with Tenable Security Center, Tenable Secur-
ity Center counts the IP addresses associated with each imported instance against your
license. For more information, see License Requirements.
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b. Select a Repository for the event vulnerability data.

c. Type a Username and Password you want Tenable Security Center to use for access to

the Log Correlation Engine server.

6. Click Submit.

Tenable Security Center saves your configuration.

7. (Optional) If you enabled the Check Authentication option above, Tenable Security Center

checks its ability to authenticate with the Log Correlation Engine server.

l If authentication is successful, Tenable Security Center displays a message to acknow-

ledge that fact.

l If authentication fails, Tenable Security Center prompts you for credentials to the Log

Correlation Engine server:

a. Type a username and password.

b. Click Push Key to init iate the transfer of the SSH Key.

If the transfer is successful, Tenable Security Center displays a message to

acknowledge that fact.
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Tenable Log Correlation Engine Clients

The Log Correlation Engine server manages configuration files for Log Correlation Engine 5.x cli-

ents remotely from the command line. Tenable Security Center manages the configuration files for

Tenable Log Correlation Engine 5.x clients via a graphical interface.

The default view for the Log Correlation Engine Clients page displays all of the available clients for

the selected Tenable Log Correlation Engine server in the Filters section, and may be changed by

updating the Log Correlation Engine Server filter. Use the other filter options, to narrow down the

displayed clients for the selected server by a mix of criteria based on combinations of the displayed

columns.

Current Log Correlation Engine Client versions display information in the table including their name,

host address, authorization status, client type, host OS, assigned policy file, date last updated, and

client version. Log Correlation Engine Client configurations can be managed from Tenable Security

Center.

Tip: Configured clients prior to version 5.x appear in the list without OS and policy information. However,
these clients cannot have their policy files centrally managed from Tenable Security Center.

Each client may have a name assigned to it to help easily identify the client. The currently assigned

name appears in the Name column. To change the name, click on the client to edit from the list, and

type the name. Client names may not contain spaces. Click the Submit button to save the change.

Log Correlation Engine Clients are init ially configured to send their data to a particular Log Cor-

relation Engine server, but must be authorized by the Log Correlation Engine sever for the server to

accept the data. The client’s authorization status appears in the left-side column. If there is no icon,

the client is authorized to send data to the Log Correlation Engine server. If there is a broken link

icon, the client is not authorized to send data to the Log Correlation Engine server. Toggle this by
selecting the menu for the client and clicking either the Authorize or Revoke Authorization from

the list as appropriate.

Each client must have a policy assigned to it that specifies the appropriate data to send. The cur-

rently assigned policy appears in the Policy column. To change the assigned policy, select the client

to edit and click the appropriate policy from the drop-down box. Search client policies by name by

entering text into the Policy box. Click the Submit button to save the change. The policy updates on

the client on its next connection.
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Tenable Log Correlation Engine Client Policies

The Log Correlation Engine Client Policies page contains a list of all the client policies currently

available for use by Log Correlation Engineclients. The list contains the name of the policy, the oper-

ating system it is configured for use on, and the type of client the policy can be applied to.

Example policy files are available for use with the names default and beginning with TNS-. You can

use these policy files as is or export them to be used as a basis for custom policy files. Tenable may

update or change these example policy files without notice, so using them as is may return dif-

ferent results at a later t ime.

Use the Add button to add customized Log Correlation EngineClient policy files to the Log Cor-

relation Engine server and make them available for use. The Name option is appended to the begin-

ning of the file name and offers a description of the function or use of the policy file. The OS Type is

used in the file name to easily identify the OS for which the policy is designed. The Client Type indic-

ates the LCE Client for which the policy is written. The Source option is used to select and upload

the custom policy file or type the policy file into the box. Click the Submit button to save the policy

file and send it to the Log Correlation Engine server.

Note: The default and TNS prefixes should only be used by policies supplied by Tenable. If you use default
or TNS as a prefix for custom policy files, they may be overwritten or manipulated.

Select a policy, click the menu, then click Export to save the policy to a local drive. The file is in

XML format, which you can edit with standard text or XML editors.

Select a policy, click the menu, then click View to display the policy name and source of the

policy in a window within Tenable Security Center. You cannot edit the information from within this

window.

Note: For more information on creating Log Correlation Engine Client policy files, see the Tenable Log Cor-
relation Engine Client Guide.
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Tenable OT Security Instances

Tenable OT Security protects industrial networks by providing industrial and crit ical infrastructure

operations with visibility, security, and control to ensure safe facility operation while reducing over-

all risk. You can use Tenable Security Center to analyze Tenable OT Security asset and vulnerability

data alongside your data from other scanners.

When you configure data synchronization from Tenable OT Security to Tenable Security Center, Ten-

able OT Security sends asset and vulnerability data to an agent repository in Tenable Security

Center. Tenable OT Security communicates with Tenable Security Center using the Tenable Security

Center API.

Note: It is important to restrict the data Tenable OT Security collects to only the desired host IP address
ranges. For example, if Tenable OT Security collects information on 1100 hosts and Tenable Security Center
is licensed for 1000 hosts, Tenable OT Security sends all of the data to Tenable Security Center and Ten-
able Security Center will indicate that you exceeded your host count. For more information, see License
Requirements.

Before you begin:

l Deploy Tenable OT Security, as described in the Tenable OT Security User Guide.

l Begin vulnerability assessment in Tenable OT Security, as described in the Tenable

OT Security User Guide.

To fully configure data synchronization from Tenable OT Security to Tenable Security

Center:

1. Add a designated agent repository for Tenable OT Security data in Tenable Security Center, as

described in Add a Repository.

2. Using the Tenable OT Security API, configure the Tenable Security Center integration to spe-

cify the sync schedule, import repository, and authentication.

What to do next:

l View scan results from Tenable OT Security, as described in View Scan Results.

l View vulnerability data filtered by your Tenable OT Security repository, as described in Vul-

nerability Analysis.
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Repositories

Repositories are databases within Tenable Security Center that contain vulnerability data. You can

share repositories with users and organizations based on admin-defined assets. Repositories

provide scalable and configurable data storage. Optionally, you can share repository data between

multiple Tenable Security Centers.

Note: The maximum repository size is 64 GB. For best performance, Tenable recommends split t ing repos-
itories larger than 32 GB.

When adding a local repository, you designate storage within Tenable Security Center for different

types of vulnerability data (identif ied by IPv4 addresses, IPv6 addresses, agents, or mobile scan-

ners). Scanners attached to a Tenable Security Center populate your local repositories with vul-

nerability data. For more information, see Local Repositories.

When adding an external repository, you access a local repository from another Tenable Security

Center:

l Remote repositories allow you to share repository data from one Tenable Security Center

deployment to your primary Tenable Security Center deployment via an SSH session.

l Offline repositories allow you to share repository data from one Tenable Security Center

deployment to your primary Tenable Security Center deployment via manual export and import

(a .tar.gz archive file). You can combine data from several repository files into a single off-

line repository by importing mult iple files to the offline repository.

External repository data is static and used solely for reporting purposes. For more information, see

External Repositories.

For more information, see Add a Repository and Manage Repositories. For information about Ten-

able Security Center repository data encryption, see Encryption Strength.

Tip: If you need to remove data from a repository (for example, to remove retired asset data or to resolve a
license issue), see the knowledge base article.
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Add a Repository

Required User Role: Administrator

For more information about repositories, see Repositories.

To add a repository:

1. Log in to Tenable Security Center via the user interface.

2. Click Repositories > Repositories.

The Repositories page appears.

3. Click Add.

The Add Repository page appears.

4. Click the tile for the repository type you want to add.

The Add Repository page appears.

5. Configure the options for your repository type:

l IPv4/ IPv6 Repositories

l Mobile Repositories

l Agent Repositories

l Remote Repositories

l Offline Repositories

6. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l If you added an offline repository, export one or more repositories from your other Tenable

Security Center as described in Export a Repository.
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l If you added an offline repository, import one or more exported repository files as described

in Import a Repository.
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Manage Repositories

Required User Role: Administrator

For more information, see Repositories.

To manage your repositories:

1. Log in to Tenable Security Center via the user interface.

2. Click Repositories > Repositories.

The Repositories page appears.

3. To filter the repositories that appear on the page, apply a filter as described in Apply a Filter.

4. To view details for a repository:

a. In the row for the repository, click the menu.

The actions menu appears.

b. Click View.

The View Repository page appears. For more information, see Repository Details.

5. To edit a repository:

a. In the row for the repository, click the menu.

The actions menu appears.

b. Click Edit.

The Edit Repository page appears.

c. Modify the repository options, as described in IPv4/ IPv6 Repositories, Mobile Repos-

itories, Agent Repositories, Remote Repositories, or Offline Repositories.

d. Click Submit.

Tenable Security Center saves your configuration.

6. To export a repository, see Export a Repository.
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7. To import a repository file into an offline repository, see Import a Repository.

8. To delete a repository, see Delete a Repository.
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View Your Repositories

Required User Role: Administrator

You can view a list of all repositories on your Tenable Security Center. For more information, see

Repositories.

To view a list of your repositories:

1. Log in to Tenable Security Center via the user interface.

2. Click Repositories > Repositories.

The Repositories page appears.

3. View details about each repository.

l Name —The name of the repository.

l Vulnerability Count —The total number of vulnerability instances in the repository.

Tip: A vulnerability instance is a single instance of a vulnerability appearing on an asset, iden-
tif ied uniquely by plugin ID, port, and protocol.

l IP/Device Count —The total number of assets for which the repository contains vul-

nerability data.

l Type —The repository type.

l Capacity —(IPv4, IPv6, and Agent repositories only) The percentage of maximum avail-

able repository space you are currently using. The maximum repository size is 64 GB.

Tip: For best performance, Tenable recommends split t ing repositories larger than 32 GB.

l Last Updated —The date and time the repository was last updated.
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View Repository Details

Required User Role: Administrator

You can view details for any repository. For more information, see Repositories.

To view repository details:

1. Log in to Tenable Security Center via the user interface.

2. Click Repositories > Repositories.

The Repositories page appears.

3. In the row for the repository, click the menu.

The actions menu appears.

4. Click View.

The View Repository page appears.

Section Repository Type Action

General All View general information for the repos-

itory.

l Name —The repository name.

l Description —The repository descrip-

t ion.

l IP Count —The total number of

assets for which the repository con-

tains vulnerability data.

l Last Vuln Update —The date and

time the repository was last updated.

l Vulnerability Count —The total num-

ber of vulnerability instances in the

repository.
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Section Repository Type Action

Tip: A vulnerability instance is a
single instance of a vulnerability
appearing on an asset, identif ied
uniquely by plugin ID, port, and pro-
tocol.

l Repository Capacity —(IPv4, IPv6,

and Agent repositories only) The per-

centage of maximum available repos-

itory space you are currently using.

The maximum repository size is 64

GB.

Tip: For best performance, Tenable
recommends split t ing repositories lar-
ger than 32 GB.

l Created —The date the repository

was created.

l Last Modified —The date the repos-

itory was last modified.

l ID —The repository ID.

MDM Mobile View a summary of your sett ings for the

repository. For more information about a

sett ing, see Mobile Repositories.

Data IPv4/ IPv6, Agent,

Remote, Offline

View a summary of the repository data (for

example, the IP address range). For more

information, see:

l IPv4/ IPv6 Repositories

l Agent Repositories
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Section Repository Type Action

l Remote Repositories

l Offline Repositories

Access All View the name of the organizations with

access to this repository.

Advanced Settings IPv4/ IPv6, Agent,

Remote, Offline

View a summary of your sett ings for the

repository. For more information about a

sett ing, see:

l IPv4/ IPv6 Repositories

l Agent Repositories

l Remote Repositories

l Offline Repositories

Tenable.io Syn-

chronization Data

All supported for

Tenable Lumin syn-

chronization

View synchronization summary data:

l Status —The status of the repository

in Tenable Lumin synchronization: 

l Finished —The most recent syn-

chronization that included this

repository succeeded.

l Not Synced —The repository is

not configured for Tenable

Lumin synchronization.

l Error —An error occurred. For

more information, see View Ten-

able Lumin Data Syn-

chronization Logs.

l First Synchronization —The date and

time of the first synchronization of
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Section Repository Type Action

this repository.

l Last Success —The date and time of

the most recent synchronization of

this repository.

l Last Failure —The date and time of

the most recent failed syn-

chronization of this repository.

For more information about Tenable Lumin

synchronization, see Tenable Lumin Syn-

chronization.

Vulnerability Data

Lifetime

IPv4/ IPv6, Agent View the data expiration sett ings for the

repository. For more information, see:

l IPv4/ IPv6 Repositories

l Agent Repositories
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Export a Repository

Required User Role: Administrator

You can export a repository from one Tenable Security Center and import it as an offline repository

on another Tenable Security Center. You can export repositories via the Tenable Security Center

user interface or the CLI. For more information, see Offline Repositories.

Note: Depending on the size of the repository database, this file can be quite large. It is important to save
the file to a location with sufficient free disk space.

Tip: If the repository you want to export has trend data enabled and you want to include trend data in your
repository export, export the repository via the CLI. Repositories that you export via the user interface do
not include trend data. For more information about trend data, see IPv4/ IPv6 Repositories and Agent
Repositories.

To export a repository via the user interface:

1. Log in to Tenable Security Center via the user interface.

2. Click Repositories > Repositories.

The Repositories page appears.

3. In the row for the repository, click the menu.

The actions menu appears.

4. Click Export.

Tenable Security Center exports the repository.

To export a repository via the CLI:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. Prepare the command you want to run.

/opt/sc/customer-tools/exportRepository.sh [repID] [trendingDays] [trendWithRaw]

- 336 -



Variable Description

repID The repository ID of the repository you want to export. To locate

the repository ID, view the details for the repository, as described

in View Repository Details.

trendingDays (IP and Agent repositories only) The number of days of vul-

nerability trending data to include. To use the preconfigured

repository sett ing, type default.

Note: The number of days of trending data included in the export can-
not exceed the Days Trending sett ing for the repository or the num-
ber of days of trending data available for the repository. For example,
if you request 30 days of trending data, but trending data has been
enabled for only 15 days, then the export includes only 15 days of
trending data. For more information about repository sett ings, see
IPv4/ IPv6 Repositories and Agent Repositories.

trendWithRaw (IP and Agent repositories only) Specify whether you want the

export to include plugin output data: yes or no. To use the pre-

configured repository sett ing, type default.

(Optional) To automatically overwrite an existing repository file with the same name, include

the optional argument -f.

3. In the CLI in Tenable Security Center, run the export command.

For example:

/opt/sc/customer-tools/exportRepository.sh 1 default default -f

Tenable Security Center exports the repository.

What to do next:

l To import the repository to another Tenable Security Center, add an offline repository to that

Tenable Security Center, as described in Add a Repository.
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Import a Repository

Required User Role: Administrator

You can import one or more repository files to an offline repository. For more information, see Off-

line Repositories.

Note: When importing the repository archive, the default maximum file import size is 360MB. This is spe-
cified by the post_max_size directive in /opt/sc/support/etc/php.ini. If larger file uploads are
required, increase the default value.

Before you begin:

l Export one or more repository files from your other Tenable Security Center, as described in

Export a Repository.

l Add an offline repository, as described in Add a Repository.

To import an exported repository to an offline repository:

1. Log in to Tenable Security Center via the user interface.

2. Click Repositories > Repositories.

The Repositories page appears.

3. In the row for the offline repository you created, click the menu.

The actions menu appears.

4. Click Upload and browse to the file you want to upload.

Tenable Security Center imports the repository.
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Delete a Repository

Required User Role: Administrator

To delete a repository:

1. Log in to Tenable Security Center via the user interface.

2. Click Repositories > Repositories.

The Repositories page appears.

3. In the row for the repository you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the repository.
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Local Repositories

When adding local repositories, you designate storage within Tenable Security Center for different

types of vulnerability data. Scanners attached to a Tenable Security Center populate your local

repositories with vulnerability data.

Tenable Security Center supports three types of local repositories: IPv4/ IPv6 Repositories, Mobile

Repositories, and Agent Repository Options.

For more information, see Repositories and Add a Repository.
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IPv4/ IPv6 Repositories

These are the most common types of repositories used with Tenable Security Center. They store

IPv4 and IPv6 data from active and passive scans. Data stored in local repositories can be shared

between organizations and includes the full range of event and vulnerability metadata.

Caution: When creating Tenable Security Center IPv4 or IPv6 repositories, Log Correlation Engine event
source IP address ranges must be included along with the vulnerability IP address ranges or the event data
and event vulnerabilit ies are not accessible from the Tenable Security Center web interface.

For more information, see Add a Repository.

IP Repository Options

Option Description

General

Name The repository name.

Description (Optional) A description for the repository.

Data

IP Ranges Specifies the IP address range of vulnerability data you want to store in

the repository.

Type the range as a comma-delimited list of IP addresses, IP address

ranges, and/or CIDR blocks.

Access

Organizations Specifies which organizations have access to the vulnerability data stored

in the repository.

If groups are configured for the organization, Tenable Security Center

prompts you to grant or deny access to all of the groups in the organ-

ization. For more granular control, grant access within the sett ings for

that group.

Advanced Settings

- 341-



Option Description

Generate Trend

Data

When enabled, Tenable Security Center generates trend data by taking

periodic snapshots of the cumulative database. Trend data is displayed in

some Tenable Security Center tools (e.g., trending line charts and trending

area charts).

Tenable Security Center also produces differential data (snapshot com-

parison data), which improves performance when displaying trend data in

Tenable Security Center tools.

Tip: Disable this option to reduce your disk space usage.

Days Trending Specifies the number of days of cumulative vulnerability data that you

want Tenable Security Center to display in dashboard and report vul-

nerability trending displays.

Enable Full Text

Search

When enabled, Tenable Security Center includes vulnerability text in peri-

odic snapshots of .nessus data for vulnerability trending purposes. For

more information about the Vulnerability Text f ilter component, see Vul-

nerability Analysis Filter Components.

Log Correlation

Engine Cor-

relation

Not supported for IPv6 repositories.

The Log Correlation Engine server where you want Tenable Security

Center to retrieve data. The data retrieved depends on the Import Vul-

nerabilities sett ing in your Log Correlation Engine server configuration:

l If Import Vulnerabilities is enabled, Tenable Security Center retrieves

vulnerability data and Log Correlation Engine events.

l If Import Vulnerabilities is disabled, Tenable Security Center

retrieves Log Correlation Engine events.

Vulnerability Data Lifetime (Data Expiration Settings)

Active The number of days you want Tenable Security Center to retain active

scan vulnerability data stored in IP repositories. The default value of this

option is 365 days.
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Option Description

Passive The number of days you want Tenable Security Center to retain Tenable

Nessus Network Monitor vulnerability data stored in IP repositories. The

default value of this option is 7 days.

Event (IPv4 repositories only) The number of days you want Tenable Security

Center to retain Log Correlation Engine event data stored in

IPv4 repositories. The default value of this option is 365 days.

Compliance The number of days you want Tenable Security Center to retain audit com-

pliance data stored in agent repositories. The default value of this option

is 365 days.

Mitigated The number of days you want Tenable Security Center to retain mitigated

vulnerability data. The default value of this option is 365 days.
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Mobile Repositories

The mobile repository is a local type that stores data from various servers. For more information,

see Add a Repository.

l General Options

l ActiveSync Options

l AirWatch MDMOptions

l Apple Profile Manager Options

l Blackberry UEMOptions

l Good MDMOptions

l Microsoft Intune Options

l Mobile Iron Options

General Options

Configure the following options for all mobile repository types.

Option Description Default

Name The repository name. --

Description (Optional) A description for the repository. --

Type The type of repository you want to configure. Your Type

selection determines the type-specific options you must

configure: ActiveSync Options, AirWatch MDMOptions,

Apple Profile Manager Options, Blackberry UEMOptions,

Good MDMOptions, Microsoft Intune Options, or Mobile Iron

Options.

--

Organizations Specifies which organizations have access to the vul-

nerability data stored in the repository.

If groups are configured for the organization, Tenable Secur-

--

- 344 -



Option Description Default

ity Center prompts you to grant or deny access to all of the

groups in the organization. For more granular control, grant

access within the sett ings for that group.

ActiveSync Options

The following table describes the addit ional options to configure when creating an ActiveSync

mobile repository.

Option Description Default

Domain Con-

troller

The domain controller for ActiveSync. --

Domain The Windows domain for ActiveSync. --

Domain User-

name

The username for the domain administrator's account that Ten-

able Security Center uses to authenticate to ActiveSync.

--

Domain Pass-

word

The password for the domain administrator user. --

Scanner Specifies which Tenable Nessus scanner Tenable Security

Center uses when scanning the server. Tenable Security Center

can only use one Tenable Nessus scanner to add data to a

mobile repository.

--

Update

Schedule

Specifies when Tenable Security Center scans the server to

update the mobile repository. On each scan, Tenable Security

Center removes the current data in the repository and replaces

it with data from the latest scan.

Every day

at 12:30 -

04:00

AirWatch MDMOptions

The following table describes the addit ional options to configure when creating an AirWatch MDM

mobile repository.
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Option Description Default

AirWatch Envir-

onment API URL

The SOAP URL or REST API URL you want Tenable Secur-

ity Center to use to authenticate with AirWatch.

--

Port The TCP port that AirWatch listens on for com-

munications from Tenable Security Center.

443

Username The username for the AirWatch user account Tenable

Security Center uses to authenticate to AirWatch's REST

API.

--

Password The password for the AirWatch user. --

API Key The API key for the AirWatch REST API. --

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

Enabled

Verify

SSL Certificate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this
sett ing.

Enabled

Scanner Specifies which Tenable Nessus scanner Tenable Secur-

ity Center uses when scanning the server. Tenable Secur-

ity Center can only use one Tenable Nessus scanner to

add data to a mobile repository.

--

Update Schedule Specifies when Tenable Security Center scans the server

to update the mobile repository. On each scan, Tenable

Security Center removes the current data in the repos-

itory and replaces it with data from the latest scan.

Every day

at 12:30 -

04:00

Apple Profile Manager Options
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The following table describes the addit ional options to configure when creating an Apple Profile

Manager mobile repository.

Option Description Default

Server The server URL Tenable Security Center uses to authen-

ticate with Apple Profile Manager.

--

Port The TCP port that Apple Profile Manager listens on for

communications from Tenable Security Center.

443

Username (Optional) The username for the Apple Profile Manager

user account Tenable Security Center uses to authen-

ticate to Apple Profile Manager.

--

Password (Optional) The password for the Apple Profile Manager

user.

--

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

Enabled

Verify

SSL Certificate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this
sett ing.

Enabled

Scanner Specifies which Tenable Nessus scanner Tenable Secur-

ity Center uses when scanning the server. Tenable Secur-

ity Center can only use one Tenable Nessus scanner to

add data to a mobile repository.

--

Update Schedule Specifies when Tenable Security Center scans the server

to update the mobile repository. On each scan, Tenable

Security Center removes the current data in the repos-

itory and replaces it with data from the latest scan.

Every day

at 12:30 -

04:00
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Blackberry UEMOptions

The following table describes the addit ional options to configure when creating a Blackberry UEM

mobile repository.

Option Description Default

Blackberry UEM

Hostname

The hostname for the Blackberry UEM server. --

Blackberry UEM

Port

The port you want Tenable Security Center to use for

authenticating to the Blackberry UEMserver.

--

Blackberry UEM

Tenant

The SRP ID value in Blackberry UEM. --

Blackberry UEM

Domain

(Optional) The domain name value in Blackberry UEM. --

Blackberry UEM

Username

The username for the Blackberry UEMuser account Ten-

able Security Center uses to authenticate to Blackberry

UEM.

--

Blackberry UEM

Password

The password for the Blackberry UEMuser. --

Blackberry UEM

SSL

When enabled, Tenable Security Center uses an encryp-

ted connection to authenticate with Blackberry UEM.

Disabled

Blackberry UEM

Verify

SSL Certificate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this
sett ing.

Disabled

Scanner Specifies which Tenable Nessus scanner Tenable Secur-

ity Center uses when scanning the server. Tenable Secur-

ity Center can only use one Tenable Nessus scanner to

add data to a mobile repository.

--

Update Schedule Specifies when Tenable Security Center scans the server Every day at
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Option Description Default

to update the mobile repository. On each scan, Tenable

Security Center removes the current data in the repos-

itory and replaces it with data from the latest scan.

12:30 -

04:00

Good MDMOptions

The following table describes the addit ional options to configure when creating a Good MDMmobile

repository.

Option Description Default

Server The server URL Tenable Security Center uses to authen-

ticate with Good MDM.

--

Port The TCP port that Good MDMlistens on for com-

munications from Tenable Security Center.

--

Domain The domain name for Good MDM. --

Username The username for the Good MDMuser account Tenable

Security Center uses to authenticate to Good MDM.

--

Password The password for the Good MDMuser. --

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

Enabled

Verify

SSL Certificate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this
sett ing.

Enabled

Scanner Specifies which Tenable Nessus scanner Tenable Secur-

ity Center uses when scanning the server. Tenable Secur-

--
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Option Description Default

ity Center can only use one Tenable Nessus scanner to

add data to a mobile repository.

Update Schedule Specifies when Tenable Security Center scans the server

to update the mobile repository. On each scan, Tenable

Security Center removes the current data in the repos-

itory and replaces it with data from the latest scan.

Every day

at 12:30 -

04:00

Microsoft Intune Options

The following table describes the addit ional options to configure when creating a Microsoft Intune

mobile repository.

Option Description Default

Intune Tenant The Microsoft Azure Directory value in your Microsoft Intune

registration.

--

Intune Client The Microsoft Azure Application value generated during your

Microsoft Intune registration.

--

Intune Secret The Microsoft Azure client secret key. --

Intune User-

name

The username for the Microsoft Intune user account Tenable

Security Center uses to authenticate to Microsoft Intune.

--

Intune Pass-

word

The password for the Microsoft Intune user. --

Scanner Specifies which Tenable Nessus scanner Tenable Security

Center uses when scanning the server. Tenable Security Center

can only use one Tenable Nessus scanner to add data to a

mobile repository.

--

Update

Schedule

Specifies when Tenable Security Center scans the server to

update the mobile repository. On each scan, Tenable Security

Center removes the current data in the repository and replaces

it with data from the latest scan.

Every day

at 12:30 -

04:00
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Mobile Iron Options

The following table describes the addit ional options to configure when creating a Mobile Iron mobile

repository.

Option Description Default

MobileIron VSP

Admin Portal URL

The server URL Tenable Security Center uses to authen-

ticate to the MobileIron administrator portal.

--

VSP Admin Portal

Port

(Optional) The TCP port that the MobileIron administrator

portail listens on for communications from Tenable Secur-

ity Center.

--

MobileIron Port The TCP port that MobileIron listens on for com-

munications from Tenable Security Center.

443

Username The username for the MobileIron administrator account

Tenable Security Center uses to authenticate to

MobileIron.

--

Password The password for the MobileIron administrator user. --

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

Enabled

Verify

SSL Certificate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this
sett ing.

Enabled

Scanner Specifies which Tenable Nessus scanner Tenable Secur-

ity Center uses when scanning the server. Tenable Secur-

ity Center can only use one Tenable Nessus scanner to

add data to a mobile repository.

--

Update Schedule Specifies when Tenable Security Center scans the server Every day
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Option Description Default

to update the mobile repository. On each scan, Tenable

Security Center removes the current data in the repos-

itory and replaces it with data from the latest scan.

at 12:30 -

04:00
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Agent Repositories

Agent repositories can store data from Tenable Nessus Agents (identif ied by agent ID) or Tenable

OT Security (identif ied by Tenable OT Security UUID).

An agent ID uniquely identif ies agent-detected assets that may share a common IP address.

Tenable OT Security assigns UUIDs to assets to uniquely identify them, since not all operational

technology assets have IP addresses. Then, Tenable Security Center uses the UUIDs to uniquely

identify Tenable OT Security data in Tenable Security Center. For more information about viewing

Tenable OT Security data in Tenable Security Center, see Tenable OT Security Instances.

For more information, see Add a Repository.

Agent Repository Options

Option Description

General

Name The repository name.

Description (Optional) A description for the repository.

Access

Organizations Specifies which organizations have access to the vulnerability data stored

in the repository.

If groups are configured for the organization, Tenable Security Center

prompts you to grant or deny access to all of the groups in the organ-

ization. For more granular control, grant access within the sett ings for

that group.

Advanced Settings

Generate Trend

Data

When enabled, Tenable Security Center generates trend data by taking

periodic snapshots of the cumulative database. Trend data is displayed in

some Tenable Security Center tools (e.g., trending line charts and trending

area charts).
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Option Description

Tenable Security Center also produces differential data (snapshot com-

parison data), which improves performance when displaying trend data in

Tenable Security Center tools.

Tip: Disable this option to reduce your disk space usage.

Days Trending Specifies the number of days of cumulative vulnerability data that you

want Tenable Security Center to display in dashboard and report vul-

nerability trending displays.

Enable Full Text

Search

When enabled, Tenable Security Center includes vulnerability text in peri-

odic snapshots of .nessus data for vulnerability trending purposes. For

more information about the Vulnerability Text f ilter component, see Vul-

nerability Analysis Filter Components.

Vulnerability Data Lifetime (Data Expiration Settings)

Active The number of days you want Tenable Security Center to retain agent scan

vulnerability data stored in agent repositories. The default value of this

option is 365 days.

Compliance The number of days you want Tenable Security Center to retain audit com-

pliance data stored in agent repositories. The default value of this option

is 365 days.

Mitigated The number of days you want Tenable Security Center to retain mitigated

vulnerability data. The default value of this option is 365 days.
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External Repositories

When adding an external repository, you access a local repository from another Tenable Security

Center:

l Offline repositories allow you to share repository data from one Tenable Security Center

deployment to your primary Tenable Security Center deployment via manual export and import

(a .tar.gz archive file). You can combine data from several repository files into a single off-

line repository by importing mult iple files to the offline repository.

l Remote repositories allow you to share repository data from one Tenable Security Center

deployment to your primary Tenable Security Center deployment via an SSH session.

External repository data is static and used solely for reporting purposes. For more information, see

Offline Repository Options and Remote Repositories.

For more information, see Repositories and Add a Repository.
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Offline Repositories

Offline repositories allow you to share repository data from one Tenable Security Center deploy-

ment to your primary Tenable Security Center deployment via manual export and import (a .tar.gz
archive file). You can combine data from several repository files into a single offline repository by

importing mult iple files to the offline repository.

Offline repositories are particularly useful to export data from air-gapped instances of Tenable

Security Center. For more information, see Considerations for Air-Gapped Environments.

Note: You cannot set an offline repository as the Import Repository for active scans. You can only use off-
line repository data for reporting purposes.

To fully configure an offline repository:

1. Add an offline repository to your primary Tenable Security Center deployment.

2. Export one or more repositories from your other Tenable Security Center deployment.

3. Import one or more repositories to the offline repository on your primary Tenable Security

Center deployment.

Offline Repository Options

Option Description

General

Name The repository name.

Description (Optional) A description for the repository.

Access

Data Type The type of data in the other Tenable Security Center repository: IPv4,

IPv6, Mobile, or Agent.

IP Ranges If the Data Type is IPv4 or IPv6, specifies the IP address range of vul-

nerability data that you want to view in the offline repository. For example,

to view all data from the exported repository file, specify a range that

includes all data in that repository.
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Option Description

Type the range as a comma-delimited list of IP addresses, IP address

ranges, and/or CIDR blocks.

For more information, see IPv4/ IPv6 Repositories.

Type If the Data Type is Mobile, the type of mobile repository: ActiveSync,

AirWatch MDM, Apple Profile Manager, Blackberry UEM, Good MDM,

Microsoft Intune, or Mobile Iron.

For more information, see Mobile Repositories.

Access

Organizations Specifies which organizations have access to the vulnerability data stored

in the repository.

If groups are configured for the organization, Tenable Security Center

prompts you to grant or deny access to all of the groups in the organ-

ization. For more granular control, grant access within the sett ings for

that group.

Advanced Settings

Generate Trend

Data

When enabled, Tenable Security Center generates trend data by taking

periodic snapshots of the cumulative database. Trend data is displayed in

some Tenable Security Center tools (e.g., trending line charts and trending

area charts).

Tenable Security Center also produces differential data (snapshot com-

parison data), which improves performance when displaying trend data in

Tenable Security Center tools.

Tip: Disable this option to reduce your disk space usage.

Days Trending Specifies the number of days of cumulative vulnerability data that you

want Tenable Security Center to display in dashboard and report vul-

nerability trending displays.
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Option Description

Enable Full Text

Search

When enabled, Tenable Security Center includes vulnerability text in peri-

odic snapshots of .nessus data for vulnerability trending purposes. For

more information about the Vulnerability Text f ilter component, see Vul-

nerability Analysis Filter Components.
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Remote Repositories

Remote repositories allow you to share repository data from one Tenable Security Center deploy-

ment to your primary Tenable Security Center deployment via an SSH session.

Note: You cannot set a remote repository as the Import Repository for active scans. You can use remote
repository data only for reporting purposes.

Note: If your remote repository exists on a Tenable Security Center running 5.19.x or later, upgrade your
primary Tenable Security Center deployment to Tenable Security Center 5.19.x or later.

For more information, see Add a Repository.

To use tiered remote repositories for large enterprise deployments of Tenable Security Center, see

Tiered Remote Repositories.

Option Description

General

Name The repository name.

Description (Optional) A description for the repository.

Remote Tenable Security Center

Host The IP address for the host you want to synchronize with to obtain repos-

itory data. After you type the IP address:

1. Click Request Repositories.

2. Type the username and password for an administrator account on

the remote Tenable Security Center.

The Tenable Security Center deployments exchange SSH keys, and

the system populates the Repository list with all available repos-

itories from the remote Tenable Security Center.

Repository The remote repository you want to collect IP addresses and vulnerability

data from.

Update Schedule Sets the schedule for the remote server to be queried for updated inform-
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Option Description

ation.

Access

Organizations Specifies which organizations have access to the vulnerability data stored

in the repository.

If groups are configured for the organization, Tenable Security Center

prompts you to grant or deny access to all of the groups in the organ-

ization. For more granular control, grant access within the sett ings for

that group.
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Tiered Remote Repositories

Remote repositories allow you to share repository data from one Tenable Security Center deploy-

ment to your primary Tenable Security Center deployment via an SSH session.

A t iered remote repository configuration uses remote repositories to share data between multiple

Tenable Security Center instances.

l If you plan to support 100,000-249,999 hosts, Tenable recommends a tiered remote repository

configuration.

l If you plan to support 250,000 or more hosts, Tenable requires a tiered remote repository con-

figuration.

Tiered Tenable Security Center instances perform informal roles in your overall Tenable Security

Center deployment. Tenable recommends at least one designated reporting Tenable Security

Center and an addit ional Tenable Security Center instance for every 100,000 to 150,000 hosts on

your network.

l A scanning tier Tenable Security Center optimizes scanning by managing scan jobs across

your attached scanners. Scanning tier Tenable Security Center instances priorit ize efficient

collection of scan data.

l A reporting tier Tenable Security Center optimizes dashboards and reporting by centralizing

the data collected by scanning tier Tenable Security Center instances.

Note: Your scanning tier and reporting tier Tenable Security Center instances must be running the same
Tenable Security Center version.

Without a tiered remote repository configuration, enterprise-scale scanning and analysis may cause

performance issues on a single Tenable Security Center. Tiered remote repositories optimize your

analysis and report generation without negatively impacting scanning performance.

For more information, see Configure Tiered Remote Repositories.

Tip: Configuring tiered remote repositories does not allow you to monitor the status of scanning tier Ten-
able Security Center instances. To monitor the status of mult iple Tenable Security Center instances, con-
nect your Tenable Security Center instances to Tenable Security Center Director. For more information
about Tenable Security Center Director, see the Tenable Security Center Director User Guide.
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Configure Tiered Remote Repositories

You may want to configure tiered remote repositories in large deployments of Tenable Security

Center. For more information, see Tiered Remote Repositories.

To configure a tiered remote repository deployment:

1. On the scanning tier Tenable Security Center instance, create one or more repositories for

storing scan result data.

Note: To view trend data for scanning tier Tenable Security Center instances on your
reporting tier Tenable Security Center instance, enable the Generate Trend Data option for
each repository on your scanning tier Tenable Security Center instances. For more inform-
ation, see Agent Repositories and IPv4/ IPv6 Repositories.

2. On the scanning tier Tenable Security Center instance, run scans to populate the repositories

with data.

3. On the reporting tier Tenable Security Center instance, create a remote repository for each

repository on your scanning tier Tenable Security Center instance.

The reporting tier Tenable Security Center syncs scan result data from the scanning tier Ten-

able Security Center repositories.
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Active Scans

In active scanning, the scanner sends packets to a remote target to provide a snapshot of network

services and applications. Tenable Security Center compares this data to a plugin database to

determine if any vulnerabilit ies are present. Tenable Security Center can also use a scanner located

outside the local network to simulate what an external entity might see.

For more information about supported active scanner types (Tenable Nessus and Tenable Vul-

nerability Management deployments) in Tenable Security Center, see Tenable Nessus Scanners.

You can use credentialed Tenable Nessus scans, a type of active scanning, to perform highly accur-

ate and rapid patch, configuration, and vulnerability audits on Unix, Windows, Cisco, and database

systems by actually logging in to the target system with provided credentials. Credentialed scans

can also enumerate all UDP and TCP ports in just a few seconds. Tenable Security Center can man-

age these credentials securely across thousands of different systems and also share the results of

these audits only with users who need to access them.

For more information, see Manage Active Scans and Active Scan Settings.

To fully configure active scans using a Tenable Nessus or Tenable Vulnerability Man-

agement scanner:

1. If you are configuring a Tenable Nessus scanner (not a Tenable Vulnerability Management

deployment), configure scanning in Tenable Nessus, as described in Scans in the Tenable Nes-

sus User Guide.

Note: For information about credentialed scanning in Tenable Nessus, see Credentialed Checks in the
Tenable Nessus User Guide.

2. Add the Tenable Nessus scanner or your Tenable Vulnerability Management deployment in Ten-

able Security Center, as described in Tenable Nessus Scanners.

3. Add a scan zone in Tenable Security Center, as described in Add a Scan Zone.

4. Add a repository for the scan data in Tenable Security Center, as described in Add a Repos-

itory.

5. Create active scan objects in Tenable Security Center, as described in:
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a. Add a Template-Based Asset or Add a Custom Asset.

b. Add Credentials.

c. Add a Template-Based Audit File or Add a Custom Audit File.

d. Add a Scan Zone.

e. Add a Scan Policy.

6. Add an active scan in Tenable Security Center, as described in Add an Active Scan.

What to do next:

l View scan results, as described in Scan Results.

l View vulnerability data by IP address, as described in Vulnerability Analysis.

Special Active Scans

Diagnostic Scans

If you experience issues with an active scan, Tenable Support may ask you to run a diagnostic scan

to assist with troubleshooting. After Tenable Security Center runs the diagnostic scan, download

the diagnostic file and send it to Tenable Support.

For more information, see Run a Diagnostic Scan.

Remediation Scans

You can run a remediation scan to run a followup active scan against existing active scan results. A

remediation scan evaluates a specific plugin against a specific target or targets where the related

vulnerability was present in your earlier active scan.

For more information, see Launch a Remediation Scan.
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Add an Active Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information about active scan options, see Active Scan Settings.

Before you begin:

l Confirm you are running Tenable Nessus 6.3.6 or later.

l Confirm you understand the complete scanning configuration process, as described in Active

Scans.

To add an active scan:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Active Scans.

The Active Scans page appears.

3. Click Add.

The Add Active Scan page appears.

4. Click General.

5. Type a Name for the scan.

6. (Optional) Type a Description for the scan.

7. Select a Policy for the scan.

8. (Optional) If you want to schedule the scan to run automatically, select a Schedule for the

scan.

9. Click Settings.

The Settings tab appears.

10. If prompted, select a preconfigured Scan Zone for the scan.

11. Select an Import Repository for the scan.
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12. Select a Scan Timeout Action for the scan.

13. Select a Rollover Schedule for the scan.

14. Enable or disable the Advanced options.

15. Click Targets.

The Targets tab appears.

16. Select a Target Type for the scan.

17. Select one or more Assets and IPs / DNS Names for the scan.

18. (Optional) To configure credentialed scanning, do the following:

a. Click Credentials.

The Credentials tab appears.

b. Click Add Credential.

c. In the drop-down boxes, select a credential type and a preconfigured credential.

d. Click the check mark to save your selection.

19. (Optional) If you want to configure mult iple credentials for the active scan, repeat step 19.

Note: When running an active scan, Tenable Security Center attempts authentication
using the newest credentials added by an Administrator user. If the newest Administrator-
added credentials do not match, Tenable Security Center attempts authentication with
older Administrator-added credentials.

Then, if no Administrator-added credentials match, Tenable Security Center attempts to
authenticate using the newest credentials added by an organizational user. If the newest
organizational user-added credentials do not match, Tenable Security Center attempts
authentication with older organizational user-added credentials.

If no credentials match, the scan runs without credentialed access.

20. (Optional) To configure post-scan options, do the following: 

a. Click Post Scan.

The Post Scan tab appears.
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b. To configure automatic report generation, click Add Report.

c. Select the report you want to run after the scan completes, as described in Add a Report

to a Scan.

21. Click Submit.

Tenable Security Center saves your configuration.
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Configure vSphere Scanning

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can configure a scan policy to scan the following virtual environments:

l ESXi/vSphere managed by vCenter

l ESXi/vSphere that is not managed by vCenter

l Virtual machines

Scanning ESXi/vSphere Not Managed by vCenter

To configure an ESXi/vSphere scan that is not managed by vCenter:

1. Begin configuring a scan policy that supports credentialed access, as described in Add a Scan

Policy. For more information about authentication options in scan policies, see Authentication

Options.

2. In the left navigation menu, click Authentication.

The Authentication tab appears.

3. Click Add Authentication Settings.

The authentication options appear.

4. In the first Type drop-down box, select Miscellaneous.

5. In the second Type drop-down box, select VMware ESX SOAP API.

6. Click Select.

The VMware ESX SOAP API options appear. For more information, see VMware ESX SOAP API.

7. In the Username box, type the username associated with the local ESXi account.

8. In the Password box, type the password associated with the username you provided.

9. If your vCenter host includes an SSL certif icate (not a self-signed certif icate), disable the Do

not verify SSL Certificate toggle.
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10. Click the button.

Tenable Security Center applies the VMware ESX SOAP API authentication options to the scan

policy.

What to do next:

l Reference the scan policy in an active scan configuration, as described in Add an Active Scan.

Scanning vCenter Managed ESXi/vSpheres

Note: The SOAP API requires a vCenter admin account with read and write permissions. The
REST API requires a vCenter admin account with read permissions, and a VMware vSphere Lifecycle man-
ager account with read permissions.

To configure an ESXi/vSphere scan managed by vCenter:

1. Begin configuring a scan policy that supports credentialed access, as described in Add a Scan

Policy. For more information about authentication options in scan policies, see Authentication

Options.

2. In the left navigation menu, click Authentication.

The Authentication tab appears.

3. Click Add Authentication Settings.

The authentication options appear.

4. In the first Type drop-down box, select Miscellaneous.

5. In the second Type drop-down box, select VMware vCenter SOAP API.

6. Click Select.

The VMware vCenter SOAP API options appear. For more information, see VMware vCenter

SOAP API.

7. In the vCenter Host box, type the IP address of the vCenter host.

8. In the vCenter Port box, type the port for the vCenter host.

9. In the Username box, type the username associated with the local ESXi account.
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10. In the Password box, type the password associated with the username you provided.

11. If the vCenter host is not SSL enabled, disable the HTTPS toggle.

12. If your vCenter host includes an SSL certif icate (not a self-signed certif icate), enable the

Verify SSL Certificate toggle.

13. Click the button.

Tenable Security Center applies the VMware vCenter SOAP API authentication options to the

scan policy.

What to do next:

l Reference the scan policy in an active scan configuration, as described in Add an Active Scan.

Scanning Virtual Machines

You can scan virtual machines just like any other host on the network. Be sure to include the IP

addresses of virtual machines you want to scan in your scan targets. For more information, see Add

an Active Scan.
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Manage Active Scans

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information about active scans, see Active Scans.

To manage active scans:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Active Scans.

The Active Scans page appears.

3. To filter the scans that appear on the page, apply a filter as described in Apply a Filter.

4. To start or pause a scan, see Start or Pause a Scan.

5. To suspend or resume a scheduled scan, see Suspend or Resume a Scheduled Active Scan.

6. To view details for a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click View.

The View Active Scan page appears.

7. To edit a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click Edit.

The Edit Active Scan page appears.

c. Modify the scan options.

d. Click Submit.
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Tenable Security Center saves your configuration.

8. To copy a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click Copy.

Tenable Security Center creates a copy of the scan.

9. To run a diagnostic scan, see Run a Diagnostic Scan.

10. To delete a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click Delete.

A confirmation window appears.

c. Click Delete.

Tenable Security Center deletes the scan.
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Start or Pause a Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To start or pause an active scan, agent scan, or agent synchronization job:

1. Log in to Tenable Security Center.

2. Click one of the following:

l Scans > Active Scans (to manage active scans)

l Scans > Agent Synchronization Jobs (to manage agent synchronization jobs)

l Scans > Agent Scans (to manage agent scans)

l Scans > Scan Results (to manage a scan from the results page).

3. Do one of the following:

l To pause the scan or synchronization job, click the pause button on the right side of the

scan or synchronization job row.

l To start the scan or synchronization job, click the start button on the right side of the

scan or synchronization job row.
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Suspend or Resume a Scheduled Active Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

If you suspend a scheduled active scan, Tenable Security Center stops launching new scans for that

active scan configuration. Tenable Security Center does not disrupt scans already in progress or

prevent users from launching scans on demand.

If you resume a suspended active scan, Tenable Security Center resumes launching scans on the

schedule configured for that active scan.

For more information, see Active Scans.

Before you begin:

l Configure a scheduled active scan, as described in Add an Active Scan.

To suspend or resume a scheduled active scan:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Active Scans.

The Active Scans page appears.

3. In the row for the scheduled scan you want to suspend or resume, click the menu.

The actions menu appears.

4. Click Suspend Schedule or Resume Schedule.

The page updates to reflect the scan schedule status. When a scan is suspended, Tenable

Security Center displays a line through the Start Time and Schedule values.
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Run a Diagnostic Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

If you experience issues with an active scan, Tenable Support may ask you to run a diagnostic scan

to assist with troubleshooting. After Tenable Security Center runs the diagnostic scan, download

the diagnostic file and send it to Tenable Support.

Before you begin:

l Add an active scan, as described in Add an Active Scan.

l Confirm the scanner associated with the active scan is running a supported version of Ten-

able Nessus. For minimum Tenable Nessus scanner version requirements, see the Tenable

Security Center Release Notes for your version.

To run a diagnostic scan:

1. Click Scans > Active Scans.

2. In the row for the scan where you want to run a diagnostic scan, click the menu.

The actions menu appears.

3. Click Run Diagnostic Scan.

Note: You must resolve repository errors before running a diagnostic scan.

4. In the Diagnostic Target box, type a target as a single IPv4 address, IPv6 address, or host-

name. The target must also be specified in the active scan's Targets.

5. In the Diagnostic Password box, type a password to secure the diagnostic file.

6. Click Submit.

The diagnostic scan runs and finishes.

7. Click Scans > Scan Results.

8. Locate the diagnostic scan and confirm that the scan finished without errors.
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9. In the row for the diagnostic scan result, click the menu.

The actions menu appears.

10. Click Download Diagnostic Info.

The diagnostic scan file downloads.
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Active Scan Settings

For more information, see Add an Active Scan.

l General Options

l Settings Options

l Targets Options

l Credentials Options

l Post Scan Options

General Options

Parameter Description

General

Name The scan name that is associated with the scan’s results and may be any

name or phrase (for example, SystemA, DMZ Scan, or Daily Scan of the Web

Farm).

Description Descriptive information related to the scan.

Policy The policy on which you want to base the scan. You can scroll through the

list, or search by entering text in the search box at the top of the list of avail-

able policies.

Schedule

Schedule The frequency you want to run the scan.

l Now specifies that you want Tenable Security Center to launch the

scan immediately without saving the configuration for later.

Note: Scans configured to run Now do not appear on the Active Scans
page.

l Once specifies that you want Tenable Security Center to launch the

scan at the specified time without saving the configuration for later.
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Parameter Description

Note: Scans configured to run Once do not appear on the Active Scans
page.

l Daily, Weekly, or Monthly specifies that you want Tenable Security

Center to launch the scan at a scheduled interval.

Note: If you schedule your scan to repeat monthly, Tenable recommends
sett ing a start date no later than the 28th day. If you select a start date
that does not exist in some months (e.g., the 29th), Tenable Security
Center cannot run the scan on those days.

l On Demand specifies that you want to manually launch the scan at any

time.

l Dependent specifies that you want Tenable Security Center to launch

the scan every time Tenable Security Center finishes a scheduled run

of the dependent scan you select.

Settings Options

Parameter Description

Basic

Scan Zone Note: If your organization's Distribution Method sett ing is Locked Zone, you
cannot modify this sett ing. If your organization's Distribution Method sett ing
is Automatic Distribution Only, Tenable Security Center automatically chooses
one or more scan zones and hides this sett ing.

Specifies the scan zone you want to use to run the scan. Depending on

your organization's Distribution Method sett ing, you can select one of the

following:

l An available zone —use a single scan zone to run the scan.

Note: If you select a single scan zone, Tenable Security Center ignores
the ranges in the scan zone and scans all of the targets you specify in
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Parameter Description

the scan configuration.

l Automatic Distribution —allow Tenable Security Center to choose

the best scan zone to run the scan.

For more information, see Organizations and Scan Zones.

Import Repository Specifies the repository where Tenable Security Center imports the scan

results. Select a IPv4 or IPv6 repository to receive IPv4 or IPv6 results

appropriate to the scan.

Scan Timeout

Action

The action you want Tenable Security Center to perform in the event a

scan is incomplete:

l Import Completed Results With Rollover —(Default) The system

imports the results from the scan into the database and creates a

rollover scan that you can launch manually to complete the scan.

l Import Completed Results —The system imports the results of the

current scan and discards the information for the unscanned hosts.

l Discard Results —The system does not import any of the results

obtained by the scan to the database.

Rollover Schedule If you set the Scan Timeout Action to Import results with Rollover, this

option specifies how to handle the rollover scan. You can create the

rollover scan as a template to launch manually, or to launch the next day

at the same start t ime as the just-completed scan.

Advanced

Scan Virtual

Hosts

Specifies whether the system treats a new DNS entry for an IP address as

a virtual host as opposed to a DNS name update.

When Tenable Security Center finds a new DNS name for an IP address:

l If Scan Virtual Hosts is enabled, vulnerability data for the two DNS

names appears as two entries with the same IP address in the IP
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Parameter Description

Summary analysis tool.

l If Scan Virtual Hosts is disabled, vulnerability data for the two DNS

names merge into a single IP address entry in the IP Summary ana-

lysis tool.

Track hosts which

have been issued

new IP address

This option uses the DNS name, NetBIOS name, Agent ID, and MAC

address (if known), in that order, to track a host when its IP address

changes. Once Tenable Security Center finds a match, Tenable Security

Center does not search further for matches.

For example, if Tenable Security Center does not match a DNS name, but

it does match a NetBIOS name, the system does not check the MAC

address. Networks using DHCP require that you set this option to properly

track hosts.

Immediately

remove vul-

nerabilities from

scanned hosts

that do not reply

If a previously responsive host does not reply to a scan, Tenable Security

Center removes the host's vulnerabilit ies from the cumulative database. If

the host has vulnerabilit ies in the mitigated database, they remain in the

mitigated database.

l If you enable this option, the system removes the vulnerabilit ies

immediately after the scan completes.

l If you disable this option, the system removes the vulnerabilit ies

according to the interval set in the Number of days to wait before

removing dead hosts option.

Number of days

to wait before

removing dead

hosts

If you disable Immediately remove vulnerabilities from scanned hosts that

do not reply, this value specifies how many days the system waits to

remove vulnerabilit ies.

Max scan duration

(hours)

Specifies the maximum number of hours you want a scan to run.

If a scan reaches this threshold, Tenable Security Center automatically

creates a rollover scan that you can launch manually to complete the
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Parameter Description

scan. Tenable Security Center creates a rollover scan regardless of your

Scan Timeout Action sett ing.

Targets Options

The Targets section identif ies the devices Tenable Security Center scans.

Option Description

Target Type Specifies the target type for the scan:

l Assets —Scan one or more assets. For more information, see Assets.

l IP / DNS Name —Scan one or more IP addresses or DNS names.

l Mixed—Scan a combination of asset lists, IP addresses, and DNS

names.

Assets (Available if Target Type is Assets or Mixed) The list of assets to scan. Click

to select or deselect the assets you want to scan.

IPs /

DNS Names

(Available if Target Type is IP / DNS Name or Mixed) The IP addresses or DNS

names you want to scan.

Specify IP addresses and DNS names using the following valid formats:

l A single IPv4 address (for example, 192.0.2.202)

l A single IPv6 address (for example, 2001:d-

b8:d54e:cca6:4109:ac02:2fbe:134e)

l An IP address range in dot-decimal or CIDR notation (for example,

192.0.2.0-192.0.2.255 or 192.0.2.0/24)

l A resolvable hostname (for example, www.yourdomain.com)

Note: You cannot scan both IPv4 and IPv6 addresses in the same scan, because
you can only select one Import Repository.

Credentials Options
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The Credentials section allows users to select pre-configured credential sets for authenticated

scanning. For more information, see Credentials.

Tenable Security Center active scans support the following credential types:

l Windows Credentials

l SSH Credentials

l SNMP Credentials

l Database Credentials

l API Gateway Credentials

Post Scan Options

These options determine what actions occur immediately before and after the active scan com-

pletes.

Option Description

Reports to Run on Scan Completion

Add

Report

This option provides a list of reports available to the user to run when the scan

completes. For more information, see Add a Report to a Scan.
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Launch a Remediation Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can run a remediation scan to run a followup active scan against existing active scan results. A

remediation scan evaluates a specific plugin against a specific target or targets where the related

vulnerability was present in your earlier active scan.

Remediation scans allow you to validate whether your vulnerability remediation actions on the tar-

gets have been successful. If a remediation scan cannot identify a vulnerability on targets where it

was previously identif ied, the system changes the status of the vulnerability to mitigated. For more

information, see Cumulative vs. Mit igated Vulnerabilit ies.

Note the following:

l You can perform remediation scans only for active scan results.

l You cannot perform remediation scans for agent repository scan results.

l If the selected plugin requires dependent plugins, the system automatically includes those plu-

gins in the remediation scan.

l Remediation scans only evaluate plugins against the port you specify. Keep this in mind when

launching a remediation scan for a plugin that typically targets mult iple ports.

l Remediation scans work best for un-credentialed network scan results. Use caution when run-

ning a remediation scan for a plugin that requires scan credentials. If you neglect to add scan

credentials when required for a specific plugin, or if you mis-enter the credentials, the system

may identify the related vulnerabilit ies as mitigated, not because they are mitigated, but

because the system could not complete the credentialed scan.

To launch a remediation scan:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.
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3. In the analysis tools drop-down box, select Vulnerability Detail List, Vulnerability List, or Vul-

nerability Summary.

The page refreshes to show the analysis tool view you selected.

4. In the row for the vulnerability you want to launch a remediation scan, click the menu.

The actions menu appears.

5. Click Launch Remediation Scan.

The Launch Remediation Scan page appears.

Note: A remediation scan inherits certain sett ings from the vulnerability or vulnerability
instance you selected. The Launch Remediation Scan page:

l Automatically populates the relevant plugin information.

l Provides an editable scan name in the format "Remediation Scan of Plugin #
number".

l Populates the target IP address based on the asset where the previous scan iden-
tif ied the vulnerability.

6. Configure the sett ings for the scan, as described in Active Scan Settings.

Note: You do not need to associate the remediation scan with a scan policy.

Note: You cannot schedule a remediation scan. The scan launches as soon as you submit it .

7. Click Submit.

Tenable Security Center launches the remediation scan.
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Active Scan Objects

Complete Tenable Security Center scan configurations rely on the following scan objects. For

information about active scans, see Active Scans.

Scan Object Description

assets Assets are lists of devices (for example, laptops, servers, tablets, or phones)

within a Tenable Security Center organization. You can share assets with one

or more users based on local security policy requirements.

You can add an asset to group devices that share common attributes. Then,

you can use the asset during scan configuration to target the devices in the

asset.

For more information, see Assets.

credentials Credentials are reusable objects that facilitate a login to a scan target. You

can configure various types of credentials with different authentication meth-

ods for use within scan policies. You can also share credentials between

users for scanning purposes.

Tenable Security Center supports an unlimited number of SSH, Windows, and

database credentials, and four SNMP credential sets per scan configuration.

For more information, see Credentials.

audit files During a configuration audit, auditors verify that your server and device con-

figurations meet an established standard and that you maintain them with an

appropriate procedure. Tenable Security Center can perform configuration

audits on key assets by using local Tenable Nessus checks that can log dir-

ectly on to a Unix or Windows server without an agent.

Tenable Security Center supports several audit standards. Some of these

come from best practice centers like the PCI Security Standards Council and

the Center for Internet Security (CIS). Some of these are based on Tenable’s

interpretation of audit requirements to comply with specific industry stand-

ards such as PCI DSS or legislation such as Sarbanes-Oxley.

In addit ion to base audits, you can create customized audits for the par-

- 385 -



t icular requirements of any organization. You can upload customized audits

into Tenable Security Center and make them available to anyone performing

configuration audits within an organization.

You can upload and use NIST SCAP files in the same manner as an audit file.

Navigate to NIST’s SCAP website (http:/ / scap.nist.gov) and under the SCAP

Content section, download the desired SCAP security checklist zip file. You

can then upload the file to Tenable Security Center and select it for use in

Tenable Nessus scan jobs.

Once you configure audit scan policies in Tenable Security Center, you can

use them as needed. Tenable Security Center can also perform audits inten-

ded for specific assets. A Tenable Security Center user can use audit policies

and asset lists to determine the compliance posture of any specified asset.

For more information, see Audit Files.

scan zones Scan zones represent areas of your network that you want to target in an act-

ive scan, associating an IP address or range of IP addresses with one or more

scanners in your deployment. Scan zones define the IP address ranges asso-

ciated with the scanner along with organizational access.

For more information, see Scan Zones.

scan policies Scan policies contain options related to performing an active scan. For

example:

l Options that control technical aspects of the scan such as timeouts,

number of hosts, type of port scanner, and more.

l Options that provide plugin family-based or individual plugin-based

scan specifications.

l Options that control compliance policy checks (Windows, Linux, Data-

base, etc.), report verbosity, service detection scan sett ings, audit

files, patch management systems, and more.

For more information, see Scan Policies.
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Assets

Tenable Security Center assets are lists of devices (for example, laptops, servers, tablets, or

phones) within a Tenable Security Center organization. Assets can be shared with one or more

users based on local security policy requirements.

You can add an asset to group devices that share common attributes. Then, you can use the asset

during scan configuration to target the devices in the asset. Examples of common attributes

include:

l IP address ranges

l hardware types

l vulnerabilit ies

l outdated software versions

l operating systems

Tenable Security Center supports template-based and custom assets. For more information, see

Add a Template-Based Asset and Add a Custom Asset. To view details for any of your assets, see

View Asset Details.

To view details about individual hosts that appear in your assets, see View Hosts and View Host

Details.

Template-Based Assets

Tenable provides asset templates that you can customize for your environment. Tenable-provided

asset templates are updated via the Tenable Security Center feed and visible depending on other

configurations.

Custom Assets

Tenable Security Center supports the following custom assets types: Static Assets, DNS Name List

Assets, LDAP Query Assets, Combination Assets, Dynamic Assets, Watchlist Assets, and Import

Assets.

Static Assets
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Static assets are lists of IP addresses. You can use static assets immediately after configuration.

For example, if your organization assigns laptops within a defined IP address range, you can create

a custom static asset for laptops using that IP address range.

Option Description

Name A name for the asset.

Description A description for the asset.

Tag A tag for the asset. For more information, see Tags.

IP Addresses IP addresses to include within the asset (20,000 character limit).

l Type a comma-separated list of IP addresses, CIDR addresses, or

ranges.

l Upload a .txt f ile containing a comma-separated list of

IP addressees, CIDR addresses, or ranges.

DNS Name List Assets

Option Description

Name A name for the asset.

Description A description for the asset.

DNS Names The DNS hostnames for the asset to be based on.

LDAP Query Assets

The LDAP query asset type appears if your organization includes a configured LDAP server.

Option Description

Name A name for the asset.

Description A description for the asset.

LDAP Server The LDAP server where you want to perform the query.
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Option Description

Note: If the LDAP server uses a different DNS server than Tenable Security
Center, Tenable Security Center cannot resolve hostnames retrieved from the
LDAP server.

Note: Tenable Security Center cannot retrieve more than one page of LDAP res-
ults. If Tenable Security Center asset or user authentication queries are not
retrieving all expected results, consider modifying your LDAP pagination control
sett ings to increase the results per page.

Search Base The LDAP search base used as the start ing point to search for specific

LDAP data.

Search String Modify this string to create a search based on a location or filter other than

the default search base or attribute.

Generate Pre-

view

Click to display a preview query in the Results Preview section. The preview

lists the LDAP data that matches the defined search string.

Combination Assets

Combination assets allow you to create an asset based on existing assets and the AND, OR, and

NOT operators.

Combination assets can include agent IDs if the asset contains exclusively dynamic assets. You may

experience unexpected asset behavior if your combination asset contains other asset types and

interacts with agent repository data.

Option Description

Name A name for the asset.

Description A description for the asset.

Combination This option accepts mult iple existing assets utilizing the operators AND,

OR, and NOT. You can use these operators and multiple existing assets to

create new unique assets. If the source assets change, the Combination

asset updates to match the new condit ions.
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Option Description

To configure the query:

1. Click inside the Combination box.

A list of assets appears.

2. Click one of the options in the list to select it .

3. Press Space.

4. Continue selecting options and pressing space to describe the com-

bination asset you want to configure.

Tip: A red border around a combination option indicates there is a problem in
the query logic.

Dynamic Assets

Dynamic assets are flexible groups of condit ion statements that Tenable Security Center uses to

retrieve a list of devices meeting the condit ions. Tenable Security Center refreshes dynamic asset

lists using the results from Tenable Security Center scans. You cannot use dynamic assets until

after Tenable Security Center performs an init ial discovery scan and retrieves a list of devices.

Dynamic assets can include agent IDs.
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For example, in the asset above, Tenable Security Center retrieves a list of Linux systems listening

on TCP Port 80. For more information about using dynamic asset condit ions, see Dynamic Assets.

Option Description

Name A name for the asset.

Description A description for the asset.

Asset Defin-

ition

Defines the rules for creating a dynamic asset list. Hover over an existing

rule to display the options to add, edit, or delete a group or a rule.

Dynamic Asset Rule Logic

Valid Operators Effect

Plugin ID

is equal to Value must be equal to value specified.
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Valid Operators Effect

not equal to Value must be not equal to value specified.

is less than Value must be less than the value specified.

is greater than Value must be greater than the value specified.

Plugin Text

is equal to Value must be equal to value specified.

not equal to Value must be not equal to value specified.

contains the pat-

tern

Value must contain the text specified (for example, ABCDEF contains ABC).

Posix regex Any valid Posix regex pattern contained within “/ ” and “/ ” (example:

/ .*ABC.*/ ).

Perl compatible

regex

Any valid Perl compatible regex pattern.

Operating System

is equal to Value must be equal to value specified.

not equal to Value must be not equal to value specified.

contains the pat-

tern

Value must contain the text specified (for example, ABCDEF contains ABC).

Posix regex Any valid Posix regex pattern contained within “/ ” and “/ ” (for example,

/ .*ABC.*/ ).

Perl compatible

regex

Any valid Perl compatible regex pattern.

IP Address

is equal to Value must be equal to value specified.

not equal to Value must be not equal to value specified.
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Valid Operators Effect

DNS, NetBIOS Host, NetBIOS Workgroup, MAC, SSH v1Fingerprint, SSH v2 Fingerprint

is equal to Value must be equal to value specified.

not equal to Value must be not equal to value specified.

contains the pat-

tern

Value must contain the text specified (for example, 1.2.3.124 contains 124).

Posix regex Any valid Posix regex pattern contained within “/ ” and “/ ” (for example,

/ .*ABC.*/ ).

Perl compatible

regex

Any valid Perl compatible regex pattern.

Port, TCP Port, UDP Port

is equal to Value must be equal to value specified.

not equal to Value must be not equal to value specified.

is less than Value is less than value specified.

is greater than Value is greater than the value specified.

Days Since Discovery, Days Since Observation

is equal to Value must be equal to value specified (maximum 365).

not equal to Value must be not equal to value specified (maximum 365).

is less than Value is less than value specified (maximum 365).

is greater than Value is greater than the value specified (maximum 365).

where Plugin ID

is

Any valid plugin ID number. You can enter mult iple plugin IDs using a range

or comma-separated plugin IDs (for example, 3, 10189, 34598, 50000-

55000, 800001-800055).

Severity

is equal to Value must be equal to value specified: Info, Low, Medium, High, or Critical.
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Valid Operators Effect

not equal to Value must be not equal to value specified: Info, Low, Medium, High, or Crit-

ical.

is less than Value must be less than the value specified: Info, Low, Medium, High, or

Critical.

is greater than Value must be greater than the value specified: Info, Low, Medium, High, or

Critical.

where Plugin ID

is

Any valid plugin ID number. You can enter mult iple plugin IDs using a range

or comma-separated plugin IDs (for example, 3, 10189, 34598, 50000-

55000, 800001-800055).

Exploit Available

Is Click True or False in the drop-down box.

Exploit Frameworks

is equal to Value must be equal to value specified.

Is not equal to Value must not be equal to value specified.

contains the pat-

tern

Value must contain the pattern entered.

XRef

Value must be in the XRef option.

Watchlist Assets

You can use a watchlist asset to maintain lists of IPs that are not in the user’s managed range of IP

addresses. You can filter for IPs from a watchlist regardless of your IP address range configuration

to help analyze event activity originating outside of the user’s managed range. For example, if a

block of IP addresses is a known source of malicious activity, you could add it to a Malicious IPs

watchlist and added to a custom query.

Note: Watchlists only uses event data to create the asset list.
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Option Description

Name A name for the asset.

Description A description for the asset.

IP Addresses IP addresses to include within the asset list (20,000 character limit). You

can enter one address, CIDR address, or range per line.

Click Choose File to import a list of IP addresses from a saved file.

Import Assets

Option Description

Name The asset name.

Asset Click Choose File to choose the asset that was previously exported for import into

Tenable Security Center.
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Add a Template-Based Asset

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For information, see Assets.

To add an asset from a Tenable-provided template:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Assets > Assets.

The Assets page appears.

3. Click Add.

The Asset Templates page appears.

4. (Optional) If you want to search for a specific asset template, type a search phrase in the

Search Templates box.

5. In the Common section, click a template type.

The Add Asset Template page for the template type appears.

6. View the available templates.

l The four square icon ( ) on the left side indicates a collection of several assets.

l The data icons ( ) on the right side indicate the data required to build the

asset. The Tenable Nessus Network Monitor (PVS), Log Correlation Engine, and NS icons

indicate you must have Tenable Nessus Network Monitor, Log Correlation Engine, or Ten-
able Nessus data. The key icon ( ) indicates you must have credentials for the device.

The notepad icon ( ) indicates you must have compliance data.

7. (Optional) If you want to search for a specific asset template, type a search phrase in the

Search Templates box or select a category from the All drop-down box.

8. Click the row for the template you want to use.

The detail page for the template type appears.
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9. Click Add.

The Assets page appears.

10. Click the row for the asset you just added.

The Edit page appears.

11. View the details for the asset.

12. (Optional) If necessary, edit the asset to customize it for your environment. For more inform-

ation about asset options, see Assets.

13. Click Submit.

Tenable Security Center saves your configuration.
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Add a Custom Asset

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For information, see Assets.

To add a custom asset:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Assets > Assets.

The Assets page appears.

3. Click Add.

The Asset Templates page appears.

4. In the Other section, click an asset type.

The Add Assets page for the asset type appears.

5. Configure the required options for the asset type, as described in Assets.

6. Click Submit.

Tenable Security Center saves your configuration.
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View Asset Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can view details for any asset. For more information, see Assets.

To view asset details:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Assets > Assets.

The Assets page appears.

3. In the row for the asset you want to view, click the menu.

The actions menu appears.

4. Click View.

The View Asset page appears.

Section Action

General View general information for the asset.

l Name —The asset name.

l Description —The asset description.

l Tag —The tag applied to the asset. For more information,

see Tags.

l IP Addresses (static assets only) —The IP addresses spe-

cified in the asset. For more information, see Assets.

l Created —The date the asset was created.

l Last Modified —The date the asset was last modified.

l Owner —The username for the user who created the asset.

l Group —The group in which the asset belongs.
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Section Action

l ID —The asset ID.

Tenable.io Syn-

chronization Data

View synchronization summary data:

l Status —The status of the asset in Tenable Lumin syn-

chronization:

l Finished —The most recent synchronization that

included this asset succeeded.

l Not Synced —The asset is not configured for Tenable

Lumin synchronization.

l Error —An error occurred. For more information, see

View Tenable Lumin Data Synchronization Logs.

l First Synchronization —The date and time of the first syn-

chronization of this asset.

l Last Success —The date and time of the most recent syn-

chronization of this asset.

l Last Failure —The date and time of the most recent failed

synchronization of this asset.

l Details —If the Status is Error, details about the error.

For more information about Tenable Lumin synchronization, see

Tenable Lumin Synchronization.
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View Hosts

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can view a list of hosts associated with asset lists. For more information, see Assets.

To view details for an individual host, see View Host Details.

To view the list of hosts:

1. Log in to Tenable Security Center via the user interface.

2. Click Assets > Host Assets.

The Host Assets page appears.

3. (Optional) To show or hide columns on the Host Assets page:

a. In the top right corner, click Options.

The options menu appears.

b. Click Choose Columns.

The list of display columns appears.

c. Check or uncheck the boxes to show or hide columns.

d. Click Submit.

The page updates to show the columns you selected.

4. View details about each host asset.

l Name —The name of the host.

l ACR—(Requires Tenable Security Center+ license) The host's Asset Crit icality Rating. For

more information, see Asset Crit icality Rating in the Tenable Vulnerability

Management User Guide.

l IP Address —The host's IP address, if available.

l Repository —The repository that contains vulnerability data associated with the host.
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l OS —The operating system running on the host, if available.

l System Type —The host's device type, as determined by plugin 54615.

l Net BIOS —The host's NetBIOS name, if available.

l DNS —The host's DNS name, if available.

l Last Seen —The date and time last Tenable Security Center detected the host on your

network.

l Asset ID —The ID of the host.

l Source —The type of scan that discovered the host on your network: Tenable Nessus

Scan, Tenable Nessus Network Monitor, Log Correlation Engine, or Agent Scan.

Tip: The following columns are hidden by default: System Type, Net BIOS, DNS, and Asset ID.
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Credentials

Credentials are reusable objects that facilitate scan target login.

Administrators can add credentials available to all organizations. Organizational users can add cre-

dentials available to other users in the same organization. For information about user access in Ten-

able Security Center, see User Access.

Users can share credentials with other users, allowing them to scan remote hosts without knowing

the credentials of the host. For information about Tenable Security Center credential data encryp-

t ion, see Encryption Strength.

Tenable Security Center supports the following credential types:

l API Gateway Credentials

l Database Credentials

l SNMP Credentials

l SSH Credentials

l Windows Credentials

If a scan contains mult iple instances of one type of credential, Tenable Security Center tries the cre-

dentials on each scan target in the order you added the credentials to Tenable Security Center.

Note: Tenable Security Center uses the first credential that allows successful login to perform cre-
dentialed checks on the target. After a credential allows a successful login, Tenable Security Center does
not try any of the other credentials in the list, even if a different credential has greater privileges.

To add credentials, see Add Credentials.
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Add Credentials

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information about credentials, see Credentials.

Note: You can add up to 1000 SSH credentials in a single scan. For best performance, Tenable recom-
mends adding no more than 10 SSH credentials per scan.

To add credentials:

1. Log in to Tenable Security Center.

2. Click Scanning > Credentials (administrator users) or Scans > Credentials (organizational

users).

The Credentials page appears.

3. Click Add.

The Credential Templates page appears.

4. In the API Gateway, Database, SNMP, SSH, or Windows sections, click the tile for the specific

method you want to configure.

The Add Credentials configuration page appears.

5. In the Name box, type a name for the credentials.

6. In the Description box, type a description for the credentials.

7. (Optional) Type or select a Tag. For more information, see Tags.

8. Configure the options, as described in:

l API Gateway Credentials

l Database Credentials

l SNMP Credentials
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l SSH Credentials

l Windows Credentials

9. Click Submit.

Tenable Security Center saves your configuration.
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API Gateway Credentials

Configure the following options for all API gateway credentials.

Option Description

Name (Required) A name for the credential.

Description A description for the credential.

Tag A tag for the credential. For more information, see Tags.

IBMDataPower Options

The following table describes the addit ional options to configure for IBM DataPower credentials.

Option Description

Client Cer-

tificate

The file that contains the PEMcertif icate used to communicate with the IBM

DataPower host.

Client Cer-

tificate Private

Key

The file that contains the PEMprivate key for the client cert if icate.

Client Cer-

tificate Private

Key Pass-

phrase

The passphrase for the private key, if required.

Custom

Header Key

If your IBM DataPower configuration uses custom HTTP headers, the custom

HTTP header key.

Custom

Header Value

If your IBM DataPower configuration uses custom HTTP headers, the custom

HTTP header value.

Enable for

Hashicorp

Vault

When enabled, allows Tenable Security Center to use the IBM DataPower cre-

dential with a Hashicorp Vault credential.

Tip: If you want to run a test that does not use IBM DataPower credentials
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Option Description

without having to delete the credential, you can temporarily disable this option to
prevent Tenable Security Center from using IBM DataPower credentials.
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Database Credentials

The following topic describes the available Database credentials.

Note: Aspects of credential options are based on Nessus plugin options. Therefore, specific credential
options may differ from the descriptions documented here.

Configure the following options for all database credentials:

Options Description

Name (Required) A name for the credential.

Description A description for the credential.

Tag A tag for the credential. For more information, see Tags.

- 408 -

https://docs.tenable.com/security-center/Content/Tags.htm


IBMDB2

The following table describes the addit ional options to configure for IBM DB2 credentials.

Options Description

Source The method for providing the required credential details: Entry or

Import.

l Entry —Specifies you want to use a single SID value or

SERVICE_NAME value for the credential. You must also con-

figure the remaining options on the Add Credential page, as

described in Add Credentials.

l Import —Specifies you want to use mult iple SID values for

the credential, uploaded as a .csv f ile. For more inform-

ation about the required .csv f ile format, see Database Cre-

dentials Authentication.

Authentication Method The authentication method for providing the required cre-

dentials.

l CyberArk

l Password

l Lieberman

l Hashicorp Vault

For descriptions of the options for your selected authentication

type, see Database Credentials Authentication.

Port The TCP port that the IBM DB2 database instance listens on for

communications from Tenable Security Center. The default is

port 50000.

Database Name The name for your database (not the name of your instance).
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Informix/DRDA

The following table describes the addit ional options to configure for Informix/DRDA credentials.

Options Description

Username The username for a user on the database.

Password The password associated with the username you provided.

Port The TCP port that the Informix/DRDA database instance listens on for com-

munications from Tenable Security Center. The default is port 1526.
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MySQL

The following table describes the addit ional options to configure for MySQL credentials.

Options Description

Source The method for providing the required credential details: Entry or

Import.

l Entry —Specifies you want to use a single SID value or

SERVICE_NAME value for the credential. You must also con-

figure the remaining options on the Add Credential page, as

described in Add Credentials.

l Import —Specifies you want to use mult iple SID values for

the credential, uploaded as a .csv f ile. For more inform-

ation about the required .csv f ile format, see Database Cre-

dentials Authentication.

Authentication Method The authentication method for providing the required cre-

dentials.

l CyberArk

l Password

l Lieberman

l Hashicorp Vault

For descriptions of the options for your selected authentication

type, see Database Credentials Authentication.

Username The username for a user on the database.

Password The password associated with the username you provided.

Port The TCP port that the MySQL database instance listens on for

communications from Tenable Security Center. The default is

port 3306.

SID The name for your database instance.
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Oracle Database

The following table describes the addit ional options to configure for Oracle Database credentials.

Options Description

Source The method for providing the required credential details: Entry or

Import.

l Entry —Specifies you want to use a single SID value or

SERVICE_NAME value for the credential. You must also con-

figure the remaining options on the Add Credential page, as

described in Add Credentials.

l Import —Specifies you want to use mult iple SID values for

the credential, uploaded as a .csv f ile. For more inform-

ation about the required .csv f ile format, see Database Cre-

dentials Authentication.

Authentication Method The authentication method for providing the required cre-

dentials.

l CyberArk

l Password

l Lieberman

l Hashicorp Vault

For descriptions of the options for your selected authentication

type, see Database Credentials Authentication.

Port The TCP port that the Oracle database instance listens on for

communications from Tenable Security Center. The default is

port 1521.

Authentication The type of account you want Tenable Security Center to use to

access the database instance: 

l Normal
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Options Description

l System Operator

l System Database Administrator

Service Type The Oracle parameter you want to use to specify the database

instance: SID or Service Name.

Service The SID value or SERVICE_NAME value for your database

instance.

The Service value you enter must match your parameter selec-

t ion for the Service Type option.

- 413 -



PostgreSQL

The following table describes the addit ional options to configure for PostgreSQL credentials.

Options Description

Authentication Method The authentication method for providing the required cre-

dentials.

l CyberArk

l Password

l Lieberman

l Hashicorp Vault

For descriptions of the options for your selected authentication

type, see Database Credentials Authentication.

Port The TCP port that the PostgreSQL database instance listens on

for communications from Tenable Security Center. The default is

port 5432.

Database Name The name for your database instance.
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SQL Server

The following table describes the addit ional options to configure for SQL Server credentials.

Options Description

Source The method for providing the required credential details: Entry or

Import.

l Entry —Specifies you want to use a single SID value or

SERVICE_NAME value for the credential. You must also con-

figure the remaining options on the Add Credential page, as

described in Add Credentials.

l Import —Specifies you want to use mult iple SID values for

the credential, uploaded as a .csv f ile. For more inform-

ation about the required .csv f ile format, see Database Cre-

dentials Authentication.

Authentication Method The authentication method for providing the required cre-

dentials.

l CyberArk

l Password

l Lieberman

l Hashicorp Vault

For descriptions of the options for your selected authentication

type, see Database Credentials Authentication.

Username The username for a user on the database.

Password The password associated with the username you provided.

Port The TCP port that the SQL Server database instance listens on

for communications from Tenable Security Center. The default is

port 1433.

Authentication The type of account you want Tenable Security Center to use to
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Options Description

access the database instance: SQL or Windows.

Instance Name The name for your database instance.

Sybase ASE

The following table describes the addit ional options to configure for Sybase ASE credentials.

Options Description

Authentication Method The authentication method for providing the required cre-

dentials.

l CyberArk

l Password

l Lieberman

l Hashicorp Vault

For descriptions of the options for your selected authentication

type, see Database Credentials Authentication.

Port The TCP port that the Sybase ASE database instance listens on

for communications from Tenable Security Center. The default is

port 3638.

Sybase ASE Auth Type The type of authentication used by the Sybase ASE

database: RSA or Plain Text.

Apache Cassandra

Option Description

Authentication Method The authentication method for providing the required cre-

dentials.
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Option Description

l CyberArk

l Password

l Lieberman

l Hashicorp Vault

For descriptions of the options for your selected authentication

type, see Database Credentials Authentication.

Database Port The port the database listens on. The default is port 9042.

MongoDB

Option Description

Username The username for the database.

Password The password for the supplied username.

Database The name of the database to authenticate to.

Tip: To authenticate via LDAP or saslauthd, type $external.

Port (Required) The TCP port that the MongoDB database instance listens on for

communications from Tenable Security Center.

- 417 -



Database Credentials Authentication Method Settings

Depending on the authentication type you select for your database credentials, you must configure

the following options. For more information about database credential sett ings, see Database Cre-

dentials.

l Import

l CyberArk Vault Options

l Password Options

l Lieberman Options

l Hashicorp Vault Options

Import

Upload a .csv f ile with the credentials entered in the specified format. For descriptions of valid val-

ues to use for each item, see Database Credentials.

You must configure either CyberArk or HashiCorp credentials for a database credential in the same

scan so that Tenable Security Center can retrieve the credentials.

Database Credential CSV Format

IBMDB2 target, port, database_name, username, cred_manager,
accountname_or_secretname

MySQL target, port, database_name, username, cred_manager,
accountname_or_secretname

Oracle target, port, service_type, service_ID, username,
auth_type, cred_manager, accountname_or_secretname

SQL Server target, port, instance_name, username, auth_type,
cred_manager, accountname_or_secretname

Note: Include the required data in the specified order, with commas between each value, without spaces.
For example, for Oracle with CyberArk: 192.0.2.255,1521,SID,service_id,username,SYSDBA,Cy-
berArk,Database-Oracle-SYS.
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Note: The value for cred_manager must be either CyberArk or HashiCorp.

CyberArk Vault Options

The following table describes the addit ional options to configure when using CyberArk as the

Authentication Method for IBMDB2, SQL Server, MySQL, Oracle Database, or PostgreSQL database

credentials.

Note: You must be running Tenable Nessus 7.0.0 or later to configure CyberArk credentials.

Option
Database

Types
Description

Username All The username for the target system.

Port All The port the database is listening on.

Service Type Oracle Data-

base

The Oracle parameter you want to use to identify the data-

base instance: SID or Service Name.

Service Oracle Data-

base

The SID value for your database instance or a SERVICE_

NAME value.

The Service value you enter must match your parameter

selection for the Service Type option.

Database

Name

IBM D2

Postgre SQL

The name for your database instance.

Central Cre-

dential Pro-

vider URL Host

All The IP/DNS address of the CyberArk Central Credential Pro-

vider.

Central Cre-

dential Pro-

vider URL Port

All The port the CyberArk Central Credential Provider is listen-

ing on.

Vault User-

name

All The username for the vault, if the CyberArk Central Cre-

dential Provider is configured for basic authentication.
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Option
Database

Types
Description

Vault Password All The password for the vault, if the CyberArk Central Cre-

dential Provider is configured for basic authentication.

Safe All The safe on the CyberArk Central Credential Provider server

that contains the credentials you want to retrieve.

CyberArk Client

Certificate

All The file that contains the PEMcertif icate used to com-

municate with the CyberArk host.

CyberArk Client

Certificate Priv-

ate Key

All The file that contains the PEMprivate key for the client cer-

t if icate.

CyberArk Client

Certificate Priv-

ate Key Pass-

phrase

All The passphrase for the private key, if required.

AppID All The AppID with CyberArk Central Credential Provider per-

missions to retrieve the target password.

Folder All The folder on the CyberArk Central Credential Provider

server that contains the credentials you want to retrieve.

PolicyID All The PolicyID assigned to the credentials you want to

retrieve from the CyberArk Central Credential Provider.

Vault Use SSL All When enabled, Tenable Security Center uses SSL through

IIS for secure communications. You must configure SSL

through IIS in CyberArk Central Credential Provider before

enabling this option.

Vault Verify

SSL

All When enabled, Tenable Security Center validates the SSL

certif icate. You must configure SSL through IIS in CyberArk

Central Credential Provider before enabling this option.

For more information about using self-signed certif icates,
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Option
Database

Types
Description

see the Nessus custom_CA.inc documentation.

CyberArk AIM

Service URL

All The URL for the CyberArk AIM web service. By default, Ten-

able Security Center uses /AIMWebservice/v1.1/AIM.asmx.

Password Options

The following table describes the addit ional options to configure when using Password as the

Authentication Method for database credentials.

Option
Database

Types
Description

Username All The username for a user on the database.

Password All The password associated with the username you

provided.

Port All The port the database is listening on.

Database Name IBM D2

PostgreSQL

The name for your database instance.

Authentication Oracle Data-

base

SQL Server

The type of account you want Tenable Security Center

to use to access the database instance.

Service Type Oracle Data-

base

The Oracle parameter you want to use to identify the

database instance: SID or Service Name.

Service Oracle Data-

base

The SID value for your database instance or a

SERVICE_NAME value.

The Service value you enter must match your para-

meter selection for the Service Type option.

Instance Name SQL Server The name for your database instance.
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Lieberman Options

The following table describes the addit ional options to configure when using Lieberman as the

Authentication Method for IBMDB2, SQL Server, MySQL, Oracle Database, or PostgreSQL database

credentials.

Note: You must meet the version requirements specified in Tenable Integrated Product Compatibility.

Option
Database

Types
Description

Username All The username for a user on the database.

Port All The port the database is listening on.

Database Name IBM DB2

PostgreSQL

The name for your database instance.

Authentication Oracle Data-

base

SQL Server

The type of account you want Tenable Security

Center to use to access the database instance.

Service Type Oracle Data-

base

The Oracle parameter you want to use to identify the

database instance: SID or Service Name.

Service Oracle Data-

base

The SID value for your database instance or a

SERVICE_NAME value.

The Service value you enter must match your para-

meter selection for the Service Type option.

Instance Name SQL Server The name for your database instance.

Lieberman Host All The Lieberman IP address or DNS address.

Lieberman Port All The port Lieberman is listening on.

Lieberman User All The username for the Lieberman explicit user you

want Tenable Security Center to use for authen-

- 422 -



Option
Database

Types
Description

t ication to the Lieberman Rapid Enterprise Defense

(RED) API.

Lieberman Pass-

word

All The password for the Lieberman explicit user.

Use SSL All When enabled, Tenable Security Center uses SSL

through IIS for secure communications. You must con-

figure SSL through IIS in Lieberman before enabling

this option.

Verify

SSL Certificate

All When enabled, Tenable Security Center validates the

SSL certif icate. You must configure SSL through IIS

in Lieberman before enabling this option.

System Name All The name for the database credentials in Lieberman.

Hashicorp Vault Options

The following table describes the addit ional options to configure when using Hashicorp Vault as the

Authentication Method for IBMDB2, SQL Server, MySQL, Oracle Database, or PostgreSQL database

credentials.

Option Credential Description Required

Port Oracle Database

IBMDB2

MySQL

PostgreSQL

SQL Server

The port on which Tenable Security

Center communicates with the

database.

yes

SID MySQL The security identif ier used to con-

nect to the database.

yes
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Database Name IBMDB2

PostgreSQL

The name of the database. no

Instance Name SQL Server The SQL server name. yes

Hashicorp Host All The Hashicorp Vault IP address or

DNS address.

Note: If your Hashicorp Vault
installat ion is in a subdirectory, you
must include the subdirectory
path. For example, type IP
address or hostname/sub-
directory path.

yes

Hashicorp Port All The port on which Hashicorp Vault

listens.

yes

Service Type Oracle Database The unique SID or Service Name

that identif ies your database.

yes

Service Oracle Database The SID or Service Name value for

your database instance.

Note: The Service value must
match the Service Type option
parameter selection.

yes

Authentication

Type

All Specifies the authentication type

for connecting to the instance: App

Role or Certificates.

yes

Client Cert All If Authentication Type is Cer-

tificates, the client cert if icate file

you want to use to authenticate

the connection.

yes

Private Key All If Authentication Type is Cer-

tificates, the private key file asso-

yes
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ciated with the client cert if icate

you want to use to authenticate

the connection.

Role ID All The GUID provided by Hashicorp

Vault when you configured your

App Role.

yes

Role Secret ID All The GUID generated by Hashicorp

Vault when you configured your

App Role.

yes

Authentication URL All The path/subdirectory to the

authentication endpoint. This is

not the full URL. For example:

/v1/auth/approle/login

yes

Namespace All The name of a specified team in a

mult i-team environment.

no

Hashicorp Vault

Type

All The type of Hashicorp Vault

secrets engine: 

l KV1—Key/Value Secrets

Engine Version 1

l KV2 —Key/Value Secrets

Engine Version 2

l AD —Active Directory

yes

KV Engine URL All The URL Tenable Security Center

uses to access the Hashicorp Vault

secrets engine.

Example: /v1/path_to_secret.

No trailing /

yes

Username Source All (Only displays if Hashicorp Vault

Type is KV1or KV2) Specifies if the

yes
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username is input manually or

pulled from Hashicorp Vault.

Username key All (Only displays if Hashicorp Vault

Type is KV1or KV2) The name in

Hashicorp Vault that usernames

are stored under.

no

Username All (Only displays if Username Source

is Manual Entry) The name in

Hashicorp Vault that usernames

are stored under.

yes

Password key All (Only displays if Hashicorp Vault

Type is KV1or KV2) The key in

Hashicorp Vault that passwords are

stored under.

no

Secret Name All The key secret you want to retrieve

values for.

yes

Use SSL All When enabled, Tenable Security

Center uses SSL for secure com-

munications. You must configure

SSL in Hashicorp Vault before

enabling this option.

no

Verify SSL All When enabled, Tenable Security

Center validates the SSL cer-

t if icate. You must configure SSL in

Hashicorp Vault before enabling

this option.

no
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SNMP Credentials

Configure the following options for SNMP credentials. Tenable Security Center supports SNMPv1for

authentication via a community string.

Options Description

Name (Required) A name for the credential.

Description A description for the credential.

Tag A tag for the credential. For more information, see Tags.

Community The SNMP community string used for authentication.
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SSH Credentials

Use SSH credentials for host-based checks on Unix systems and supported network devices. Ten-

able Security Center uses these credentials to obtain local information from remote Unix systems

for patch audit ing or compliance checks. Tenable Security Center uses Secure Shell (SSH) protocol

version 2 based programs (e.g., OpenSSH, Solaris SSH, etc.) for host-based checks.

Tenable Security Center encrypts the data using the AES-256-CBC algorithm to protect it from

being viewed by sniffer programs.

Note: Non-privileged users with local access on Linux systems can determine basic security issues, such
as patch levels or entries in the /etc/passwd f ile. For more comprehensive information, such as system
configuration data or file permissions across the entire system, an account with root privileges is required.

Note: You can add up to 1000 SSH credentials in a single scan. For best performance, Tenable recom-
mends adding no more than 10 SSH credentials per scan.

Configure the following options for SSH credentials, including options specific for your authen-

tication method: Arcon Options, Centrify Options, Certif icate Options, CyberArk Vault (Legacy)

Options, CyberArk Vault Options, Hashicorp Vault Options, Kerberos Options, Password Options,

Public Key Options, Thycotic Secret Server Options, BeyondTrust Options, and Lieberman Options.

General Option Description

Name (Required) A name for the credential.

Description A description for the credential.

Tag A tag for the credential. For more information, see Tags.

Arcon Options

The following table describes the addit ional options to configure when using Arcon as the authen-

tication method for SSH credentials.

Option Description

Arcon Host (Required) The Arcon IP address or DNS address.
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Note: If your Arcon installat ion is in a subdirectory, you must
include the subdirectory path. For example, type IP address or
hostname/subdirectory path.

Arcon Port (Required) The port on which Arcon listens. By default, Ten-

able Security Center uses port 444.

API User (Required) The API user provided by Arcon.

API Key (Required) The API key provided by Arcon.

Authentication URL (Required) The URL Tenable Security Center uses to access

Arcon.

Password Engine URL (Required) The URL Tenable Security Center uses to access

the passwords in Arcon.

Username (Required) The username to log in to the hosts you want to

scan.

Checkout Duration (Required) The length of t ime, in minutes, that you want to

keep credentials checked out in Arcon. Configure the Check-

out Duration to exceed the typical duration of your Tenable

Security Center scans. If a password from a previous scan is

still checked out when a new scan begins, the new scan

fails.

Tip: Configure the password change interval in Arcon so that
password changes do not disrupt your Tenable Security Center
scans. If Arcon changes a password during a scan, the scan
fails.

Use SSL When enabled, Tenable Security Center uses SSL through IIS

for secure communications. You must configure SSL

through IIS in Arcon before enabling this option.

Verify SSL Certificate When enabled, Tenable Security Center validates the SSL

certif icate. You must configure SSL through IIS in Arcon

before enabling this option.
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Privilege Escalation The privilege escalation method you want to use to increase

users' privileges after init ial authentication. Your Privilege

Escalation selection determines the specific options you

must configure. For more information, see Privilege Escal-

ation.

Centrify Options

The following table describes the addit ional options to configure when using Centrify as the authen-

tication method for SSH credentials.

Option Description

Centrify Host (Required) The Centrify IP address or DNS address.

Note: If your Centrify installat ion is in a subdirectory, you must
include the subdirectory path. For example, type IP address or
hostname/subdirectory path.

Centrify Port (Required) The port on which Centrify listens. By default, Ten-

able Security Center uses port 443.

API User (Required) The API user provided by Centrify.

API Key (Required) The API key provided by Centrify.

Tenant (Required) The Centrify tenant associated with the API. By

default, Tenable Security Center uses centrify.

Authentication URL (Required) The URL Tenable Security Center uses to access

Centrify. By default, Tenable Security Center uses /Security.

Password Query URL (Required) The URL Tenable Security Center uses to query

the passwords in Centrify. By default, Tenable Security

Center uses /RedRock.

Password Engine URL (Required) The URL Tenable Security Center uses to access

the passwords in Centrify. By default, Tenable Security

Center uses /ServerManage.
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Username (Required) The username to log in to the hosts you want to

scan.

Checkout Duration (Required) The length of t ime, in minutes, that you want to

keep credentials checked out in Centrify.

Configure the Checkout Duration to exceed the typical dur-

ation of your Tenable Security Center scans so that pass-

word changes do not disrupt your Tenable Security Center

scans. If Centrify changes a password during a scan, the

scan fails. If a password from a previous scan is still

checked out when a new scan begins, the new scan fails.

Use SSL When enabled, Tenable Security Center uses SSL through IIS

for secure communications. You must configure SSL

through IIS in Centrify before enabling this option.

Verify SSL Certificate When enabled, Tenable Security Center validates the SSL

certif icate. You must configure SSL through IIS in Centrify

before enabling this option.

Certif icate Options

The following table describes the addit ional options to configure when using Certificate as the

authentication method for SSH credentials.

Option Description

Username (Required) The username for a user on the host system.

User Cer-

tificate

(Required) The RSA or DSA OpenSSH certif icate file for the user.

Private Key (Required) The RSA or DSA OpenSSH private key file for the user.

Passphrase The passphrase for the private key, if required.

Privilege Escal-

ation

The privilege escalation method you want to use to increase users' privileges

after init ial authentication. Your Privilege Escalation selection determines
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Option Description

the specific options you must configure. For more information, see Privilege

Escalation.

CyberArk Vault (Legacy) Options

The following table describes the addit ional options to configure when using CyberArk Vault

(Legacy) as the authentication method for SSH credentials.

Option Description

Username (Required) The username for the target system.

CyberArk elev-

ate privileges

with

The privilege escalation method you want to use to increase users' privileges

after init ial authentication. Your CyberArk elevate privileges with selection

determines the specific options you must configure. For more information,

see Privilege Escalation.

Central Cre-

dential Pro-

vider URL Host

(Required) The CyberArk Central Credential Provider IP/DNS address.

Central Cre-

dential Pro-

vider URL Port

(Required) The port the CyberArk Central Credential Provider is listening on.

CyberArk

Address

The domain for the CyberArk account. You must configure SSL through IIS in

CyberArk Central Credential Provider before configuring this option.

Vault User-

name

The username for the vault, if the CyberArk Central Credential Provider is

configured for basic authentication.

Vault Pass-

word

The password for the vault, if the CyberArk Central Credential Provider is

configured for basic authentication.

Safe (Required) The safe on the CyberArk Central Credential Provider server that

contains the credentials you want to retrieve.

CyberArk Cli- The file that contains the PEMcertif icate used to communicate with the
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Option Description

ent Certificate CyberArk host.

CyberArk Cli-

ent Certificate

Private Key

The file that contains the PEMprivate key for the client cert if icate.

CyberArk Cli-

ent Certificate

Private Key

Passphrase

The passphrase for the private key, if required.

AppID (Required) The AppID with CyberArk Central Credential Provider permissions

to retrieve the target password.

Folder (Required) The folder on the CyberArk Central Credential Provider server that

contains the credentials you want to retrieve.

PolicyID The PolicyID assigned to the credentials you want to retrieve.

Vault Use SSL When enabled, Tenable Security Center uses SSL through IIS for secure com-

munications. You must configure SSL through IIS in CyberArk Central Cre-

dential Provider before enabling this option.

Vault Verify

SSL

When enabled, Tenable Security Center validates the SSL certif icate. You

must configure SSL through IIS in CyberArk Central Credential Provider

before enabling this option.

CyberArk Escal-

ation Account

Details Name

The unique name of the credential you want to retrieve from CyberArk.
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Option Description

CyberArk AIM

Service URL

The URL for the CyberArk AIM web service. By default, Tenable Security

Center uses /AIMWebservice/v1.1/AIM.asmx.

CyberArk Vault Options

The following table describes the addit ional options to configure when using CyberArk Vault as the

authentication method for SSH credentials.

Option Description Required

CyberArk Host The IP address or FQDN name for the CyberArk AIM

Web Service.

yes

Port The port on which the CyberArk API communicates.

By default, Tenable uses 443.

yes

AppId The Application ID associated with the CyberArk

API connection.

yes

Client Certif icate The file that contains the PEMcertif icate used to

communicate with the CyberArk host.

no

Client Certif icate Priv-

ate Key

The file that contains the PEMprivate key for the

client cert if icate.

yes, if private

key is applied

Client Certif icate Priv-

ate Key Passphrase

The passphrase for the private key, if required. yes, if private

key is applied

Get credential by The method with which your CyberArk

API credentials are retrieved. Can be Username,

Identifier, or Address.

Note: The frequency of queries for Username is one
query per target. The frequency of queries for Iden-
tifier is one query per chunk. This feature requires all
targets have the same identif ier.

yes
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Option Description Required

Note: The Username option also adds the Address
parameter of the API query and assigns the target IP
of the resolved host to the Address parameter. This
may lead to failure to fetch credentials if the Cyber-
Ark Account Details Address f ield contains a value
other than the target IP address.

Username (If Get credential by is Username) The username of

the CyberArk user to request a password from.

no

Safe The CyberArk safe the credential should be

retrieved from.

no

Address The option should only be used if the Address value

is unique to a single CyberArk account credential.

no

Account Name (If Get credential by is Identifier) The unique

account name or identif ier assigned to the Cyber-

Ark API credential.

no

Use SSL If enabled, the scanner uses SSL through IIS for

secure communications. Enable this option if Cyber-

Ark is configured to support SSL through IIS.

no

Verify SSL Certif icate If enabled, the scanner validates the SSL cer-

t if icate. Enable this option if CyberArk is con-

figured to support SSL through IIS and you want to

validate the certif icate.

no

Hashicorp Vault Options

The following table describes the addit ional options to configure when using Hashicorp Vault as the

authentication method for SSH credentials.

Option Default Value Required

Hashicorp Host The Hashicorp Vault IP address or DNS address. yes
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Note: If your Hashicorp Vault installat ion is in a sub-
directory, you must include the subdirectory path. For
example, type IP address or hostname/subdirectory
path.

Hashicorp Port The port on which Hashicorp Vault listens. yes

Authentication

Type

Specifies the authentication type for connecting to the

instance: App Role or Certificates.

If you select Certificates, addit ional options for

Hashicorp Client Certificate (Required) and Hashicorp Cli-

ent Certificate Private Key (Required) appear. Select the

appropriate files for the client cert if icate and private

key.

yes

Role ID The GUID provided by Hashicorp Vault when you con-

figured your App Role.

yes

Role Secret ID The GUID generated by Hashicorp Vault when you con-

figured your App Role.

yes

Authentication

URL

The path/subdirectory to the authentication endpoint.

This is not the full URL. For example:

/v1/auth/approle/login

yes

Namespace The name of a specified team in a mult i-team envir-

onment.

no

Hashicorp Vault

Type

The type of Hashicorp Vault secrets engine: 

l KV1—Key/Value Secrets Engine Version 1

l KV2 —Key/Value Secrets Engine Version 2

l AD —Active Directory

yes

KV Engine URL The URL Tenable Security Center uses to access the

Hashicorp Vault secrets engine.

Example: /v1/path_to_secret. No trailing /

yes
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Username Source (Only displays if Hashicorp Vault Type is KV1or KV2) Spe-

cifies if the username is input manually or pulled from

Hashicorp Vault.

yes

Username key (Only displays if Hashicorp Vault Type is KV1or KV2) The

name in Hashicorp Vault that usernames are stored

under.

yes

Password key (Only displays if Hashicorp Vault Type is KV1or KV2) The

key in Hashicorp Vault that passwords are stored under.

yes

Secret Name The key secret you want to retrieve values for. yes

Use SSL When enabled, Tenable Security Center uses SSL for

secure communications. You must configure SSL in

Hashicorp Vault before enabling this option.

no

Verify SSL When enabled, Tenable Security Center validates the

SSL certif icate. You must configure SSL in Hashicorp

Vault before enabling this option.

no

Kerberos Options

The following table describes the addit ional options to configure when using Kerberos as the

authentication method for SSH credentials.

Option Description

Username (Required) The username for a user on the target system.

Password (Required) The password associated with the username you provided.

KDC Host (Required) The host supplying the session tickets.

KDC Port (Required) The port you want to use for the KDC connection. By default,

Tenable Security Center uses port 88.

KDC Transport (Required) The method you want to use to connect to the KDC server.

Note: If you select UDP, you may need to edit the KDC Port. The KDC UDP pro-
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Option Description

tocol uses either port 88 or port 750.

Realm (Required) The authentication domain, typically the domain name of the

target (e.g., example.com).

Privilege Escal-

ation

The privilege escalation method you want to use to increase users' priv-

ileges after init ial authentication. Your Privilege Escalation selection

determines the specific options you must configure. For more inform-

ation, see Privilege Escalation.

Password Options

The most effective credentialed scans are those with root privileges (enable privileges, for Cisco

IOS). Since many sites do not permit a remote login as root for security reasons, a Nessus user

account can invoke a variety of privilege escalation options including: su, sudo, su+sudo, Dir-
ectAuthorize (dzdo), PowerBroker (pbrun), k5login, and Cisco Enable.

The following table describes the addit ional options to configure when using Password as the

authentication method for SSH credentials.

Option Description

Username (Required) The username for a user on the target system.

Password (Required) The password associated with the username you provided.

Privilege

Escalation

The privilege escalation method you want to use to increase users' privileges

after init ial authentication. Your Privilege Escalation selection determines the

specific options you must configure. For more information, see Privilege

Escalation.

Public Key Options

The following table describes the addit ional options to configure when using Public Key as the

authentication method for SSH credentials.

- 438 -



Option Description

Username (Required) The username for a user on the host system.

Private Key (Required) The RSA or DSA OpenSSH key file for the user.

Passphrase The passphrase for the private key, if required.

Privilege Escal-

ation

The privilege escalation method you want to use to increase users' privileges

after init ial authentication. Your Privilege Escalation selection determines

the specific options you must configure. For more information, see Privilege

Escalation.

Thycotic Secret Server Options

The following table describes the addit ional options to configure when using Thycotic Secret Server

as the authentication method for SSH credentials.

Option Description

Username (Required) The username for a user on the target system.

Thycotic elev-

ate privileges

with

The privilege escalation method you want to use to increase users' priv-

ileges after init ial authentication. Your selection for this sett ing determines

the specific options you must configure. For more information, see Priv-

ilege Escalation.

Thycotic Secret

Name

The Secret Name value on the Thycotic server.

Thycotic Secret

Server URL

(Required) The value you want Tenable Security Center to use when sett ing

the transfer method, target, and target directory for the scanner. Find the

value on the Thycotic server, in Admin > Configuration > Application Set-

tings > Secret Server URL.

For example, if you type https:/ /pw.mydomain.com/SecretServer, Tenable

Security Center determines it is an SSL connection, that pw.mydomain.com

is the target address, and that /SecretServer is the root directory.

Thycotic Login (Required) The username for a user on the Thycotic server.
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Option Description

Name

Thycotic Pass-

word

(Required) The password associated with the Thycotic Login Name you

provided.

Thycotic Organ-

ization

In cloud instances of Thycotic, the value that identif ies the organization you

want Tenable Security Center to target.

Thycotic

Domain

The domain, if set for the Thycotic server.

Verify SSL Cer-

tificate

If enabled, Tenable Security Center verifies the SSL Certif icate on the Thy-

cotic server.

For more information about using self-signed certif icates, see the Nessus

custom_CA.inc documentation.

Use Private Key If enabled, Tenable Security Center uses key-based authentication for

SSH connections instead of password authentication.

BeyondTrust Options

The following table describes the addit ional options to configure when using BeyondTrust as the

authentication method for SSH credentials.

Option Description

Username The username to log in to the hosts you want to scan.

BeyondTrust Host The BeyondTrust IP address or DNS address.

BeyondTrust Port The port BeyondTrust is listening on.

BeyondTrust

API User

The API user provided by BeyondTrust.

BeyondTrust

API Key

The API key provided by BeyondTrust.
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Option Description

Checkout Duration The length of t ime, in minutes, that you want to keep credentials

checked out in BeyondTrust. Configure the Checkout duration to exceed

the typical duration of your Tenable Security Center scans. If a password

from a previous scan is still checked out when a new scan begins, the

new scan fails.

Tip: Configure the password change interval in BeyondTrust so that pass-
word changes do not disrupt your Tenable Security Center scans. If Bey-
ondTrust changes a password during a scan, the scan fails.

Use SSL If enabled, Tenable Security Center uses SSL through IIS for secure com-

munications. You must configure SSL through IIS in BeyondTrust before

enabling this option.

Verify

SSL Certificate

If enabled, Tenable Security Center validates the SSL certif icate. You

must configure SSL through IIS in BeyondTrust before enabling this

option.

Use Private Key If enabled, Tenable Security Center uses key-based authentication for

SSH connections instead of password authentication.

Use Privilege

Escalations

If enabled, Tenable Security Center uses BeyondTrust for privilege escal-

ation.

Lieberman Options

The following table describes the addit ional options to configure when using Lieberman as the

authentication method for SSH credentials.

Option Description

Username The username for a user on the database.

Lieberman Host The Lieberman IP address or DNS address.

Note: If your Lieberman installat ion is in a subdirectory, you must include the
subdirectory path. For example, type IP address or hostname/sub-
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Option Description

directory path.

Lieberman Port The port Lieberman is listening on.

Lieberman User The username for the Lieberman explicit user you want Tenable Security

Center to use for authentication to the Lieberman Rapid Enterprise

Defense (RED) API.

Lieberman Pass-

word

The password for the Lieberman explicit user.

Use SSL When enabled, Tenable Security Center uses SSL through IIS for secure

communications. You must configure SSL through IIS in Lieberman

before enabling this option.

Verify

SSL Certificate

When enabled, Tenable Security Center validates the SSL certif icate.

You must configure SSL through IIS in Lieberman before enabling this

option.

System Name The name for the database credentials in Lieberman.
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Privilege Escalation

Some SSH credential types support privilege escalation.

Note: BeyondTrust's PowerBroker (pbrun) and Centrify's DirectAuthorize (dzdo) are proprietary root task del-
egation methods for Unix and Linux systems.

Tip: Scans run using su+sudo allow the user to scan with a non-privileged account and then switch to a
user with sudo privileges on the remote host. This is important for locations where remote privileged login
is prohibited.

Note: Scans run using sudo vs. the root user do not always return the same results because of the dif-
ferent environmental variables applied to the sudo user and other subtle differences. For more inform-
ation, see https:/ /www.sudo.ws/docs/man/sudo.man/ .

The following table describes the addit ional options to configure for privilege escalation.

Option SSH Types Description

Escalation Username Arcon

Kerberos

Password

Public Key

The username for the account with elevated priv-

ileges.

Escalation Password Kerberos

Password

Public Key

The password for the account with elevated priv-

ileges.

Escalation Path Arcon

Kerberos

Password

Public Key

The directory path for the privilege escalation com-

mands.

Escalation Su User Arcon

CyberArk

The username for the account with su privileges.
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Option SSH Types Description

Kerberos

Password

Public Key

Escalation Account

Name

Arcon The name parameter for the Arcon account with elev-

ated privileges.

CyberArk Escalation

Account Details

Name

CyberArk The name parameter for the CyberArk account with

elevated privileges.

Note: The system uses the password associated with
the CyberArk account name you provide for all scanned
hosts.

Escalation Account CyberArk The username for the account with elevated priv-

ileges.

Escalation sudo user CyberArk The username for the account with sudo privileges.

Location of dzdo (dir-

ectory)

CyberArk The directory path for the dzdo command.

Location of pbrun

(directory)

CyberArk The directory path for the pbrun command.

Location of su (dir-

ectory)

CyberArk The directory path for the su command.

Location of su and

sudo (directory)

CyberArk The directory path for the su and sudo commands.

Location of sudo (dir-

ectory)

CyberArk The directory path for the sudo command.

su login CyberArk The username for the account with su privileges.

sudo login CyberArk The username for the account with sudo privileges.
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Option SSH Types Description

Thycotic Escalation

Account

Thycotic

Secret

Server

The name parameter for the Thycotic account with

elevated privileges.

Note: The system uses the password associated with
the Thycotic account name you provide for all scanned
hosts.
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Windows Credentials

Nessus has vulnerability checks that can use a Microsoft Windows domain account to find local

information from a remote Windows host. For example, using credentials enables Nessus to determ-

ine if important security patches have been applied.

Tip: Using a non-administrator account will greatly affect the quality of the scan results. Often it makes
sense to create a special Nessus user with administrative privileges that is used solely for scheduled scan-
ning.

Configure the following options for Windows credentials, including options specific for your authen-

tication method: Arcon Options, Centrify Options, CyberArk Vault (Legacy) Options, CyberArk Vault

Options, Hashicorp Vault Options, Kerberos Options, LM Hash Options, NTLM Hash Options, Pass-

word Options, Thycotic Secret Server Options, BeyondTrust Options, and Lieberman Options.

General Options Description

Name (Required) A name for the credential.

Description A description for the credential.

Tag A tag for the credential. For more information, see Tags.

Arcon Options

The following table describes the addit ional options to configure when using Arcon as the authen-

tication method for Windows credentials.

Option Description

Arcon Host (Required) The Arcon IP address or DNS address.

Note: If your Arcon installat ion is in a subdirectory, you must
include the subdirectory path. For example, type IP address or
hostname/subdirectory path.

Arcon Port (Required) The port on which Arcon listens. By default, Ten-

able Security Center uses port 444.

API User (Required) The API user provided by Arcon.
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API Key (Required) The API key provided by Arcon.

Authentication URL (Required) The URL Tenable Security Center uses to access

Arcon.

Password Engine URL (Required) The URL Tenable Security Center uses to access

the passwords in Arcon.

Username (Required) The username to log in to the hosts you want to

scan.

Checkout Duration (Required) The length of t ime, in minutes, that you want to

keep credentials checked out in Arcon. Configure the Check-

out Duration to exceed the typical duration of your Tenable

Security Center scans. If a password from a previous scan is

still checked out when a new scan begins, the new scan

fails.

Tip: Configure the password change interval in Arcon so that
password changes do not disrupt your Tenable Security Center
scans. If Arcon changes a password during a scan, the scan
fails.

Use SSL When enabled, Tenable Security Center uses SSL through IIS

for secure communications. You must configure SSL

through IIS in Arcon before enabling this option.

Verify SSL Certificate When enabled, Tenable Security Center validates the SSL

certif icate. You must configure SSL through IIS in Arcon

before enabling this option.

Centrify Options

The following table describes the addit ional options to configure when using Centrify as the authen-

tication method for Windows credentials.

Option Description

Centrify Host (Required) The Centrify IP address or DNS address.
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Note: If your Centrify installat ion is in a subdirectory, you must
include the subdirectory path. For example, type IP address or
hostname/subdirectory path.

Centrify Port (Required) The port on which Centrify listens. By default, Ten-

able Security Center uses port 443.

API User (Required) The API user provided by Centrify.

API Key (Required) The API key provided by Centrify.

Tenant (Required) The Centrify tenant associated with the API. By

default, Tenable Security Center uses centrify.

Authentication URL (Required) The URL Tenable Security Center uses to access

Centrify. By default, Tenable Security Center uses /Security.

Password Query URL (Required) The URL Tenable Security Center uses to query

the passwords in Centrify. By default, Tenable Security

Center uses /RedRock.

Password Engine URL (Required) The URL Tenable Security Center uses to access

the passwords in Centrify. By default, Tenable Security

Center uses /ServerManage.

Username (Required) The username to log in to the hosts you want to

scan.

Checkout Duration (Required) The length of t ime, in minutes, that you want to

keep credentials checked out in Centrify.

Configure the Checkout Duration to exceed the typical dur-

ation of your Tenable Security Center scans so that pass-

word changes do not disrupt your Tenable Security Center

scans. If Centrify changes a password during a scan, the

scan fails. If a password from a previous scan is still

checked out when a new scan begins, the new scan fails.

Use SSL When enabled, Tenable Security Center uses SSL through IIS

for secure communications. You must configure SSL
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through IIS in Centrify before enabling this option.

Verify SSL Certificate When enabled, Tenable Security Center validates the SSL

certif icate. You must configure SSL through IIS in Centrify

before enabling this option.

CyberArk Vault (Legacy) Options

The following table describes the options to configure when using CyberArk Vault (Legacy) as the

authentication method for Windows credentials.

Option Description

Username The username for the target system.

Domain The domain, if the username is part of a domain.

Central Cre-

dential Provider

URL Host

The CyberArk Central Credential Provider IP/DNS address.

Central Cre-

dential Provider

URL Port

The port the CyberArk Central Credential Provider is listening on.

Vault Username The username for the vault, if the CyberArk Central Credential Provider is

configured for basic authentication.

Vault Password The password for the vault, if the CyberArk Central Credential Provider is

configured for basic authentication.

Safe The safe on the CyberArk Central Credential Provider server that contains

the credentials you want to retrieve.

CyberArk Client

Certificate

The file that contains the PEMcertif icate used to communicate with the

CyberArk host.

CyberArk Client

Certificate Priv-

ate Key

The file that contains the PEMprivate key for the client cert if icate.
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Option Description

CyberArk Client

Certificate Priv-

ate Key Pass-

phrase

The passphrase for the private key, if required.

AppID The AppID with CyberArk Central Credential Provider permissions to

retrieve the target password.

Folder The folder on the CyberArk Central Credential Provider server that con-

tains the credentials you want to retrieve.

PolicyID The PolicyID assigned to the credentials you want to retrieve.

Vault Use SSL When enabled, Tenable Security Center uses SSL through IIS for secure

communications. You must configure SSL through IIS in CyberArk Central

Credential Provider before enabling this option.

Vault Verify SSL When enabled, Tenable Security Center validates the SSL certif icate. You

must configure SSL through IIS in CyberArk Central Credential Provider

before enabling this option.

For more information about using self-signed certif icates, see Custom Plu-

gin Packages for NASL and CA Certif icate Upload.

CyberArk Escal-

ation Account

Details Name

The unique name of the credential you want to retrieve from CyberArk.

CyberArk AIMSer-

vice URL

The URL for the CyberArk AIM web service. By default, Tenable Security

Center uses /AIMWebservice/v1.1/AIM.asmx.
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CyberArk Vault Options

The following table describes the addit ional options to configure when using CyberArk Vault as the

authentication method for Windows credentials.

Option Description Required

CyberArk Host The IP address or FQDN name for the CyberArk AIM

Web Service. This can be the host, or the host with

a custom URL added on in a single string.

yes

Port The port on which the CyberArk API communicates.

By default, Tenable uses 443.

yes

AppId The Application ID associated with the CyberArk

API connection.

yes

Client Certif icate The file that contains the PEMcertif icate used to

communicate with the CyberArk host.

no

Client Certif icate Priv-

ate Key

The file that contains the PEMprivate key for the

client cert if icate.

yes, if private

key is applied

Client Certif icate Priv-

ate Key Passphrase

The passphrase for the private key, if required. yes, if private

key is applied

Get credential by The method with which your CyberArk

API credentials are retrieved. Can be Username,

Identifier, or Address.

Note: The frequency of queries for Username is one
query per target. The frequency of queries for Iden-
tifier is one query per chunk. This feature requires all
targets have the same identif ier.

Note: The Username option also adds the Address
parameter of the API query and assigns the target IP
of the resolved host to the Address parameter. This
may lead to failure to fetch credentials if the Cyber-
Ark Account Details Address f ield contains a value

yes
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Option Description Required

other than the target IP address.

Username (If Get credential by is Username) The username of

the CyberArk user to request a password from.

no

Safe The CyberArk safe the credential should be

retrieved from.

no

Address The option should only be used if the Address value

is unique to a single CyberArk account credential.

no

Account Name (If Get credential by is Identifier) The unique

account name or identif ier assigned to the Cyber-

Ark API credential.

no

Use SSL If enabled, the scanner uses SSL through IIS for

secure communications. Enable this option if Cyber-

Ark is configured to support SSL through IIS.

no

Verify SSL Certif icate If enabled, the scanner validates the SSL cer-

t if icate. Enable this option if CyberArk is con-

figured to support SSL through IIS and you want to

validate the certif icate.

no

Hashicorp Vault Options

The following table describes the addit ional options to configure when using Hashicorp Vault as the

authentication method for Windows credentials.

Option Default Value Required

Hashicorp Host The Hashicorp Vault IP address or DNS address.

Note: If your Hashicorp Vault installat ion is in a sub-
directory, you must include the subdirectory path.
For example, type IP address or hostname/sub-
directory path.

yes
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Hashicorp Port The port on which Hashicorp Vault listens. yes

Authenticaton Type Specifies the authentication type for connecting

to the instance: App Role or Certificates.

If you select Certificates, addit ional options for

Hashicorp Client Certificate (Required) and

Hashicorp Client Certificate Private Key

(Required) appear. Select the appropriate files for

the client cert if icate and private key.

yes

Role ID The GUID provided by Hashicorp Vault when you

configured your App Role.

yes

Role Secret ID The GUID generated by Hashicorp Vault when you

configured your App Role.

yes

Authentication URL The path/subdirectory to the authentication end-

point. This is not the full URL. For example:

/v1/auth/approle/login

yes

Namespace The name of a specified team in a mult i-team

environment.

no

Hashicorp Vault Type The type of Hashicorp Vault secrets engine:

l KV1—Key/Value Secrets Engine Version 1

l KV2 —Key/Value Secrets Engine Version 2

l AD —Active Directory

yes

KV Engine URL The URL Tenable Security Center uses to access

the Hashicorp Vault secrets engine.

Example: /v1/path_to_secret. No trailing /

yes

Username Source (Only displays if Hashicorp Vault Type is KV1

or KV2) Specifies if the username is input manu-

ally or pulled from Hashicorp Vault.

yes
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Username key (Only displays if Hashicorp Vault Type is KV1

or KV2) The name in Hashicorp Vault that user-

names are stored under.

yes

Password key (Only displays if Hashicorp Vault Type is KV1

or KV2) The key in Hashicorp Vault that passwords

are stored under.

yes

Secret Name The key secret you want to retrieve values for. yes

Use SSL When enabled, Tenable Security Center uses SSL

for secure communications. You must configure

SSL in Hashicorp Vault before enabling this

option.

no

Verify SSL When enabled, Tenable Security Center validates

the SSL certif icate. You must configure SSL in

Hashicorp Vault before enabling this option.

no

Kerberos Options

The following table describes the options to configure when using Kerberos as the authentication

method for Windows credentials.

Option Description

Username The username for a user on the target system.

Password The password associated with the username you provided.

Domain The authentication domain, typically the domain name of the target (e.g.,

example.com).

KDC Host The host supplying the session tickets.

KDC Port The port you want to use for the KDC connection. By default, Tenable

Security Center uses port 88.

KDC Transport The method you want to use to connect to the KDC server.
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Option Description

Note: If you select UDP, you may need to edit the KDC Port. The KDC UDP pro-
tocol uses either port 88 or port 750.

LM Hash Options

The following table describes the options to configure when using LM Hash as the authentication

method for Windows credentials.

Option Description

Username The username for a user on the target system.

Hash The LM hash you want to use.

Domain The domain of the username, if required.

NTLM Hash Options

The following table describes the options to configure when using NTLM Hash as the authentication

method for Windows credentials.

Option Description

Username The username for a user on the target system.

Hash The NTLM hash you want to use.

Domain The domain of the username, if required.

Password Options

The following table describes the options to configure when using Password as the authentication

method for Windows credentials.

Option Description

Username The username for a user on the target system.
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Option Description

Password The password associated with the username you provided.

Domain The domain of the username, if required.

Thycotic Secret Server Options

The following table describes the options to configure when using Thycotic Secret Server as the

authentication method for Windows credentials.

Option Description

Username (Required) The username for a user on the target system.

Domain The domain of the username, if set on the Thycotic server.

Thycotic Secret

Name

The Secret Name value on the Thycotic server.

Thycotic Secret

Server URL

(Required) The value you want Tenable Security Center to use when sett ing

the transfer method, target, and target directory for the scanner. Find the

value on the Thycotic server, in Admin > Configuration > Application Set-

tings > Secret Server URL.

For example, if you type https:/ /pw.mydomain.com/SecretServer, Tenable

Security Center determines it is an SSL connection, that pw.mydomain.com

is the target address, and that /SecretServer is the root directory.

Thycotic Login

Name

(Required) The username for a user on the Thycotic server.

Thycotic Pass-

word

(Required) The password associated with the Thycotic Login Name you

provided.

Thycotic Organ-

ization

In cloud instances of Thycotic, the value that identif ies which organization

the Tenable Security Center query should target.

Thycotic

Domain

The domain, if set for the Thycotic server.
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Option Description

Use Private Key If enabled, Tenable Security Center uses key-based authentication for

SSH connections instead of password authentication.

Verify SSL Cer-

tificate

If enabled, Tenable Security Center verifies the SSL Certif icate on the Thy-

cotic server.

For more information about using self-signed certif icates, see Custom Plu-

gin Packages for NASL and CA Certif icate Upload.

BeyondTrust Options

The following table describes the options to configure when using BeyondTrust as the authen-

tication method for Windows credentials.

Option Description

Username The username to log in to the hosts you want to scan.

Domain The domain of the username, if required by BeyondTrust.

BeyondTrust Host The BeyondTrust IP address or DNS address.

BeyondTrust Port The port BeyondTrust is listening on.

BeyondTrust

API User

The API user provided by BeyondTrust.

BeyondTrust

API Key

The API key provided by BeyondTrust.

Checkout Duration The length of t ime, in minutes, that you want to keep credentials

checked out in BeyondTrust. Configure the Checkout duration to exceed

the typical duration of your Tenable Security Center scans. If a password

from a previous scan is still checked out when a new scan begins, the

new scan fails.

Tip: Configure the password change interval in BeyondTrust so that pass-
word changes do not disrupt your Tenable Security Center scans. If Bey-
ondTrust changes a password during a scan, the scan fails.
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Option Description

Use SSL If enabled, Tenable Security Center uses SSL through IIS for secure com-

munications. You must configure SSL through IIS in BeyondTrust before

enabling this option.

Verify

SSL Certificate

If enabled, Tenable Security Center validates the SSL certif icate. You

must configure SSL through IIS in BeyondTrust before enabling this

option.

Lieberman Options

The following table describes the addit ional options to configure when using Lieberman as the

authentication method for Windows credentials.

Option Description

Username The username for a user on the database.

Domain The domain of the username, if required by Lieberman.

Lieberman Host The Lieberman IP address or DNS address.

Note: If your Lieberman installat ion is in a subdirectory, you must include the
subdirectory path. For example, type IP address or hostname/sub-
directory path.

Lieberman Port The port Lieberman is listening on.

Lieberman User The username for the Lieberman explicit user you want Tenable Security

Center to use for authentication to the Lieberman Rapid Enterprise

Defense (RED) API.

Lieberman Pass-

word

The password for the Lieberman explicit user.

Use SSL When enabled, Tenable Security Center uses SSL through IIS for secure

communications. You must configure SSL through IIS in Lieberman

before enabling this option.
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Verify

SSL Certificate

When enabled, Tenable Security Center validates the SSL certif icate.

You must configure SSL through IIS in Lieberman before enabling this

option.

For more information about using self-signed certif icates, see Custom

Plugin Packages for NASL and CA Certif icate Upload.

System Name The name for the database credentials in Lieberman.
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Audit Files

The Tenable Nessus vulnerability scanner allows you to perform compliance audits of numerous plat-

forms including (but not limited to) databases, Cisco, Unix, and Windows configurations as well as

sensit ive data discovery based on regex contained in audit files. Audit files are XML-based text files

that contain the specific configuration, file permission, and access control tests to be performed.

For more information, see Manage Audit Files.

After you create an audit file, you can reference the audit file in a template-based Policy Com-

pliance Audit ing scan policy or a custom scan policy. For more information about compliance

options in custom scan policies, see Compliance Options.

For more information on compliance checks and creating custom audits, see the Compliance

Checks Reference.

Template-Based Audit Files

You can add template-based audit files using templates embedded within Tenable Security Center.

Tenable updates these templates regularly through the Tenable Security Center feed.

For more information, see Add a Template-Based Audit File.

Custom Audit Files

You can add custom audit files to upload any of the following:

l a Tenable-created audit file downloaded from the Tenable downloads page.

l a Security Content Automation Protocol (SCAP) Data Stream file downloaded from a

SCAP repository (e.g., https:/ /nvd.nist.gov/ncp/ repository).

The file must contain full SCAP content (Open Vulnerability and Assessment Language

(OVAL) and Extensible Configuration Checklist Description Format (XCCDF) content) or

OVAL standalone content.

Note: XCCDF standalone content audit files lack automated checks and do not return scan results in
Tenable Security Center.

l a custom audit file created or customized for a specific environment. For more information,

see the knowledge base article.
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For more information, see Add a Custom Audit File.

- 461-



Add a Template-Based Audit File

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can add template-based audit files using templates embedded within Tenable Security Center.

Tenable updates these templates regularly through the Tenable Security Center feed.

For more information, see Audit Files.

To add a template-based audit file:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Audit Files (administrator users) or Scans > Audit Files (organizational users).

The Audit Files page appears.

3. Click Add

The Audit File Templates page appears.

4. In the Common section, click a template category tile.

The Add Audit Template page appears.

5. In the Name box, type a name for the audit file.

6. (Optional) In the Description box, type a description for the audit file.

7. (Optional) Edit the template-specific options if you do not want to use the default values.

8. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Reference the audit file in a template-based Policy Compliance Audit ing scan policy or a cus-

tom scan policy. For more information about compliance options in custom scan policies, see

Compliance Options.
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Add a Custom Audit File

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can add custom audit files to upload any of the following:

l a Tenable-created audit file downloaded from the Tenable downloads page.

l a Security Content Automation Protocol (SCAP) Data Stream file downloaded from a

SCAP repository (e.g., https:/ /nvd.nist.gov/ncp/ repository).

The file must contain full SCAP content (Open Vulnerability and Assessment Language

(OVAL) and Extensible Configuration Checklist Description Format (XCCDF) content) or

OVAL standalone content.

Note: XCCDF standalone content audit files lack automated checks and do not return scan results in
Tenable Security Center.

l a custom audit file created or customized for a specific environment. For more information,

see the knowledge base article.

For more information, see Audit Files.

Before you begin:

l Download or prepare the file you intend to upload.

To add a custom audit file or SCAP Data Stream file:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Audit Files (administrator users) or Scans > Audit Files (organizational users).

The Audit Files page appears.

3. Click Add

The Audit File Templates page appears.

4. In the Other section, click the Advanced t ile.

5. In the Name box, type a descriptive name for the audit file.
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6. In the Description box, type a description for the audit file.

7. Click Choose File and browse to the Audit File you want to upload.

The system uploads the file. If you uploaded a SCAP Data Stream file, addit ional options

appear.

8. If you uploaded a Data Stream file with full SCAP content, continue configuring options for the

file:

a. If you uploaded SCAP 1.2 content or later, in the Data Stream Name box, select the Data

Stream identif ier found in the SCAP 1.2 Data Stream content.

b. In the Benchmark Type box, select the operating system that the SCAP content targets.

c. In the Benchmark Name box, select the benchmark identif ier found in the

SCAP XCCDF component.

d. In the Profile box, select the benchmark profile identif ier found in the

SCAP XCCDF component.

9. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Reference the audit file in a template-based Policy Compliance Audit ing scan policy or a cus-

tom scan policy. For more information about compliance options in custom scan policies, see

Compliance Options.
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Manage Audit Files

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Audit Files.

To manage your audit files:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Audit Files.

The Audit Files page appears.

3. To filter the audit files that appear on the page, apply a filter as described in Apply a Filter.

4. To add an audit file, see Add a Template-Based Audit File or Add a Custom Audit File.

5. To view details for an audit file:

a. In the row for the audit file, click the menu.

The actions menu appears.

b. Click View.

The View Audit File page appears.

6. To edit or replace an audit file:

a. In the row for the audit file, click the menu.

The actions menu appears.

b. Click Edit.

The Edit Audit File page appears.

c. To edit the name or description, type a new Name or Description.

d. To replace the audit file, click the delete button ( ) next to the file and upload a new

audit file.

e. Click Submit.
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Tenable Security Center saves your configuration.

7. To share or revoke access to an audit file:

a. In the row for the audit file, click the menu.

The actions menu appears.

b. Click Share.

c. Share or revoke access for each group in your organization.

d. Click Submit.

Tenable Security Center saves your configuration.

8. To export an audit file:

a. In the row for the audit file, click the menu.

The actions menu appears.

b. Click Export.

Tenable Security Center exports the audit file.

9. To delete an audit file:

a. In the row for the audit file, click the menu.

The actions menu appears.

b. Click Delete.

A confirmation window appears.

c. Click Delete.

Tenable Security Center deletes the audit file.
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Scan Zones

Scan zones are areas of your network that you want to target in an active scan, associating an

IP address or range of IP addresses with one or more scanners in your deployment. You must create

scan zones in order to run active scans in Tenable Security Center.

For more information, see Add a Scan Zone, View Your Scan Zones, Edit a Scan Zone, and Delete a

Scan Zone.

Option Description

Name A name for the scan zone.

Description (Optional) A description for the scan zone.

Ranges One or more IP addresses that you want the scan zone to target. Supported

formats:

l a comma-separated list of IP addresses and/or CIDR addresses.

l a newline-separated list of IP addresses and/or CIDR addresses.

l a hyphenated range of IP addresses (e.g., 192.0.2.0-192.0.2.25).

Scanners One or more scanners that you want to use to scan the Ranges in this scan

zone.

Note: Do not choose scanners that cannot reach the areas of your network iden-
tif ied in the Ranges. Similarly, consider the quality of the network connection
between the scanners you choose and the Ranges.

Best Practices

Tenable recommends pre-planning your scan zone strategy to efficiently target discrete areas of

your network. If configured improperly, scan zones prevent scanners from reaching their targets.

Consider the following best practices:

l It is simplest to configure and manage a small number of scan zones with large ranges.

l It is simplest to target ranges (versus large lists of individual IP addresses).
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l If you use Nessus Manager for agent management, do not target Nessus Manager in any scan

zone ranges.

Overlapping Scan Zones

In some cases, you may want to configure overlapping scan zones to ensure scanning coverage or

redundancy.

Note: Do not configure overlapping scan zones without pre-planning your scan zone and Distribution
Method strategy.

Two or more scan zones are redundant if they target the same area of your network. If Tenable

Security Center executes a scan with redundant scan zones, it f irst attempts the scan using the nar-

rowest, most specific scan zone.

In this example, the red numbers represent specific IP addresses on your network. The grey circles

represent the network coverage of individual scan zones.

See the following table to understand the primary and redundant scan zones for the IP addresses in

this example.

- 468 -



IP Address Primary Scan Zone Redundant Scan Zones

1 Scan Zone A None.

2 Scan Zone B Scan Zone A.

3 Scan Zone C Scan Zone B, then Scan Zone A.

4 Scan Zone C Scan Zone A.

5 Scan Zone D Scan Zone A.

6 Scan Zone E Scan Zone A.

7 Scan Zone F Scan Zone E, then Scan Zone A.

- 469 -



Add a Scan Zone

Required User Role: Administrator

For more information about scan zone options, see Scan Zones.

To add a scan zone:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Scan Zones.

The Scan Zones page appears.

3. Click Add.

The Add Scan Zone page appears.

4. In the Name box, type a name for the scan zone.

5. In the Description box, type a description for the scan zone.

6. In the Ranges box, type one or more IP addresses, CIDR addresses, or ranges to target with

the scan zone.

7. In the Scanners box, choose one or more scanners to associate with the scan zone.

8. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Configure scan zone-related organization sett ings, as described in Organizations.

l Configure an active scan that targets your scan zone, as described in Add an Active Scan.
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View Your Scan Zones

Required User Role: Administrator

For more information, see Scan Zones.

To view a list of configured scan zones:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Scan Zones.

The Scan Zones page appears.

3. View details about each scan zone.

l Name —The name of the scan zone.

l Status —The status of the scan zone.

Scan Zone Status Description

All Scanners Available All of the scanners in the scan zone are Working.

x/y Scanners Available Only some of the scanners in the scan zone are Working.

No Scanners Available None of the scanners in the scan zone are Working.

For information about Working and other scanner statuses, see Tenable Nessus Scanner

Statuses.

l Scanners —The number of Tenable Nessus scanners in the scan zone.

l Last Modified —The date and time the scan zone was last modified.
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Edit a Scan Zone

Required User Role: Administrator

For more information about scan zone options, see Scan Zones.

To edit a scan zone:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Scan Zones.

The Scan Zones page appears.

3. In the row for the scan zone you want to edit, click the menu.

The actions menu appears.

4. Click Edit.

The Edit Scan Zone page appears.

5. Modify the following scan zone options. For more information, see Scan Zones. 

l Name

l Description

l Ranges

l Scanners

6. Click Submit.

Tenable Security Center saves your configuration.
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Delete a Scan Zone

Required User Role: Administrator

For more information, see Scan Zones.

Before you begin:

l Confirm that no scans target the scan zone you want to delete. Tenable Security Center scans

may fail if you delete an actively targeted scan zone.

To delete a scan zone:

1. Log in to Tenable Security Center via the user interface.

2. Click Resources > Scan Zones.

The Scan Zones page appears.

3. In the row for the scan zone you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the scan zone.
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Scan Policies

Scan policies contain plugin sett ings and advanced directives for active scans.

When an administrator user creates a scan policy, the policy is available to all organizations. When

an organizational user creates a scan policy, the scan policy is available only to their organization.

Users with the appropriate permissions can use scan policies in an active scan, modify policy

options, and more. For more information about user permissions, see User Roles.

For more information, see:

l Add a Scan Policy

l Scan Policy Templates

l Scan Policy Options

l View Your Scan Policies

l View Scan Policy Details

l Edit a Scan Policy

l Share or Revoke Access to a Scan Policy

l Export a Scan Policy

l Import a Scan Policy

l Copy a Scan Policy

l Delete a Scan Policy
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Add a Scan Policy

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can create template-based or custom scan policies for your active scans. When you create a

custom scan policy, you can configure any scan policy option. When you configure a template-

based scan policy, you can configure the options included for the template type.

For more information, see Scan Policies and Active Scans.

To add a template-based scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. Click Add.

The Add Policy page appears.

4. In the Template section, click a policy template. For more information, see Scan Policy Tem-

plates.

The policy template page appears.

5. Configure the options described in Scan Policy Options.

6. Click Submit.

Tenable Security Center saves your configuration.

To add a custom scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. Click Add.
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The Add Policy page appears.

4. In the Custom section, click Advanced Scan.

The Advanced Scan page appears.

5. Configure the options described in Scan Policy Options.

6. Click Submit.

Tenable Security Center saves your configuration.

What to do next:

l Reference the scan policy in an active scan configuration, as described in Add an Active Scan.
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Scan Policy Templates

Tenable Security Center provides scan policy templates with pre-configured plugin sett ings and

advanced directives for active scans. You can configure a Tenable-provided template or you can cre-

ate a fully customized scan policy from all of the available scan policy options in Tenable Security

Center.

Each Tenable-provided scan policy template contains a different set of scan policy options. You can

only modify the sett ings included for that scan policy template type.

Custom scan policies, such as Advanced Scan, contain all scan policy options. You can modify any

scan policy options for custom scans.

For more information, see Scan Policies and Scan Policy Options.

Template Description

Common

Advanced Agent

Scan

The most configurable scan type. You can configure this scan template

to match any policy. This template has the same default sett ings as the

basic scan template, but it allows for addit ional configuration options.

Note: Advanced scan templates allow you to scan more deeply using custom
configuration, such as faster or slower checks, but misconfigurations can
cause asset outages or network saturation. Use the advanced templates with
caution.

Advanced Scan The most configurable scan type. You can configure this scan template

to match any policy. This template has the same default sett ings as the

basic scan template, but it allows for addit ional configuration options.

Basic Network

Scan

Performs a full system scan that is suitable for any host. Use this tem-

plate to scan an asset or assets with all of Nessus's plugins enabled. For

example, you can perform an internal vulnerability scan on your organ-

ization's systems.

Credentialed Patch

Audit

Authenticates hosts and enumerates missing updates.

Use this template with credentials to give Tenable Security Center direct
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access to the host, scan the target hosts, and enumerate missing patch

updates.

Web Application

Tests

Scan for published and unknown web vulnerabilit ies.

Compliance Configuration

Internal PCI Net-

work Scan

Performs an internal PCI DSS (11.2.1) vulnerability scan.

This template creates scans that you can use to satisfy internal (PCI DSS

11.2.1) scanning requirements for ongoing vulnerability management pro-

grams that satisfy PCI compliance requirements. You can use these

scans for ongoing vulnerability management and to perform rescans until

passing or clean results are achieved. You can provide credentials to enu-

merate missing patches and client-side vulnerabilit ies.

Note: While the PCI DSS requires you to provide evidence of passing or
"clean" scans on at least a quarterly basis, you must also perform scans after
any significant changes to your network (PCI DSS 11.2.3).

PCI Quarterly

External Scan

Performs quarterly external scans as required by PCI.

You can use this template to simulate an external scan (PCI DSS 11.2.2) to

meet PCI DSS quarterly scanning requirements. However, you cannot

submit the scan results from this template to Tenable for PCI Validation.

Only Tenable Vulnerability Management customers can submit their PCI

scan results to Tenable for PCI ASV validation.

Policy Compliance

Audit ing

Audits system configurations against a known baseline.

The compliance checks can audit against custom security policies, such

as password complexity, system settings, or registry values on Windows

operating systems. For Windows systems, the compliance audits can

test for a large percentage of anything that can be described in a Win-

dows policy file. For Unix systems, the compliance audits test for run-

ning processes, user security policy, and content of files.

SCAP and OVAL

Audit ing

Audits systems using SCAP and OVAL definit ions.
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The National Institute of Standards and Technology (NIST) Security Con-

tent Automation Protocol (SCAP) is a set of policies for managing vul-

nerabilit ies and policy compliance in government agencies. It relies on

mult iple open standards and policies, including OVAL, CVE, CVSS, CPE,

and FDCC policies.

l SCAP compliance audit ing requires sending an executable to the

remote host.

l Systems running security software (for example, McAfee Host Intru-

sion Prevention), may block or quarantine the executable required

for audit ing. For those systems, you must make an exception for

either the host or the executable sent.

l When using the SCAP and OVAL Auditing template, you can per-

form Linux and Windows SCAP CHECKS to test compliance stand-

ards as specified in NIST’s Special Publication 800-126.

Other

2022 Threat Land-

scape Restro-

spective (TLR)

Detects vulnerabilit ies featured in Tenable's 2022 Threat Landscape Ret-

rospective report.

Active Directory

Starter Scan

Scans for misconfigurations in Active Directory.

Note: Active Directory Starter Scans require ADSI credentials. For more
information, see Miscellaneous.

Use this template to check Active Directory for Kerberoasting, Weak Ker-

beros encryption, Kerberos pre-authentication validation, non-expiring

account passwords, unconstrained delegation, null sessions, Kerberos

KRBTGT, dangerous trust relationships, Primary Group ID integrity, and

blank passwords.

CISA Alerts AA22-

011A and AA22-

047A

Performs remote and local checks for vulnerabilit ies from CISA alerts

AA22-011A and AA22-047A.
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GHOST (glibc)

Detection

Performs local checks to detect vulnerabilit ies related to CVE-2015-

0235.

Host Discovery Performs a simple scan to discover live hosts and open ports.

Launch this scan to see what hosts are on your network and associated

information such as IP address, FQDN, operating systems, and open

ports, if available. After you have a list of hosts, you can choose what

hosts you want to target in a specific vulnerability scan.

Tenable recommends that organizations who do not have a passive net-

work monitor, such as Nessus Network Monitor, run this scan weekly to

discover new assets on your network.

Note: Assets identif ied by discovery scans do not count toward your license.

Intel AMT Security

Bypass Detection

Performs remote and local checks for CVE-2017-5689.

Log4Shell Detects the Log4Shell vulnerability (CVE-2021-44228) in Apache Log4j

via local checks.

Log4Shell Remote

Checks

Detects the Log4Shell vulnerability (CVE-2021-44228) in Apache Log4j

via remote checks.

Log4Shell Vul-

nerability Ecosys-

tem

Detects the Log4Shell vulnerability (CVE-2021-44228) in Apache Log4j

via local and remote checks. This template is dynamic and is regularly

updated with new plugins as third-party vendors patch their software.

Malware Scan Scans for malware on Windows and Unix systems.

Tenable Security Center detects malware using a combined allow list and

block list approach to monitor known good processes, alert on known

bad processes, and identify coverage gaps between the two by flagging

unknown processes for further inspection.

PrintNightmare Performs local checks for CVE-2021-34527, the PrintNightmare Windows

Print Spooler vulnerability.

ProxyLogon: Performs remote and local checks to detect Microsoft Exchange Server
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MS Exchange vulnerabilit ies related to CVE-2021-26855, CVE-2021-26857, CVE-2021-

26858, and CVE-2021-27065.

Solarigate Detects SolarWinds Solorigate vulnerabilit ies using remote and local

checks.

Spectre and Melt-

down Detection

Performs remote and local checks for CVE-2017-5753, CVE-2017-5715,

and CVE-2017-5754.

WannaCry

Ransomeware

Detection

Scans for the WannaCry ransomware (MS17-010).

Zerologon Remote

Scan

Detects Microsoft Netlogon elevation of privilege vulnerability (Zer-

ologon).
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Scan Policy Options

Scan policy options specify granular configurations for your active scans.

When you create a custom scan policy, you can configure any scan policy option. When you con-

figure a template-based scan policy, you can configure the options included for the template type.

For more information about Tenable-provided scan policy templates, see Scan Policy Templates.

l Setup Options

l Advanced Options

l Host Discovery Options

l Port Scanning Options

l Service Discovery Options

l Assessment Options

l Brute Force Options

l Malware Options

l SCADA Options

l Web Applications Options

l Windows Options

l Report Options

l Authentication Options

l Compliance Options

l Plugins Options

Setup Options

Option Description

Name A unique name for the policy.
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Option Description

Description (Optional) A description for the policy.

Tag A tag for the policy. For more information, see Tags.

Advanced Options

Option Description

General Settings

Enable safe

checks

Tenable Nessus attempts to identify remote vulnerabilit ies by interpreting

banner information and attempting to exercise a vulnerability. When

Enable safe checks is enabled, the second step is skipped. This is not as

reliable as a full probe, but is less likely to negatively impact a targeted sys-

tem.

Stop scanning

hosts that

become unre-

sponsive during

the scan

During a scan, hosts may become unresponsive after a period of t ime.

Enabling this sett ing stops scan attempts against hosts that stop sending

results.

Automatically

accept detected

SSH disclaimer

prompts

When enabled, if a credentialed scan tries to connect via SSH to a FortiOS

host that presents a disclaimer prompt, the scanner provides the neces-

sary text input to accept the disclaimer prompt and continue the scan.

The scan init ially sends a bad ssh request to the target in order to retrieve

the supported authorization methods. This allows you to determine how to

connect to the target, which is helpful when you configure a custom ssh

banner and then try to determine how to connect to the host.

When disabled, credentialed scans on hosts that present a disclaimer

prompt fail because the scanner cannot connect to the device and accept

the disclaimer. The error appears in the plugin output.

Performance Options

Slow down the When Tenable Nessus detects congestion during a scan, it will slow the
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Option Description

scan when net-

work congestion

is detected

speed of the scan in an attempt to ease the burden on the affected seg-

ment(s).

Use Linux kernel

congestion

detection

Use Linux kernel congestion detection during the scan to help alleviate sys-

tem lockups on the Tenable Nessus scanner server.

Network timeout

(in seconds)

Determines the amount of t ime, in seconds, to determine if there is an

issue communicating over the network.

Max sim-

ultaneous

checks per host

This sett ing limits the maximum number of checks a Tenable Nessus scan-

ner will perform against a single host at one time. The default value of this

option is 5 simultaneous checks per host.

Type an integer greater than 0. If you enter 0, enter a negative integer, or

delete the value in the field, Tenable Security Center does not perform any

checks and scans will not complete.

Max sim-

ultaneous hosts

per scan

This sett ing limits the maximum number of hosts that a single Tenable

Nessus scanner will scan at the same time. The default value of this option

is 30 hosts per scan.

If the scan is using a zone with mult iple scanners, each scanner will accept

up to the amount specified in the Max simultaneous hosts per scan option.

For example, if the Max simultaneous hosts per scan is set to 5 and there

are 5 scanners per zone, each scanner will accept 5 hosts to scan, allowing

a total of 25 hosts to be scanned between the 5 scanners.

If you set Max Simultaneous hosts per scan to more than the Nessus scan-

ner’s max_hosts value, the following message appears in the scanner's nes-
susd.messages: Tried to raise the maximum hosts number - 150. Using

100. Change 'max_hosts' in the server configuration if you believe this is

incorrect . You can ignore this message; Tenable Security Center send

scans to the scanner into scan chunks of up to eight IPs and will not reach

the scanner's max_hosts, which must be nine or greater.
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Option Description

Max number of

concurrent TCP

sessions per

host

Specifies the maximum number of established TCP sessions for a single

host.

This TCP thrott ling option also controls the number of packets per second

the SYN scanner sends, which is 10 times the number of TCP sessions. For

example, if this option is set to 15, the SYN scanner sends 150 packets per

second at most.

Type an integer between 1-2000. If you leave the box empty or enter 0,

Tenable Security Center does not enforce a limit.

Max number of

concurrent TCP

sessions per

scan

This sett ing limits the maximum number of TCP sessions established by

any of the active scanners during a scan.

Type an integer between 1-2000. If you leave the box empty or enter 0,

Tenable Security Center does not enforce a limit.

Unix find command Options

Exclude Filepath A plain text file containing a list of filepaths to exclude from all plugins

that search using the find command on Unix systems.

In the file, enter one filepath per line, formatted per patterns allowed by

the Unix find command -path argument. For more information, see the

find command man page.

Exclude Filesys-

tem

A plain text file containing a list of filesystems to exclude from all plugins

that search using the find command on Unix systems.

In the file, enter one filesystem per line, using filesystem types supported

by the Unix find command -fstype argument. For more information, see

the find command man page.

Include Filepath A plain text file containing a list of filepaths to include from all plugins that

search using the find command on Unix systems.

In the file, enter one filepath per line, formatted per patterns allowed by

the Unix find command -path argument. For more information, see the

find command man page.
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Option Description

Including filepaths increases the locations that are searched by plugins,

which extends the duration of the scan. Make your inclusions as specific

as possible.

Tip: Avoid having the same filepaths in Include Filepath and Exclude Filepath.
This conflict may result in the filepath being excluded from the search, though
results may vary by operating system.

Debug Settings

Enumerate

Launched Plu-

gins

Shows a list of plugins that were launched during the scan. You can view

the list in scan results under plugin 112154.

Stagger scan start

Maximum delay

(minutes)

(Agents 8.2 and later) If set, each agent in the agent group delays start ing

the scan for a random number of minutes, up to the specified maximum.

Staggered starts can reduce the impact of agents that use a shared

resource, such as virtual machine CPU.

If the maximum delay you set exceeds your scan window, Tenable

shortens your maximum delay to ensure that agents begin scanning at

least 30 minutes before the scan window closes.

Host Discovery Options

Option Description

Ping the

remote host

When enabled, Tenable Nessus attempts to ping the hosts in the scan to

determine if the host is alive or not.

General Settings (available when Ping the remote host is enabled)

Test the local

Tenable Nessus

host

This option allows you to include or exclude the local Tenable Nessus host

from the scan. This is used when the Tenable Nessus host falls within the

target network range for the scan.
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Use fast net-

work discovery

When Tenable Nessus pings a remote IP address and receives a reply, it per-

forms extra checks to make sure that it is not a transparent proxy or a load

balancer that would return noise but no result (some devices answer to

every port 1- 65535 even when there is no service behind the device). Such

checks can take some time, especially if the remote host is firewalled. If

Use fast network discovery is enabled, Tenable Nessus does not perform

these checks.

Ping Methods (available when Ping the remote host is enabled)

ARP Ping a host using its hardware address via Address Resolution Protocol

(ARP). This only works on a local network.

TCP Ping a host using TCP.

Destination

ports

Destination ports can be configured to use specific ports for TCP ping. This

option specifies the list of ports that are checked via TCP ping. Type one of

the following:

l a single port

l a comma-separated list of ports

l built-in

For more information about which ports built-in specifies, see the

knowledge base article.

ICMP Ping a host using the Internet Control Message Protocol (ICMP).

Assume ICMP

unreachable

means the host

is down

When a ping is sent to a host that is down, its gateway may return an ICMP

unreachable message. When enabled, this option considers this to mean

the host is dead. This is to help speed up discovery on some networks.

Some firewalls and packet filters use this same behavior for hosts that are

up but are connecting to a port or protocol that is filtered. With this option

enabled, this leads to the scan considering the host is down when it is

indeed up.
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Option Description

Maximum num-

ber of retries

(If you enabled ICMP) Allows you to specify the number of attempts to try to

ping the remote host. The default is two attempts.

UDP Ping a host using the User Datagram Protocol (UDP).

Tip: UDP is a stateless protocol, meaning that communication is not performed
with handshake dialogues. UDP-based communication is not always reliable, and
because of the nature of UDP services and screening devices, they are not
always remotely detectable.

Fragile Devices

Scan Network

Printers

Instructs the Tenable Nessus scanner not to scan network printers if unse-

lected. Since many printers are prone to denial of service condit ions, Ten-

able Nessus can skip scanning them once identif ied. This is recommended

if scanning is performed on production networks.

Scan Novell Net-

ware hosts

Instructs the Tenable Nessus scanner not to scan Novel Netware hosts if

unselected. Since many Novell Netware hosts are prone to denial of service

condit ions, Tenable Nessus can skip scanning them once identif ied. This is

recommended if scanning is performed on production networks.

Scan Oper-

ational Tech-

nology devices

When enabled, Tenable Security Center performs a full scan of Operational

Technology (OT) devices such as programmable logic controllers (PLCs) and

remote terminal units (RTUs) that monitor environmental factors and the

activity and state of machinery.

When disabled, Tenable Security Center uses ICS/SCADA Smart Scanning to

identify OT devices cautiously and stops scanning them once they are dis-

covered.

Wake-on-LAN

List of MAC

addresses

Wake on Lan (WOL) packets will be sent to the hosts listed, one on each

line, in an attempt to wake the specified host(s) during a scan.

Boot time wait

(in minutes)

The number of minutes Tenable Nessus will wait to attempt a scan of hosts

sent a WOL packet.
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Port Scanning Options

Option Description

Ports

Consider

unscanned

ports as closed

If a port is not scanned with a selected port scanner (for example, out of

the range specified), the scanner will consider it closed.

Port scan range Specifies a keyword (default) or a custom port range that you want the

scanner to target.

l Type default to instruct the scanners to scan approximately 4,790

commonly used ports. The list of ports can be found in the nessus-

services file.

l Type all to instruct the scanner to scan all 65,536 ports, including port

0.

l Type a custom port range to instruct the scanners to scan the cus-

tom range of ports. Type a custom port range as a comma-separated

list of ports or port ranges. For example, 21,23,25,80,110 or 1-

1024,8080,9000-9200.

Tenable Security Center applies the custom range to the protocols

you specify in the Local Port Enumerators section. If you want to

scan both TCP and UDP, you can specify a split range specific to each

protocol. For example, if you want to scan a different range of ports

for TCP and UDP in the same policy, type T:1-1024,U:300-500. You

can also specify a set of ports to scan for both protocols, as well as

individual ranges for each separate protocol. For example, 1-

1024,T:1024-65535,U:1025.

Local Port Enumerators

SSH (netstat) When enabled, the scanner uses netstat to check for open ports from the

local machine. It relies on the netstat command being available via an SSH

connection to the target. This scan is intended for Linux-based systems

and requires authentication credentials.
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WMI (netstat) When enabled, the scanner uses netstat to determine open ports while per-

forming a WMI-based scan.

In addit ion, the scanner:

l Ignores any custom range specified in the Port Scan Range sett ing.

l Continues to treat unscanned ports as closed if the Consider

unscanned ports as closed sett ing is enabled.

If any port enumerator (netstat or SNMP) is successful, the port range

becomes all.

SNMP When enabled, if the appropriate credentials are provided by the user, the

scanner can better test the remote host and produce more detailed audit

results. For example, there are many Cisco router checks that determine

the vulnerabilit ies present by examining the version of the returned SNMP

string. This information is necessary for these audits.

Only run net-

work port scan-

ners if local port

enumeration

failed

If a local port enumerator runs, all network port scanners will be disabled

for that asset.

Verify open TCP

ports found by

local port enu-

merators

When enabled, if a local port enumerator (for example, WMI or netstat)

finds a port, the scanner also verifies that the port is open remotely. This

approach helps determine if some form of access control is being used (for

example, TCP wrappers or a firewall).

Network Port Scanners

TCP Use the built-in Tenable Nessus TCP scanner to identify open TCP ports on

the targets, using a full TCP three-way handshake. TCP scans are only pos-

sible if you are using Linux or FreeBSD. On Windows or macOS, the scanner

does not do a TCP scan and instead uses the SYN scanner to avoid per-

formance issues native to those operating systems.If you enable this
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Option Description

option, you can also set the Override Automatic Firewall Detection option.

Note: On some platforms (for example, Windows and Mac OS X), if the operating
system is causing serious performance issues using the TCP scanner, Tenable
Nessus launches the SYN scanner instead.

SYN Use the built-in Tenable Nessus SYN scanner to identify open TCP ports on

the target hosts. SYN scans do not init iate a full TCP three-way handshake.

The scanner sends a SYN packet to the port, waits for SYN-ACK reply, and

determines the port state based on a response or lack of response.

If you enable this option, you can also set the Override Automatic Firewall

Detection option.

Override auto-

matic firewall

detection

Rely on local port enumeration first before relying on network port scans.

UDP This option engages the built-in Tenable Nessus UDP scanner to identify

open UDP ports on the targets.

Due to the nature of the protocol, it is generally not possible for a port scan-

ner to tell the difference between open and filtered UDP ports. Enabling the

UDP port scanner may dramatically increase the scan time and produce

unreliable results. Consider using the netstat or SNMP port enumeration

options instead if possible.

Service Discovery Options

The Service Discovery tab specifies how the scanner looks for services running on the target’s

ports.

Option Description

Probe all ports

to find ser-

vices

When enabled, the scanner attempts to map each open port with the service

that is running on that port, as defined by the Port scan range option.
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Caution: In some rare cases, probing might disrupt some services and cause
unforeseen side effects.

Search for

SSL/TLS ser-

vices

Controls how the scanner tests SSL-based services.

Caution: Testing for SSL capability on all ports may be disruptive for the tested
host.

Search for

SSL/TLS on

Specifies which ports on target hosts the scanner searches for SSL/TLS ser-

vices.

This sett ing has two options:

l Known SSL/TLS ports

l All ports

Search for

DTLS on

Specifies which ports on target hosts the scanner searches for DTLS ser-

vices.

This sett ing has the following options:

l None

l Known SSL/TLS ports

l All TCP ports

Identify cer-

tificates expir-

ing within x

days

Identif ies SSL certif icates that age out within the specified timeframe. Type

a value to set a timeframe (in days).

Enumerate all

SSL/TLS

ciphers

When Tenable Security Center performs an SSL scan, it tries to determine

the SSL ciphers used by the remote server by attempting to establish a con-

nection with each different documented SSL cipher, regardless of what the

server says is available.

Enable CRL Direct Tenable Nessus to check SSL certif icates against known Certif icate
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checking (con-

nects to the

Internet)

Revocation Lists (CRL). Enabling this option makes a connection and query

one or more servers on the internet.

Assessment Options

The Assessment tab specifies how the scanner tests for information during the scan.

Value Description

Accuracy

Override nor-

mal accuracy

In some cases, Tenable Nessus cannot remotely determine whether a flaw is

present or not. If report paranoia is set to Paranoid then a flaw is reported

every time, even when there is a doubt about the remote host being affected.

Conversely, a paranoia sett ing of Avoid false alarms will cause Tenable Nessus

to not report any flaw whenever there is a hint of uncertainty about the remote

host. Normal is a middle ground between these two sett ings.

Perform thor-

ough tests

(may disrupt

your network

or impact

scan speed)

Causes various plugins to use more aggressive sett ings. For example, when

looking through SMB file shares, a plugin can analyze 3 directory levels deep

instead of its default of 1. This could cause much more network traffic and ana-

lysis in some cases. Note that by being more thorough, the scan will be more

intrusive and is more likely to disrupt the network, while potentially providing

better audit results.

Antivirus

Antivirus

definition

grace period

(in days)

This option determines the delay in the number of days of reporting the soft-

ware as being outdated. The valid values are between 0 (no delay, default) and

7.

SMTP

Third party

domain

Tenable Nessus attempts to send spam through each SMTP device to the

address listed in this option. This third party domain address must be outside
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the range of the site being scanned or the site performing the scan. Other-

wise, the test may be aborted by the SMTP server.

From

address

The test messages sent to the SMTP server(s) will appear as if they originated

from the address specified in this option.

To Address Tenable Nessus attempts to send messages addressed to the mail recipient lis-

ted in this option. The postmaster address is the default value since it is a

valid address on most mail servers.

Brute Force Options

The Brute Force tab specifies how the scanner tests for information against SCADA systems.

Addit ionally, if Hydra is installed on the same host as a Tenable Nessus server linked to Tenable

Security Center, the Hydra section is enabled. Hydra extends brute force login testing for the fol-

lowing services: Asterisk, AFP, Cisco AAA, Cisco auth, Cisco enable, CVS, Firebird, FTP, HTTP-

FORM-GET, HTTP-FORM-POST, HTTP-GET, HTTP-HEAD, HTTP-PROXY, HTTPS-FORM-GET, HTTPS-

FORM-POST, HTTPS-GET, HTTPS-HEAD, HTTP-Proxy, ICQ, IMAP, IRC, LDAP, MS-SQL, MYSQL, NCP,

NNTP, Oracle Listener, Oracle SID, Oracle, PC-Anywhere, PCNFS, POP3, POSTGRES, RDP, Rexec, Rlo-

gin, Rsh, S7-300, SAP/R3, SIP, SMB, SMTP, SMTP Enum, SNMP, SOCKS5, SSH (v1and v2), Sub-

version, Teamspeak (TS2), Telnet, VMware-Auth, VNC and XMPP.

Option Description

General Settings

Only use cre-

dentials

provided by the

user

In some cases, Tenable Nessus can test default accounts and known default

passwords. This can cause the account to be locked out if too many con-

secutive invalid attempts trigger security protocols on the operating system

or application. By default, this sett ing is enabled to prevent Tenable Nessus

from performing these tests.

Oracle Database

Test default

Oracle

accounts (slow)

Test for known default accounts in Oracle software.
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Hydra

Always enable

Hydra (slow)

Enables Hydra whenever the scan is performed.

Logins file A file that contains user names that Hydra will use during the scan.

Passwords file A file that contains passwords for user accounts that Hydra will use during

the scan.

Number of par-

allel tasks

The number of simultaneous Hydra tests that you want to execute. By

default, this value is 16.

Timeout (in

seconds)

The number of seconds per login attempt.

Try empty pass-

words

If enabled, Hydra will addit ionally try user names without using a password.

Try login as

password

If enabled, Hydra will addit ionally try a user name as the corresponding pass-

word.

Stop brute for-

cing after the

first success

If enabled, Hydra will stop brute forcing user accounts after the first t ime an

account is successfully accessed.

Add accounts

found by other

plugins to the

login file

If disabled, only the user names specified in the logins file will be used for

the scan. Otherwise, addit ional user names discovered by other plugins will

be added to the logins file and used for the scan.

PostgreSQL

database name

The database that you want Hydra to test.

SAP R3 Client

ID (0 - 99)

The ID of the SAP R3 client that you want Hydra to test.

Windows

accounts to

Can be set to Local accounts, Domain Accounts, or Either.
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test

Interpret pass-

words as NTLM

hashes

If enabled, Hydra will interpret passwords as NTLMhashes.

Cisco login

password

This password is used to login to a Cisco system before brute forcing enable

passwords. If no password is provided here, Hydra will attempt to login using

credentials that were successfully brute forced earlier in the scan.

Web page to

brute force

Type a web page that is protected by HTTP basic or digest authentication. If

a web page is not provided here, Hydra will attempt to brute force a page dis-

covered by the Tenable Nessus web crawler that requires HTTP authen-

tication.

HTTP proxy

test website

If Hydra successfully brute forces an HTTP proxy, it will attempt to access

the website provided here via the brute forced proxy.

LDAP DN The LDAP Distinguish Name scope that Hydra will authenticate against.

Malware Options

The Malware tab specifies options for DNS Resolution, hash, and allowlist files and file system scan-

ning.

Option Description

Malware Scan Settings

Malware scan When enabled, displays the General Settings, Hash and Allowlist Files,

and File System Scanning sections.

General Settings (available when Malware scan is enabled)

Disable DNS Res-

olution

Checking this option will prevent Tenable Nessus from using the

cloud to compare scan findings against known malware.

Hash and Allowlist Files (available when Malware scan is enabled)

Custom Netstat IP A text file that contains a list of known bad IP addresses that you
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Threat List want to detect.

Each line in the file must begin with an IPv4 address. Optionally, you

can add a description by adding a comma after the IP address, fol-

lowed by the description. You can also use hash-delimited comments

(e.g., #) in addit ion to comma-delimited comments.

Note: Tenable does not detect private IP ranges in the text file.

Provide your own list

of known bad

MD5/SHA1/SHA256

hashes

Addit ional known bad MD5 hashes can be uploaded via a text file that

contains one MD5 hash per line.

If you want to add a description for each hash, type a comma after

the hash, followed by the description. If any matches are found when

scanning a target and a description was provided for the hash, the

description will show up in the scan results.

Provide your own list

of known good

MD5/SHA1/SHA256

hashes

Addit ional known good MD5 hashes can be uploaded via a text file

that contains one MD5 hash per line.

If you want to add a description for each hash, type a comma after

the hash, followed by the description. If any matches are found when

scanning a target and a description was provided for the hash, the

description will show up in the scan results.

Hosts file allowlist Tenable Nessus checks system hosts files for signs of a compromise

(e.g., Plugin ID 23910). This option allows you to upload a file con-

taining a list of IPs and hostnames that will be ignored by Tenable

Nessus during a scan. Include one IP address and hostname (format-

ted identically to your hosts file on the target) per line in a regular

text file.

File System Scanning (available when Malware scan is enabled)

Scan file system Turning on this option allows you to scan system directories and files

on host computers.

Caution: Enabling this sett ing in scans targeting 10 or more hosts could
result in performance degradation.
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Directories (available when File System Scanning is enabled)

Scan %Systemroot% Enable file system scanning to scan %Systemroot%.

Scan %Pro-

gramFiles%

Enable file system scanning to scan %ProgramFiles%.

Scan %ProgramFiles

(x86)%

Enable file system scanning to scan %ProgramFiles(x86)%.

Scan %ProgramData% Enable file system scanning to scan %ProgramData%.

Scan User Profiles Enable file system scanning to scan user profiles.

Custom Filescan Dir-

ectories

A custom file that lists directories for malware file scanning. List

each directory on one line.

Caution: Root directories such as C:\ or D:\ are not accepted.

Yara Rules Files A .yar f ile containing the YARA rules to be applied in the scan. You

can only upload one file per scan, so include all rules in a single file.

For more information, see yara.readthedocs.io.

SCADA Options

The SCADA tab specifies how the scanner tests for information against SCADA systems.

Option Description

Modbus/TCP Coil Access

Start at

register

End at

register

These options are available for commercial users. This drop-down box item is

dynamically generated by the SCADA plugins available with the commercial ver-

sion of Tenable Nessus. Modbus uses a function code of 1to read coils in a Mod-

bus slave. Coils represent binary output sett ings and are typically mapped to

actuators. The ability to read coils may help an attacker profile a system and

identify ranges of registers to alter via a write coil message. The defaults for

this are 0 for the Start at register value and 16 for the End at register value.

ICCP/COTP TSAP Addressing Weakness
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Start COTP

TSAP

Stop COTP

TSAP

The ICCP/COTP TSAP Addressing menu determines a Connection Oriented Trans-

port Protocol (COTP) Transport Service Access Points (TSAP) value on an ICCP

server by trying possible values. The start and stop values are set to 8 by

default.

Web Applications Options

The Web Applications tab specifies how the scanner tests for information against web server applic-

ations.

Value Description

Web Application Settings

Scan web

applications

When enabled, displays the General Settings, Web Crawler, and Application

Test Settings sections.

General Settings (available when Scan web applications is enabled)

Use a custom

User-Agent

Specifies which type of web browser Tenable Nessus will impersonate while

scanning.

Web Crawler (available when Scan web applications is enabled)

Start crawling

from

The URL of the first page that will be tested. If mult iple pages are required,

use a colon delimiter to separate them (e.g., / :/php4:/base).

Excluded pages

(regex)

Enable exclusion of portions of the web site from being crawled. For

example, to exclude the /manual directory and all Perl CGI, set this option

to: (̂ /manual)|(\ .pl(\?.*)?$). Tenable Nessus supports POSIX regular expres-

sions for string matching and handling, as well as Perl-compatible regular

expressions (PCRE).

Maximum

pages to crawl

The maximum number of pages to crawl.

Maximum depth

to crawl

Limit the number of links Tenable Nessus will follow for each start page.
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Follow dynam-

ically generated

pages

When enabled, Tenable Nessus will follow dynamic links and may exceed the

parameters set above.

Application Test Settings (available when Scan web applications is enabled)

Enable generic

web application

tests

Enables the Application Test Settings options.

Abort web

application

tests if HTTP

login fails

If Tenable Nessus cannot login to the target via HTTP, then do not run any

web application tests.

Try all HTTP

Methods

This option will instruct Tenable Nessus to also use POST requests for

enhanced web form testing. By default, the web application tests will only

use GET requests, unless this option is enabled. Generally, more complex

applications use the POST method when a user submits data to the applic-

ation. This sett ing provides more thorough testing, but may considerably

increase the time required. When selected, Tenable Nessus will test each

script/variable with both GET and POST requests. This sett ing provides

more thorough testing, but may considerably increase the time required.

Attempt HTTP

Parameter Pol-

lution

When performing web application tests, attempt to bypass filtering mech-

anisms by injecting content into a variable while supplying the same variable

with valid content as well. For example, a normal SQL injection test may

look like /target.cgi?a='&b=2. With HTTP Parameter Pollution (HPP)

enabled, the request may look like /target.cgi?a='&a=1&b=2.

Test embedded

web servers

Embedded web servers are often static and contain no customizable CGI

scripts. In addit ion, embedded web servers may be prone to crash or

become non-responsive when scanned. Tenable recommends scanning

embedded web servers separately from other web servers using this option.

Test more than This option manages the combination of argument values used in the HTTP
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one parameter

at a time per

form

requests. The default, without checking this option, is testing one para-

meter at a time with an attack string, without trying non-attack variations

for addit ional parameters. For example, Tenable Nessus attempts

/test.php?arg1=XSS&b=1&c=1 where b and c allows other values, without

testing each combination. This is the quickest method of testing with the

smallest result set generated.

This drop-down box has five selections:

l One value —This tests one parameter at a time with an attack string,

without trying non-attack variations for addit ional parameters. For

example, Tenable Nessus attempts /test.php?arg1=XSS&b=1&c=1
where b and c allows other values, without testing each combination.

This is the quickest method of testing with the smallest result set gen-

erated.

l Some pairs —This form of testing will randomly check a combination

of random pairs of parameters. This is the fastest way to test mult iple

parameters.

l All pairs (slower but efficient) —This form of testing is slightly slower

but more efficient than the one value test. While testing mult iple para-

meters, it will test an attack string, variations for a single variable and

then use the first value for all other variables. For example, Tenable

Nessus attempts /test.php?arg1=XSS&b=1&c=1 and then cycles

through the variables so that one is given the attack string, one is

cycled through all possible values (as discovered during the mirror pro-

cess) and any other variables are given the first value. In this case,

Tenable Nessus will never test for /test.php?a=XSS&b=3&c=3&d=3
when the first value of each variable is 1.

l Some combinations —This form of testing will randomly check a com-

bination of three or more parameters. This is more thorough than test-

ing only pairs of parameters. Note that increasing the amount of

combinations by three or more increases the web application test
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t ime.

l All combinations (extremely slow) —This method of testing will do a

fully exhaustive test of all possible combinations of attack strings with

valid input to variables. Where All-pairs testing seeks to create a smal-

ler data set as a tradeoff for speed, all combinations makes no com-

promise on time and uses a complete data set of tests. This testing

method may take a long time to complete.

Do not stop

after the first

flaw is found

per web page

This option determines when a new flaw is targeted. This applies at the

script level; finding an XSS flaw will not disable searching for SQL injection

or header injection, but you will have at most one report for each type on a

given port, unless thorough tests is set. Note that several flaws of the same

type (e.g., XSS, SQLi, etc.) may be reported sometimes, if they were caught

by the same attack. The drop-down has four options:

l Per CGI —As soon as a flaw is found on a CGI by a script, Tenable Nes-

sus switches to the next known CGI on the same server, or if there is

no other CGI, to the next port/server. This is the default option.

l Per port (faster) —As soon as a flaw is found on a web server by a

script, Tenable Nessus stops and switches to another web server on a

different port.

l Per parameter (slow) —As soon as one type of flaw is found in a para-

meter of a CGI (e.g., XSS), Tenable Nessus switches to the next para-

meter of the same CGI, or the next known CGI, or to the next

port/server.

l Look for all flaws (slower) —Perform extensive tests regardless of

flaws found. This option can produce a very verbose report and is not

recommend in most cases.

URL for

Remote File

Inclusion

During Remote File Inclusion (RFI) testing, this option specifies a file on a

remote host to use for tests. By default, Tenable Nessus will use a safe file

hosted by Tenable for RFI testing. If the scanner cannot reach the Internet,
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using an internally hosted file is recommended for more accurate RFI test-

ing.

Maximum run

time (minutes)

This option manages the amount of t ime in minutes spent performing web

application tests. This option defaults to 60 minutes and applies to all ports

and CGIs for a given web site. Scanning the local network for web sites with

small applications will typically complete in under an hour, however web

sites with large applications may require a higher value.

Windows Options

The Windows tab specifies basic Windows SMB domain options.

Option Description

General Settings

Request inform-

ation about the

SMB Domain

When enabled, Tenable Nessus queries domain users instead of local

users.

User Enumeration Methods

SAM Registry When enabled, Tenable Nessus enumerates users via the Security Account

Manager (SAM) registry.

ADSI Query When enabled, Tenable Nessus enumerates users via Active Directory Ser-

vice Interfaces (ADSI). To use ADSI, you must also configure

ADSI authentication options.

WMI Query When enabled, Tenable Nessus enumerates users via Windows Man-

agement Interface (WMI).

RID Brute For-

cing

When enabled, Tenable Nessus enumerates users via relative identif ier

(RID) brute forcing. Enabling this sett ing enables the Enumerate Domain

User and Enumerate Local User options.

Enumerate Domain Users (available when RID Brute Forcing is enabled)
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Start UID 1000

End UID 1200

Enumerate Local Users (available when RID Brute Forcing is enabled)

Start UID 1000

End UID 1200

Report Options

The Report tab specifies information to include in the scan’s report.

Option Description

Processing

Override normal

verbosity

Determines the verbosity of the detail in the output of the scan results:

l Normal —Provides the standard level of plugin activity in the report.

l Quiet —Provides less information about plugin activity in the report

to minimize impact on disk space.

l Verbose —Provides more information about plugin activity in the

report. When this option is selected, the output includes the inform-

ational plugins 56310, 64582, and 58651.

Show missing

patches that

have been super-

seded

Show patches in the report that have not been applied but have been

superseded by a newer patch if enabled.

Hide results from

plugins initiated

as a dependency

If a plugin is only run due to it being a dependency of a selected plugin,

hide the results if enabled.

Output

Designate hosts When possible, designate hosts by their DNS name rather than IP address
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Option Description

by their DNS

name

in the reports.

Display hosts that

respond to ping

When enabled, show a list of hosts that respond to pings sent as part of

the scan.

Display unreach-

able hosts

Display a list of hosts within the scan range that were not able to be

reached during the scan, if enabled.

Display Unicode

characters

When enabled, Unicode characters appear in plugin output such as user-

names, installed application names, and SSL certif icate information.

Note: Plugin output may sometimes incorrectly parse or truncate strings with
Unicode characters. If this issue causes problems with regular expressions in
plugins or custom audits, disable this sett ing and scan again.

Generate SCAP

XML Results

Generate a SCAP XML results file as a part of the report output for the

scan.

Authentication Options

The Authentication tab specifies authentication options during a scan.

Option Description

Authentication

Type Specifies the type of authentication you want scanners to use for cre-

dentialed access to scan targets. Credentialed access gathers more com-

plete data about a target.

l Host

l Database Credentials

l Miscellaneous

l Plaintext Authentication

l Patch Management
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Option Description

SNMP

UDP Port

Additional UDP

port #1

Additional UDP

port #2

Additional UDP

port #3

This is the UDP port that will be used when performing certain SNMP

scans. Up to four different ports may be configured, with the default port

being 161.

SSH

known_hosts file If an SSH known_hosts file is provided for the scan policy, Tenable Nes-

sus will only attempt to log in to hosts defined in this file. This helps to

ensure that the same username and password you are using to audit your

known SSH servers is not used to attempt a login to a system that may

not be under your control.

Preferred port This option is set to direct the scan to connect to a specific port if SSH is

known to be listening on a port other than the default of 22.

Client version Specifies which type of SSH client to impersonate while performing

scans.

Attempt least priv-

ilege (exper-

imental)

Enables or disables dynamic privilege escalation. When enabled, if the

scan target credentials include privilege escalation, Tenable Nessus first

attempts to run commands without privilege escalation. If running com-

mands without privilege escalation fails, Tenable Nessus retries the com-

mands with privilege escalation.

Plugins 102095 and 102094 report whether plugins ran with or without

privilege escalation.

Note: Enabling this option may increase the time required to perform scans
by up to 30%.
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Option Description

Windows

Never send cre-

dentials in the

clear

By default, Windows credentials are not sent to the target host in the

clear.

Do not use

NTLMv1authen-

tication

When disabled, it is theoretically possible to trick Tenable Nessus into

attempting to log in to a Windows server with domain credentials via the

NTLMversion 1protocol. This provides the remote attacker with the abil-

ity to use a hash obtained from Tenable Nessus. This hash can be poten-

tially cracked to reveal a username or password. It may also be used to

directly log in to other servers.

Because NTLMv1is an insecure protocol, this option is enabled by

default.

Start the Remote

Registry service

during the scan

This option tells Tenable Nessus to start the Remote Registry service on

computers being scanned if it is not running. This service must be run-

ning in order for Tenable Nessus to execute some Windows local check

plugins.

Enable admin-

istrative shares

during the scan

This option will allow Tenable Nessus to access certain registry entries

that can be read with administrator privileges.

Start the Server

service during the

scan

When enabled, the scanner temporarily enables the Windows Server ser-

vice, which allows the computer to share files and other devices on a net-

work. The service is disabled after the scan completes.

By default, Windows systems have the Windows Server service enabled,

which means you do not need to enable this sett ing. However, if you dis-

able the Windows Server service in your environment, and want to scan

using SMB credentials, you must enable this sett ing so that the scanner

can access files remotely.

Plaintext Authentication
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Option Description

Perform patch

audits over telnet

When enabled, Tenable Security Center uses telnet to connect to the

host device for patch audits.

Note: This protocol is sent in cleartext and could contain unencrypted user-
names and passwords.

Perform patch

audits over rsh

When enabled, Tenable Security Center permits patch audits over a rsh

connection.

Note: This protocol is sent in cleartext and could contain unencrypted user-
names and passwords.

Perform patch

audits over rexec

When enabled, Tenable Security Center permits patch audits over a rexec

connection.

Note: This protocol is sent in cleartext and could contain unencrypted user-
names and passwords.

HTTP

Login method Specify whether the login action is performed via a GET or POST request.

Re-authenticate

delay (seconds)

The delay between authentication attempts, in seconds.

Tip: A time delay can help prevent triggering brute force lockout mechanisms.

Follow 30x redir-

ections (# of

levels)

If a 30x redirect code is received from a web server, this directs Tenable

Nessus to follow the link provided or not.

Invert authen-

ticated regex

The regex pattern you want Tenable Security Center to look for on the

login page that, if found, denies authentication.

Tip: Tenable Security Center can attempt to match a given string, such as
Authentication failed.

Use authen- When enabled, Tenable Security Center searches the HTTP response
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Option Description

ticated regex on

HTTP headers

headers for a given regex pattern instead of searching the body of a

response to better determine authentication state.

Case insensitive

authenticated

regex

When enabled, Tenable Security Center ignores case in regex.

Compliance Options

The Compliance tab specifies compliance the audit files to reference in a scan policy. The options

available depend on the type of audit file selected.

For more information, see Audit Files and Configure Compliance Options.

Option Description

Generic

SSH Escalation

command

(Generic SSH audits only) The command to use for accomplishing the priv-

ilege escalation. This is similar to the enable command for Cisco devices.

Generic

SSH Escalation

success check

(Generic SSH audits only) A regular expression that must match after the

escalation has succeeded. This can be the prompt or any other message

notifying the success of privilege escalation.

Plugins Options

The Plugins tab specifies which plugins are used during the policy’s Tenable Nessus scan. You can

enable or disable plugins in the plugin family view or in the plugin view for more granular control.

For more information, see Configure Plugin Options.

Caution: The Denial of Service plugin family contains plugins that could cause outages on network hosts if
the Safe Checks option is not enabled, but it also contains useful checks that do not cause any harm. The
Denial of Service plugin family can be used in conjunction with Safe Checks to ensure that any potentially
dangerous plugins are not run. However, Tenable does not recommend enabling the Denial of Service plu-
gin family in production environments.
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Configure Compliance Options

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can configure compliance options within a scan policy to reference one or more audit files in a

template-based Policy Compliance Auditing scan policy or a custom scan policy.

For more information, see Audit Files, Scan Policies, and Scan Policy Options.

To configure compliance options for a scan policy:

1. Begin configuring a scan policy, as described in Add a Scan Policy.

2. In the left navigation bar, click Compliance.

The Compliance options appear.

3. Click + Add Audit File.

The Select a Type drop-down box appears.

4. In the Select a Type drop-down box, select the type of audit file you want to reference in the

scan policy.

The Select an Audit File drop-down box appears.

5. In the Select an Audit File drop-down box, select the name of the audit file you want to ref-

erence in the scan policy.

6. Click the button.

Tenable Security Center applies the audit file to the scan policy.

7. If required, configure addit ional options for the audit file you applied to the scan policy. For

more information, see Compliance Options.

- 510 -

https://docs.tenable.com/security-center/Content/UserRoles.htm


Configure Plugin Options

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can configure plugin options within a scan policy to enable or disable plugins at the plugin fam-

ily level or individual plugin level.

Note: When Tenable adds new plugins to Tenable Security Center, Tenable Security Center automatically
enables the new plugins if the entire plugin family they belong to is enabled in your scan policy template. If
you only enabled some plugins from a family, you must manually enable new plugins to include them in your
scan policy.

To configure plugin options at the plugin family level:

1. Begin configuring a scan, policy as described in Add a Scan Policy.

2. In the left navigation bar, click Plugins.

The Plugins page appears with the plugin family view displayed.

3. In the Status column, view the plugin family status and the number of enabled plugins within

the plugin family:

l Enabled —All plugins in the family are enabled. The scan targets the parameters in the

plugins.

l Disabled —All plugins in the family are disabled. The scan does not target the para-

meters in the plugins.

Note: Disabling a plugin family reduces the time and resources required to run the scan.

l Mixed —The plugin family contains a combination of Enabled and Disabled plugins.

4. In the Total column, view the number of plugins in the family.

5. To enable or disable all plugins in the family, click the Status box.

6. To filter the plugin families listed on the page, use the Select a Filter drop-down box to build

and apply a filter.
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The Total column becomes the Matched column and indicates the number of plugins in the

family that match the current filter.

7. To hide all disabled plugin families, click Hide Disabled.

8. If you hid all disabled plugin families and you want to show them again, click Show All.

9. To sort the plugin families listed on the page, click the Status, Plugin Family, or Total column

tit le.

10. To perform a bulk action on all of the plugin families displayed on the page, click Enable

Shown or Disable Shown.

Tenable Security Center enables or disables all plugins within the plugin families shown on the

page, not just the number of plugins in the Total or Matched column. For more granular con-

trol, set plugin statuses in the plugin view.

11. To enable or disable individual plugins within a family, click the plugin family name to access

the plugin view.

The plugin view appears.

To configure plugin options at the individual plugin level:

1. Begin configuring a scan policy as described in Add a Scan Policy.

2. Click Plugins in the left navigation bar.

The Plugins page appears.

3. Click the plugin family name.

The plugin view appears.

4. In the Status column, view the plugin status:

l Enabled —The plugin is enabled. The scan targets the parameters in the plugins.

l Disabled —The plugin is disabled. The scan does not target the parameters in the plu-

gins.

Disabling a plugin family reduces the time and resources required to run the scan.

5. In the Plugin ID column, click the information icon to display the plugin details.
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6. To enable or disable a plugin, click the Status box.

7. To filter the plugins listed on the page, use the Select a Filter drop-down box to build and

apply a filter.

8. To hide all disabled plugins, click Hide Disabled.

9. If you hid all disabled plugins and you want to show them again, click Show All.

10. To sort the plugins listed on the page, click the Status, Plugin Name, or Plugin ID column tit le.

11. To perform a bulk action on all of the plugins displayed on the page, click Enable Shown or Dis-

able Shown.

Tenable Security Center enables or disables all plugins shown on the page.

12. To return to the plugin family view, click the Back option.

13. To view the plugins in a different family, click the drop-down box and select a different plugin

family.
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Host

Tenable Security Center can use SNMPv3 credentials to scan remote systems that use an encrypted

network management protocol (including network devices). Tenable Security Center uses these cre-

dentials to scan for patch audit ing or compliance checks.

You can configure SNMPv3 options in scan policies, as described in Authentication Options and Add

a Scan Policy.

SNMPv3 Options

Option Description Default

Username The username for the SNMPv3 account that Ten-

able Security Center uses to perform checks on

the target system.

-

Port (Required) The TCP port that SNMPv3 listens on for

communications from Tenable Security Center.

161

Security Level The security level for SNMP:

l No authentication and no privacy

l Authentication without privacy

l Authentication and privacy

Authentication

and privacy

Authentication

algorithm

The algorithm the remove service supports: MD5 or

SHA1.

SHA1

Authentication

password

The password associated with the Username. -

Privacy algorithm The encryption algorithm to use for SNMP traffic:

AES or DES.

AES

Privacy password A password used to protect encrypted SNMP com-

munication.

-
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Miscellaneous

Tenable Security Center supports the following addit ional authentication methods:

l ADSI

l F5

l IBM iSeries

l Red Hat Enterprise Virtualization (RHEV)

l Netapp API

l Palo Alto Networks PAN-OS

l VMware ESX SOAP API

l VMware vCenter SOAP API

l X.509

You can configure these authentication methods in scan policies, as described in Authentication

Options and Add a Scan Policy.

ADSI

ADSI allows Tenable Security Center to query an ActiveSync server to determine if any Android or

iOS-based devices are connected. Using the credentials and server information, Tenable Security

Center authenticates to the domain controller (not the Exchange server) to directly query it for

device information. These sett ings are required for mobile device scanning and Active Directory

Starter Scans.

Tenable Security Center supports obtaining the mobile information from Exchange Server 2010 and

2013 only.

Option Description Default

Domain Con-

troller

(Required) The name of the domain controller for Act-

iveSync.

-

Domain (Required) The name of the NetBIOS domain for ActiveSync. -
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Option Description Default

Domain Admin (Required) The domain administrator's username. -

Domain Pass-

word

(Required) The domain administrator's password. -

F5

Option Description Default

Username (Required) The username for the scanning F5 account that

Tenable Security Center uses to perform checks on the target

system.

-

Password (Required) The password for the F5 user. -

Port (Required) The TCP port that F5 listens on for com-

munications from Tenable Security Center.

443

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

enabled

Verify SSL

Certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this sett ing.

enabled

IBM iSeries

Option Description Default

Username (Required) The username for the IBM iSeries account that Ten-

able Security Center uses to perform checks on the target sys-

tem.

-

Password (Required) The password for the IBM iSeries user. -
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Red Hat Enterprise Virtualization (RHEV)

Option Description Default

Username (Required) The username for RHEV account that Tenable

Security Center uses to perform checks on the target system.

-

Password (Required) The password for the RHEV user. -

Port (Required) The TCP port that the RHEV server listens on for

communications from Tenable Security Center.

443

Verify SSL

Certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this sett ing.

enabled

Netapp API

Option Description Default

Username (Required) The username for the Netapp API account with

HTTPS access that Tenable Security Center uses to perform

checks on the target system.

-

Password (Required) The password for the Netapp API user. -

vFiler The vFiler nodes to scan for on the target systems.

To limit the audit to a single vFiler, type the name of the vFiler.

To audit for all discovered Netapp virtual filers (vFilers) on tar-

get systems, leave the field blank.

-

Port (Required) The TCP port that Netapp API listens on for com-

munications from Tenable Security Center.

443

Palo Alto Networks PAN-OS
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Option Description Default

Username (Required) The username for the PAN-OS account that Ten-

able Security Center uses to perform checks on the target sys-

tem.

-

Password (Required) The password for the PAN-OS user. -

Port (Required) The TCP port that PAN-OS listens on for com-

munications from Tenable Security Center.

443

Verify SSL

Certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this sett ing.

enabled

VMware ESX SOAP API

For more information about configuring VMWare ESX SOAP API, see Configure vSphere Scanning.

Tenable Security Center can access VMware servers through the native VMware SOAP API.

Option Description Default

Username (Required) The username for the ESXi server account that

Tenable Security Center uses to perform checks on the target

system.

-

Password (Required) The password for the ESXi user. -

Do not verify

SSL Cer-

t if icate

Do not validate the SSL certif icate for the ESXi server. disabled

VMware vCenter SOAP API

For more information about configuring VMWare vCenter SOAP API, see Configure vSphere Scan-

ning.
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Tenable Security Center can access vCenter through the native VMware vCenter SOAP API. If avail-

able, Tenable Security Center uses the vCenter REST API to collect data in addit ion to the SOAP API.

Note: The SOAP API requires a vCenter admin account with read and write permissions. The
REST API requires a vCenter admin account with read permissions, and a VMware vSphere Lifecycle man-
ager account with read permissions.

Option Description Default

vCenter Host (Required) The name of the vCenter host. -

vCenter Port (Required) The TCP port that vCenter listens on for com-

munications from Tenable Security Center.

443

Username (Required) The username for the vCenter server account with

admin read/write access that Tenable Security Center uses to

perform checks on the target system.

-

Password (Required) The password for the vCenver server user. -

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS). When disabled, Tenable

Security Center connects using standard HTTP.

enabled

Verify SSL

Certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this sett ing.

enabled

X.509

Option Description Default

Client Certif icate (Required) The client cert if icate. -

Client Key (Required) The client private key. -

Password (Required) The passphrase for the client private key. -

CA Certif icate to

Trust

(Required) The trusted Certif icate Authority's (CA) digital

cert if icate.

-
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Plaintext Authentication

Caution: Tenable does not recommend plaintext credentials. Instead, use encrypted authentication meth-
ods when possible.

If a secure method of performing credentialed checks is not available, you can configure Tenable

Security Center to perform checks over unsecure protocols using plaintext authentication sett ings.

Tenable Security Center supports the following plaintext authentication methods:

l telnet/ rsh/ rexec

l NNTP

l FTP

l POP2

l POP3

l IMAP

l IPMI

l HTTP

You can configure plaintext authentication options in scan policies, as described in Authentication

Options and Add a Scan Policy.

telnet/ rsh/ rexec

Tenable Security Center performs patch audit ing on non-Windows targets only.

Setting Description Default

Username (Required) The username for the telnet, rsh, or rexec account

that Tenable Security Center uses to perform checks on the tar-

get system.

-

Password

(Unsafe!)

(Required) The password for the telnet, rsh, or rexec user. -

NNTP
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Setting Description Default

Username (Required) The username for the NNTP account that Tenable

Security Center uses to perform checks on the target system.

-

Password (Required) The password for the NNTP user. -

FTP

Setting Description Default

Username (Required) The username for the FTP account that Tenable

Security Center uses to perform checks on the target system.

-

Password (Required) The password for the FTP user. -

POP2

Setting Description Default

Username (Required) The username for the POP2 account that Tenable

Security Center uses to perform checks on the target system.

-

Password (Required) The password for the POP2 user. -

POP3

Setting Description Default

Username (Required) The username for the POP3 account that Tenable

Security Center uses to perform checks on the target system.

-

Password (Required) The password for the POP3 user. -

IMAP

Setting Description Default

Username (Required) The username for the IMAP account that Tenable -
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Security Center uses to perform checks on the target system.

Password (Required) The password for the IMAP user. -

IPMI

Setting Description Default

Username (Required) The username for the IMPI account that Tenable

Security Center uses to perform checks on the target system.

-

Password

(Sent in Clear)

(Required) The password for the IPMI user. -

HTTP

Setting Description Default

Authentication

Method

(Required) The authentication method.

l Automatic authentication

l Basic/Digest authentication

l HTTP login form —Controls the start location of

authenticated testing of a custom web-based

application.

l HTTP cookies import —Tenable Security Center

uses cookies imported from another piece of

software (such as a web browser or web proxy)

to facilitate web application testing by using

when attempting to access a web application.

HTTP Login

Form

Username (Required) The username for the HTTP account that

Tenable Security Center uses to perform checks on

the target system.

–

Password (Required) The password for the HTTP user. –
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Setting Description Default

Login page (Required) The absolute path to the application login

page. For example, /login.html.

–

Login submission

page

(Required) The action parameter for the form method.

For example, for <form method="POST" name-
e="auth_form" action="/login.php">, use /lo-
gin.php.

–

Login parameters (Required) The authentication parameters (for

example, login=%USER%&password=%PASS%).

Tenable Security Center replaces the %USER% and

%PASS% keywords with values supplied on the Login

configurations drop-down menu.

Tip: If needed, you can provide addit ional parameters,
such as a group name or other information required for
authentication.

–

Check authen-

tication on page

(Required) The absolute path of a protected web page

that requires authentication. For example, /ad-
min.html.

–

Regex to verify

successful authen-

tication

(Required) The regex pattern you want Tenable Secur-

ity Center to look for on the login page to validate

authentication.

Tip: Tenable Security Center can attempt to match a
given string, such as Authentication successful.

–

Cookies file (Required) A cookie file in Netscape cookies.txt
format.

–
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Patch Management

Tenable Security Center can leverage credentials for patch management systems to perform patch

audit ing on systems for which credentials may not be available to Nessus Professional or managed

scanners.

Tenable Security Center supports:

l Dell KACE K1000

l HCL BigFix

l Microsoft System Center Configuration Manager (SCCM)

l Microsoft Windows Server Update Services (WSUS)

l Red Hat Satellite Server

l Symantec Alt iris

You can configure patch management options in scan policies, as described in Authentication

Options and Add a Scan Policy.

IT administrators are expected to manage the patch monitoring software and install any agents

required by the patch management system on their systems.

Note: If the credential check sees a system but it is unable to authenticate against the system, it uses the
data obtained from the patch management system to perform the check. If Tenable Security Center is able
to connect to the target system, it performs checks on that system and ignores the patch management
system output.

Note: The data returned to Tenable Security Center by the patch management system is only as current as
the most recent data that the patch management system has obtained from its managed hosts.

Scanning with Mult iple Patch Managers

If you provide mult iple sets of credentials to Tenable Security Center for patch management tools,

Tenable Security Center uses all of them.

If you provide credentials for a host and for one or more patch management systems, Tenable

Security Center compares the findings between all methods and report on conflicts or provide a sat-
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isfied finding. Use the Patch Management Windows Audit ing Conflicts plugins to highlight patch

data differences between the host and a patch management system.

Dell KACE K1000

KACE K1000 is available from Dell to manage the distribution of updates and hotfixes for Linux, Win-

dows, and macOS systems. Tenable Security Center can query KACE K1000 to verify whether or not

patches are installed on systems managed by KACE K1000 and display the patch information

through the Tenable Security Center user interface.

Tenable Security Center supports KACE K1000 versions 6.x and earlier.

KACE K1000 scanning uses the following Tenable plugins: 76867, 76868, 76866, and 76869.

Option Description Default

Server (Required) The KACE K1000 IP address or system name. -

Database Port (Required) The TCP port that KACE K1000 listens on for com-

munications from Tenable Security Center.

3306

Organization

Database Name

(Required) The name of the organization component for the

KACE K1000 database (e.g., ORG1).

ORG1

Database User-

name

(Required) The username for the KACE K1000 account that

Tenable Security Center uses to perform checks on the tar-

get system.

R1

K1000 Database

Password

(Required) The password for the KACE K1000 user. -

HCL BigFix

HCL Bigfix is available to manage the distribution of updates and hotfixes for desktop systems. Ten-

able Security Center can query HCL Bigfix to verify whether or not patches are installed on systems

managed by HCL Bigfix and display the patch information.

Package reporting is supported by RPM-based and Debian-based distributions that HCL Bigfix offi-

cially supports. This includes Red Hat derivatives such as RHEL, CentOS, Scientif ic Linux, and

Oracle Linux, as well as Debian and Ubuntu. Other distributions may also work, but unless

HCL Bigfix officially supports them, there is no support available.
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For local check plugins to trigger, only RHEL, CentOS, Scientif ic Linux, Oracle Linux, Debian,

Ubuntu, and Solaris are supported. Plugin 160250 must be enabled.

Tenable Security Center supports HCL Bigfix 9.5 and later and 10.x and later.

HCL Bigfix scanning uses the following Tenable plugins: 160247, 160248, 160249, 160250, and

160251.

Option Description Default

Web Reports

Server

(Required) The name of HCL Bigfix Web Reports server. -

Web Reports

Port

(Required) The TCP port that the HCL Bigfix Web Reports

server listens on for communications from Tenable Security

Center.

-

Web Reports

Username

(Required) The username for the HCL Bigfix Web Reports

administrator account that Tenable Security Center uses to

perform checks on the target system.

-

Web Reports

Password

(Required) The password for the HCL Bigfix Web Reports

administrator user.

-

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

Enabled

Verify SSL

certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this sett ing.

Enabled

HCL Bigfix Server Configuration

In order to use these audit ing features, you must make changes to the HCL Bigfix server. You must

import a custom analysis into HCL Bigfixso that detailed package information is retrieved and made

available to Tenable Security Center.

From the HCL BigFix Console application, import the following .bes f iles.
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BES file:

<?xml version="1.0" encoding="UTF-8"?>
<BES xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:noNamespaceSchemaLocation="BES.xsd">

<Analysis>
<Title>Tenable</Title>
<Description>This analysis provides SecurityCenter with the data it needs for vulnerability reporting. </Description>
<Relevance>true</Relevance>
<Source>Internal</Source>
<SourceReleaseDate>2013-01-31</SourceReleaseDate>
<MIMEField>

<Name>x-fixlet-modification-time</Name>
<Value>Thu, 13 May 2021 21:43:29 +0000</Value>

</MIMEField>
<Domain>BESC</Domain>
<Property Name="Packages - With Versions (Tenable)" ID="74"><![CDATA[if (exists true whose (if true then (exists object

repository) else false)) then unique values of (lpp_name of it & "|" & version of it as string & "|" & "fileset" & "|" & archi-
tecture of operating system) of filesets of products of object repository else if (exists true whose (if true then (exists debi-
anpackage) else false)) then unique values of (name of it & "|" & version of it as string & "|" & "deb" & "|" & architecture of
it & "|" & architecture of operating system) of packages whose (exists version of it) of debianpackages else if (exists true
whose (if true then (exists rpm) else false)) then unique values of (name of it & "|" & version of it as string & "|" & "rpm" &
"|" & architecture of it & "|" & architecture of operating system) of packages of rpm else if (exists true whose (if true then
(exists ips image) else false)) then unique values of (full name of it & "|" & version of it as string & "|" & "pkg" & "|" &
architecture of operating system) of latest installed packages of ips image else if (exists true whose (if true then (exists
pkgdb) else false)) then unique values of(pkginst of it & "|" & version of it & "|" & "pkg10") of pkginfos of pkgdb else
"<unsupported>"]]></Property>

<Property Name="Tenable AIX Technology Level" ID="76">current technology level of operating system</Property>
<Property Name="Tenable Solaris - Showrev -a" ID="77"><![CDATA[if ((operating system as string as lowercase contains

"SunOS 5.10" as lowercase) AND (exists file "/var/opt/BESClient/showrev_patches.b64")) then lines of file "/var/-
opt/BESClient/showrev_patches.b64" else "<unsupported>"]]></Property>

</Analysis>
</BES>

BES file:

<?xml version="1.0" encoding="UTF-8"?>
<BES xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:noNamespaceSchemaLocation="BES.xsd">

<Task>
<Title>Tenable - Solaris 5.10 - showrev -a Capture</Title>
<Description><![CDATA[&lt;enter a description of the task here&gt; ]]></Description>
<GroupRelevance JoinByIntersection="false">

<SearchComponentPropertyReference PropertyName="OS" Comparison="Contains">
<SearchText>SunOS 5.10</SearchText>
<Relevance>exists (operating system) whose (it as string as lowercase contains "SunOS

5.10" as lowercase)</Relevance>
</SearchComponentPropertyReference>

</GroupRelevance>
<Category></Category>
<Source>Internal</Source>
<SourceID></SourceID>
<SourceReleaseDate>2021-05-12</SourceReleaseDate>
<SourceSeverity></SourceSeverity>
<CVENames></CVENames>
<SANSID></SANSID>
<MIMEField>

<Name>x-fixlet-modification-time</Name>
<Value>Thu, 13 May 2021 21:50:58 +0000</Value>
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</MIMEField>
<Domain>BESC</Domain>
<DefaultAction ID="Action1">

<Description>
<PreLink>Click </PreLink>
<Link>here</Link>
<PostLink> to deploy this action.</PostLink>

</Description>
<ActionScript MIMEType="application/x-sh"><![CDATA[#!/bin/sh

/usr/bin/showrev -a > /var/opt/BESClient/showrev_patches
/usr/sfw/bin/openssl base64 -in /var/opt/BESClient/showrev_patches -out /var/opt/BESClient/showrev_
patches.b64

]]></ActionScript>
</DefaultAction>

</Task>
</BES>

Microsoft System Center Configuration Manager (SCCM)

Microsoft System Center Configuration Manager (SCCM) is available to manage large groups of Win-

dows-based systems. Tenable Security Center can query the SCCMservice to verify whether or not

patches are installed on systems managed by SCCMand display the patch information through the

scan results.

Tenable Security Center connects to the server that is running the SCCMsite (e.g., credentials must

be valid for the SCCMservice, so the selected user must have privileges to query all the data in the

SCCMMMC). This server may also run the SQL database, or the database and the SCCMrepository

can be on separate servers. When leveraging this audit, Tenable Security Center must connect to

the SCCMserver via WMI and HTTPS.

SCCMscanning uses the following Tenable plugins: 57029, 57030, 73636, and 58186.

Note: SCCMpatch management plugins support SCCM2007, SCCM2012, SCCM2016, and SCCM2019.

Credential Description Default

Server (Required) The SCCMIP address or system name. -

Domain (Required) The name of the SCCMserver's domain. -

Username (Required)  The username for the SCCM user account that Ten-

able Security Center uses to perform checks on the target sys-

tem. The user account must have privileges to query all data in

-
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Credential Description Default

the SCCM MMC.

Password (Required) The password for the SCCMuser with privileges to

query all data in the SCCM MMC.

-

Windows Server Update Services (WSUS)

Windows Server Update Services (WSUS) is available from Microsoft to manage the distribution of

updates and hotfixes for Microsoft products. Tenable Security Center can query WSUS to verify

whether or not patches are installed on systems managed by WSUS and display the patch inform-

ation through the Tenable Security Center user interface.

WSUS scanning uses the following Tenable plugins: 57031, 57032, and 58133.

Option Description Default

Server (Required) The WSUS IP address or system name. -

Port (Required) The TCP port that Microsoft WSUS listens on

for communications from Tenable Security Center.

8530

Username (Required) The username for the WSUS administrator

account that Tenable Security Center uses to perform

checks on the target system.

-

Password (Required) The password for the WSUS administrator

user.

-

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

Enabled

Verify

SSL Certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this
sett ing.

Enabled
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Red Hat Satellite Server

Red Hat Satellite is a systems management platform for Linux-based systems. Tenable Security

Center can query Satellite to verify whether or not patches are installed on systems managed by

Satellite and display the patch information.

Although not supported by Tenable, the Red Hat Satellite plugin also works with Spacewalk Server,

the Open Source Upstream Version of Red Hat Satellite. Spacewalk can manage distributions based

on Red Hat (RHEL, CentOS, Fedora) and SUSE. Tenable supports the Satellite server for Red Hat

Enterprise Linux.

Satellite scanning uses the following Tenable plugins: 84236, 84235, 84234, 84237, and 84238.

Option Description Default

Satellite

Server

(Required) The Red Hat Satellite IP address or system name. -

Port (Required) The TCP port that Red Hat Satellite listens on for

communications from Tenable Security Center.

443

Username (Required) The username for the Red Hat Satellite account

that Tenable Security Center uses to perform checks on the

target system.

-

Password (Required) The password for the Red Hat Satellite user. -

Verify SSL

Certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this set-
t ing.

Enabled

Red Hat Satellite 6 Server

Red Hat Satellite 6 is a systems management platform for Linux-based systems. Tenable Security

Center can query Satellite to verify whether or not patches are installed on systems managed by

Satellite and display the patch information.

Although not supported by Tenable, the Red Hat Satellite 6 plugin also works with Spacewalk

Server, the Open Source Upstream Version of Red Hat Satellite. Spacewalk can manage
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distributions based on Red Hat (RHEL, CentOS, Fedora) and SUSE. Tenable supports the Satellite

server for Red Hat Enterprise Linux.

Red Hat Satellite 6 scanning uses the following Tenable plugins: 84236, 84235, 84234, 84237, 84238,

84231, 84232, and 84233.

Option Description Default

Satellite Server (Required) The Red Hat Satellite 6 IP address or system

name.

-

Port (Required) The TCP port that Red Hat Satellite 6 listens

on for communications from Tenable Security Center.

443

Username (Required) The username for the Red Hat Satellite 6

account that Tenable Security Center uses to perform

checks on the target system.

-

Password (Required) The password for the Red Hat Satellite 6 user. -

HTTPS When enabled, Tenable Security Center connects using

secure communication (HTTPS).

When disabled, Tenable Security Center connects using

standard HTTP.

Enabled

Verify

SSL Certif icate

When enabled, Tenable Security Center verifies that the

SSL certif icate on the server is signed by a trusted CA.

Tip: If you are using a self-signed certif icate, disable this
sett ing.

Enabled

Symantec Alt iris

Altiris is available from Symantec to manage the distribution of updates and hotfixes for Linux, Win-

dows, and macOS systems. Tenable Security Center has the ability to use the Alt iris API to verify

whether or not patches are installed on systems managed by Alt iris and display the patch inform-

ation through the Tenable Security Center user interface.
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Tenable Security Center connects to the Microsoft SQL server that is running on the Alt iris host.

When leveraging this audit, if the MSSQL database and Alt iris server are on separate hosts, Tenable

Security Center must connect to the MSSQL database, not the Alt iris server.

Alt iris scanning uses the following Tenable plugins: 78013, 78012, 78011, and 78014.

Credential Description Default

Server (Required) The Alt iris IP address or system name. -

Database Port (Required) The TCP port that Alt iris listens on for com-

munications from Tenable Security Center.

5690

Database Name (Required) The name of the MSSQL database that man-

ages Alt iris patch information.

Symantec_

CMDB

Database User-

name

(Required) The username for the Alt iris MSSQL data-

base account that Tenable Security Center uses to per-

form checks on the target system. Credentials must be

valid for a MSSQL databas account with the privileges

to query all the data in the Alt iris MSSQL database.

-

Database Pass-

word

(Required) The password for the Alt iris MSSQL data-

base user.

-

Use Windows

Authentication

When enabled, use NTLMSSP for compatibility with

older Windows Servers.

When disabled, use Kerberos.

Enabled
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View Your Scan Policies

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Scan Policies.

To view a list of configured scan policies:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. View details about each scan policy.

l Name —The name of the scan policy.

l Tag —The tag applied to the scan policy.

l Type —The name of the template used to add the scan policy.

l Group —The group associated with the scan policy.

l Owner —The username for the user associated with the scan policy.

l Last Modified —The date and time the scan policy was last modified.
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View Scan Policy Details

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can view details for individual scan policies. For more information, see Scan Policies.

To view details of a scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. In the row for the scan policy you want to view, click the menu.

The actions menu appears.

4. Click View.

The View Policy page appears.

Section Action

General View general information for the scan policy.

l Name —The name of the scan policy.

l Description —The description for the scan policy.

l Tag —The tag applied to the scan policy.

l Type —The name of the template used to add the scan policy.

l Created —The date and time the scan policy was added.

l Last Modified —The date and time the scan policy was last

modified.

l Owner —The username for the user associated with the scan

policy.

l Group —The group associated with the scan policy.
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Section Action

l ID —The scan policy ID.

Configuration (Template-based policies only) View a summary of options con-

figured for the scan policy. For more information, see Scan Policy

Options.

Options tabs View all of the options configured for the scan policy. The tabs dis-

played depend on the scan policy type. For more information, see

Scan Policy Options.
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Edit a Scan Policy

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Scan Policies.

To edit a scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. In the row for the scan policy you want to edit, click the menu.

The actions menu appears.

4. Click Edit.

The Edit Policy page appears.

5. Modify the scan policy. For more information, see Scan Policy Options.

6. Click Submit.

Tenable Security Center saves your configuration.
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Share or Revoke Access to a Scan Policy

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can share or revoke access to a scan policy to allow or restrict access to a user group. When

you share a scan policy with a user group, users in the group with the appropriate permissions can

use the policy in an active scan, modify policy options, and more.

For more information, see Scan Policies. For more information about user groups, see Groups.

To share or revoke access to a scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. In the row for the scan policy for which you want to share or revoke access, click the

menu.

The actions menu appears.

4. Click Share.

The Share Policy window appears.

5. In the Share Policy window, select the groups for which you want to share or revoke access to

the scan policy.

6. Click Submit.

Tenable Security Center saves your configuration.
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Export a Scan Policy

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can export a scan policy as a .nessus f ile and import it to another Tenable Security Center to

use in an active scan configuration.

In some cases, Tenable Support may also ask you to export a scan policy for troubleshooting.

Note: Exported scan policy files do not include audit files or credentials. You can re-configure audit files
and credentials you want to use with the scan policy on the Tenable Security Center where you import the
scan policy. For more information, see Audit Files and Credentials.

For more information, see Scan Policies.

Before you begin:

l Add a scan policy, as described in Add a Scan Policy.

l Confirm your PHP Serialization Mode sett ing is set to PHP Serialization ON. For more inform-

ation, see Security Sett ings.

To export a scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. In the row for the scan policy you want to export, click the menu.

The actions menu appears.

4. Click Export.

Tenable Security Center exports the scan policy as a .xml f ile.

What to do next:
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l Do any of the following:

o Import the scan policy into another Tenable Security Center, as described in Import a

Scan Policy.

o If Tenable Support requested a scan policy file for troubleshooting, share the scan policy

file with Tenable Support.
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Import a Scan Policy

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can import a .nessus scan policy file from Tenable Nessus or from another Tenable Security

Center to use in an active scan configuration. For more information, see Scan Policies.

Note: Imported scan policies do not include audit files or credentials. For more information, see Audit Files
and Credentials.

Before you begin:

l Ensure your PHP Serialization Mode sett ing is PHP Serialization ON. For more information, see

Security Sett ings.

l Do one of the following:

o Export a scan policy from another Tenable Security Center, as described in Export a

Scan Policy.

o Export a scan policy from Tenable Nessus. For more information, see Policies in the Ten-

able Nessus User Guide.

To import a scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. In the top right corner of the page, click Options.

The options menu appears.

4. Click Upload Policy.

The Upload Policy page appears.

5. In the Name box, type a name for the scan policy.

6. (Optional) In the Description box, type a description for the scan policy.
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7. (Optional) In the Tag box, type or select a tag for the scan policy.

8. Click Choose File and browse to the .nessus scan policy file you want to import.

9. Click Submit.

Tenable Security Center imports the scan policy.

What to do next:

l (Optional) Modify the scan policy sett ings, as described in Edit a Scan Policy.

l (Optional) Configure audit files and credentials you wish to reference with the scan policy, as

described in Add a Custom Audit File and Add Credentials.

l Reference the scan policy in an active scan configuration, as described in Add an Active Scan.
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Copy a Scan Policy

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Scan Policies.

To create a copy of a scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. In the row for the scan policy you want to copy, click the menu.

The actions menu appears.

4. Click Copy.

Tenable Security Center copies the scan policy. The copy appears, named Copy of

PolicyName.
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Delete a Scan Policy

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Scan Policies.

Note: If you delete a scan policy referenced by an active scan, Tenable Security Center disables the scan.
For more information, see Scan Result Statuses.

Before you begin:

l If any active scans reference the scan policy you intend to delete, update the active scans to

use a different scan policy, as described in Manage Active Scans.

To delete a scan policy:

1. Log in to Tenable Security Center via the user interface.

2. Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

The Policies page appears.

3. In the row for the scan policy you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the scan policy.
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Agent Scanning

To perform agent scanning, Tenable Security Center fetches agent scan results from agent-capable

Tenable Nessus Manager or Tenable Vulnerability Management instances. Using Tenable Nessus

Agents for scanning reduces network usage and allows devices to maintain their scan schedules

even when disconnected from the network. Tenable Security Center fetches these results for

review with other acquired information about the host and network.

You can configure one or both methods of fetching agent scan results in Tenable Security Center:

l Agent scans fetch results from agent scans you add and launch in Tenable Security Center.

When you add an agent scan in Tenable Security Center, Tenable Security Center creates a

corresponding agent scan in an instance of Tenable Nessus Manager or Tenable Vulnerability

Management that you linked to Tenable Security Center. When you launch an agent scan in

Tenable Security Center, Tenable Security Center launches the corresponding scan in Tenable

Nessus Manager or Tenable Vulnerability Management, then imports the results into Tenable

Security Center.

You can create agent scans in Tenable Security Center using the Advanced Agent Scan tem-

plate. For more information, see Scan Policy Templates.

For more information, see Agent Scans.

l Agent synchronization jobs fetch results from agent scans you previously created and

launched in Tenable Nessus Manager or Tenable Vulnerability Management.

Agent synchronization jobs can fetch results from agent scans configured in Tenable Nessus

Manager or Tenable Vulnerability Management using any agent scan template.

For more information, see Agent Synchronization Jobs.

To configure agent scanning:

1. Configure Tenable Nessus Agents in either Tenable Nessus Manager or Tenable Vulnerability

Management, as described in Deployment Workflow in the Tenable Nessus Agent Deployment

and User Guide.

2. Add your agent-capable Tenable Nessus Manager or Tenable Vulnerability Management

instance as a Tenable Nessus scanner in Tenable Security Center, as described in Tenable
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Nessus Scanners.

3. Add one or more agent repositories in Tenable Security Center, as described in Add a Repos-

itory.

4. Do one or both of the following:

l Add an agent scan using the Basic Agent Scan or Advanced Agent Scan template in Ten-

able Security Center, as described in Add an Agent Scan.

l Add an agent synchronization job in Tenable Security Center, as described in Add an

Agent Synchronization Job.

What to do next: 

l View scan results, as described in Scan Results.

l View vulnerability data by unique Agent ID, as described in Vulnerability Analysis.
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Agent Scans

Agent scans fetch results from agent scans you add and launch in Tenable Security Center. When

you add an agent scan in Tenable Security Center, Tenable Security Center creates a corresponding

agent scan in an instance of Tenable Nessus Manager or Tenable Vulnerability Management that you

linked to Tenable Security Center. When you launch an agent scan in Tenable Security Center, Ten-

able Security Center launches the corresponding scan in Tenable Nessus Manager or Tenable Vul-

nerability Management, then imports the results into Tenable Security Center.

You can create agent scans in Tenable Security Center using the Advanced Agent Scan template.

For more information, see Scan Policy Templates.

For more information about agent scanning in Tenable Security Center, see Agent Scanning.

The Agent Scans page displays a list of all available agent scans. Tenable Security Center shares

newly created agent scan import schedules to everyone within the same user group when users

have the appropriate permissions.

When more than one agent scan result is ready on Tenable Vulnerability Management or Tenable

Nessus Manager, the scan results queue for import to Tenable Security Center.

For more information about agent scans, see:

l Add an Agent Scan

l Agent Scan Settings

l Manage Agent Scans
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Add an Agent Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can create agent scans in Tenable Security Center using the Advanced Agent Scan template.

For more information, see Scan Policy Templates.

For more information, see Agent Scans and Agent Scan Settings.

Before you begin:

l Confirm you understand the complete agent scanning configuration process, as described in

Agent Scanning.

l (Optional) Configure an Advanced Agent Scan policy template, as described in Add a Scan

Policy.

To add an agent scan:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Agent Scans.

The Agent Scans page appears.

3. Click Add.

The Add Agent Scan page appears.

4. Click General.

5. Type a Name for the scan.

6. (Optional) Type a Description for the scan.

7. (Optional) To reference an Advanced Agent Scan policy in the scan:

a. Click Custom Policy to enable the toggle.

b. In the Policy drop-down menu, select the Advanced Agent Scan policy.

8. Select an Agent Scanner.
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9. Select one or more Agent Groups.

10. Select a Scan Window.

11. (Optional) Select a Schedule for the scan.

12. Click Settings.

13. Select an Import Repository for the scan.

14. (Optional) Click Post Scan.

l If you want to configure automatic report generation, click Add Report. For more inform-

ation, see Add a Report to a Scan.

15. Click Submit.

Tenable Security Center saves your configuration.

What to do next: 

l View scan results, as described in Scan Results.

l View vulnerability data by unique Agent ID, as described in Vulnerability Analysis.
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Manage Agent Scans

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information about agent scans, see Agent Scans.

To manage agent scans:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Agent Scans.

The Agent Scans page appears.

3. To filter the scans that appear on the page, apply a filter as described in Apply a Filter.

4. To start or pause a scan, see Start or Pause a Scan.

5. To view details for a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click View.

The View Agent Scan page appears.

6. To edit a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click Edit.

The Edit Agent Scan page appears.

c. Modify the scan options. For more information, see Agent Scan Settings.

d. Click Submit.

Tenable Security Center saves your configuration.
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7. To delete a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click Delete.

Tenable Security Center deletes the scan.
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Start or Pause a Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To start or pause an active scan, agent scan, or agent synchronization job:

1. Log in to Tenable Security Center.

2. Click one of the following:

l Scans > Active Scans (to manage active scans)

l Scans > Agent Synchronization Jobs (to manage agent synchronization jobs)

l Scans > Agent Scans (to manage agent scans)

l Scans > Scan Results (to manage a scan from the results page).

3. Do one of the following:

l To pause the scan or synchronization job, click the pause button on the right side of the

scan or synchronization job row.

l To start the scan or synchronization job, click the start button on the right side of the

scan or synchronization job row.
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Agent Scan Settings

For more information, see Agent Scans.

l General Options

l Settings Options

l Post Scan Options

General Options

Parameter Description Default

General

Name The scan name associated with the scan’s results. This may

be any name or phrase (for example, SystemA, DMZ Scan, or

Daily Scan of the Web Farm).

--

Description Descriptive information related to the scan. --

Custom Policy When enabled, select an agent scan policy to apply to the

scan. For more information, see Scan Policy Templates.

When disabled, the scan uses a Tenable Nessus or Tenable

Vulnerability Management Basic Agent Scan template. For

more information, see Agent Scan and Policy Templates in

the Tenable Nessus Agent Deployment and User Guide and

Tenable-Provided Agent Templates in the Tenable Vul-

nerability Management User Guide.

Disabled

Policy (If Custom Policy is enabled) The name of the agent scan

policy.

--

Agent Scanner The Agent-enabled scanner from which to retrieve agent res-

ults.

--

Agent Groups Specifies the agent group or groups in Tenable Nessus Man-

ager you want the scan to target. For more information, see

--
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Parameter Description Default

Agent Groups in the Tenable Nessus User Guide.

Scan Window Specifies the amount of t ime Tenable Security Center waits

before fetching the results of the agent scan: 15 minutes, 30

minutes, 1hour, 3 hours, 6 hours, 12 hours, or 1day.

If Tenable Security Center fetches results for the scan

before the scan completes, Tenable Security Center displays

the results available at the time the scan window expired.

The agent scan continues to run in Tenable Vulnerability Man-

agement or Tenable Nessus Manager during the scan win-

dow specified in Tenable Vulnerability Management or

Tenable Nessus Manager, even if the scan window in Ten-

able Security Center expires.

Note: To view complete agent scan result data in Tenable
Security Center, Tenable recommends sett ing a Scan Window
value that allows your agent scans to complete before Tenable
Security Center fetches the results.

1hour

Schedule

Schedule The frequency you want Tenable Security Center to fetch

agent scan results: Now, Remediation, Once, Daily, Weekly,

Monthly, or On Demand.

Note: If you schedule your scan to repeat monthly, Tenable
recommends sett ing a start date no later than the 28th day. If
you select a start date that does not exist in some months
(e.g., the 29th), Tenable Security Center cannot run the scan on
those days.

Tip: Retrieve agent scan results as close to the completion
time of the scan as possible to most accurately display within
Tenable Security Center when the scan discovered the vul-
nerability results.

On Demand
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Settings Options

Parameter Description Default

Import Repos-

itory

Specifies the repository where you want the agent scan results

to import. Select an agent repository to receive scan data.

Note: You cannot import agent scan data to a non-agent repos-
itory.

--

Post Scan Options

These options determine what actions occur immediately before and after the agent scan com-

pletes.

Option Description Default

Add

Report

This option provides a list of reports available to the user to run

when the agent scan data import completes. For more inform-

ation, see Add a Report to a Scan.

--
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Agent Synchronization Jobs

Agent synchronization jobs fetch results from agent scans you previously created and launched in

Tenable Nessus Manager or Tenable Vulnerability Management. Agent synchronization jobs can

fetch results from agent scans configured in Tenable Nessus Manager or Tenable Vulnerability Man-

agement using any agent scan template. For more information about agent scanning in Tenable

Security Center, see Agent Scanning.

The Agent Synchronization Jobs page displays a list of all available agent synchronization jobs. Ten-

able Security Center shares newly created agent scan import schedules to everyone within the

same user group when users have the appropriate permissions.

When more than one agent scan result is ready on Tenable Nessus Manager, the scan results queue

for import to Tenable Security Center.

For more information about agent synchronization jobs, see:

l Add an Agent Synchronization Job

l Agent Synchronization Job Settings

l Manage Agent Synchronization Jobs
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Add an Agent Synchronization Job

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information about agent synchronization jobs, see Agent Synchronization Jobs. For more

information about agent synchronization job options, see Agent Synchronization Job Settings.

Before you begin:

l Confirm you understand the complete agent scanning configuration process, as described in

Agent Scanning.

To add an agent synchronization job:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Agent Synchronization Jobs.

The Agent Synchronization Jobs page appears.

3. Click Add.

The Add Agent Synchronization Job page appears.

4. Click General.

5. Type a Name for the agent synchronization job.

6. (Optional) Type a Description for the agent synchronization job.

7. Select an Agent Scanner.

8. Type an Agent Scan Name Filter.

9. (Optional) If you want to limit the scan results fetched by Tenable Security Center, enable

Scan Result Threshold and select a date and time to specify the oldest scan results you want

Tenable Security Center to fetch.

10. (Optional) Select a Schedule for the agent synchronization job.

11. Click Settings.

12. Select an Import Repository for the agent synchronization job.
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13. (Optional) Click Post Scan.

l If you want to configure automatic report generation, click Add Report. For more inform-

ation, see Add a Report to a Scan.

l If you previously added an email address to your account profile and you want to con-

figure email notif ications, enable or disable E-Mail Me on Launch or E-Mail Me on Com-

pletion.

14. Click Submit.

Tenable Security Center saves your configuration.

What to do next: 

l View scan results, as described in Scan Results.

l View vulnerability data by unique Agent ID, as described in Vulnerability Analysis.
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Manage Agent Synchronization Jobs

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Agent Synchronization Jobs.

To manage agent synchronization jobs:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Agent Synchronization Jobs.

The Agent Synchronization Jobs page appears.

3. To filter the agent synchronization jobs that appear on the page, apply a filter as described in

Apply a Filter.

4. To start or pause an agent synchronization job, see Start or Pause a Scan.

5. To view details for an agent synchronization job:

a. In the row for the agent synchronization job, click the menu.

The actions menu appears.

b. Click View.

The View Agent Synchronization Job page appears.

6. To edit an agent synchronization job:

a. In the row for the agent synchronization job, click the menu.

The actions menu appears.

b. Click Edit.

The Edit Agent Synchronization Job page appears.

c. Modify the agent synchronization job options. For more information, see Agent Syn-

chronization Job Settings.

d. Click Submit.
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Tenable Security Center saves your configuration.

7. To copy an agent synchronization job:

a. In the row for the agent synchronization job, click the menu.

The actions menu appears.

b. Click Copy.

Tenable Security Center creates a copy of the agent synchronization job.

8. To delete an agent synchronization job:

a. In the row for the agent synchronization job, click the menu.

The actions menu appears.

b. Click Delete.

Tenable Security Center deletes the agent synchronization job.
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Agent Synchronization Job Settings

For more information, see Agent Synchronization Jobs.

l General Options

l Settings Options

l Post Scan Options

General Options

Option Description

Name The agent synchronization job name associated with the scan’s results. This

may be any name or phrase (e.g., SystemA, DMZ Scan, Daily Scan of the Web

Farm, etc.).

Description A description for the agent synchronization job.

Agent Scanner The agent-capable scanner from which you want Tenable Security Center to

retrieve agent results.

Agent Scan

Name Filter

A filter for agent scan results to retrieve from the Tenable Nessus Agent-

enabled scanner. Filters can use the specific name of the result(s) to retrieve

or an asterisk (*) or question mark (?) for all or part of the scan result name(s)

to retrieve. You can find the available agent scans retrieved from the selec-

ted scanner on the Scan page of the user logged in to the Nessus server.

You can click the Preview Filter button to view results that match the filter.

Scan Result

Threshold

Specifies whether Tenable Security Center fetches all or some agent scan

results from the agent-capable scanner.

l When disabled, Tenable Security Center fetches all agent scan results.

l When enabled, Tenable Security Center restricts the agent scan results

it fetches.

Note: You cannot modify the Scan Result Threshold after init ial creation of the
agent synchronization job.
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Option Description

After you create the agent synchronization job, the Edit Agent Syn-

chronization Job and View Agent Synchronization Job pages display the Last

Fetched date to indicate when Tenable Security Center performed the most

recent successful agent synchronization job.

Select Date

and Time

When Scan Result Threshold is enabled, specifies the oldest agent scan res-

ults you want Tenable Security Center to fetch.

Schedule The frequency you want Tenable Security Center to fetch agent scan results.

Select Now, Once, Daily, Weekly, Monthly, On Demand, or Dependent to cre-

ate an agent scan result retrieval template that you can launch manually at

any time. The other time frames allow you to retrieve agent scan results at

specified times and intervals.

Tenable recommends retrieving agent scan results as close to the com-

pletion time of the scan as possible to most accurately display within Ten-

able Security Center when the scan discovered the vulnerability results. For

more information about how Tenable Security Center determines vul-

nerability discovery dates, see Vulnerability Discovered.

Note: If you schedule your scan to repeat monthly, Tenable recommends sett ing
a start date no later than the 28th day. If you select a start date that does not
exist in some months (e.g., the 29th), Tenable Security Center cannot run the
scan on those days.

Settings Options

Parameter Description

Import Repos-

itory

Specifies the agent repository where you want the agent scan results to

import.

Note: You cannot import agent scan data to a non-agent repository.

Post Scan Options
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These options determine what actions occurs immediately before and after the agent syn-

chronization job completes. The table below describes the post agent synchronization job options

available to users:

Option Description

Add

Report

This option provides a list of reports available to the user to run when the agent

scan data import completes.

The init ial choices are to click the group and owner of the report to present a list

of valid report options. Next, click the report from the list that can be searched

using the text search box. When hovering over a report name, you can select the

information icon to display the name and description of the report. You can base

the generated report on the current scan’s results or the results in the Cumu-

lative database.

Selecting the check mark causes the report to launch once the agent syn-

chronization job completes. Selecting the X removes the changes. Once added,

you can modify or delete the report information.
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Freeze Windows

You can set a freeze window in Tenable Security Center to specify a time frame when you do not

want Tenable Security Center to scan specific targets. This prevents remediation or ad-hoc scans

from scanning assets during undesired time frames, such as during production hours. For more

information about what happens to in-progress scans at the start of a freeze window, see the know-

ledge base article.

Freeze windows are organizational and affect all scans in the creating user’s organization. Only

users with the Manage Freeze Windows permission can add, edit, or delete freeze windows.

Note: If you configure a freeze window in Tenable Security Center, it will not stop Agent scans. To stop
Agent scans, configure a freeze window in each Tenable Nessus Manager.

For more information, see Add a Freeze Window, Edit a Freeze Window, and Delete a Freeze Win-

dow.

Option Description

Name A name for the freeze window.

Description (Optional) A description for the freeze window.

Enabled When enabled, Tenable Security Center does not scan any assets that

are affected by the freeze window. If a scan does not include any

assets outside of the freeze window, then the scan will abort.

When disabled, Tenable Security Center scans all assets as scheduled.

Targets Specifies the targets you do not want to scan during the freeze win-

dow.

l All Systems —Tenable Security Center does not scan any assets.

l Assets —Tenable Security Center does not scan specific

Tenable-provided or user-defined asset lists.

l IPs —Tenable Security Center does not scan specific

IP addresses.

l Mixed —Tenable Security Center does not scan a combination of
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Option Description

IP addresses and/or Tenable-provided or user-defined asset

lists.

Note: If you select an Import Repository later in the configuration, Tenable
Security Center applies your Target selections only to scans configured
with that import repository. Scans configured with other import repos-
itories still run and scan targeted assets, regardless of your freeze window
Targets selection.

Assets If you selected Assets or Mixed as the Targets, specifies one or more

Tenable-provided or user-defined asset lists that you do not want to

scan during the freeze window.

IPs If you selected IPs or Mixed as the Targets, specifies one or more

asset IP addresses that you do not want to scan during the freeze win-

dow.

ImportRepository (Optional) If you selected Assets, IPs, or Mixed as your Targets, spe-

cifies whether you want to restrict the freeze window to apply to scans

configured with a specific import repository.

l If you select a repository, Tenable Security Center applies the

freeze window to scans with the repository configured.

l If you do not select a repository, Tenable Security Center does

not restrict the freeze by repository.

Starts On

Frequency

Repeat Every

Repeat On

Specifies a schedule for the freeze window.
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Add a Freeze Window

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information about configuration options, see Freeze Windows.

To add a freeze window:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Freeze Windows.

The Freeze Windows page appears.

3. Click Add.

The Add Freeze Window page appears.

4. In the Name box, type a name for the freeze window.

5. In the Description box, type a description for the freeze window.

6. Confirm the Enabled toggle is enabled.

7. In the Targets drop-down box, select a target: All Systems, Assets, IPs, or Mixed.

Addit ional options appear based on the targets you specified.

8. In the Assets and/or IPs boxes, select or type targets for the freeze window.

9. (Optional) If you selected Assets or Mixed as the Targets and you want to restrict the freeze

window by scan repository, in the Repository section, select a repository.

10. Modify the Starts On, Frequency, Repeat Every, and Repeat On options to set the schedule for

the freeze window.

11. Click Submit.

Tenable Security Center saves your configuration.
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Edit a Freeze Window

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Freeze Windows.

To edit a freeze window:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Freeze Windows.

The Freeze Windows page appears.

3. In the row for the freeze window you want to edit, click the menu.

The actions menu appears.

4. Click Edit.

The Edit Freeze Window page appears.

5. To disable the freeze window, click the Enabled slider.

6. To edit the freeze window sett ings, modify options described in Edit a Freeze Window.

7. Click Submit.

Tenable Security Center saves your configuration.
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Delete a Freeze Window

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Freeze Windows.

To delete a freeze window:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Freeze Windows.

The Freeze Windows page appears.

3. In the row for the freeze window you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the freeze window.
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Tags

You can use tags in Tenable Security Center to label assets, policies, credentials, or queries with a

custom descriptor to improve filtering and object management. For example, you could add a tag

named East Coast Employees to label all of your assets in that geographic area.

After you create a tag and apply it to an object, the tag is visible to all users who can view or modify

that object. However, tags are not shared across object types.

For more information, see Add a Tag and Remove or Delete a Tag.
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Add a Tag

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Tags.

To add a tag:

1. Log in to Tenable Security Center.

2. Navigate to the assets, policies, credentials, or queries page:

l Click Assets > Assets.

l Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

l Click Scanning > Credentials (administrator users) or Scans > Credentials (organizational

users).

l Click Analysis > Queries.

3. In the row for the asset, policy, credential, or query you want to tag, click the menu.

The actions menu appears.

4. Click Edit.

5. In the Tag drop-box, select an existing tag or type a new tag.

6. Click Submit.

The tag appears, applied to the asset, policy, credential, or query.
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Remove or Delete a Tag

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can remove a tag from an asset, policy, credential, or query to stop associating that object with

the tag. To completely delete a tag from Tenable Security Center, you must remove the tag from all

assets, policies, credentials, or queries. For more information, see Tags.

To remove a tag or completely delete a tag from Tenable Security Center:

1. Log in to Tenable Security Center via the user interface.

2. Navigate to the assets, policies, credentials, or queries page:

l Click Assets > Assets.

l Click Scanning > Policies (administrator users) or Scans > Policies (organizational users).

l Click Scanning > Credentials (administrator users) or Scans > Credentials (organizational

users).

l Click Analysis > Queries.

3. In the row for the asset, policy, credential, or query where you want to remove the tag, click
the menu.

The actions menu appears.

4. Click Edit.

5. In the Tag drop-box, remove the tag from the asset, policy, credential, or query.

6. Click Submit.

Tenable Security Center removes the tag from the asset, policy, credential, or query.

7. (Optional) If you want to delete the tag from Tenable Security Center, repeat steps 2 through 6

until you have removed all uses of the tag for the object type.

Tenable Security Center deletes the tag.
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Analyze Data

See the following sections to analyze and respond to Tenable Security Center data.

Analysis Tool Description

Scan Results View a table of scan results from active and agent scans.

Dashboards View graphical summaries of scans, scan results, and system activity.

Solutions Ana-

lysis

View recommended solutions for all vulnerabilit ies on your network.

Vulnerability

Analysis

View a table of cumulative or mitigated vulnerability data.

Event Analysis View a table of Tenable Log Correlation Engine security event data.

Mobile Analysis View a table of vulnerability data discovered by scanning an ActiveSync,

Apple Profile Manager, AirWatch, Good, or MobileIron MDMserver.

Reports Create custom or template-based reports to export Tenable Security Center

data for further analysis.

Assurance

Report Cards

Create ARCs to develop security program objectives and assess your organ-

ization's security posture.

You can use Filters and Queries to manipulate the data you see in analysis tools and save views for

later access. You can perform Workflow Actions (alert ing, t icketing, accepting risk, recasting risk)

from some analysis tools.

If you are licensed for Tenable Lumin, you can synchronize Tenable Security Center with Tenable

Lumin to take advantage of Cyber Exposure features, as described in Tenable Lumin Syn-

chronization. For more information, contact your Tenable representative.
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Dashboards

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

Administrator users can view Tenable-provided Overview and LCE Overview dashboards. For more

information, see Overview Dashboard and LCE Overview Dashboard.

Organizational users can configure custom or template-based dashboards that contain dashboard

components, which display vulnerability, event, t icket, user, and alert data for analysis. When view-

ing vulnerability or event data, you can drill into the underlying dataset for further evaluation.

Tip: Tenable provides many dashboard templates (for example, the VPR Summary dashboard). For a com-
plete index of Tenable-provided dashboard templates, see the Tenable Security Center Dashboards blog.

Dashboards allow you to organize similar dashboard components to streamline your analysis.

Instead of creating a single dashboard with several dozen dashboard components, you can create

several dashboards that group similar dashboard components together. For example, you can cre-

ate two separate dashboards to view active scanning data and passive scanning data.

Note: Dashboards display vulnerability, event, and other scan data. Tenable recommends configuring sev-
eral data sources to optimize the data you see in dashboards. For more information, see Scanning Over-
view.

Tip: Tenable Security Center automatically refreshes dashboard data once per day. To refresh all dash-
board components on demand as an organizational user, click Refresh All.

For more information, see:

l View a Dashboard

l Add a Template-Based Dashboard

l Add a Custom Dashboard

l Import a Dashboard

l Manage Dashboards

l Manage Dashboard Components
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Dashboard Options

Option Description

General

Name The name of the dashboard.

Description (Optional) A description for the dashboard.

Layout The number and arrangement of dashboard columns.
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View a Dashboard

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

For more information, see Dashboards.

To view a dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears, displaying your default dashboard.

3. If you want to switch to a different dashboard:

a. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

b. Click the dashboard you want to view.

The dashboard appears.

If you are an organizational user, you can:

l Add a dashboard component to the dashboard in view, as described in Add a Tem-

plate-Based Dashboard Component or Add a Custom Dashboard Component.

l Manage dashboard components on the dashboard in view, as described in Manage

Dashboard Components.

l Edit the dashboard sett ings for the dashboard in view, as described in Edit Set-

t ings for a Dashboard.

l Share or revoke access to the dashboard in view, as described in Share or Revoke

Access to a Dashboard.

l Create a report from the dashboard in view:
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a. In the upper-right corner of the page, click the Options drop-down box.

b. Click Send to Report.

For more information about reports, see Reports.

l Delete the dashboard in view, as described in Delete a Dashboard.
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Overview Dashboard

Tenable provides the Overview dashboard to administrator users by default. For more information,

see View a Dashboard.

Widget Action

Licensing Status

How close am I to hitt ing my

license limit?

View a graph of your total license size compared to your total

currently active IP addresses.

Repository Statistics

How am I using my repos-

itories?

View information about your repositories:

l Name —The name of the repository.

l Vuln Count —The number of vulnerability instances in

the repository.

Tip: A vulnerability instance is a single instance of a vul-
nerability appearing on an asset, identif ied uniquely by plu-
gin ID, port, and protocol.

l Last Update —The date and time of the most recent

scan that updated the repository data.

l IP/Device Count —The number of IP addresses in the

repository counting toward your Tenable Security Center

license.

l Type —The repository type.

l Data Format —The type of data stored in the

repository: IPv4, IPv6, Mobile, or Agent.

System Status

Is the Tenable Security

Center job daemon running?

l View the status of the job daemon, which powers the job

queue.

l To change the status of the job daemon, click Start or

Stop.

Tenable Security Center changes the status of the job
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Widget Action

daemon.

Scanner Status

What is the status of my

scanners?

View information about your scanners:

l Name —The name of the scanner or instance.

l Type —The type of connection: Passive or Active.

l Status —The status of the scanner or instance.

Latest Plugins

What plugins were most

recently changed in a feed

update?

View information about the latest plugin changes in feed

updates.

l ID —The plugin ID.

l Name —The name of the plugin.

l Family —The plugin family.

l Type —The plugin type.

l Date —The date and time of the feed update that con-

tained the plugin change.
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LCE Overview Dashboard

Tenable provides the LCE Overview dashboard to administrator users by default. For more inform-

ation, see View a Dashboard.

Widget Action

LCE Status

What is the status of my Ten-

able Log Correlation Engine

servers?

View information about your Tenable Log Correlation

Engine server:

l Name —The name of the Tenable Log Correlation

Engine server.

l Status —The status of the Tenable Log Correlation

Engine server.

LCE Client Status

What is the status of my Ten-

able Log Correlation

Engine clients?

View information about your Tenable Log Correlation

Engine clients:

l Client IP —The IP address of the Tenable Log Cor-

relation Engine client.

l LCE —The Tenable Log Correlation Engine server asso-

ciated with the Tenable Log Correlation Engineclient.

l Last Update —The date and time of the most recent

Tenable Log Correlation Engine client import to Ten-

able Security Center.

l Status —The status of the Tenable Log Correlation

Engine client.
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Set a Dashboard as Your Default Dashboard

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Dashboards.

To set a dashboard as your default dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears, displaying your default dashboard.

3. If you want to switch to a different dashboard:

a. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

b. Click the dashboard you want to view.

The dashboard appears.

4. In the upper-right corner of the page, click the Options drop-down box.

5. Click Set as Default.

The system sets the dashboard as your default.
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Add a Template-Based Dashboard

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can add a dashboard by configuring a Tenable-provided dashboard template. To add a custom

dashboard instead, see Add a Custom Dashboard. To import a dashboard, see Import a Dashboard.

For more information, see Dashboards and Dashboard and Component Templates.

To add a template-based dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears.

3. In the upper-right corner of the page, click the Options drop-down button.

4. Click Add Dashboard

The Dashboard Templates page appears.

5. In the Common section, click a template category tile.

The Add Dashboard Template page appears.

6. Click a template.

The Add Dashboard Template page updates to reflect the template you selected.

7. Modify the dashboard template:

l To edit the dashboard name, click the name box and edit the name.

l To edit the dashboard description, click the Description box and edit the description.

l To restrict the target data displayed in the dashboard, click the Targets drop-down box.

l To edit the dashboard refresh schedule, click the Schedule link.

8. Click Add.

Tenable Security Center saves your configuration and the Dashboards page appears.
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9. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

10. Click the name of the dashboard you just created.

The page for the dashboard appears.

What to do next:

l Add dashboard components, as described in Add a Template-Based Dashboard Component or

Add a Custom Dashboard Component.
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Add a Custom Dashboard

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can add a fully customized dashboard. To add a dashboard from a Tenable-provided template

instead, see Add a Template-Based Dashboard.

For more information, see Dashboards.

To add a custom dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears.

3. In the upper-right corner of the page, click the Options drop-down button.

4. Click Add Dashboard

The Dashboard Templates page appears.

5. In the Other section, click the Advanced t ile.

6. In the Name box, type a name for the dashboard.

7. In the Description box, type a description for the dashboard.

8. In the Layout section, select the layout you want to use for the dashboard.

9. Click Submit.

Tenable Security Center saves your configuration and the Dashboards page appears.

10. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

11. Click the name of the dashboard you just created.

The page for the dashboard appears.

What to do next:
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l Add dashboard components, as described in Add a Template-Based Dashboard Component or

Add a Custom Dashboard Component.
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Dashboard and Component Templates

Tenable Security Center provides a selection of dashboards and dashboard component templates.

You can configure a Tenable-provided dashboard template or you can create a fully customized

dashboard. For more information, see Dashboards and Custom Dashboard Component Options.

For a complete index of Tenable-provided report templates, see the Tenable Security Center Dash-

boards blog.

Template Description

Common

Compliance & Configuration

Assessment

Dashboards that aid with configuration, change, and com-

pliance management.

Discovery & Detection Dashboards that aid in trust identif ication, rogue detection,

and new device discovery.

Executive Dashboards that provide operational insight and metrics

geared towards executives.

Monitoring Dashboards that provide intrusion monitoring, alert ing, and

analysis.

Security Industry Trends Dashboards related to trends, reports, and analysis from

industry leaders.

Threat Detection

& Vulnerability Assessments

Dashboards that aid with identifying vulnerabilit ies and

potential threats.

Other (Dashboards)

Advanced A custom dashboard with no pre-configured sett ings.

Import Import a dashboard. For more information, see Import a

Dashboard.

Other (Dashboard Components)

Table Add a table to your dashboard.
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Bar Chart Add a bar chart to your dashboard.

Pie Chart Add a pie chart to your dashboard.

Matrix Add a matrix to your dashboard.

Line Chart Add a line chart to your dashboard.

Area Chart Add an area chart to your dashboard.
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Import a Dashboard

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Dashboards.

To import a dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard.

The Dashboards page appears.

3. In the upper-right corner of the page, click the Options drop-down button.

4. Click Add Dashboard

The Dashboard Templates page appears.

5. In the Other section, click Import.

The Import Dashboard page appears.

6. In the Name box, type a name for the dashboard.

7. Click Choose File and browse to the dashboard file you want to import.

8. Click Submit.

Tenable Security Center imports the dashboard.
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Manage Dashboards

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Dashboards.

To manage dashboards:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears.

3. In the upper-right corner of the page, click the Options drop-down button.

4. Click Manage Dashboards

The Manage Dashboards page appears.

5. To add a dashboard, click Add. For more information, see Add a Template-Based Dashboard

or Add a Custom Dashboard.

6. To filter the dashboards in the table, see Apply a Filter.

7. To manage a single dashboard, click the menu in a dashboard row.

The actions menu appears.

From this menu, you can:

l Click View to view details for the dashboard.

l Click Share to share or revoke access to the dashboard.

l Click Copy to copy the dashboard.

l Click Edit to edit the dashboard.

l Click Delete to delete the dashboard.

8. To show or hide a dashboard from the Switch Dashboard drop-down on the Dashboards page,

pin or unpin the dashboard:
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l —pinned, the dashboard appears.

l —unpinned, the dashboard does not appear.

To export the dashboard as an XML file:

a. Click Export.

b. Then, identify how you want Tenable Security Center to handle object references:

o Remove All References – all object references are removed, altering the definit ions of

the components. Importing users do not need to make any changes for components to

be useable.

o Keep All References – object references are kept intact. Importing users must be in the

same organization and have access to all relevant objects for the components to be

useable.

o Replace With Placeholders – object references are removed and replaced with their

respective names. Importing users see the name of the reference object, but need to

replace it with an applicable object within their organization before the component is

useable.

Note: Due to version-specific changes in dashboard XML file formats, exported dashboards are not always
compatible for import between Tenable Security Center versions.
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Edit Settings for a Dashboard

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Dashboards.

To edit the sett ings for a dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears, displaying your default dashboard.

3. If you want to switch to a different dashboard:

a. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

b. Click the dashboard you want to view.

The dashboard appears.

4. In the upper-right corner of the page, click the Options drop-down box.

5. Click Edit.

The Edit Dashboard page appears.

6. Edit the Name, Description, or Layout.

7. Click Submit.

Tenable Security Center saves your configuration.
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Share or Revoke Access to a Dashboard

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can share access to a dashboard to give users in a group the ability to view the dashboard. The

user's role and custom permissions determine if they can drill down into other pages with more

information. For more information, see Dashboards.

To share or revoke access to a dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears, displaying your default dashboard.

3. If you want to switch to a different dashboard:

a. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

b. Click the dashboard you want to view.

The dashboard appears.

4. In the upper-right corner of the page, click the Options drop-down box.

5. Click Share.

The Share Dashboard window appears.

6. In the box, search for and select the groups for which you want to share or revoke access.

7. Click Submit.

Tenable Security Center saves your configuration.
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Delete a Dashboard

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Dashboards.

To delete a dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears, displaying your default dashboard.

3. If you want to switch to a different dashboard:

a. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

b. Click the dashboard you want to view.

The dashboard appears.

4. In the upper-right corner of the page, click the Options drop-down box.

5. Click Delete.

A confirmation window appears.

6. Click Delete.

The system deletes the dashboard.
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Manage Dashboard Components

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Dashboards.

To manage dashboard components:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Dashboard.

The Dashboards page appears.

To edit a dashboard component:

1. Hover over the dashboard component.

2. Click the menu.

The actions menu appears.

3. Click Edit.

4. Edit the dashboard component options. For more information, see Custom Dashboard Com-

ponent Options.

To view the data behind a dashboard component:

1. Hover over the dashboard component.

2. Click the arrow icon.

3. The analysis page appears.

Note: Only dashboard components that display vulnerability analysis or event analysis data support
viewing the data behind a dashboard component.

To reorder a dashboard component:

1. Click the tit le of a dashboard component.

2. Drag the dashboard component around the page.
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To copy a dashboard component to the dashboard in view or a different dashboard:

1. Hover over the dashboard component.

2. Click the menu.

The actions menu appears.

3. Click Copy.

4. In the Name box, edit the name for the copied dashboard component.

5. In the Dashboard drop-down box, click the name of the dashboard where you want to copy the

dashboard component.

6. Click Copy.

Tenable Security Centercopies the dashboard component.

To refresh the dashboard component data:

1. Hover over the dashboard component.

2. Click the menu.

The actions menu appears.

3. Click Refresh.

Tenable Security Centerrefreshes the dashboard component data.

To delete the dashboard component:

1. Hover over the dashboard component.

2. Click the menu.

The actions menu appears.

3. Click Delete.

A confirmation window appears.

4. Click Delete.

Tenable Security Center deletes the dashboard component.
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Add a Template-Based Dashboard Component

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can add a dashboard component by configuring a Tenable-provided dashboard component tem-

plate. To add a custom dashboard component instead, see Add a Custom Dashboard Component.

For more information, see Dashboards and Dashboard and Component Templates.

Before you begin:

l Add a dashboard, as described in Add a Template-Based Dashboard, Add a Custom

Dashboard, or Import a Dashboard.

To add a template-based dashboard component to a dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard.

The Dashboards page appears.

3. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

4. Click the name of the dashboard for which you want to add a component.

The dashboard appears.

5. In the upper-right corner of the page, click the Options drop-down box.

6. Click Add Component.

The Component Templates page appears.

7. In the Common section, click the template you want to use for the dashboard component.

The Add Component Template page updates to reflect the template you selected.

8. Modify the dashboard component template:
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l To edit the dashboard component name, click the name box and edit the name.

l To edit the dashboard component description, click the Description box and edit the

description.

l To restrict the target data displayed in the dashboard component, click the Targets

drop-down box.

l To edit the dashboard component refresh schedule, click the Schedule link.

9. Click Add.

Tenable Security Center saves your configuration and the Dashboards page appears.

- 595 -



Add a Custom Dashboard Component

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can configure a custom dashboard component to add a table, bar chart, pie chart, line chart,

area chart, or matrix to a dashboard. For more information, see Dashboards and Dashboard and

Component Templates.

For an example matrix component configuration, see Configure a Simple Matrix Dashboard Com-

ponent.

Before you begin:

l Add a dashboard, as described in Add a Template-Based Dashboard, Add a Custom

Dashboard, or Import a Dashboard.

To add a custom dashboard component to a dashboard:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard.

The Dashboards page appears.

3. In the upper-right corner of the page, click the Switch Dashboard drop-down box.

4. Click the name of the dashboard for which you want to add a component.

The dashboard page appears.

5. In the upper-right corner of the page, click the Options drop-down box.

6. Click Add Component.

The Component Templates page appears.

7. In the Other section, click the type of component you want to configure.

The component configuration page appears.

8. Configure the options for your component type, as described in Custom Dashboard Com-

ponent Options.
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9. Click Submit.

Tenable Security Center saves your configuration.
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Custom Dashboard Component Options

Use the following options to configure custom dashboard components. For more information about

dashboard component types, see Dashboard and Component Templates.

Tenable Security Center supports the following custom dashboard components:

l Table Component Options

l Bar Chart Component Options

l Pie Chart Component Options

l Matrix Component Options

l Line and Area Chart Component Options

General Options

Configure the following options for all custom dashboard component types.

Option Description Default

Name (Required) A name for the dashboard component. --

Description A description for the dashboard component. The description

appears on the Dashboards page when you hover over a dash-

board component.

--

Schedule (Required for all except Matrix components) Specifies how

often the component polls the data source to obtain updates:

l Never —The component never polls the data source.

l Minutely —Polls every 15, 20, or 30 minutes.

l Hourly —Polls every 1, 2, 4, 6, or 12 hours.

l Daily —Polls daily or every specified number of days at

the specified time.

l Weekly —Polls weekly or every specified number of

weeks at the specified time.

Daily
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Option Description Default

l Monthly —Polls monthly or every specified number of

months at the specified day and time.

Caution: Excessively frequent updates may cause the application
to become less responsive due to the added processing load
imposed on the host OS.

Table Component Options

Option Description Default

Data

Type The type of data: Vulnerability, Event, Mobile, User, Ticket,

or Alert.

Vulnerability

Query Predefined query used to further narrow down the data

source options. If a query does not exist or is not desired,

it may be left unselected. The query may be used as is or

as a template on which to base the Filters option.

--

Source (If Type is Vulnerability or Event) Specifies the data

source.

For vulnerability data, select Cumulative or Mitigated.

For event data, the data source is Active. Tenable Security

Center can use only active event data for event-based

components.

Cumulative

Tool The analysis tool to use for creating the chart. For more

information, see Vulnerability Analysis Tools and Event

Analysis Tools.

Vulnerability

Summary

Filters Addit ional filters to use on the data source. For more

information, see Filters.

--

Display
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Option Description Default

Results Dis-

played

The number of displayed results. You can choose to dis-

play up to 999 results.

If the Viewport Size sett ing is smaller than this sett ing, the

results display is limited to the Viewport Size sett ing with

a scrollbar to display the addit ional results.

10

Viewport

Size

The number of records (maximum: 50) to display along

with a scrollbar to handle addit ional records. For example,

if Results Displayed is set to 100 and Viewport Size is 15, 15

records are displayed with a scrollbar to view the addi-

t ional 85 records.

10

Sort Column (Not available if Type is Event) The column Tenable Secur-

ity Center uses to sort the results.

Plugin ID

Sort Dir-

ection

(Not available if Type is Event) The sort direction: Des-

cending or Ascending.

Descending

Display

Columns

The columns to display in the component output. --

Bar Chart Component Options

Option Description Default

Data

Type The type of data: Vulnerability, Event, Mobile, or Ticket. Vulnerability

Query Predefined query used to further narrow down the data

source options. If a query does not exist or is not desired,

it may be left unselected. The query may be used as is or

as a template on which to base the Filters option.

--

Source (If Type is Vulnerability or Event) Specifies the data

source.

Cumulative
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Option Description Default

For vulnerability data, select Cumulative or Mitigated.

For event data, the data source is Active. Tenable Security

Center can use only active event data for event-based

components.

Tool The analysis tool to use for creating the chart. For more

information, see Vulnerability Analysis Tools and Event

Analysis Tools.

Vulnerability

Summary

Filters Addit ional filters to use on the data source. For more

information, see Filters.

--

Display

Results Dis-

played

The number of displayed results. You can choose to dis-

play up to 100 results.

10

Sort Column (If Type is Vulnerability or Ticket) The column Tenable

Security Center uses to sort the results.

Plugin ID

Sort Dir-

ection

(If Type is Vulnerability or Ticket) The sort direction: Des-

cending or Ascending.

Descending

Display

Column

The columns to display in the component output. --

Pie Chart Component Options

Option Description Default

Data

Type The type of data: Vulnerability, Event, Mobile, or Ticket. Vulnerability

Query Predefined query used to further narrow down the data

source options. If a query does not exist or is not desired,

it may be left unselected. The query may be used as is or

as a template on which to base the Filters option.

--
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Option Description Default

Source (If Type is Vulnerability or Event) Specifies the data

source.

For vulnerability data, select Cumulative or Mitigated.

For event data, the data source is Active. Tenable Security

Center can use only active event data for event-based

components.

Cumulative

Tool The analysis tool to use for creating the chart. For more

information, see Vulnerability Analysis Tools and Event

Analysis Tools.

Vulnerability

Summary

Filters Addit ional filters to use on the data source. For more

information, see Filters.

--

Display

Results Dis-

played

The number of displayed results. 10

Sort Column The column Tenable Security Center uses to sort the res-

ults.

Plugin ID

Sort Dir-

ection

The sort direction: Descending or Ascending. Descending

Display

Column

The columns to display in the component output. --

Matrix Component Options

For information about configuring matrix components and to download samples, visit the Tenable

Security Center Dashboards blog. For an example matrix component, see Configure a Simple Matrix

Dashboard Component.

When you create a matrix component, you define rules to determine what displays in each cell in a

table of customizable columns and rows.
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l Use columns to define a group of vulnerability, mobile, event, t icket, user, or alert data. For

example, you could create columns for crit ical, high, medium, low, and informational vul-

nerabilit ies.

l Use rows to define the operations performed against each column element for that row. For

example, if each column determines the vulnerability type (crit ical, high, medium, low, and

informational), you can create a row to calculate the ratio of the particular vulnerability type

count against the total vulnerability count.

By default, each cell definit ion includes a single customizable rule that defines what appears in the

cell if no other condit ions have been defined or triggered.

Tenable Security Center reviews each rule in a cell from top to bottom and triggers the display rule

on the first rule match. Once a rule triggers, Tenable Security Center stops reviewing rules for the

cell. If none of the added rules match, Tenable Security Center performs the default rule.

Option Action

Cells

Size Use the drop-down menus to select the number of columns and rows for the mat-

rix. Tenable Security Center supports matrices from 1x1to 10x10.

Click Generate Cells create a blank matrix with customizable cells.

icon Click the icon in a row or column header cell to manage the column or row.

l To edit the header name or refresh frequency, click Edit Header.

Tip: You can choose to refresh the data more often to see the most current
view. However, frequent refreshes can cause slow system performance.

l To delete the row or column, click Delete Cells.

Tenable Security Center deletes the row or column.

l To copy the row or column, click Copy.

Tenable Security Center copies the row or column.

icon Click the icon inside a cell to configure rules for the cell. For more information,

see Matrix Component Query Options.
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Matrix Component Query Options

Option Description Default

Data

Data Type The type of data: Vulnerability, Mobile, Event, User,

Alert, or Ticket.

The Data Type determines which query values are avail-

able in the Condition option.

Vulnerability

Type The matrix component display type: Count or Ratio Count

Source (If Data Type is Vulnerability or Event) Specifies the

data source.

For vulnerability data, select Cumulative or Mitigated.

For event data, the data source is Active. Tenable

Security Center can use only active event data for

event-based components.

Cumulative

Filters (If Type is Count) Addit ional filters to use on the data

source. For more information, see Filters.

--

Numerator Fil-

ters

(If Type is Ratio) The filters to apply to the ratio numer-

ator. For more information, see Filters.

--

Denominator Fil-

ters

(If Type is Ratio) The filters to apply to the ratio denom-

inator. For more information, see Filters.

--

Rules

Condition Specifies the condit ions for the matrix component. Use

the drop-down menus to define the quantity and query

value to use for the rule.

Quantit ies: Less than or equal to, Greater than or equal

to, Exactly, or Not Equal to.

Query values: Events, Hosts, Vulnerabilities, Ports,

--
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Option Description Default

Devices, Users, Alerts, or Tickets.

Note: The available query values depend on the Data
Type.

Display Specifies the appears of the matrix component when

the rule Condition is met.

l Text —Displays the Query Value or custom User-

Defined text.

l Icon —Displays the selected indicator icon.

l (If Type is Ratio) Bar —Displays a percentage.

Text

Text Color (If Display is Text) The matrix component text color. #1a1a40

Background (If Display is Text) The matrix component background

color.

#333333 or

#ffffff

Line and Area Chart Component Options

Option Description Default

Data

Date Type The date type:

l Relative —A date relative to the current t ime when the chart

is loaded.

l Absolute —An absolute time frame that is the same on each

page visit.

Relative

Date

Range

The date range for the line or area chart.

If Date Type is Relative, select from the following options:

l Within x Minutes —Display data within the last 15, 20, or 30

minutes.

Within 24

Hours
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Option Description Default

l Within x Hours —Display data within the last 1, 2, 4, 6, 12, 24,

48, or 72 hours.

l Within x Days —Display data within the last 5, 7, 25, or 50

days.

l Within x Months —Display data within the last 3 or 6 months.

l Within 1Year —Display data within the last year.

If Date Type is Absolute, select a date and time for the beginning

and end of the range.

Series Click to add a series to the line or area chart. For more inform-

ation, see Line and Area Chart Series Options.

--

Line and Area Chart Series Options

Option Description Default

Name The name of the series. --

Data

Data Type The type of data: Vulnerability or Event.

Note: For line/area charts, vulnerability data analysis often
requires that the underlying repository be a trending repository.
If the selected repository is not a trending repository, no his-
torical analysis is available.

Vulnerability

Query Predefined query used to further narrow down the data

source options. If a query does not exist or is not desired, it

may be left unselected. The query may be used as is or as a

template on which to base the Filters option.

--

Filters Addit ional filters to use on the data source. For more inform-

ation, see Filters.

--
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Display

Series

Data

Data to display in the chart: Total, Info, Low, Medium, High, or

Critical.

All
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Configure a Simple Matrix Dashboard Component

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Dashboards and Matrix Component Options.

Before you begin:

l Begin adding a custom matrix dashboard component, as described in Add a Custom Dash-

board Component.

To construct a simple matrix dashboard component:

1. On the Add Matrix Component page, in the Name box, type a name for the dashboard com-

ponent.

2. Type a Description for the dashboard component.

3. In the Cells section, select the number of Columns and Rows for the matrix.
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For example, 5 columns and 3 rows.

4. Click Generate Cells.

The matrix editor appears.

5. Next to the header label, click the menu.

The actions menu appears.

6. Click Edit Header.

7. Type a Label for the column or row header.

8. Click Submit.

The matrix editor appears, with the new header label displayed.
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9. Repeat the header label steps for the other header cells.

10. Hover over the body cells and click the edit icon.

The Add Matrix Component page appears.

11. Customize the matrix component options.

For example, this matrix component displays Vulnerability data by a ratio from the Cumulative

database. The numerator filters are looking for vulnerabilit ies that have an exploit available

with a Crit ical severity discovered within the last 7 days. The Denominator filters are for vul-

nerabilit ies that have a Crit ical severity discovered within the last 7 days. The rules are looking

for percentages of the vulnerabilit ies that match and designate the ratio value with the cor-

responding color based on the percentages found.
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12. Repeat the body cell steps for the other body cells.

In the example above, the other cells are similar with many of the same rules. The differences

are adding a Numerator filter to include the Exploit Framework we are looking for and a

Denominator filter for the Exploit Available option.
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13. Click Submit.

The matrix element appears.
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Scan Results

The Scan Results page displays scan results and statuses from active scans, agent scans, and

agent synchronization jobs .

Note: Tenable Security Center does not include all agent scans in the scan results table. If an agent scan
imports scan results identical to the previous agent scan, Tenable Security Center omits the most recent
agent scan from the scan results table.

Note: If you added the parent node of a Tenable Nessus Manager cluster as a scanner in Tenable Security
Center, Tenable Security Center displays scan results for all child nodes. For more information, see Clus-

tering in the Tenable Nessus User Guide.

Note: For each agent synchronization job result for a child node, Tenable Security Center
imports a metadata record containing no vulnerability data. This metadata record appears as a
second result on the Scan Results page. To prevent Tenable Security Center from importing the
metadata file, configure and launch agent scans from Tenable Security Center, as described in
Agent Scans.

For more information, see Manage Scan Results and Scan Result Statuses.
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Scan Result Statuses

You can view the scan status and the import status for all scan results, as described in View Scan

Result Details.

l Scan Status

l Import Status

Scan Status

The scan status specifies the status of the scan.

Status Description

Active Scans

Queued The scan is queued.

Preparing Tenable Security Center is preparing to run the scan.

Resolving Host-

names

Tenable Security Center is resolving hostnames before running the

scan.

Verifying Targets Tenable Security Center is verifying targets before running the scan.

Initializing Scanners Tenable Security Center is init ializing scanners before running the

scan.

Running The scan is running.

Pausing You paused the scan and Tenable Security Center is pausing the scan.

Paused The scan is paused.

Resuming You resumed the scan and Tenable Security Center is resuming the

scan.

Stopping Tenable Security Center is stopping the scan.

Completed The scan finished successfully.

Partial The scan finished and some results are available.
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Status Description

Error The scan did not finish.

Agent Scans

Queued The scan is queued.

Running The scan is running.

Completed The scan finished successfully.

Error The scan did not finish.

Import Status

The scan status specifies the status of the scan result import to Tenable Security Center.

Status Description

Active and Agent Scans

No Results The scan finished successfully but yielded no results.

Import Pend-

ing

Tenable Security Center is preparing to start the import.

Importing Tenable Security Center is importing the scan result data.

Finished The import finished successfully.

Blocked Tenable Security Center did not import the scan result for one of the following

reasons:

l You have exceeded your license limit.

l The scan result import would cause you to exceed your license.

For more information about license limits, see License Requirements.

Error The import did not finish.
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Manage Scan Results

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

Depending on the state of a scan result, you can perform different management actions (for

example, you cannot download results for a scan with errors).

For more information, see Scan Results.

To manage scan results:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Scan Results.

The Scan Results page appears.

3. Manage the results:

To filter the scan results:

l Click the filter icon.

Filters allow you to view only desired scan results. Filter parameters include:

l Access - filters by whether the scan is manageable or usable.

l Group - filters by the groups that can access the scans.

l Name - filters by the scan name.

l Owner - filters by the scan owner.

l Scan Policy - filters by the scan policy.

l Status - filters by the scan status.

l Completion Time - filters by when the scan finished running.

l Type - filters by the type of scan.

To remove all f ilters:
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l Under the filter options, click Clear Filters.

Note: To return to the default filter for your user account, refresh your browser window. The
number in grey next to the filter displays how many filters are currently in use.

To view a set of scan results:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Select Browse.

The Vulnerability Summary analysis tool appears, populated with data from the scan.

To view scan result details for a set of scan results:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Click View.

The View Scan Result page appears. For more information, see Scan Result Details.

To download the results of a scan:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Select Download.

Tip: On a standard scan, you can download a Tenable Nessus results file. If the scan contains
SCAP results, you can use an addit ional option to download the SCAP results.

To manually import scans listed on the scan results page:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Select Import.
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Tip: This option is useful for cases where a scan may have not fully imported after completion.
For example, if Tenable Security Center blocked a scan because importing it would have
exceeded the licensed IP address count, you can increase the IP address count, then import
the scan results previously not imported.

To share scan results with other users:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Select Copy.

Selecting a Group from the drop-down box displays a list of users from that group. You

can select one or more users from the list.

To send a copy of the scan results to users without access to Tenable Secur-
ity Center:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Select Email.

To generate a report for the scan results based off a preconfigured report:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Select Send to Report.

Tenable Security Center sends the scan results to a report.

To upload Tenable Nessus scan results performed by other systems:

l See Upload Scan Results.

To pause or resume a running scan:
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l In the row for the scan, click the pause or play button, as described in Start or Pause a

Scan.

To delete a set of scan results from Tenable Security Center:

a. In the row for the scan, click the menu.

The actions menu appears.

b. Select Delete.

Tenable Security Center deletes the scan results.
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View Scan Results

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Scan Results.

Note: Tenable Security Center does not include all agent scans in the scan results table. If an agent scan
imports scan results identical to the previous agent scan, Tenable Security Center omits the most recent
agent scan from the scan results table.

Note: If you added the parent node of a Tenable Nessus Manager cluster as a scanner in Tenable Security
Center, Tenable Security Center displays scan results for all child nodes. For more information, see Clus-

tering in the Tenable Nessus User Guide.

Note: For each agent synchronization job result for a child node, Tenable Security Center
imports a metadata record containing no vulnerability data. This metadata record appears as a
second result on the Scan Results page. To prevent Tenable Security Center from importing the
metadata file, configure and launch agent scans from Tenable Security Center, as described in
Agent Scans.

To view a list of scan results:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Scan Results.

The Scan Results page appears.

3. View details about each scan result.

l Name —The name for the scan associated with the result.

l Type —The type of scan that generated the scan result.

l Scan Policy —The name of the scan policy that generated the scan result.

l Scanned IPs —The number of IP addresses scanned.

l Group —The group associated with the scan.

l Owner —The username for the user who added the scan.
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l Duration —The total t ime elapsed while running the scan.

l Import Time —The date and time Tenable Security Center completed the scan result

import.

l Status —The status of the scan that generated the scan result. For more information,

see Scan Status.

4. To view addit ional details for a scan result, see View Scan Result Details.
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View Scan Result Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can view details for any scan result. For more information, see Scan Results.

To view scan result details:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Scan Results.

The Scan Results page appears.

3. In the row for the scan result, click the menu.

The actions menu appears.

4. Click View.

The View Scan Result page appears.

Section Action

General View general information for the scan result.

l Name —The scan result name.

l Type —The type of scan that generated the scan result.

l Scan Policy —The name of the scan policy that generated

the scan result.

l Repository —The name of the repository associated with the

scan policy that generated the scan result.

l Scanned IPs / Total IPs —The number of IP addresses

scanned compared to the total number of IP addresses tar-

geted in the scan.

l Status —The scan status. For more information, see Scan

Status.
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Section Action

l Start Time —The date and time Tenable Security Center star-

ted the scan.

l Finish Time —The date and time Tenable Security Center

completed the scan.

l Status —The scan status. For more information, see Scan

Status.

l Duration —The total t ime elapsed while running the scan.

l Import Start —The date and time Tenable Security Center

started the scan result import.

l Import Finish —The date and time Tenable Security Center

completed the scan result import.

l Import Status —The scan result import status. For more

information, see Import Status.

l Import Duration —The total t ime elapsed during scan result

import.

l Owner —The username for the user who added the scan.

l Group —The group associated with the scan.

l ID —The scan result ID.

Tenable.io Syn-

chronization Data

View synchronization summary data:

l Status —The status of the Tenable Lumin synchronization

containing this scan result data:

l Not Synced —The repository containing this scan res-

ult data is not configured for Tenable Lumin syn-

chronization.

l Syncing —The Tenable Lumin synchronization con-
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Section Action

taining this scan result data is in progress.

l Finished —The most recent synchronization that

included this scan result data succeeded.

l Error —An error occurred. For more information, see

View Tenable Lumin Data Synchronization Logs.

l Start Time —The date and time Tenable Security Center star-

ted the most recent transfer of data to Tenable Vulnerability

Management.

l Finish Time —The date and time Tenable Security Center fin-

ished the most recent transfer of data to Tenable Vul-

nerability Management.

l Duration —The total t ime elapsed during the most recent

transfer of data to Tenable Vulnerability Management.

l Details —If the Status is Error, details about the error.

For more information about Tenable Lumin synchronization, see

Tenable Lumin Synchronization.
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Upload Scan Results

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can upload active or agent scan results from scans performed by other systems. Tenable Secur-

ity Center supports either raw (.nessus) or compressed (.zip) files, with one .nessus file per archive

before uploading. This allows you to import scan results from scans run in remote locations without

network connectivity to Tenable Security Center.

Note: To upload files greater than 300 MB to Tenable Security Center, you must modify upload_max_
filesize in /opt/sc/support/etc/php.ini to accommodate the larger uploads.

Scan Result-Repository Incompatibility

Caution: Tenable does not recommend importing scan results to incompatible repositories since data may
be omitted.

If you upload agent scan results to a non-agent repository, Tenable Security Center omits all vul-

nerabilit ies without IP Address data for the host. Non-agent repositories cannot uniquely identify

hosts without IP Address data for the host.

If you upload non-agent scan results to an agent repository, Tenable Security Center omits all vul-

nerabilit ies without Agent ID data for the host. Agent repositories cannot uniquely identify hosts

without Agent ID data for the host.

To upload scan results:

1. Log in to Tenable Security Center via the user interface.

2. Click Scans > Scan Results.

The Scan Results page appears.

3. Click Upload Scan Results.

4. In the Scan File option, click Choose File.

The file uploads to Tenable Security Center.

5. In the Import Repository drop-down box, select a repository.
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6. If you selected an IPv4 or IPv6 repository, enable or disable the Advanced options: Track hosts

which have been issued new IP address, Scan Virtual Hosts, and Immediately remove vul-

nerabilities from scanned hosts that do not reply.

For more information about the advanced options, see Active Scan Settings.

7. Click Submit.

Tenable Security Center saves your configuration.
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Solutions Analysis

Tenable provides recommended solutions for all vulnerabilit ies on your network. You can perform

the recommended action in a solution to lower the risk on your network.

For more information, see:

l View Solutions

l View Solution Details
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View Solutions

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can use the Solutions page to view solutions for specific assets on your network or drill into

solution details.

To view solutions for assets on your network:

1. Log in to Tenable Security Center via the user interface.

2. Click Solutions.

The Solutions page appears.

3. To filter the solutions in the table by an asset list, in the Targeted Assets drop-down box, click

an asset list name.

The system refreshes the page and filters the table by the asset list you selected. For more

information about asset lists, see Assets.

4. View information about each solution.

l Solution —A description for the solution.

l Risk Reduction —The percent you would reduce your risk by addressing the vulnerability

in the solution. Tenable Security Center calculates the risk reduction percentage by

dividing the score of the vulnerabilit ies in the solution by the score of all of the vul-

nerabilit ies on your network.

l Hosts Affected —The number of devices affected by the solution.

l Vulnerabilities —The number of vulnerability instances included in the solution.

Tip: A vulnerability instance is a single instance of a vulnerability appearing on an asset, iden-
tif ied uniquely by plugin ID, port, and protocol.

l VPR —The highest VPR for a vulnerability included in the solution.

l CVSSv3 Base Score —The highest CVSSv3 score for a vulnerability included in the solu-

t ion. If only CVSSv2 is available, the column is blank.
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5. To view details for a solution, click a row.

The Solution Details page appears. For more information, see Solution Details.
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View Solution Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can use the Solution Details page to view details for a specific solution. To export the details

for a solution, see Export Hosts Affected by a Solution.

To view details for a specific solution:

1. Log in to Tenable Security Center via the user interface.

2. Click Solutions.

The Solutions page appears.

3. Click a solution row.

The Solution Details page appears.

Section Action

Metrics summary View summary statist ics for the recommended solution.

l Hosts Affected —The number of devices affected by the solu-

t ion.

l Vulnerabilities —The total number of vulnerability instances

included in the solution.

Tip: A vulnerability instance is a single instance of a vulnerability
appearing on an asset, identif ied uniquely by plugin ID, port, and
protocol.

l VPR —The highest VPR for a vulnerability included in the solu-

t ion.

l CVSSv3 Base Score —The highest CVSSv3 score for a vul-

nerability included in the solution. If only CVSSv2 is available,

the column is blank.
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Section Action

Vulnerabilities

Included table

View all vulnerabilit ies related to the recommended solution, sorted

by decreasing VPR.

l Plugin —The plugin ID.

l Hosts Affected —The number of devices affected by the solu-

t ion.

l VPR —The VPR for the vulnerability.

l CVSSv3 Base Score —The CVSSv3 score for the vulnerability

included in the solution. If only CVSSv2 is available, the column

is blank.

Hosts Affected

table

View device information.

l IP Address —The IP address for the device.

l NetBIOS —The NetBIOS name, if known.

l DNS —The DNS name, if known.

l OS CPE —The operating system common platform enu-

meration (CPE) name.

l Repository —The repository name where device's scan data is

stored.

A device appears in mult iple rows if the device's scan data is

stored in mult iple repositories.

What to do next:

l (Optional) Export the hosts affected by the solution to share with others in your organization,

as described in Export Hosts Affected by a Solution.
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Export Hosts Affected by a Solution

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can export a list of hosts affected by a solution as a .csv f ile to share the data with others in

your organization. For more information, see Solutions Analysis.

To export hosts affected by a solution:

1. Log in to Tenable Security Center via the user interface.

2. Click Solutions.

The Solutions page appears.

3. Click the row for the solution for which you want to export a list of affected hosts.

The Solution Details page appears.

4. In the upper-right corner, click Export as CSV.

A confirmation window appears.

Note: If the number of affected hosts is greater than 1,000, Tenable Security Center prompts you to
type a name for the CSV report result you want to generate. After generation, you can download the
report result, as described in Download a Report Result.

5. Select or clear the check boxes to indicate which columns you want to appear in the exported

file.

Column Name Description

Solution ID The plugin ID associated with the recommended solution.

Solution A description for the solution.

Tenable UUID The Tenable UUID, if applicable. A Tenable UUID uniquely identif ies:

l Agent-detected assets that may share a common IP address.

l Tenable OT Security assets that may not have an IP address.
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For more information, see Tenable OT Security Instances.

DNS The DNS name of the device, if known.

IP Address The IP address for the device.

OS The operating system running on the device.

CVEs The number of unique CVEs associated with vulnerabilit ies on the

affected host that are addressed by the solution.

CVE Instances The total number of CVE instances associated with vulnerabilit ies

on the affected host that are addressed by the solution.

Tip: A vulnerability instance is a single instance of a vulnerability appear-
ing on an asset, identif ied uniquely by plugin ID, port, and protocol.

OS CPE The operating system common platform enumeration (CPE) name of

the device.

Repository The name of the repository that stores the device's scan data.

MAC The MAC address of the device, if known.

NetBIOS The NetBIOS name of the device, if known.

Vulnerabilit ies The total number of vulnerability instances on the affected host

addressed by the solution.

Tip: A vulnerability instance is a single instance of a vulnerability appear-
ing on an asset, identif ied uniquely by plugin ID, port, and protocol.

Vulnerability Per-

centage

The number of vulnerability instances on the affected host

addressed by the solution as a percentage of total vulnerability

instances.

Tip: A vulnerability instance is a single instance of a vulnerability appear-
ing on an asset, identif ied uniquely by plugin ID, port, and protocol.
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Score The sum of the weighted CVSS score across vulnerability instances

on the affected host addressed by the solution.

Note: Tenable Security Center uses either CVSSv2 or CVSSv3 to assess
the severity of vulnerabilit ies, depending on your configuration. For
more information, see Organizations.

Tip: A vulnerability instance is a single instance of a vulnerability appear-
ing on an asset, identif ied uniquely by plugin ID, port, and protocol.

Risk Reduction The percent you would reduce your risk across all solutions and

affected hosts by addressing the vulnerabilit ies on this affected

host associated with the solution. Tenable Security Center cal-

culates the risk reduction percentage by dividing the total CVSS

score of the vulnerabilit ies on the affected host addressed by the

solution by the total CVSS score of all of the vulnerabilit ies on your

network.

Note: Tenable Security Center uses either CVSSv2 or CVSSv3 to assess
the severity of vulnerabilit ies, depending on your configuration. For
more information, see Organizations.

MS Bulletins The number of unique MS Bulletins associated with vulnerabilit ies

on the affected host that are addressed by the solution.

MS Bulletin

Instances

The total number of vulnerabilit ies with associated MS Bulletins on

the affected host that are addressed by the solution.

VPR The highest VPR of all vulnerabilit ies on the affected host that are

addressed by the solution. If no VPR is available, the column is

blank.

CVSS v3 The highest CVSSv3 score of all vulnerabilit ies on the affected host

that are addressed by the solution. If only a CVSSv2 score is avail-

able, the column is blank.

6. Click Download.

Tenable Security Center exports the list of hosts affected by the solution.
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Vulnerability Analysis

The Vulnerability Analysispage displays vulnerabilit ies from either the cumulative or mitigated vul-

nerability database. For more information, see Cumulative vs. Mit igated Vulnerabilit ies.

Note: If mult iple vulnerabilit ies share the same IP Address or Agent ID data, Tenable Security Center
assumes they are from the same host.

To perform a common type of vulnerability analysis, see View Vulnerabilit ies by Plugin or View Vul-

nerabilit ies by Host.

To view a specific vulnerability analysis tool, see Vulnerability Analysis Tools.
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Cumulative vs. Mitigated Vulnerabilities

Tenable Security Center stores vulnerabilit ies in two databases: the cumulative database and the

mitigated database. You can choose to view cumulative vulnerabilit ies or mitigated vulnerabilit ies in

any vulnerability analysis tool. For more information, see View Cumulative or Mitigated Vul-

nerabilit ies.

Cumulative Vulnerabilit ies

The cumulative database contains currently vulnerable vulnerabilit ies, including recast, accepted, or

previously mitigated vulnerabilit ies.

Mitigated Vulnerabilit ies

The mitigated database contains vulnerabilit ies that Tenable Security Center determines are not vul-

nerable, based on the scan definit ion, the results of the scan, the current state of the cumulative

view, and authentication information.

A vulnerability is mit igated if:

l The IP address of the vulnerability was in the target list of the scan.

l The plugin ID of the vulnerability was in the list of scanned plugins.

l The port of the vulnerability was in the list of scanned ports.

l The vulnerability with that IP address/port/plugin ID combination was not in the scan result.

To start, the vulnerability must appear in the cumulative view to be considered for mit igation. The

import process then looks at each vulnerability in the import repository. The import process also

verifies that authentication was successful before mitigating any local check vulnerabilit ies that

meet the above criteria.

Note: Mitigation logic works with scans using policies defined by templates, advanced policies, and remedi-
ation scans. These policies are set up to take advantage of this new mitigation logic.

For more information about mitigation, see the knowledge base article.
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View Cumulative or Mitigated Vulnerabilities

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For general information about cumulative vulnerabilit ies and mitigated vulnerabilit ies, see Cumu-

lative vs. Mit igated Vulnerabilit ies.

To switch between viewing mitigated or cumulative vulnerabilit ies:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the upper-right corner, click the Options drop-down menu.

The actions menu appears.

4. Click Switch to Mitigated or Switch to Cumulative..

The page updates to display data from the mitigated or cumulative vulnerability database.
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CVSS vs. VPR

Tenable uses CVSS scores and a dynamic Tenable-calculated Vulnerability Priority Rating (VPR) to

quantify the risk and urgency of a vulnerability.

Note: When you view these metrics on an analysis page organized by plugin (for example, the
Vulnerability Analysis page), the metrics represent the highest value assigned or calculated for a
vulnerability associated with the plugin.
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CVSS

Tenable uses and displays third-party Common Vulnerability Scoring System (CVSS) values retrieved

from the National Vulnerability Database (NVD) to describe risk associated with vulnerabilit ies.

Tenable assigns all vulnerabilit ies a severity (Info, Low, Medium, High, or Critical) based on the vul-

nerability's static CVSSv2 or CVSSv3 score, depending on your configuration. For more information,

see Organizations.

Tenable Security Center analysis pages provide summary information about vulnerabilit ies using the

following CVSS categories.

Severity CVSSv2 Range CVSSv3 Range

Crit ical The plugin's highest vulnerability

CVSSv2 score is 10.0.

The plugin's highest vulnerability

CVSSv3 score is between 9.0 and 10.0.

High The plugin's highest vulnerability

CVSSv2 score is between 7.0 and 9.9.

The plugin's highest vulnerability

CVSSv3 score is between 7.0 and 8.9.

Medium The plugin's highest vulnerability

CVSSv2 score is between 4.0 and 6.9.

The plugin's highest vulnerability

CVSSv3 score is between 4.0 and 6.9.

Low The plugin's highest vulnerability

CVSSv2 score is between 0.1and 3.9.

The plugin's highest vulnerability

CVSSv3 score is between 0.1and 3.9.

Info The plugin's highest vulnerability

CVSSv2 score is 0.

- or -

The plugin does not search for vul-

nerabilit ies.

The plugin's highest vulnerability

CVSSv3 score is 0.

- or -

The plugin does not search for vul-

nerabilit ies.
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Vulnerability Priority Rating

Tenable calculates a dynamic VPR for most vulnerabilit ies. The VPR is a dynamic companion to the

data provided by the vulnerability's CVSS score, since Tenable updates the VPR to reflect the cur-

rent threat landscape. VPR values range from 0.1-10.0, with a higher value representing a higher like-

lihood of exploit.

VPR Category VPR Range

Crit ical 9.0 to 10.0

High 7.0 to 8.9

Medium 4.0 to 6.9

Low 0.1to 3.9

Note: Vulnerabilit ies without CVEs in the National Vulnerability Database (NVD) (for example, many vul-
nerabilit ies with the Info severity) do not receive a VPR. Tenable recommends remediating these vul-
nerabilit ies according to their CVSS-based severity.

Note: You cannot edit VPR values.

Tenable Security Center provides new and updated VPR values through the Tenable Security Center

feed. For more information, see Edit Plugin and Feed Schedules.

Tenable recommends resolving vulnerabilit ies with the highest VPRs first. You can view VPR scores

and summary data in:

l The Tenable-provided Vulnerability Priority Rating (VPR) Summary dashboard, described in

Dashboards.

l The Vulnerability Summary, Vulnerability List, and Vulnerability Detail List tools, described in

View Vulnerabilit ies by Plugin.
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VPR Key Drivers

You can view the following key drivers to explain a vulnerability's VPR.

Note: Tenable does not customize these values for your organization; VPR key drivers reflect a vul-
nerability's global threat landscape.

Key Driver Description

Vulnerability

Age

The number of days since the National Vulnerability Database (NVD) pub-

lished the vulnerability.

CVSSv3 Impact

Score

The NVD-provided CVSSv3 impact score for the vulnerability. If the NVD did

not provide a score, Tenable Security Center displays a Tenable-predicted

score.

Exploit Code

Maturity

The relative maturity of a possible exploit for the vulnerability based on the

existence, sophistication, and prevalence of exploit intelligence from

internal and external sources (e.g., Reversinglabs, Exploit-db, Metasploit,

etc.). The possible values (High, Functional, PoC, or Unproven) parallel the

CVSS Exploit Code Maturity categories.

Product Cover-

age

The relative number of unique products affected by the vulnerability: Low,

Medium, High, or Very High.

Threat Sources A list of all sources (e.g., social media channels, the dark web, etc.) where

threat events related to this vulnerability occurred. If the system did not

observe a related threat event in the past 28 days, the system displays No

recorded events.

Threat Intensity The relative intensity based on the number and frequency of recently

observed threat events related to this vulnerability: Very Low, Low, Medium,

High, or Very High.

Threat Recency The number of days (0-180) since a threat event occurred for the vul-

nerability.

Threat Event Examples

Common threat events include:
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l An exploit of the vulnerability

l A posting of the vulnerability exploit code in a public repository

l A discussion of the vulnerability in mainstream media

l Security research about the vulnerability

l A discussion of the vulnerability on social media channels

l A discussion of the vulnerability on the dark web and underground

l A discussion of the vulnerability on hacker forums
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Vulnerability Analysis Tools

On the Vulnerability Analysis page, you can use the drop-down box to select the vulnerability ana-

lysis tool you want to view.

To perform a common type of vulnerability analysis, see View Vulnerabilit ies by Plugin or View Vul-

nerabilit ies by Host.

Analysis Tool Description

IP Summary Summarizes host information, organized by IP address/agent ID. You can
click the IP Address to view host details, as described in View Host

Details.

For more information, see View Vulnerabilit ies by Host.

Class A Summary

Class B Summary

Class C Summary

Summarizes host information.

The vulnerability score for an address is computed by adding up the num-

ber of vulnerabilit ies at each severity level and mult iplying it with the

organization’s severity score.

Start ing out with a Class A or Class B summary can identify more active

network ranges for networks with a large number of active IP addresses.

You can click a Class A or Class B row to view the Class B or Class C tool,

f iltered by the asset list you selected. You can click a Class C row to view

the IP Summary tool, f iltered by the asset list you selected.

Asset Summary This tool summarizes the scores and counts of vulnerabilit ies for all

dynamic or static asset lists.

A breakdown of each asset’s specific vulnerabilit ies and counts for each

severity level is also included.

You can click a count to view the IP Summary tool, f iltered by the asset

list you selected.

CCE Summary This displays a summary of hosts which have Common Configuration Enu-

meration (CCE) vulnerabilit ies.

You can click a count to view the Vulnerability Summary tool, f iltered by
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Analysis Tool Description

the CCE vulnerability you selected.

CVE Summary This view groups vulnerabilit ies based on their CVE ID, Hosts Total, and vul-

nerability count.

DNS Name Sum-

mary

Tenable Security Center includes the ability to summarize information by

vulnerable DNS name. The DNS Name Summary lists the matching host-

names, the repository, vulnerability count, and a breakdown of the indi-

vidual severity counts.

You can click a DNS name to view the Vulnerability List tool, f iltered by the

DNS name you selected.

List Mail Clients Tenable Security Center uses Tenable Nessus Network Monitor to determ-

ine a unique list of email clients. The list contains the email client name,

count of detections, and the detection method.

You can click a count to view the IP Summary tool, f iltered by the email cli-

ent you selected.

List OS Tenable Security Center understands both actively and passively fin-

gerprinted operating systems. This tool lists what has been discovered.

The method (active, passive, or event) of discovery is also indicated.

You can click a count to view the IP Summary tool, f iltered by operating

system.

List Services Tenable Security Center processes information from scans and creates a

summary of unique services discovered. The service discovered, count of

hosts, and detection method are listed.

You can click a service to view the IP Summary tool, f iltered by the service

you selected.

List SSH Servers This tool utilizes active and passive scan results to create a unique list of

known SSH servers. The list contains the ssh server name, count of detec-

t ions, and the detection method.
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Analysis Tool Description

Tip: Not all SSH servers run on port 22. Do not be surprised if you encounter
SSH servers running on unexpected ports.

You can click a count to view the IP Summary tool, f iltered by the SSH

server you selected.

List Software Tenable Security Center processes information from scans and creates a

summary of unique software packages discovered. The software name,

count of hosts, and detection method are listed.

You can click a software name to view the IP Summary tool, f iltered by the

software you selected.

List Web Clients Tenable Security Center understands Tenable Nessus Network Monitor plu-

gin ID 1735, which passively detects the web client in use. This tool lists

the unique web clients detected. The list contains the user-agents, count

of detections, and the detection method.

You can click a count to view the IP Summary tool, f iltered by the web cli-

ent you selected.

List Web Servers This tool takes the passive output from passive and active scans to create

a unique list of known web servers. The list contains the web server name,

count of detections, and the detection method.

Tip: Not all web servers run on port 80 or 443. Do not be surprised if you
encounter web servers running on unexpected ports.

You can click a count to view the IP Summary tool, f iltered by the web

server you selected.

MS Bulletin Sum-

mary

This tool filters vulnerabilit ies based on Microsoft Bulletin ID. Displayed

are the IDs, Vulnerability Totals, Host Total, and Severity. This view is par-

t icularly useful in cases where Microsoft releases a new bulletin and a

quick snapshot of vulnerable hosts is required.

Plugin Family This tool charts the Nessus, Tenable Nessus Network Monitor, or Event
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Analysis Tool Description

Summary plugin family as well as their relative counts based on severity level for all

matching vulnerabilit ies.

You can click a count to view the Vulnerability List tool, f iltered by the plu-

gin family you selected.

Port Summary A summary of the ports in use is displayed for all matched vulnerabilit ies.

Each port has its count of vulnerabilit ies as well as a breakdown for each

severity level.

You can click a port to view the IP Summary tool, f iltered by the port you

selected.

Protocol Sum-

mary

This tool summarizes the detected IP protocols such as TCP, UDP, and

ICMP. The tool also breaks out the counts for each protocol’s severity

levels.

You can click a count to view the IP Summary tool, f iltered by the count

you selected.

Remediation Sum-

mary

The Remediation Summary tool provides a list of remediation actions that

may be taken to priorit ize tasks that have the greatest effect to reduce

vulnerabilit ies in systems. This list provides a solution to resolve a par-

t icular CPE on a given OS platform. The data provided includes:

l Risk Reduction —The percent you would reduce your risk by address-

ing the vulnerability in the solution. Tenable Security Center cal-

culates the risk reduction percentage by dividing the score of the

vulnerabilit ies in the solution by the score of all of the vulnerabilit ies

on your network.

l Hosts Affected —The number of unique hosts that would be

affected by performing the remediation action.

l Vulnerabilities —The count of vulnerabilit ies (Tenable Nessus plu-

gins) that would be remediated by performing the remediation

action.
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Analysis Tool Description

l Score —This is calculated by adding up the score for each vul-

nerability that would be remediated by performing the remediation

action.

l CVE —The number of distinct CVEs that would be remediated by per-

forming the remediation action.

l MS Bulletin —The number of unique MS Bulletins that would be

remediated by performing the remediation action.

l Vulnerability % —The count of vulnerabilit ies (Tenable Nessus plu-

gins) that would be remediated by performing the remediation

action over the total vulnerability count returned by the query as a

percentage.

Severity Sum-

mary

This tool considers all of the matching vulnerabilit ies and then charts the

total number of info, low, medium, high, and crit ical vulnerabilit ies.

You can click a count to view the Vulnerability Summary tool, f iltered by

the severity you selected.

User Respons-

ibility Summary

This displays a list of the users who are assigned responsibility for the vul-

nerability based on the user’s assigned asset list. Mult iple users with the

same responsibility are displayed on the same line. Users without any

assigned responsibilit ies are not displayed in the list. Tenable Security

Center populates this list after you assign an asset to a user account.

Vulnerability

Detail List

Displays the details for a specific vulnerability instance on your network.

Tip: A vulnerability instance is a single instance of a vulnerability appearing on
an asset, identif ied uniquely by plugin ID, port, and protocol.

Important options include CVSS v2/CVSS v3 score, CVSS v2/CVSSv3 tem-

poral score, VPR, VPR key drivers, availability of public exploit, CVE, BID,

synopsis, description, and solution.

For more information, see View Vulnerability Instance Details.
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Analysis Tool Description

Vulnerability List Displays a table of all vulnerability instances found on your network, organ-

ized by plugin ID.

Tip: A vulnerability instance is a single instance of a vulnerability appearing on
an asset, identif ied uniquely by plugin ID, port, and protocol.

For more information, see View Vulnerabilit ies by Plugin.

Vulnerability Sum-

mary

Displays a table of all plugins associated with vulnerabilit ies on your net-

work, organized by plugin ID.

For more information, see View Vulnerabilit ies by Plugin.
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Vulnerability Analysis Filter Components

For general information about using filters, see Filters.

Filter Com-

ponent
Availability Description

Accept Risk Cumulative

View

Displays vulnerabilit ies based on their Accepted Risk

workflow status. Available choices include Accepted Risk

or Non-Accepted Risk. Choosing both options displays all

vulnerabilit ies regardless of acceptance status.

Address All This filter specifies an IPv4 or IPv6 address, range, or

CIDR block to limit the viewed vulnerabilit ies. For

example, entering 198.51.100.28/24 and/or 2001:DB8::/32

limits any of the web tools to show vulnerability data

from the specified networks. You can enter addresses in

a comma-separated list or on separate lines.

Agent ID All Displays results matching the specified agent UUID (Ten-

able UUID). An agent UUID uniquely identif ies:

l Agent-detected assets that may share a common

IP address.

l Tenable OT Security assets that may not have an

IP address. For more information, see Tenable

OT Security Instances.

Application CPE All Allows a text string search to match against available

CPEs. The filter may be set to search based on a con-

tains, Exact Match, or Regex Filter f ilter. The Regex Fil-

ter is based on Perl-compatible regular expressions

(PCRE).

Asset All This filter displays systems from the assets you select. If

more than one asset contains the systems from the

primary asset (i.e., there is an intersect between the

asset lists), those assets are displayed as well.
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Filter Com-

ponent
Availability Description

Tip: Use NOT, OR, and AND operators to exclude unwanted
assets from the view.

Asset Criticality

Rating (ACR)

All (Requires Tenable Security Center+ license) Filters for

vulnerabilit ies on hosts within the specified ACR range,

between 0 and 10.

For more information, see Asset Crit icality Rating in the

Tenable Vulnerability Management User Guide.

Tip: To edit the ACR for an asset, see Edit an ACR Manually.

Audit File All Filters vulnerabilit ies by plugin IDs associated with the

audit file used to perform a scan.

CCE ID All Displays results matching the entered CCE ID.

CVE ID All Displays vulnerabilit ies based on one or more CVE IDs.

Type multiple IDs as a comma-separated list (e.g., CVE-

2011-3348,CVE-2011-3268,CVE-2011-3267).

CVSS v2 Score All Displays vulnerabilit ies within the chosen Common Vul-

nerability Scoring System version 2 (CVSS v2) score

range.

CVSS v2 Vector All Filters results based on a search against the CVSS v2

vector information.

CVSS v3 Score All Displays vulnerabilit ies within the chosen Common Vul-

nerability Scoring System version 3 (CVSS v3) score

range.

CVSS v3 Vector All Filters results based on a search against the CVSS v3

vector information.

Cross Refer- All Filters results based on a search against the cross ref-
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Filter Com-

ponent
Availability Description

ences erence information in a vulnerability.

Data Format All Displays results matching the specified data type: IPv4,

IPv6, or Agent.

DNS Name All This filter specifies a DNS name to limit the viewed vul-

nerabilit ies. For example, entering host.example.com lim-

its any of the web tools to only show vulnerability data

from that DNS name.

Exploit Avail-

able

All If set to yes, displays only vulnerabilit ies for which a

known public exploit exists.

Exploit Frame-

works

All When set, the text option can be equal to or contain the

text entered in the option.

IAVMID All Displays vulnerabilit ies based on one or more IVAMIDs.

Type multiple IDs as a comma-separated list (e.g., 2011-

A-0005,2011-A-0007,2012-A-0004).

MS Bulletin ID All Displays vulnerabilit ies based on one or more Microsoft

Bulletin IDs. Type multiple IDs as a comma-separated list

(e.g., MS10-012,MS10-054,MS11-020).

Mitigated All Displays vulnerabilit ies for a specific mit igation status:

l Previously Mitigated —the vulnerability was pre-

viously mitigated but it reappeared in a scan and is

currently vulnerable

l Never Mitigated —the vulnerability is currently vul-

nerable and has never been mitigated

For more information about mitigation, see Mitigated Vul-

nerabilit ies.

Output Assets Asset Sum- This filter displays only the desired asset list systems.
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Filter Com-

ponent
Availability Description

mary Analysis

Tool

Patch Published All Some plugins contain information about when a patch

was published for a vulnerability. This filter allows the

user to search based on when a vulnerability's patch

became available:

l None (displays vulnerabilit ies that do not have a

patch available)

l Within the last day

l Within the last 7 days

l Within the last 30 days

l More than 7 days ago

l More than 30 days ago

l Current Month

l Last Month

l Current Quarter (during the current calendar year

quarter)

l Last Quarter (during the previous calendar year

quarter)

l Custom Range (during a specific range you specify)

l Explicit (at a specific t ime you specify)

Plugin Family All This filter chooses a Nessus or Tenable Nessus Network

Monitor plugin family. Only vulnerabilit ies from that fam-

ily display.

Plugin ID All Type the plugin ID desired or range based on a plugin ID.
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Filter Com-

ponent
Availability Description

Available operators are equal to (=), not equal to (!=),

greater than or equal (>=) and less than or equal to (<=).

Plugin Modified All Tenable plugins contain information about when a plugin

was last modified. This filter allows users to search

based on when a particular plugin was modified:

l Within the last day

l Within the last 7 days

l Within the last 30 days

l More than 7 days ago

l More than 30 days ago

l Current Month

l Last Month

l Current Quarter (during the current calendar year

quarter)

l Last Quarter (during the previous calendar calendar

year quarter)

l Custom Range (during a specific range you specify)

l Explicit (at a specific t ime you specify)

Plugin Name All Using the Contains option, type all or a portion of the

actual plugin name. For example, entering MS08-067 in

the plugin name filter displays vulnerabilit ies using the

plugin named MS08-067: Microsoft Windows Server Ser-

vice Crafted RPC Request Handling Remote Code Exe-

cution (958644) (uncredentialed check). Similarly,

entering the string uncredentialed displays a list of vul-

nerabilit ies with that string in the plugin name.
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Filter Com-

ponent
Availability Description

Use the Regex Match option to filter plugin names based

on Perl-compatible regular expressions (PCRE).

Plugin Pub-

lished

All Tenable plugins contain information about when a plugin

was first published. This filter allows users to search

based on when a particular plugin was created:

l Within the last day

l Within the last 7 days

l Within the last 30 days

l More than 7 days ago

l More than 30 days ago

l Current Month

l Last Month

l Current Quarter (during the current calendar year

quarter)

l Last Quarter (during the previous calendar year

quarter)

l Custom Range (during a specific range you specify)

l Explicit (at a specific t ime you specify)

Plugin Type All Select whether to view all plugin types or passive, active,

event, or compliance vulnerabilit ies.

Port All This filter is in two parts. First the equality operator is

specified to allow matching vulnerabilit ies with the same

ports, different ports, all ports less than or all ports

greater than the port filter. The port filter allows a

comma separated list of ports. For the larger than or
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Filter Com-

ponent
Availability Description

less than f ilters, only one port may be used.

Note: All host-based vulnerability checks are reported with
a port of 0 (zero).

Protocol All This filter provides boxes to select TCP, UDP, or ICMP-

based vulnerabilit ies.

Recast Risk Cumulative

View

Display vulnerabilit ies based on their Recast Risk work-

flow status. Available choices include Recast Risk or

Non-Recast Risk. Choosing both options displays all vul-

nerabilit ies regardless of recast risk status.

Repositories All Display vulnerabilit ies from the chosen repositories.

STIGSeverity All Display vulnerabilit ies with the chosen STIG severity in

the plugins database.

Scan Policy Plu-

gins

All Display vulnerabilit ies found by the currently enabled plu-

gins in the scan policy. For more information, see Plu-

gins Options.

Severity All Displays vulnerabilit ies with the selected severity. For

more information, see CVSS vs. VPR.

Users All Allows selection of one or more users who are respons-

ible for the vulnerabilit ies.

Vulnerability Dis-

covered

All Tenable Security Center tracks when each vulnerability

was first discovered. This filter allows you to see when

vulnerabilit ies were discovered:

l Within the last day

l Within the last 7 days

l Within the last 30 days
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Filter Com-

ponent
Availability Description

l More than 7 days ago

l More than 30 days ago

l Current Month

l Last Month

l Current Quarter (during the current calendar year

quarter)

l Last Quarter (during the previous calendar year

quarter)

l Custom Range (during a specific range you specify)

l Explicit (at a specific t ime you specify)

Note: The discovery date is based on when the vul-
nerability was first imported into Tenable Security Center.
For Tenable Nessus Network Monitor, this date does not
match the exact vulnerability discovery time as there is nor-
mally a lag between the time that Tenable Nessus Network
Monitor discovers a vulnerability and the import occurs.

Note: Days are calculated based on 24-hour periods prior
to the current t ime, not calendar days. For example, if the
report run time was 1/8/2019 at 1:00 PM, using a 3-day
count would include vulnerabilit ies start ing 1/5/2019 at 1:00
PMand not from 12:00 AM.

Vulnerability

Last Observed

Cumulative

View

This filter allows the user to see when the vulnerability

was last observed by Tenable Nessus, Tenable Log Cor-

relation Engine, or Tenable Nessus Network Monitor:

l Within the last day

l Within the last 7 days
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Filter Com-

ponent
Availability Description

l Within the last 30 days

l More than 7 days ago

l More than 30 days ago

l Current Month

l Last Month

l Current Quarter (during the current calendar year

quarter)

l Last Quarter (during the previous calendar year

quarter)

l Custom Range (during a specific range you specify)

l Explicit (at a specific t ime you specify)

Note: The observation date is based on when the vul-
nerability was most recently imported into Tenable Secur-
ity Center. For Tenable Nessus Network Monitor, this date
does not match the exact vulnerability discovery as there is
normally a lag between the time that Tenable Nessus Net-
work Monitor discovers a vulnerability and the import
occurs.

Vulnerability Mit-

igated

Mitigated View This filter allows the user to filter results based on when

the vulnerability was mitigated:

l Within the last day

l Within the last 7 days

l Within the last 30 days

l More than 7 days ago

l More than 30 days ago
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Filter Com-

ponent
Availability Description

l Current Month

l Last Month

l Current Quarter (during the current calendar year

quarter)

l Last Quarter (during the previous calendar year

quarter)

l Custom Range (during a specific range you specify)

l Explicit (at a specific t ime you specify)

Vulnerability Pri-

ority Rating

(VPR)

All Displays vulnerabilit ies within the chosen VPR range. For

more information, see CVSS vs. VPR.

Tip:The Vulnerability Analysis page displays vulnerabilit ies
by plugin. The VPR that appears is the highest VPR of all
the vulnerabilit ies associated with that plugin.

Vulnerability

Published

All When available, Tenable plugins contain information

about when a vulnerability was published. This filter

allows users to search based on when a particular vul-

nerability was published:

l All

l Within the last day

l Within the last 7 days

l Within the last 30 days

l More than 7 days ago

l More than 30 days ago

l Current Month
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Filter Com-

ponent
Availability Description

l Last Month

l Current Quarter (during the current calendar year

quarter)

l Last Quarter (during the previous calendar year

quarter)

l Custom Range (during a specific range you specify,

up to 999 days ago)

l Explicit (at a specific t ime you specify)

Vulnerability

Text

All Displays vulnerabilit ies containing the entered text (e.g.,

php 5.3) or regex search term.
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View Vulnerabilities by Host

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can drill into analysis views, filtering by host, to view vulnerabilit ies and vulnerability instances

on a host.

To view vulnerabilit ies and vulnerability instances associated with a host:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the drop-down box, click IP Summary.

The IP Summary tool appears.

4. Filter the tool to locate the host where you want to view vulnerability instance details, as

described in Filters and Vulnerability Analysis Filter Components.

5. Click the row for the vulnerability instance where you want to view vulnerability instance

details.

The Vulnerability List tool appears, filtered by the vulnerability instance you selected.

In this tool, you can:

Section Actions

Options menu l Export data as a .csv or a .pdf f ile, as described in Export Vul-

nerability Data.

l Save a query, as described in Add or Save a Query.

l Save an asset.

l Open a ticket, as described in Open a Ticket.

l Set the default display columns for the view.
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l Set this view as your default view.

l Switch between viewing cumulative vulnerabilit ies or mitigated

vulnerabilit ies, as described in View Cumulative or Mitigated Vul-

nerabilit ies.

Filters side bar Apply a filter, as described in Apply a Filter and Vulnerability Analysis

Filter Components.

Vulnerability

row

l Click the Plugin ID to view the plugin details associated with

the vulnerability, as described in View Plugin Details.

l Click the IP Address to view the host details for the vul-

nerability, as described in View Host Details.

l Click the row to view the vulnerability instance details in the Vul-

nerability Detail List tool, as described in View Vulnerability

Instance Details.

Tip: A vulnerability instance is a single instance of a vulnerability
appearing on an asset, identif ied uniquely by plugin ID, port, and
protocol.
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View Vulnerabilities by Plugin

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can drill into analysis views, filtering by plugin, to view vulnerabilit ies and vulnerability instances

related to that plugin.

To view vulnerabilit ies and vulnerability instances associated with a plugin:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the drop-down box, click Vulnerability Summary.

The Vulnerability Summary tool appears.

In this tool, you can:

Section Actions

Options

menu

l Export data as a .csv or a .pdf f ile, as described in Export Vul-

nerability Data.

l Save a query, as described in Add or Save a Query.

l Save an asset.

l Open a ticket, as described in Open a Ticket.

l Set the default display columns for the view.

l Set this view as your default view.

l Switch between viewing cumulative vulnerabilit ies or mitigated vul-

nerabilit ies, as described in View Cumulative or Mitigated Vul-

nerabilit ies.

Table Click or next to a column name to sort the table by that column. Not
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header all columns support sort ing.

Filters side

bar

Apply a filter, as described in Apply a Filter and Vulnerability Analysis Filter

Components.

Plugin row l Click the Plugin ID to view the plugin details for the plugin, as

described in View Plugin Details.

l Click the row to view the vulnerability details in the Vulnerability List

tool.

Plugin row
menu

l View the Asset Summary tool, DNS Summary tool, or IP Summary tool

for the plugin.

l Launch a remediation scan, as described in Launch a Remediation

Scan.

l Create an accept risk rule, as described in Add an Accept Risk Rule.

l Create a recast risk rule, as described in Add a Recast Risk Rule.

4. Click the row for the plugin where you want to view vulnerability instance details.

The Vulnerability List tool appears, filtered by the plugin you selected.

In this tool, you can:

Section Actions

Options menu l Export data as a .csv or a .pdf f ile, as described in Export Vul-

nerability Data.

l Save a query, as described in Add or Save a Query.

l Save an asset.

l Open a ticket, as described in Open a Ticket.

l Set the default display columns for the view.

l Set this view as your default view.

l Switch between viewing cumulative vulnerabilit ies or mitigated
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vulnerabilit ies, as described in View Cumulative or Mitigated Vul-

nerabilit ies.

Filters side bar Apply a filter, as described in Apply a Filter and Vulnerability Analysis

Filter Components.

Vulnerability

row

l Click the Plugin ID to view the plugin details associated with

the vulnerability, as described in View Plugin Details.

l Click the IP Address to view the host details for the vul-

nerability, as described in View Host Details.

l Click the row to view the vulnerability instance details in the Vul-

nerability Detail List tool, as described in View Vulnerability

Instance Details.

Tip: A vulnerability instance is a single instance of a vulnerability
appearing on an asset, identif ied uniquely by plugin ID, port, and
protocol.
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View Vulnerability Instance Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can drill into analysis views to view details for a specific instance of a vulnerability found on

your network.

Tip: A vulnerability instance is a single instance of a vulnerability appearing on an asset, identif ied uniquely
by plugin ID, port, and protocol.

To view vulnerability instance details:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the drop-down box, click Vulnerability Detail List.

The Vulnerability Detail List tool appears.

In this tool, you can:

Section Actions

Options menu l Export data as a .csv or a .pdf f ile, as described in Export Vul-

nerability Data.

l Save a query, as described in Add or Save a Query.

l Save an asset.

l Open a ticket, as described in Open a Ticket.

l Set this view as your default view.

l Switch between viewing cumulative vulnerabilit ies or mitigated

vulnerabilit ies, as described in View Cumulative or Mitigated Vul-

nerabilit ies.
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arrows Click the arrows to view other vulnerability instances related to the

plugin.

toolbar l Launch a remediation scan, as described in Launch a Remedi-

ation Scan.

l Create an accept risk rule, as described in Add an Accept Risk

Rule.

l Create a recast risk rule, as described in Add a Recast Risk Rule.

Synopsis and

Description

View information about the plugin, vulnerability instance, and affected

assets.

Solution View the Tenable-recommended action to remediate the vulnerability.

See Also View related links about the plugin or vulnerability.

Discovery View details about when the vulnerability was discovered and last

seen on your network.

Host Inform-

ation

View details about the asset.

Risk Inform-

ation

View metrics (e.g., CVSS score, VPR, etc.) about the risk associated

with the vulnerability.

Exploit Inform-

ation

View details about the exploit.

Plugin Details View details about the plugin.

VPR Key Drivers View the key drivers Tenable used to calculate the VPR score. For

more information, see CVSS vs. VPR.

Vulnerability

Information

View Common Platform Enumeration (CPE) details.

Reference

Information

View related links to the CVE, BID, MSFT, CERT, and other industry

materials about the vulnerability.
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View Host Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can drill into analysis views to view details for a specific host on your network.

To view host details from the Vulnerability Analysis page:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the drop-down box, click Vulnerability List.

The Vulnerability List tool appears.

4. In the IP Address column, click to view host details for a specific vulnerability instance.

Tip: A vulnerability instance is a single instance of a vulnerability appearing on an asset, identif ied
uniquely by plugin ID, port, and protocol.

The host details panel appears.

Section Actions

System Inform-

ation

View information about the host system.

l IP Address —The host's IP address, if available.

l UUID —The host's UUID, if available.

l NetBIOS Name —The host's NetBIOS name, if available.

l DNS Name —The host's DNS name, if available.

l MAC Address —The host's MAC address, if available.

l OS —The operating system running on the host, if available.

l CPE —The host's application common platform enumeration
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(CPE).

l Score —The cumulative score for all vulnerability instances on

the host. For more information about vulnerability scoring, see

CVSS vs. VPR.

Tip: A vulnerability instance is a single instance of a vulnerability
appearing on an asset, identif ied uniquely by plugin ID, port, and
protocol.

l Repository —The repository that contains vulnerability data

associated with the host.

l Last Scan —The date and time Tenable Security Center last

scanned the host.

l Passive Data —Indicates whether a passive scan detected the

vulnerability.

l Compliance Data —Indicates whether the scan that detected

the vulnerability included compliance plugins.

Vulnerabilities View the number of vulnerabilit ies on the host, organized by severity

category. For more information, see CVSS vs. VPR.

Links l View SANS and ARIN links for the host. If configured, this sec-

t ion also displays custom resource links.

l Click a resource link to view details for the current IP

address/agent IDs. For example, if the current IP address was

a publicly registered address, click the ARIN link to view the

registration information for that address.

Assets View the asset lists containing the asset. For more information, see

Assets.

To view host details from the Host Assets page:
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1. Log in to Tenable Security Center via the user interface.

2. Click Assets > Host Assets.

The Host Assets page appears.

3. Click the row for the host.

The Host Asset Details page appears.

Section Action

Host Inform-

ation

View general information about the host.

l Name —The name of the host.

l System Type —The host's device type, as determined by plugin

54615.

l Operating System —The operating system running on the host, if

available.

l IP Addresses —The host's IP address, if available.

l MAC Addresses —The host's MAC address, if available.

l Asset ID —The ID of the host.

l Repository —The repository that contains vulnerability data asso-

ciated with the host.

Asset Crit-

icality Rating

(Requires Tenable Security Center+ license) View the host's ACR and

details about modifications to the ACR.

l Overwrite Reasoning —The justif ication for overwrit ing the host's

ACR.

l Notes —Notes associated with overwrit ing the host's ACR.

l Overwritten By —The user that overwrote the host's ACR.

l ACR By Key Drivers —The key drivers used to calculate the host's

ACR.
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Section Action

For more information, see Asset Crit icality Rating and ACR Key Drivers

in the Tenable Vulnerability Management User Guide.

To edit the host's ACR, see Edit an ACR Manually.

Scan Inform-

ation

View scan information related to the host.

l First Seen —The date and time Tenable Security Center first

detected the host on your network.

l Last Seen —The date and time last Tenable Security Center

detected the host on your network.

l Source —The type of scan that discovered the host on your net-

work: Tenable Nessus Scan, Tenable Nessus Network Monitor,

Log Correlation Engine, or Agent Scan.

Findings tab l View the vulnerabilit ies detected on the host. For more inform-

ation, see CVSS vs. VPR.

Installed Soft-

ware tab

View the software packages installed on the host, if available.

- 670 -

https://docs.tenable.com/vulnerability-management/Content/Lumin/LuminMetrics.htm#Asset-Criticality-Rating-(ACR)
https://docs.tenable.com/vulnerability-management/Content/Lumin/LuminMetrics.htm#ACR-Key-Drivers


View Plugin Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can drill into analysis views to view details for a specific instance of a vulnerability found on

your network.

Tip: A vulnerability instance is a single instance of a vulnerability appearing on an asset, identif ied uniquely
by plugin ID, port, and protocol.

To view plugin details:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the drop-down box, click Vulnerability Summary.

The Vulnerability Summary tool appears.

4. In the Plugin ID column, click to view plugin details for a specific plugin.

The Plugin Details panel appears.

In this panel, you can:

Section Actions

Description View information about the plugin, vulnerability instance, and

affected assets.

Solution View the Tenable-recommended action to remediate the vul-

nerability.

Vulnerability Priority Rat-

ing (VPR) Key Drivers

View the key drivers Tenable used to calculate the vul-

nerability VPR. For more information, see CVSS vs. VPR.

CVE and BID View related links to the CVE and BID materials about the vul-

nerability.
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Cross-References View related documentation for the vulnerability.

See Also View related links about the plugin or vulnerability.
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Export Vulnerability Data

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can export data from the Vulnerability Analysis page as a .csv or a .pdf f ile.

To export data from the Vulnerability Analysis page:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the upper-right corner, click the Options drop-down box.

4. Click Export as CSV or Export as PDF.

Note: If the record count (rows displayed) of any CSV export is greater than 1,000, Tenable Security
Center prompts you for the name of the CSV report you want to generate. After generation, you can
download the report from the Report Results page.

5. Select or clear the check boxes to indicate which columns you want to appear in the exported

file.

6. Click Submit.

Tenable Security Center exports the vulnerability data.
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Event Analysis

The Events display page contains an aggregation of security events from Tenable Log Correlation

Engine. Events can be viewed in a list format with options similar to the Vulnerability interface.

Raw Syslog Events

Tenable Security Center’s event filters includes a Syslog Text option to narrow down the scope of a

set of events, and supports the use of keyword searches for active filters. In the example above, a

mix of collapsed and expanded events are seen. Selecting the Collapse All or Expand All option from

the top right Options drop-down menu will perform that action for all of the results en masse. By

selecting a particular event and clicking on the + or - icon on the right side of the event will expand

or collapse that one event.

Active vs. Archived

In the Options drop-down menu the view can be switched between the Active and Archived data.

This selection determines whether the displayed events are pulled from the active or an archived

event database. The Active view is the default that displays all currently active events. The Archived

view prompts for the selection of the Log Correlation Engine and an Archive Silo from which the

event data is displayed. In the example below, the Log Correlation Engine and Silo date range are

displayed to help the user choose the correct archive data for analysis.
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Analysis Tools

A wide variety of analysis tools are available for comprehensive event analysis.

When viewing the analysis tool results, clicking on result will generally take you to the next level of

detail for the analysis. For instance, from the Type summary page clicking on a type will display the

Normalized Event Summary. Clicking on an even in that list will display the List of Events page fea-

turing that event. Along each progression a new drop-down menu will appear allowing for easy

access to either pivot to another analysis tool based on the current view or to return to the previous

view.

Addit ionally most results will have a gear icon next to them. This icon will provide summaries, nor-

mally based on time restrict ions or a view of the vulnerability summary for the affected host,

around that item’s result.

For more information, see Event Analysis Tools.

Load Query
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The Load Query option enables users to load a predefined query and display the current dataset

against that query. Click on Load Query in the filters list to display a box with all available queries.

The query names are displayed in alphabetical order. After clicking on an individual query, the vul-

nerability view is changed to match the query view for the current dataset.

Event Analysis Filters

For more information, see Event Analysis Filter Components.

Event Analysis Actions

You can use the Options drop-down menu to perform the following event analysis actions.

Save Query

You can save the current view as a query for reuse. For more information about queries, see Quer-

ies.

Save Asset

Event results can be saved to an asset list for later use. For more information, see Assets.

Save Watchlist

Event results can be saved to a watchlist asset list for later use. For more information, see Assets.

Open Ticket

Tickets are used within Tenable Security Center to assist with the assessment and remediation of

vulnerabilit ies and security events. For more information, see Open a Ticket.

View Settings

When available, this sett ing controls the columns displayed in your view.

Switch to Archived / Switch Archive / Switch to Active

The Switch to Archived item is displayed when viewing active event data and when selected will

present a dialog to choose the archived event data to display by Tenable Log Correlation Engine and

date range.
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The Switch Archive menu item is displayed when viewing archived event data. Selecting this option

displays the same menu and selections as above to select a different archive silo for viewing.

The Switch to Active menu item is displayed when viewing archived data and when selected,

changes the view to active event data for analysis.

Export as CSV

Event results can be exported to a comma-separated file for detailed analysis outside of Tenable

Security Center by clicking on the Options drop-down menu and then the Export as CSV option.

When selected, a window opens with an option to choose the columns to be included in the CSV

file.

If the record count (rows displayed) of any CSV export is greater than 1,000 records, a note is dis-

played that prompts for the name of the CSV report to be generated. When complete, the report

can be downloaded from the Report Results page. For CSV exports of under 1,000 records, the

browser’s standard Save As dialog window is displayed.

Once the appropriate selections are made, click the Submit button to create the CSV file or Cancel

to abort the process.
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Event Analysis Tools

A wide variety of analysis tools are available for comprehensive event analysis. Clicking on the drop-

down menu indicating the current view (Type Summary by default) displays a list of analysis tools to

choose from.

When viewing the analysis tool results, clicking on result will generally take you to the next level of

detail for the analysis. For instance, from the Type summary page clicking on a type will display the

Normalized Event Summary. Clicking on an even in that list will display the List of Events page fea-

turing that event. Along each progression a new drop-down menu will appear allowing for easy

access to either pivot to another analysis tool based on the current view or to return to the previous

view.

Addit ionally most results will have a gear icon next to them. This icon will provide summaries, nor-

mally based on time restrict ions or a view of the vulnerability summary for the affected host,

around that item’s result.

Tool Description

Asset Sum-

mary

This tool can be used to see how certain types of activity, remote attackers,

or non-compliant events have occurred across different asset groups.

Clicking on the Total count for the listed asset displays a Type Summary ana-

lysis tool.

Connection

Summary

This tool lists connections made between two different hosts by source and

destination IP address and the counts of connections between them.

Clicking on a host will display the Type Summary analysis tool.

Date Summary When analyzing large amounts of data, it is often useful to get a quick sum-

mary of how the data set manifests itself across several dates.

For example, when analyzing a suspected attacker’s IP address, creating a fil-

ter for that IP address and looking at the type of events is simple enough.

However, displaying that same data over the last few days or weeks can

paint a much more interesting picture of a potential attacker’s activity.

Selecting a date will display the Type Summary analysis tool.
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Tool Description

Destination IP

Summary

This tool displays events listed by the destination IP address recorded. The

table lists the Tenable Log Correlation Engine it was discovered on, the IP

address, and the count. Clicking on the information icon next to the IP

address displays the system information pertaining to the host IP address.

Clicking on one of the hosts displays the Type Summary analysis tool.

Detailed Event

Summary

This tool displays a summary of the various events based on their full event

name and count. Clicking on an event displays the List of Events analysis

tool.

Event Trend This analysis tool displays an event trend area graph with total events over

the last 24 hours. Modify the filters for this graph to display the desired

event trend view.

IP Summary

Class A Sum-

mary

Class B Sum-

mary

Class C Sum-

mary

Tenable Security Center provides the ability to quickly summarize matching

IP addresses by single IP address, Class A, Class B, and Class C addresses.

The IP Summary tool displays the associated Tenable Log Correlation Engine

server along with the IP address of the reporting system and about the event

count for that system.

Clicking on an IP address displays a Host Detail window for that IP address.

Clicking the information icon next to the IP address displays information

about the NetBIOS Name (if known), DNS Name (if known), MAC address (if

known), OS (if known), Score, Repository, Last Scan, Passive Data, Com-

pliance Data, and Vulnerability severity counts. The Assets box displays

which asset lists the IP address belongs to. The Useful Links box contains a

list of resources that can be queried by IP address. Clicking on one of the

Resource links causes the resource to be queried with the current IP

address. For example, if the current IP address was a publicly registered

address, clicking on the ARIN link causes the ARIN database to be queried

for the registration information for that address. If custom resources have

been added by an administrative user (via the Manage IP Address Information

Links selection under the Customization tab), they will be displayed here.
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Tool Description

The Sum by Class A, B, and C tools work by displaying matching addresses.

Clicking on the number displayed in the Total column will display the Type

Summary for that IP address range.

List of Events This tool displays a line of data for each matching event. The line includes

many pieces of information such as time, event name, number of correlated

vulnerabilit ies involved IP addresses, and sensor.

Normalized

Event Sum-

mary

This tool summarizes a list ing of all normalized events and their count for

the chosen time period. Normalized events are lower-level events that have

been assigned a Tenable name based on Tenable Log Correlation Engine

scripts parsing of the log records (e.g., Snort-HTTP_Inspect).

Clicking on the event name displays the List of Events analysis tool.

Port Summary A port summary can be invoked. This tool produces a table of the top used

ports and combines counts for source and destination ports into one overall

count.

Clicking on the port will display a Type Summary of events filtered for that

port.

Note: Port 0 events are host-based events that are not specific to any particular
TCP/UDP port.

Protocol Sum-

mary

This tool summarizes counts of events based on IP protocols.

Clicking on the event total displays a Type Summary view of events filtered

by the selected protocol.

Raw Syslog

Events

Users can choose to view the original log message or IDS event for full

forensic analysis.

It is recommended that users attempt some sort of filtering match first

before attempting to find their desired event. Users will typically sort their

results and drill into the list until they find what they are looking for before

attempting to view the raw data.
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Tool Description

Sensor Sum-

mary

This tool displays the unique event counts for any query from unique sensor

types.

When a sensor is clicked on, the Type Summary analysis tool is displayed for

events from the selected sensor.

Source IP Sum-

mary

This tool displays events listed by the source IP address recorded. The table

lists the Tenable Log Correlation Engine it was discovered on, the IP

address, and the count. Clicking on the information icon next to the IP

address displays the system information pertaining to the host IP address.

Clicking on one of the hosts displays the Type Summary analysis tool.

Type Summary This tool displays the matching unique event types and the number of cor-

responding events for each.

The unique event types are based on normalized logs or events such as fire-

wall, system, correlated, network and IDS. These types are high-level types

used to describe event types (e.g., login or lce).

Clicking on any of the event counts displays the Normalized Event Summary

for the type.

User Summary This tool displays the matching unique event types and the number of cor-

responding events for each user when user tracking is enabled in Tenable

Log Correlation Engine.

The unique event types are based on normalized logs such as firewall, sys-

tem, correlated, network, and IDS.

Clicking on any of the event counts under the Total column will display the

Type Summary analysis tool.
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Event Analysis Filter Components

Filters limit the results of the event data displayed and can be added, modified, or reset as desired.

For more information, see Filters.

The Event Analysis page also supports using a filter bar for filtering. To display the filter bar, click

the gear icon Options button and select Show Filter Bar.

Note: The filter bar does not display or adjust the time frame filter.

Filter Com-

ponent
Description

Address Specifies an IP address, range, or CIDR block to limit the displayed events.

For example, entering 198.51.100.64/24 limits any of the web tools to show

only the event data from that network. You can enter addresses on sep-

arate lines or comma separated.

Asset Filter the event by the specified asset list.

Tip: Use NOT, OR, and AND operators to exclude unwanted assets from the
view.

Destination

Address

Specifies an IP address or CIDR block to limit the displayed events based on

destination. For example, entering 198.51.100.64/24 limits any of the ana-

lysis tools to show only the event data with destination IPs in that block.

Addresses can be comma-separated.

Destination

Asset

Filter the destination address of the event data by the specified asset list.

Tip: Use NOT, OR, and AND operators to exclude unwanted assets from the
view.

Destination Port This filter is in two parts. Specify the type of filter to allow matching events

with the same ports (=) or different ports (≠). The port filter may specify a

single, comma separated list of ports or range of ports (e.g., 8000-8080).

Detailed Event This is the detailed event name given by the IDS vendor. For example, an

event received from a Snort sensor can have a detailed event name of
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Filter Com-

ponent
Description

DOUBLE DECODINGATTACK, which means that HTTP_INSPECT 119:2:1fired

and was sent to the Log Correlation Engine.

Direction Filter by event direction of All by default or select Inbound, Outbound, or

Internal.

Log Correlation

Engines

Specify the Log Correlation Engine(s) to obtain events from by checking the

box next to the choices.

Normalized

Event

The name given to the event by the Log Correlation Engine after the Log

Correlation Engine runs its PRMand TASL scripts against it .

Port This filter is in two parts. Specify the type of filter to allow matching vul-

nerabilit ies with the specified ports (=), excluding ports (≠), ports greater

than or equal to (≥), or ports less than or equal to (≤). The specified and

excluding port filter may specify a single port, comma-separated list of

ports, or range of ports (for example, 8000-8080).

Note: Tenable Security Center reports all host-based vulnerability checks with a
port of 0 (zero).

Protocol Specify the protocol of the event TCP, UDP, or ICMP.

Repositories Specify the Repositories to obtain events from. You can search the repos-

itories using the search filter at the top. You can select mult iple repos-

itories from the list.

Sensor Filter the events by sensor using the equal (=) or not equal (!=) operators.

Source Address Specifies an IP address or CIDR block to limit the displayed events based on

source. For example, entering 198.51.100.64/24 limits any of the analysis

tools to show only the event data with source IPs in that block. Addresses

can be comma separated.

Source Asset Filter the source address of the event data by asset list and select an asset

list from those available or the NOT operator to exclude asset lists. After
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Filter Com-

ponent
Description

you add each list, the AND or OR operator are available to customize the

combining of asset lists.

Source Port This filter is in two parts. Specify the type of filter to allow matching events

with the same ports (=) or different ports (≠). The port filter may specify a

single port, comma-separated list of ports, or range of ports (for example,

8000-8080).

Syslog Text (Raw Syslog Events Analysis Tool) String to search for within the filtered

event.

Targeted IDS

Events

This filter box selects IDS events that have targeted systems and ports with

vulnerabilit ies likely to be exploited by the detected attack. This is determ-

ined by comparing the host’s vulnerabilit ies (CVE, etc.) against those tied to

the actual IDS event.

Timeframe Tip: Tenable Security Center always uses this filter. By default, it is set for the
last 24 hours, based on the time of the page load.

By default, Tenable Security Center displays an explicit t imeframe using the

last 24 hours. Specify either an explicit or relative timeframe for the event

filter. Choosing explicit allows for selecting dates and times from a cal-

endar and time sliders for the start and end time. Relative timeframes, avail-

able from the drop-down box, range using various time periods from the

last 15 minutes to the last 12 months and All.

Type Use this to filter by the event type. For example: error, lce, login, intrusion,

etc..

User Specify only events tied to a particular username.

Note: Clicking on Clear Filters causes the filters to return to the default sett ings.
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Mobile Analysis

The Mobile Analysis page displays lists of vulnerabilit ies discovered by scanning an ActiveSync,

Apple Profile Manager, AirWatch, Good, and/or MobileIron MDMservers.

For information about mobile analysis filtering, see Mobile Analysis Filter Components.

Mobile Analysis Actions

You can use the Options drop-down menu to perform the following mobile analysis actions.

Save Query

You can save the current view as a query for reuse. For more information about queries, see Quer-

ies.

Export as CSV or PDF

You can export mobile results in the current view to a comma-separated file or a PDF for detailed

analysis outside of Tenable Security Center.

Note: If the record count (rows displayed) of any CSV export is greater than 1,000 records, a note is dis-
played that prompts for the name of the CSV report to be generated. When complete, the report can be
downloaded from the Report Results page. For CSV exports of under 1,000 records, the browser’s standard
Save As dialog window is displayed.

Select the columns of data you want exported, then click Submit.
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Mobile Analysis Filter Components

For general information about using filters, see Filters.

Option Description

Analysis Tool Filter

Analysis Tool This drop-down box is used to choose the analysis tool used by the filter.

This is the same as selecting the desired analysis tool from the Analysis

> Mobile dialog.

Active Filters Displays the existing filters and allows the user to selectively remove fil-

ters as needed.

Filters

Identifier A text based search filter that looks at the Identifier option in the repos-

itory.

MDMType A drop-down box to select the MDMserver type of ActiveSync, Apple Pro-

file Manager, Good, AirWatch, and MobileIron MDMserver.

Model A text based search filter that looks at the Model option in the repository.

Operating System

CPE

A text based search filter that looks at the Operating System CPE option

in the repository.

Plugin ID Type the Plugin ID to filter results on.

Plugin Output Filter results based on a text search of plugin output.

Repositories Display vulnerabilit ies from the chosen repositories.

Serial Number This is a text based search filter that looks at the Serial Number option in

the repository.

Severity Displays vulnerabilit ies with the selected severity (Info, Low, Medium,

High, Critical).

Username This is a text based search filter that looks at the User option in the

repository.
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Option Description

Version This is a text based search filter that looks at the OS Version option in

the repository.

Vulnerability Last

Observed (Cumu-

lative only)

This filter allows the user to see when the vulnerability was last

observed.
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Reports

Tenable provides reporting through an assortment of report templates and customizable report

formats, including PDF and CSV.

Custom CyberScope, DISA ASR, and DISA ARF reports are also available for specialized needs. An

administrator user must enable report generation options before organizational users can generate

reports with CyberScope, DISA ASR, or DISA ARF data.

Custom CyberScope, DISA ASR, DISA ARF, and DISA Consolidated ARF reports are also available for

specialized needs. An administrator user must enable report generation options before organ-

izational users can generate reports with CyberScope, DISA ASR, DISA ARF, or DISA Consolidated

ARF data.

In Tenable Security Center, organizational users can create custom reports or template-based

reports, as described in Create a Custom Report or Create a Template Report.

Note: To create custom PDF reports and template-based reports, you must install either the Oracle Java
JRE or OpenJDK (along with their accompanying dependencies) on the system hosting the Tenable Secur-
ity Center.

Tip: Tenable provides report templates through the Tenable Security Center feed. For a complete index of
Tenable-provided report templates, see the Tenable Security Center Report Templates blog.

For more information, see:

l Manage Reports

l Manage Report Results

l CyberScope and DISA Report Attributes

l Report Images
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Manage Reports

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

On the Reports page of Tenable Security Center, you can manage report definit ions and launch

reports. For more information, see Reports.

To manage reports:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. Do any of the following:

l Filter existing report definit ions in the reports table.

l Create a custom report.

l Create a template report.

l Edit a report definit ion.

l Edit a report outline.

l Manage filters for a chapter report.

l Manage filters for a non-chapter report.

l View a report definit ion.

l Copy a report definit ion.

l Export a report definit ion.

l Import a report definit ion.

l Delete a report definit ion.

l Launch a report on demand.

l Add a report to a scan.
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Create a Custom Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Reports.

Before you begin:

l If you want to create a CyberScope, DISA ASR, DISA ARF, or DISA Consolidated ARF report,

confirm an administrator user enabled the corresponding report generation options, as

described in Configuration Settings.

l If you want to create a CyberScope, DISA ARF, or DISA Consolidated ARF report, create report

attributes as described in CyberScope and DISA Report Attributes.

To create a custom report definit ion:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

3. Click Add.

The Report Template page appears.

4. In the Other section, click a report t ile. For more information, see Report Templates.

5. Configure the options for the report.

Tenable Security Center displays options relevant to the report format you selected.

6. (Optional) Edit the report outline.

7. Click Submit to save your report.

Tenable Security Center saves your configuration.
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Create a Template Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

Template reports are formatted reports that can be customized using chapter and target selec-

t ions. For more information, see Reports.

To create a template report:

1. Log in to Tenable Security Center via the user interface.

2. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

3. Click Add.

The Report Template page appears.

4. Do one of the following to locate a specific template:

l In the Search Templates box in the top right corner of the page, search for a specific

template by keyword.

Tip: After the init ial search, you can limit search results by template category.

l In the Common section, click a template category to view the related templates. For

more information, see Report Templates.

5. Click a template report.

Note: Each template description specifies which Tenable Security Center data must be available to
obtain a complete report. For more information, see Data Required for Template-Based Reports.

6. (Optional) In the Chapters section, select which chapters from the template you want to

include in your report. By default, the report includes all chapters from the template.

7. In the Focus section, do one of the following:

Target all systems in the report.
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Note: This is the default sett ing.

To return to this sett ing, click All Systems in the Targets drop-down box.

Target specific assets in the report.

a. In the Targets drop-down box, click Assets.

b. Select Assets and Repositories.

Target specific IP addresses in the report.

a. In the Targets drop-down box, click IP Addresses.

b. In the IP Addresses box, type the IP address or addresses where you want the report to

focus. Use commas to separate mult iple addresses.

c. In the Repositories box, select a target repository or repositories.

Target specific repositories in the report.

a. In the Targets drop-down box, click Repositories.

b. In the Repositories box, select a target repository or repositories.

8. (Optional) Edit the default text in the Description box.

Note: You cannot modify any information in the Details section of the page.

9. Click Add.

Tenable Security Center creates a report based on the template and displays the Reports

page. The new report appears as the last entry in reports table.

10. (Optional) Modify report options that are common to both custom and template reports. For

more information, see Report Options.

For example, the default value for the Schedule option for all template-based reports is On

Demand. If you want to run the report automatically, modify the Schedule option for the

report.

11. (Optional) Customize the report outline, as described in Edit a Report Outline.
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For example, you might want to use text elements to add your business context to template-

based chapters.
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Data Required for Template-Based Reports

Each report template description contains icons that represent which types of data must be avail-

able on Tenable Security Center to obtain a complete report.

Hover the cursor over the icon to display the label.

Icon Label Action Required

Asset Required Configure an IPv4/ IPv6 repository and store scan results in the

repository; see Local Repositories and IPv4/ IPv6 Repositories.

Audit File

Required Upload audit files and add them to your scan policy; see Audit

Files and Scan Policies.Compliance

Data Required

Local Checks

Required

Configure and run credentialed scans; see Active Scans.

Mobile Data

Required

Configure a mobile repository and store scan results in the

repository; see Mobile Repositories.

Active Data

Required

Configure a Tenable Nessus scanner and run active scans. For

more information, see Tenable Nessus Scanners and Active

Scans.

Passive Data

Required

Configure a Tenable Nessus Network Monitor (NNM) scanner;

see Tenable Nessus Network Monitor Instances.

Event Data

Required

Configure a Tenable Log Correlation Engine server; see Ten-

able Log Correlation Engines.
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Report Templates

Tenable Security Center provides a selection of report templates and customizable report formats.

You can configure a Tenable-provided report template or you can create a fully customized report

from one of the available formats. For more information, see Reports.

For a complete index of Tenable-provided report templates, see the Tenable Security Center Report

Templates blog.

Template Description

Common

Compliance

& Configuration

Assessment

Reports that aid with configuration, change, and compliance man-

agement.

Discovery

& Detection

Reports that aid in trust identif ication, rogue detection, and new device

discovery.

Executive Reports that provide operational insight and metrics geared towards

executives.

Monitoring Reports that provide intrusion monitoring, alert ing, and analysis.

Security Industry

Trends

Reports related to trends, reports, and analysis from industry leaders.

Threat Detection

& Vulnerability

Assessments

Reports that aid with identifying vulnerabilit ies and potential threats.

Other

PDF Create a Portable Document Format (PDF) report that can be viewed uni-

versally.

CSV Create a Comma Separated Values (CSV) report that can be imported

into spreadsheets or databases.

DISA ARF (Requires Report Generation configuration) Create a report that meets
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the standards of the Defense Information Systems Agency Assessment

Results Format (DISA ARF).

DISA Consolidated

ARF

(Requires Report Generation configuration) Create a report that meets

the standards of the Defense Information Systems Agency Consolidated

Assessment Results Format (DISA Consolidated ARF).

DISA ASR (Requires Report Generation configuration) Create a report that meets

the standards of the Defense Information Systems Agency Assessment

Summary Results (DISA ASR).

CyberScope (Requires Report Generation configuration) Create a report that meets

CyberScope reporting standards to support FISMA compliance.
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Edit a Report Definition

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, you can edit both custom reports and reports based on templates.

To edit a report definit ion:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

4. Modify the report options.

Note: Tenable Security Center displays options relevant to the report type.

5. (PDF and template reports only) Edit the report outline.

6. Click Submit to save your changes to the report.
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Report Options

In Tenable Security Center, you can configure the options described below for both custom and tem-

plate reports.

Option descriptions below are grouped by the section where they appear in the Add Report and Edit

Report pages. In the option description tables, the Relevant Reports column specifies which report

types use each option.

Note: Tenable Security Center classifies a template-based report as a PDF report. You can con-
figure the same options for that report as you can for a PDF report.

During template report creation, Tenable Security Center set these options to default values.
You can change these options for a template report only after creation is complete.

l General Options

l Report Options

l Definit ion Options

l Display Options

l Distribution Options

General Options

Option Description
Relevant

Reports

Name Name assigned to the report. Any

Description Descriptive text for the report. Any

Schedule Determines how often the report runs. Options are On

Demand, Now, Once, Daily, Weekly, or Monthly. When

you select a frequency from the drop-down box, Ten-

able Security Center displays addit ional options for the

selected time frame.

Any

Attribute Sets Predefined operational attributes that add required DISA ARF, DISA
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Option Description
Relevant

Reports

information to DISA ARF, DISA Consolidated ARF, or

CyberScope report types. The drop-down box displays

only the attribute set defined for the report you are cur-

rently creating.

Consolidated

ARF, Cyber-

Scope

ASR Content When creating a report, this drop-down box offers a

selection of Benchmark, IAVM, CVE, or Plugin ID to be

included.

DISA ASR, DISA

Consolidated

ARF

ASR Record

Format

This drop-down box determines the format (Summary

or Detail) of the DISA ASR report.

DISA ASR

Include ARF When enabled, allows for the inclusion of a DISA attrib-

ute set for the report.

DISA ASR

Benchmarks Benchmarks are generated after a scan using certain

audit files that have been successfully run against at

least one target system.

DISA ASR, DISA

Consolidated

ARF, Cyber-

Scope

Report Options

Option Description
Relevant

Reports

Style A compound value that specifies the report style, paper size,

and orientation. For example, Plain, Letter

Report styles include:

l Plain —a report with basic graphs

l Tenable —a report with basic graphs and a footer logo

on the cover page

l Tenable 3D —a report with enhanced 3D graphs and a

footer logo on the cover page

PDF

- 699 -



Option Description
Relevant

Reports

Note: If an administrator configured a Classification Type ban-
ner, plain report styles are the only options listed.

Paper sizes include:

l Letter —the standard 8.5 inches x 11inches letter size

Note: Letter size is the default paper size, used by
options that do not explicit ly state a paper size. For
example, the paper size for Plain, Landscape is letter
size.

l A4 —the standard 8.27 inches x 11.69 inches A4 size

Orientation options include:

l Portrait —vertical

Note: Portrait is the default orientation, used by options
that do not explicit ly state an orientation. For example,
the orientation for Plain, Letter is vert ical.

l Landscape —horizontal

Include Cover

Page

Include a cover page in the report. Cover pages include:

l a cover logo

l the scan Name

l the date and time you generated the report

l the date and time Tenable Security Center imported

the scan results, if you generated the report from scan

results

l the scan result ID, if you generated the report from

scan results

PDF
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Option Description
Relevant

Reports

Include

Header

Include a predefined header in the report. PDF

Include Footer Include a predefined footer in the report. PDF

Include Table

of Contents

Include a table of contents with the report. PDF

Include Index Include an Index with the report. PDF

Cover Logo Specifies which image to use for the lower-left footer logo

on the cover page of the report. The default logo is the Ten-

able logo. To add a custom logo, see Report Images.

Note: The Plain report style suppresses this footer logo on the
cover page.

PDF

Footer Logo Specifies which image to use for the lower-left footer logo

on all pages except the cover page. The default logo is the

Tenable logo. To add a custom logo, see Report Images.

PDF

Watermark Specifies a watermark for each page of the report. The

default is no watermark. To add a custom watermark, see

Report Images.

PDF

Encrypt PDF Protect the PDF with a password. When enabled, the Pass-

word text box appears. Enter a password to use to open the

report and view its contents.

PDF

Definit ion Options

Tenable Security Center displays definit ion options relevant to the report or report element type.

Option Description Relevant Reports

Add Chapter The primary component in the report organization.

Chapters are listed in the table of contents for the

PDF
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Option Description Relevant Reports

report and consist of sections and elements. For

more information, see Add a Custom Chapter to a

Report and Edit a Report Outline.

Add Template

Chapter

A predefined chapter from a Tenable-provided

report template. For more information, see Add a

Template Chapter to a Report.

PDF

Query A list of predefined queries you can use to retrieve

data for the report. For more information, see

Queries.

CSV, DISA ARF, DISA

Consolidated ARF,

DISA ASR, Cyber-

Scope; Iterator,

Table, and Chart ele-

ments in PDF

Type The type of data to include in the report. CSV; Iterator, Table,

and Chart elements

in PDF

Source The source of the data to include in the report.

For CSV reports, valid values for this field differ

based on the sett ing of the Type option:

l If Type is set to Vulnerability, valid Source

values are:

o Cumulative—All vulnerabilit ies, regard-

less of whether the vulnerabilit ies have

been remediated or not

o MItigated—Remediated vulnerabilit ies

o Individual Scan—Vulnerabilit ies iden-

tif ied in a specific scan

Note: If you select Individual Scan,

CSV, DISA ARF, DISA

Consolidated ARF,

DISA ASR, Cyber-

Scope; Iterator,

Table, and Chart ele-

ments in PDF
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Option Description Relevant Reports

Tenable Security Center displays
the Selected Scan option, which
allows you to select a scan to use
as the basis of the report:

a. Click one of the predefined date
ranges, or click Custom Range
and enter start ing and ending
days for the range.

b. Click Fetch Scans to view a list
of possible scans within the date
range.

c. Click the scan you want to use in
the drop-down box.

l If Type is set to Event, valid Source values

are:

o Active—Currently active events

o Archive—Archived events

Note: If you select Archive, Tenable
Security Center displays addit ional
options, allowing you to select the LCE
that collected the events and the Silo
that stores the archived events.

l If Type is set to Mobile, Ticket, or Alert, this

option is absent.

For DISA ARF, DISA Consolidated ARF, and DISA

ASR reports, you do not set the Type option. Valid

Source values are limited to Cumulative and Indi-

vidual Scan, which operate in the same way as

they do for CSV reports.

Tool Select the tool Tenable Security Center uses to CSV; Iterator, Table,
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Option Description Relevant Reports

analyze the data in the report. and Chart elements

in PDF

Filters Specifies addit ional criteria to refine report data.

For more information, see Manage Filter Com-

ponents for a Non-Chapter Report.

CSV, DISA ARF, DISA

Consolidated ARF,

DISA ASR, Cyber-

Scope; Iterator,

Table, and Chart ele-

ments in PDF

Find/Update Fil-

ters

This option appears after you add at least one

chapter to the report.

For more information, see Manage Filter Com-

ponents for Mult iple Elements.

PDF

Display Options

These options allow you to specify column format information format. A selection to define the

columns and number of results to appear in the report is then available for configuration.

Option Description Relevant Reports

Results Dis-

played

The number of results included in the CSV file. CSV; Iterator, Table, Bar

Chart, and Pie Chart ele-

ments in PDF

Sort Column The column that Tenable Security Center uses

to sort results in the CSV file.

Available columns depend on:

l the Type you selected in the Definition

options

l the Display Columns value you select in

the Display options

CSV; Iterator, Table, Bar

Chart, and Pie Chart ele-

ments in PDF
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Option Description Relevant Reports

Sort Dir-

ection

The sort direction for results in the CSV file. CSV; Iterator, Table, Bar

Chart, and Pie Chart ele-

ments in PDF

Display

Columns

The columns included in the results file. Avail-

able columns depend on Definition options you

select.

Tip: The Display Columns appear in the results
file in the order in which you select them.

CSV; Iterator, Table, Bar

Chart, and Pie Chart ele-

ments in PDF

Distribution Options

Distribution options specify the actions Tenable Security Center takes when a report run com-

pletes.

Option Description
Relevant

Reports

Email Users Select Tenable Security Center users to whom Tenable Secur-

ity Center emails the completed report. The drop-down list

includes only users with defined email addresses.

Any

Email

Addresses

Add CC email addresses where Tenable Security Center

emails the completed report. You can specify mult iple email

addresses, separated by commas.

Any

Share Allows you to select which Tenable Security Center users

within your organization can view the completed report in

Tenable Security Center. Use this option if organizational

policies prohibit emailing potentially sensit ive data.

Any

Publishing

Sites

Allows you to select predefined publishing sites where Ten-

able Security Center uploads the completed report. For more

information, see Publishing Sites Sett ings.

Any
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Edit a Report Outline

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, the report outline allows you to modify the structure of a PDF or tem-

plate-based report.

The outline consists of the following components:

Component Outline Level Description

chapter primary Highest-level component. Can contain any type of ele-

ment (grouping, text, chart).

element subordinate A grouping, text, or chart element. Can be nested in a

chapter or grouping component.

To edit a report outline:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. The outline is, by default, expanded.

4. In the report outline, you can:

l Expand or collapse elements nested in the outline by clicking Collapse All or Expand All

at the top of the outline.

l Expand or collapse elements nested in an individual chapter or element by clicking the

arrow next to the element.

l Add a custom chapter.
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l Add a template chapter.

l Add or edit a report element.

l Reorder chapters and elements in a report.

l Delete a report element by clicking the delete icon next to the element.

Note: Tenable Security Center does not ask you to confirm this deletion. However, the dele-
t ion is not final until you save all changes to the report.

5. Click Submit to save your changes to the report.
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Add a Custom Chapter to a Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, you can add custom chapters to PDF or template-based reports.

To add a custom chapter to a report definit ion:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. At the bottom of the report outline, click Add Chapter

Tip: If the report contains mult iple chapters or sections, scroll down to locate the bottom navigation
bar. It can also be helpful to click Collapse All on the top navigation bar to collapse the outline to its
highest-level components.

The Add Chapter page appears.

5. In the Name box, enter a tit le for the chapter.

6. In the Location box, select a relative location for the chapter within the report.

7. In the Style box, select a style for the report.

8. Click Submit.

Tenable Security Center adds the chapter to the report and displays the Edit Report page.

9. Click Submit to save your changes to the report.
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Add a Template Chapter to a Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, you can add template chapters to template reports and custom PDF

reports.

To add a template-based chapter to a report definit ion:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. At the bottom of the outline, click Add Template Chapter.

5. Do one of the following:

l In the Search Templates box in the top right corner of the page, search for a specific

template by keyword.

Tip: After the init ial search, you can limit search results by template category.

l Click a template category icon to view the related templates.

6. Click the report template that contains chapters you want to include in your custom report.

7. (Optional) Modify the default options for the report template:

a. In the Chapters section, select which chapters from the template you want to include in

your report. By default, the report includes all chapters from the template.
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b. Do one of the following:

l In the Focus section, target all systems in the report.

This is the default sett ing. To return to this sett ing, click All Systems in the Tar-

gets drop-down box.

l Target specific assets in the report.

i. In the Targets drop-down box, click Assets.

ii. Select Assets and Repositories.

l Target specific IP addresses in the report.

i. In the Targets drop-down box, click IP Addresses.

ii. In the IP Addresses box, type the IP address or addresses where you want

the report to focus. Use commas to separate mult iple addresses.

iii. In the Repositories box, select a target repository or repositories.

l Target specific repositories in the report.

i. In the Targets drop-down box, click Repositories.

ii. In the Repositories box, select a target repository or repositories.

c. (Optional) Edit text in the Description box.

Note: You cannot modify any information in the Details section.

8. Click Add.

Tenable Security Center adds the template chapter or chapters to your custom report and dis-

plays the Add Report page again.

9. (Optional) Change the template chapter options.

a. Click the edit icon next to the chapter you added.

b. In the Name box, edit the chapter t it le.

c. In the Location box, change the relative location for the chapter within the report.
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d. In the Style box, select a style for the chapter.

e. Click Submit to save your changes to the chapter.

10. Click Submit to save your changes to the report.
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Add or Edit a Report Element

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can add or edit elements within chapters or grouping elements in Tenable Security Center

reports.

To add or edit a report element:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. Do one of the following:

l Click Add Element next to the element where you want to add the element.

l Click the edit icon next to the element you want to change.

Tip: To display Add Element or the edit icon, hover the cursor over the element.

5. Configure any of the following types of elements:

l Grouping

l Text

l Charts

6. Click Submit to save your changes to the report.

- 712 -

https://docs.tenable.com/security-center/Content/UserRoles.htm
https://docs.tenable.com/security-center/Content/UserRoles.htm


Configure a Grouping Element in a Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

Grouping elements in Tenable Security Centerreports include:

Type Description
Relevant

Reports

Group Groups associated elements on the same page. PDF

Section Allows you to organize content within chapters. PDF

Iterator Allows you to specify how the report groups its data. For

example, if an Iterator Type of Port Summary is chosen for a vul-

nerability report, vulnerability data in the report is grouped by

detected ports. If you do not configure an iterator, hosts and vul-

nerabilit ies are listed in the report individually.

PDF

To configure a grouping element:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. Click Add Element.

Tip: To display Add Element, hover the cursor over the element.
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5. Do one of the following:

l Add a group to the report.

a. In the Grouping section, click the Group icon.

b. Configure the following options:

Option Action

Name Type a name for the element.

Location Select a location for the element in the report.

Style Select a style for the element.

l Add a section to the report.

a. In the Grouping section, click the Section icon.

b. Configure the following options:

Option Action

Name Type a name for the element.

Location Select a location for the element in the report.

Style Select a style for the element.

l Add an iterator to the report.

a. In the Grouping section, click the Iterator icon.

b. Configure the following options:

Option Action

General

Name Type a name for the element.
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Location Select a location for the element in the report.

Style Select a style for the element.

Definit ion

Query Select a predefined query to define the data included in the

element. For more information, see Queries.

Type Select the type of data to include in the element. Iterator

elements support vulnerability or event data only.

Source Select the source of the data included in the element.

Valid values for this field differ based on the sett ing of the

Type option:

l If Type is set to Vulnerability, valid Source values are:

o Cumulative—All vulnerabilit ies, regardless of

whether the vulnerabilit ies have been remedi-

ated or not

o MItigated—Remediated vulnerabilit ies

o Individual Scan—Vulnerabilit ies identif ied in a

specific scan

Note: If you select Individual Scan, Tenable
Security Center displays the Selected Scan
option, which allows you to select a scan to
use as the basis of the report:

a. Click one of the predefined date ranges, or
click Custom Range and enter start ing and
ending days for the range.

b. Click Fetch Scans to view a list of possible
scans within the date range.
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c. Click the scan you want to use in the drop-
down box.

l If Type is set to Event, valid Source values are:

o Active—Currently active events

o Archive—Archived events

Note: If you select Archive, Tenable Security
Center displays addit ional options, allowing you
to select the LCE that collected the events and
the Silo that stores the archived events.

Filters Specify addit ional criteria to refine element data. See Man-

age Filters for a Chapter Report

Iterator Type Select a grouping method for iteration data:

l IP Summary—Group vulnerability or event data by the

IP addresses of detected hosts.

l Port Summary—Group vulnerability or event data by

the detected ports.

l Type Summary—Group event data by event type.

l User Summary—Group event data by user.

l Vulnerability Summary—Group vulnerability data by

individual vulnerability.

Results Dis-

played

Select the number of results you want to include in the iter-

ation.

Sort Column Select the column that Tenable Security Center uses to

sort the iteration data.
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Sort Direction Select the sort direction for the iteration data.

Header Inform-

ation

Select the columns you want to include in the iteration

data. Available columns depend on the sett ings of the Type

and Source options.

6. Click Submit to save the element.

7. Click Submit to save your changes to the report.
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Configure a Text Element in a Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

Text elements in Tenable Security Center reports include:

Type Description
Relevant

Reports

Matrix Data in a chart layout. PDF

Table Data in a table layout (max results displayed: 999).

The underlying data set determines the report display. The

default view for most reports is host-centric and Tenable

Security Center presents the user with the ability to choose a

vulnerability-centric report (a list ing of vulnerabilit ies with all

associated hosts).

PDF

Paragraph Descriptive text that can be inserted anywhere in the report.

Use this option to describe table elements or report output

for the viewer.

PDF

Assurance

Report Card

An element based on the results of a selected Assurance

Report Card.

PDF

To configure a text element in a report:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.
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4. Do one of the following:

l Click Add Element to add an element.

l Click the edit icon next to the element to edit an existing element.

Tip: To display Add Element and the edit icon, hover the cursor over the element.

5. Do one of the following:

l Add a matrix to the report.

l Add a table to the report.

l Add a paragraph to the report.

a. In the Text section, click the Paragraph icon.

b. Configure the following options:

Option Action

Name Type a name for the element.

Location Select a location for the element in the report.

Style Select a style for the element.

Text Type the text of the paragraph.

c. Click Submit to save your changes to the element.

l Add an Assurance Report Card to the report.

a. In the Text section, click the Assurance Report Card icon.

- 719 -



b. Configure the following options:

Option Action

Name Type a name for the element.

Location Select a location for the element in the report.

Style Select a style for the element.

Assurance

Report Card

Select the Assurance Report Card (ARC) you want to add to

the report. For more information on ARCs, see Assurance

Report Cards.

c. Click Submit to save your changes to the element.

6. Click Submit to save your changes to the report.
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Configure a Matrix Element in a Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

A matrix element is a type of text element you can insert into a Tenable Security Center report defin-

it ion. For more information on text elements, see Configure a Text Element in a Report.

To configure a matrix element in a report:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. Do one of the following:

l Add a new element.

a. Click Add Element.

b. In the Text section, click the Matrix icon.

l Click the edit icon next to the element you want to change.

Tip: To display Add Element and the edit icon next to an element, hover the cursor over the
element.

5. Configure the General options:

Option Action

Name Type a name for the element.
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Location Select a location for the element in the report.

Style Select a style for the element.

6. In the Cells section, select the number of columns and rows you want the matrix to include. By

default, the matrix is 4 cells by 4 cells.

7. Click Generate Cells.

Tenable Security Center displays the empty matrix for configuration.

8. Do one of the following:

l Edit a row or column header.

a. Click the header for the row or column you want to edit.

b. Next to the header label, click the menu.

The actions menu appears.

c. Click Edit Header.

d. In the Label box, type a new header.

e. Click Submit.

l Add a matrix component.

a. Click the matrix cell where you want to add the component.

b. In the Data Type drop-down box, select the type of data for the component.

c. In the Type drop-down box, select the type of calculation you want the component

to perform.

d. In the Source drop-down box, select a data source.

e. (Optional) In the Filter box, add or edit a filter using the same steps you would to

add a filter to a report element; see Manage Filter Components for a Single Ele-

ment.

f. In the Rules section, click Add Rule to add a rule.
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-or-

Click the edit icon next to a rule to edit an existing rule.

g. Click Submit to save your changes to the component.

l Copy a row or column.

a. Click the header for the row or column you want to copy.

b. Next to the header label, click the menu.

The actions menu appears.

c. Click Copy.

For columns, Tenable Security Center inserts the copied column to the right of the

original column

For rows, Tenable Security Center inserts the copied row under the original row.

l Delete a row or column.

a. Click the header for the row or column you want to delete.

b. Next to the header label, click the menu.

The actions menu appears.

c. Click Delete Cells.

9. Click Submit to save your changes to the element.

10. Click Submit to save your changes to the report.

Example
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Configure a Table Element in a Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

A table element is a type of text element you can insert into a Tenable Security Center report defin-

it ion. For more information on text elements, see Configure a Text Element in a Report.

To configure a table element in a report:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. Do one of the following:

l Add a new element.

a. Click Add Element.

b. In the Text section, click the Table icon.

l Click the edit icon next to the element you want to change.

Tip: To display Add Element and the edit icon next to an element, hover the cursor over the
element.

5. Configure the General options:

Option Action

Name Type a name for the element.
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Location Select a location for the element in the report.

Style Select a style for the element.

6. Configure the Data options:

Option Description

Type

Equivalent to the Definition option of the same name in Report Options.

Query

Source

Tool

Filters

7. Configure the Display options:

Option Description

Results Displayed

Equivalent to the Display option of the same name in Report Options.
Sort Column

Sort Direction

Display Columns

8. Click Submit to save your changes to the element.

9. Click Submit to save your changes to the report.

Example
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Configure a Charts Element in a Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

Charts elements in Tenable Security Center reports include:

Option Description
Relevant

Reports

Bar Chart Click to add a bar chart element to the report. PDF

Pie Chart Click to add a pie chart element to the report. PDF

Line

Chart

Click to add a line chart element to the report. PDF

- 727 -

https://docs.tenable.com/security-center/Content/UserRoles.htm
https://docs.tenable.com/security-center/Content/UserRoles.htm


Option Description
Relevant

Reports

Line charts are defined by time (x-axis) and series data (y-axis).

When selecting the time, available options include Relative time

and Absolute time. One or more series data elements can be

chosen and displayed as discrete lines for easy comparison.

Area

Chart

Click to add an area chart element to the report.

Area charts are defined by time (x-axis) and series data (y-axis).

When selecting the time, available options include Relative time

and Absolute time. One or more series data elements can be

chosen and displayed as a stackable view for easy comparison.

PDF

To configure a chart element in a report:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.
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The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. Do one of the following:

l Add a chart element

a. Click Add Element to add an element.

b. In the Charts section, click the icon for the type of chart you want to add.

l Click the edit icon next to an existing chart element.

Tip: To display Add Element and the edit icon, hover the cursor over the element.

5. For all charts, configure the General options:

Option Action

Name Type a name for the element.

Location Select a location for the element in the report.

Style Select a style for the element.

6. For bar charts and pie charts, configure the following Data options:

Option Action

Type

Equivalent to the option the Definition option of the same name in Report

Options.

Query

Source

Tool

Filters

7. For line charts and area charts, configure the following Data options:
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Option Action

Data Type Valid values are Relative and Absolute. Use to configure the x-axis of the

chart.

Data

Range

Use to configure the x-axis of the chart:

l If you select Relative for Data Type, select a relative date range.

l If you select Absolute for Data Type, select a specific start and end

date for the data.

Series Use to configure the y-axis of the chart. Line charts and area charts require

that you configure at least one series.

8. For bar charts and pie charts, configure the following Display options:

Option Action

Results Displayed

Equivalent to the Display option of the same name in Report Options.
Sort Column

Sort Direction

Display Columns

9. Click Submit to save your changes to the element.

10. Click Submit to save your changes to the report.
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Reorder Report Chapters and Elements

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, you can reorder chapters and elements in a PDF, CSV, or template-

based report.

To reorder report chapters and elements:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. Do one of the following:

l In the report outline, click the report element, then drag and drop it to its new location.

l Click the edit icon for the component, and select a new location in the Location drop-

down box.

5. Click Submit to save your changes to the report.
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Manage Filters for a Chapter Report

In Tenable Security Center, PDF and template-based reports use a chapter structure, so you can

specify different filters for individual chapter elements of those reports.

You can manage filters for a single element or for mult iple elements at the same time. For more

information, see:

l Manage Filter Components for a Single Element

l Manage Filter Components for Mult iple Elements
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Manage Filter Components for a Single Element

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

Tip: You can build filters using one or more f ilter components with defined f ilter component criteria. Filter
components are types of data (e.g., CVE ID or Severity). After you select a filter component, you specify
the filter component criteria (e.g., a specific CVE ID or a specific severity level).

To manage filter components for a single element in a chapter report in Tenable Security

Center:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. Click the edit icon next to the element you want to edit.

Tip: To display icons next to a element, hover the cursor over the element.

5. Do one of the following:

l Add a filter component.

Use these steps to add one or more filter components to a single element. For inform-

ation about the filter components available for vulnerability analysis data or event ana-

lysis data, see Vulnerability Analysis Filter Components or Event Analysis Filter

Components.
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a. In the Data section, click Add Filter.

b. Select a filter component from the drop-down box.

c. Set the filter component criteria, as prompted.

Depending on the filter component you selected, Tenable Security Center prompts

you to type the value you want to filter for or to select from valid values and oper-

ators.

Note: If Tenable Security Center does not prompt you to specify an operator, the
unstated operator is equivalent to is equal to or is set to.

d. Click the check mark next to the filter component to stop edit ing it.

Note: The new filter component is not saved until you click Submit.

l Edit a filter component.

a. In the Data section, click the pencil icon next to the filter component.

b. Edit the filter component criteria.

c. Click the check mark next to the filter component to stop edit ing it.

Note: Your changes to the filter are not saved until you click Submit.

l Delete a filter component.

In the Data section, click the delete icon next to the filter component.

Note:Tenable Security Center does not prompt you to confirm the deletion. However, the dele-
t ion is not final until you click Submit to save your changes.

6. Click Submit.
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Manage Filter Components for Multiple Elements

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

When managing filter components for a chapter report in Tenable Security Center, you can search

the report for elements that use certain filter components, then update the filter component cri-

teria for all matching elements in that report at the same time.

Tip: You can build filters using one or more f ilter components with defined f ilter component criteria. Filter
components are types of data (e.g., CVE ID or Severity). After you select a filter component, you specify
the filter component criteria (e.g., a specific CVE ID or a specific severity level).

You can use the following filter components to search and update: Address, Audit File, Asset, CVE

ID, DNS Name, IAVMID, Repositories, Scan Policy, and Severity.

For example, if you search a report definit ion for all elements where the Severity f ilter component is

set to Info, you can update the Severity f ilter component to Medium for all elements, and add an

Audit File f ilter component to the elements at the same time.

To manage filter components for mult iple elements in a chapter report:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. On the left side of the page, click Definition.

The report outline appears. This outline is, by default, expanded. For more information, see

Edit a Report Outline.

4. At the top of the outline, click Find/Update Filters.

To search for specific elements in the report:

1. In the Search Filters section, click Add Search Filter.

2. Select a filter component from the drop-down box.
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3. Select an operator from the drop-down box.

a. If you selected is equal to or contains as operator, type filter component criteria or

select a value from the list of valid filter component criteria, as appropriate to the filter

component you selected.

4. Click the check mark at the end of the filter box.

Tenable Security Center searches the report outline for elements that match your search cri-

teria and displays the results in the Matching Filters box.

To specify the filter updates you want to make:

1. In the Update Actions section, click Add Search Filter.

2. Select a filter component from the drop-down box.

3. Select an operator from the drop-down box.

4. Type filter component criteria or select a value from the list of valid filter values, as appro-

priate to the filter component and operator you selected.

5. Click the check mark at the end of the filter box.

To review and update the filter updates:

1. In the Matching Filters box, review the list to verify that you want to apply the update to all the

listed elements.

Tip: If you do not want to apply the current update to all the listed elements, it may be more appro-
priate to manage filter components by individual element. For more information, see Manage Filter
Components for a Single Element.

2. Click Update Filters.

Tenable Security Center applies the updates to the matching elements and returns you to the

report outline.

3. Click Submit to save your changes to the report.
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Manage Filter Components for a Non-Chapter Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, CSV, DISA ARF, DISA ASR, and Cyberscope reports do not use a chapter

structure, so you can create a set of filter components that apply to every element of the report.

Tip: You can build filters using one or more f ilter components with defined f ilter component criteria. Filter
components are types of data (e.g., CVE ID or Severity). After you select a filter component, you specify
the filter component criteria (e.g., a specific CVE ID or a specific severity level).

To manage filter components for a non-chapter report:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the reports table, click the name of the report you want to edit.

The Edit Report page appears.

3. Do one of the following:

l Add a filter component.

Use these steps to add one or more filter components to a single element. For inform-

ation about the filter components available for vulnerability analysis data or event ana-

lysis data, see Vulnerability Analysis Filter Components or Event Analysis Filter

Components.

a. In the Definition section, click Add Filter.

b. Select a filter component from the drop-down box.

c. Set the filter component criteria, as prompted.

Depending on the filter component you selected, Tenable Security Center prompts

you to type the value you want to filter for or to select from valid values and oper-

ators.
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d. Click the check mark next to the filter component to stop edit ing it.

Note: The new filter component is not saved until you click Submit.

l Edit a filter component.

a. In the Definition section, click the edit icon next to the filter component.

b. Edit the filter criteria.

c. Click the check mark next to the filter component to stop edit ing it.

Note: Your changes to the filter component are not saved until you click Submit.

l Delete a filter component.

In the Definition section, click the delete icon next to the filter component.

Note:Tenable Security Center does not prompt you to confirm the deletion. However, the dele-
t ion is not final until you click Submit to save your changes.

4. Click Submit to save your changes.
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View a Report Definition

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To view a report definit ion:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the row for the report definit ion you want to view, click the menu.

The actions menu appears.

3. In the row for the report definit ion you want to view, click the menu.

The actions menu appears.

4. Click View.

Tenable Security Center displays a read-only version of the report definit ion.

Note: If you want to edit or delete the report definit ion from this page, see Edit a Report Definit ion
or Delete a Report Definit ion.
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Copy a Report Definition

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can share a copy of a report definit ion with other users in your organization in Tenable Security

Center. This feature is useful for maintaining consistency throughout your organization.

After you share the copy, the other users own their local copy and can edit or delete as with any

report they create themselves. Later changes you make to the original do not synchronize auto-

matically to the copy.

To copy a report definit ion:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the row for the report definit ion you want to copy, click the menu.

The actions menu appears.

3. Click Copy.

The Copy Report page appears.

4. In the Group box, select the group you want to grant access to a copy of the report.

5. Specify the user(s) that you want to grant access to a copy of the report.

6. Click Copy.

Tenable Security Center copies the report definit ion to the other accounts you specified. The

copy appears, named Copy of DefinitionName.
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Export a Report Definition

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, you can export a report definit ion as an .xml f ile. This feature is useful

for organizations running mult iple Tenable Security Center deployments to provide consistent

reports without duplicating the work needed to create definit ion templates.

To export a report definit ion:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the row for the report definit ion you want to export, click the menu.

The actions menu appears.

3. Click Export.
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4. Click the export option you want to use:

Option Description

Keep All Refer-

ences

Export the report definit ion with object references intact.

Users who meet the following requirements can use an imported

report definit ion with intact object references:

l The user must be in the same organization as the user who

exported the report definit ion.

l The user must have access to all relevant objects in the report

definit ion.

Remove All

References

Export the report definit ion with object references removed, altering

the definit ions of the components.

Any user can use an imported report definit ion with object references

removed.

Replace With

Placeholders

Export the report definit ion with object references replaced with

their respective names.

Users must replace the placeholder names with applicable objects

available to their organization in order to use an imported report

definit ion with placeholder names.

Tenable Security Center downloads the report definit ion to your computer.
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Import a Report Definition

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

In Tenable Security Center, you can only import XML files in the same format used to export report

definit ions. This feature is useful for organizations running mult iple Tenable Security Center deploy-

ments to provide consistent reports without duplicating the work needed to create definit ion tem-

plates.

To import a report definit ion:

1. Copy the report definit ion file to your local computer.

2. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

3. In the top right corner of the page, click Options.

4. Click Import Report.

5. In the Name box, type a name for the report.

6. Click Choose File next to the Report Definition box.

7. Browse to the local copy of the report definit ion XML file.

8. Click Import.

Tenable Security Center imports the report definit ion.

9. (Optional) Edit the report definit ion as desired.
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Delete a Report Definition

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To delete a report definit ion:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. In the row for the report you want to delete, click the menu.

The actions menu appears.

3. Click Delete.

4. Click Delete to confirm the deletion.

Tenable Security Center deletes the report definit ion.

Note: Tenable Security Center retains any report results associated with the deleted definit ion. You
must manually delete results associated with the report.
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Launch a Report on Demand

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To launch a report on demand:

1. In the top navigation bar, click Reporting > Reports.

The Reports page appears.

2. Click the gray triangle icon next to the report you want to launch.

Tenable Security Center starts the report.

3. (Optional) Monitor the status of the report in the Report Results page.

To view this page, do one of the following:

l In the launch notification message, click View Report Results.

l In the top navigation bar, click Reporting > Report Results.

Note: In the Report Results page, you can also stop the currently running report.
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Add a Report to a Scan

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

After you create one or more on demand reports, you can add them to active scan, agent scan, or

agent synchronization job configurations.

To add a preconfigured report to an active scan, agent scan, or agent synchronization job:

1. Do one of the following:

l Begin configuring an active scan, as described in Add an Active Scan.

l Begin configuring an agent scan, as described in Add an Agent Scan.

l Begin configuring an agent synchronization job, as described in Add an Agent Syn-

chronization Job.

2. In the Post Scan section, click Add Report.

The page displays available on demand reports.

3. Select the report you want to add.

4. (Optional) If you want the report to include cumulative data in Tenable Security Center, enable

the Create report using cumulative data option.

If you disable this option, the report includes data only from the configured scan.

5. Click the checkmark icon to save the report.

6. (Optional) If you want to add multiple reports, repeat steps 2-5 for each addit ional report.

7. Click Submit.

Tenable Security Center saves your configuration.
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Manage Report Results

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

On the Report Results page of Tenable Security Center, you can manage both currently running

reports and completed report results. Completed report results include successful and failed report

runs, so you can access and distribute a successful report result or troubleshoot a report failure.

For more information, see Reports.

To manage report results:

1. Click Reporting > Report Results.

The Report Results page appears.

2. Do any of the following:

l Filter existing report results in the report results table.

l Stop a currently running report.

l Download a successful report result to your computer.

l View a successful report result.

l Publish a successful result.

l Email a copy of a successful result to specified users.

l Share a copy of a successful result with other Tenable Security Center user accounts.

l View error condit ions for a failed report.

l Delete a report result.
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Stop a Running Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

If you want to stop a report that is currently running:

1. Click Reporting > Report Results.

The Report Results page appears.

2. Click the gray square icon next to the report you want to stop.

Tenable Security Center stops the report run.

Note: You cannot restart a stopped report run. You can only launch the report again.
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Download a Report Result

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To download a successful report result to your computer:

1. Click Reporting > Report Results.

The Report Results page appears.

2. Do one of the following:

l In the Results table, click the name of the report.

l Click the download icon next to the report result in the results table.

l Click the menu next to the report result.

The actions menu appears.

a. Click Download.
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View a Report Result

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To view a successful report result:

1. Click Reporting > Report Results.

The Report Results page appears.

2. In the row for the report result you want to view, click the menu.

The actions menu appears.

3. Click View.

The report appears.

4. (Optional) To download the report result to your computer, click Download.

The report result downloads.

5. (Optional) To delete the report result, click Delete.

Tenable Security Center deletes the report result.
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Publish a Report Result

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To publish a successful report result:

1. Click Reporting > Report Results.

The Report Results page appears.

2. In the row for the report result you want to publish, click the menu.

The actions menu appears.

3. Click Publish.

The Publish Report Results window appears.

4. Search for and select a publishing site.

5. Click Publish.

Tenable Security Center publishes the report result.
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Email a Report Result

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To email a copy of a successful report result to specific users:

1. Click Reporting > Report Results.

The Report Results page appears.

2. In the row for the report result you want to email, click the menu.

The actions menu appears.

3. Click Email.

4. Do one of the following:

l Use the Group and User boxes to select the Tenable Security Center user or users you

want to receive the report result.

l Type the email address of recipients who are not Tenable Security Center users.

5. Click Submit.

Tenable Security Center sends the report result.
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Copy a Report Result

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To share a copy of a successful report result with other Tenable Security Center user

accounts:

1. Click Reporting > Report Results.

The Report Results page appears.

2. In the row for the report result you want to copy, click the menu.

The actions menu appears.

3. Click Copy.

4. In the Group box, select the group you want to grant access to a copy of the report result.

5. Specify a user or users that you want to grant access to a copy of the report result.

6. Click Copy.

Tenable Security Center copies the report result to the other accounts you specified. The

copy appears, named Copy of ResultName.
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View Errors for a Failed Report

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To view error condit ions for a failed report:

1. Click Reporting > Report Results.

The Report Results page appears.

2. Click the name of the failed result in the results table.

The View Report Results page appears.

3. Review the Error Details section.
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Delete a Report Result

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To delete a report result: 

1. Click Reporting > Report Results.

The Report Results page appears.

2. In the row for the report result you want to delete, click the menu.

The actions menu appears.

3. Click Delete.

A confirmation window appears.

4. Click Delete to confirm the deletion.

Tenable Security Center deletes the report result.
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CyberScope and DISA Report Attributes

Report attributes are used for adding required information to CyberScope or DISA report types.

After you create an attribute, you can select it during CyberScope, DISA ARF, or DISA Consolidated

ARF report creation. For more information, see Create a Custom Report.

To filter the Report Attributes page, see Apply a Filter.

Configure the following options, including options specific for your attribute type: CyberScope

Options or DISA Options.

General Option Description

Name A name for the attribute.

Description (Optional) A description for the attribute.

Type The type of attribute you want to create. Your Type selection determines the

other options you must configure: CyberScope Options or DISA Options.

CyberScope Options

The following table describes the addit ional options to configure when configuring a CyberScope

attribute.

Option Description

Reporting Com-

ponent

The CyberScope value for a reporting component (e.g., Department of

Justice).

Component

Bureau

The CyberScope value for a FISMA reporting entity within the Reporting Com-

ponent (e.g., Justice Management Division).

Enclaves The CyberScope value for an enclave associated with the Reporting Com-

ponent or Component Bureau.

DISA Options

The following table describes the addit ional options to configure when configuring a DISA attribute.
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Option Description

Owning Unit

Name (Required) The Cyber Operational Attributes Management Sys-

tem (COAMS) fully qualif ied hierarchy name of the owning organ-

ization.

Owning Service

Name The COAMS fully qualif ied hierarchy name of the owning com-

batant command, service, or agency.

Current AOR The COAMS fully qualif ied hierarchy name of the appropriate

combatant command area of responsibility (COCOM AOR).

Region A region for the owning service.

Administration Unit

Name The COAMS fully qualif ied hierarchy name of the administering

organization.

Administration POC

Any required information you need to provide about the administration unit 's point of contact

(POC).

Tip: Tenable recommends leaving the Generational Qualifier option blank.

CND Service Provider

Name The COAMS fully qualif ied hierarchy name of the Computer Net-

work Defense Service Provider (CNDSP).

Por Managed (Required) Specifies if the reported assets are centrally man-

aged by a program management office (PMO): true or false.

System Affiliat ion The COAMS operationalacredit value that specifies the fully qual-

if ied hierarchy name of the system affiliat ion.
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Option Description

Location

Tip: Tenable recommends leaving all options blank except the Street Address. The Street Address spe-
cifies the COAMS geolocation area.
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Report Images

In Tenable Security Center, the Report Images interface allows a user with permissions to view

details, add, edit, or delete PDF report images. From this interface, you can manage two types of

images: logos and watermarks. Logos appear at the bottom of each page, while watermarks appear

prominently across the center of the report page.

Note: Image files must be of type .png or .jpg. Images used must be consistent when selecting the bit
depth (8-bit, 16-bit, 24-bit, etc.). Otherwise, errors might be encountered when generating reports.

To filter the Report Images page, see Apply a Filter.

Report Image Options

Option Description

Add Add a new logo or watermark image. Note that only PNGand JPEGformats are

supported. The default image sizes are as follows, all at 300 DPI:

l default-cover-logo = 987x130

l default-footer-logo = 380x100

l default-page-logo = 579x84

l default-watermark = 887x610

While there are no set limitations on image size or resolution, using images that

are different from these specifications can have a negative impact on report

appearance.

Note: The image size must be set to 300 DPI to prevent image breaks.

Edit Edit any of the selected image’s options, including name, description, type and

file.

Detail View image details, including name, description, date uploaded, last modified, and

type.

Delete Delete the highlighted image.
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Assurance Report Cards

Assurance Report Cards (ARCs) provide an overview of the security posture of your network. These

configurable reports provide quick visible feedback using a pass or fail methodology for each policy

statement in the ARC.

Organizational users with appropriate permissions can add a template-based ARC using Tenable-

provided templates or you can add a custom ARC. For more information about Tenable-provided

ARC templates, see the Assurance Report Cards blog. For more information about user per-

missions, see User Roles.

l Add a Template-Based Assurance Report Card

l Add a Custom Assurance Report Card

l Assurance Report Card Options

l Edit an Assurance Report Card

l View Your Assurance Report Cards

l View Details for an Assurance Report Card

l Share or Revoke Access to an Assurance Report Card

l Export an Assurance Report Card

l Copy an Assurance Report Card

l Delete an Assurance Report Card
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Add a Template-Based Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can use a Tenable-provide template to add an Assurance Report Card (ARC). For more inform-

ation about Tenable-provided ARC templates, see the Assurance Report Cards blog. To create a cus-

tom ARC, see Add a Custom Assurance Report Card.

For more information, see Assurance Report Cards.

To add a template-based Assurance Report Card:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. Click Add.

The Assurance Report Card Templates page appears.

4. Click a template category tile.

The list of templates for the selected category appears.

5. Click a template.

The Add Assurance Report Card Template page updates to reflect the template you selected.

6. Modify the ARC template. For more information, see Assurance Report Card Options.

l To edit the ARC name, click ARC template tit le.

l To edit the ARC description, click the Description box.

l To edit the required assets, click an item in the Required Assets section.

l To restrict the target data displayed in the ARC, click the Targets drop-down box.

l To set how often the ARC polls data sources to obtain updates, click Schedule.

7. Click Add.

Tenable Security Center saves your configuration.
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Add a Custom Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can create a fully customized Assurance Report Card (ARC). To add an ARC from a Tenable-

provided template, see Add a Template-Based Assurance Report Card.

For more information, see Assurance Report Cards.

To add a custom Assurance Report Card:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. In the Options drown-down box, click Advanced Add.

The Advanced Add Assurance Report Cards page appears.

4. Configure the ARC options. For more information, see Assurance Report Card Options.

5. Click Submit.

Tenable Security Center saves your configuration.
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View Your Assurance Report Cards

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can view a summary that displays each Assurance Report Card (ARC), the overall status of the

ARC, and the status of each policy statement in each ARC. To view details for an ARC, see View

Details for an Assurance Report Card.

For more information, see Assurance Report Cards.

Tip: To change the posit ion of an ARC in the list, click the icon next to the ARC and drag it to a new pos-
it ion.

Before you begin:

l Add an ARC, as described in Add a Template-Based Assurance Report Card or Add a Custom

Assurance Report Card.

To view a summary of your Assurance Report Cards:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. Click the row for the ARC.

The ARC expands to display each policy statement in the ARC.

4. View the status of each ARC and its policy statements.

l A green icon ( ) next to an ARC indicates all policy statement in the ARC passed.

l A red icon ( ) next to an ARC indicates one or more policy statements in the ARC failed.

l A green check mark ( ) next to a policy statement indicates the policy statement

passed.

l A red x ( ) next to a policy statement indicates the policy statement failed.

What to do next:
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l (Optional) Click a policy statement to view vulnerability analysis for the policy statement data.

For more information, see Vulnerability Analysis.
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View Details for an Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Assurance Report Cards.

Before you begin:

l Add an Assurance Report Card (ARC), as described in Add a Template-Based Assurance

Report Card or Add a Custom Assurance Report Card.

To view details for an Assurance Report Card:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. In the Options drop-down menu, click Manage ARCs.

The Manage Assurance Report Cards page appears.

4. In the row for the ARC, click the menu.

The actions menu appears.

5. Click View.

The View Assurance Report Card page appears. For more information, see Assurance Report

Card Options.

Section Action

Options drop-down box l To edit the ARC, click Edit.

l To delete the ARC, click Delete.

General View general information about the ARC.

l Name —The ARC name.

l Description —The ARC description.
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Section Action

l Schedule —TheARC schedule.

l Created —The date the ARC was created.

l Last Modified —The date the ARC was last modified.

l Owner —The user who created or owns the ARC.

l Group —The group associated with the Owner.

l ID —The unique identif ier for the ARC.

Policy Statements View the policy statements in the ARC.

Focus View the targets configured for the ARC.
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Edit an Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Assurance Report Cards.

Before you begin:

l Add an Assurance Report Card (ARC), as described in Add a Template-Based Assurance

Report Card or Add a Custom Assurance Report Card.

To edit an Assurance Report Card:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. In the Options drop-down menu, click Manage ARCs.

The Manage Assurance Report Cards page appears.

4. In the row for the ARC, click the menu.

The actions menu appears.

5. Click Edit.

The Edit Report Card page appears.

6. Modify the ARC options. For more information, see Assurance Report Card Options.

7. Click Submit.

Tenable Security Center saves your configuration.
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Share or Revoke Access to an Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can share access to an Assurance Report Card (ARC) to give users in a group the ability to view

the ARC. The user's role and custom permissions determine if they can drill down into other pages

with more information. For more information, see Assurance Report Cards.

Before you begin:

l Add an ARC, as described in Add a Template-Based Assurance Report Card or Add a Custom

Assurance Report Card.

To share or revoke access to an Assurance Report Card:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. In the Options drop-down menu, click Manage ARCs.

The Manage Assurance Report Cards page appears.

4. In the row for the ARC, click the menu.

The actions menu appears.

5. Click Share.

The Share Assurance Report Card page appears.

6. In the box, search for and select the groups for which you want to share or revoke access.

7. Click Submit.

Tenable Security Center saves your configuration.
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Export an Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can export an Assurance Report Card (ARC) to share with other users in your organization. For

more information, see Assurance Report Cards.

Before you begin:

l Add an ARC, as described in Add a Template-Based Assurance Report Card or Add a Custom

Assurance Report Card.

To export an Assurance Report Card:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. In the Options drop-down menu, click Manage ARCs.

The Manage Assurance Report Cards page appears.

4. In the row for the ARC you want to export, click the menu.

The actions menu appears.

5. Click Export.

The export options appear.
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6. Click the export option you want to use:

Option Description

Keep All Refer-

ences

Export the ARC with object references intact.

Users who meet the following requirements can use an imported ARC

with intact object references:

l The user must be in the same organization as the user who

exported the ARC.

l The user must have access to all relevant objects in the ARC.

Remove All

References

Export the ARC with object references removed, altering the defin-

it ions of the components.

Any user can use an imported ARC with object references removed.

Replace With

Placeholders

Export the ARC with object references replaced with their respective

names.

Users must replace the placeholder names with applicable objects

available to their organization in order to use an imported ARC with

placeholder names.

Template Export the ARC as a template.

Tenable Security Center exports the ARC as an .xml f ile.
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Copy an Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Assurance Report Cards.

Before you begin:

l Add an Assurance Report Card (ARC), as described in Add a Template-Based Assurance

Report Card or Add a Custom Assurance Report Card.

To copy an Assurance Report Card:

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. In the Options drop-down menu, click Manage ARCs.

The Manage Assurance Report Cards page appears.

4. In the row for the ARC, click the menu.

The actions menu appears.

5. Click Copy.

Tenable Security Center copies the ARC. The copy appears, named Copy of ARC Name.
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Delete an Assurance Report Card

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Assurance Report Cards.

To delete an Assurance Report Card (ARC):

1. Log in to Tenable Security Center via the user interface.

2. Click Dashboard > Assurance Report Cards.

The Assurance Report Cards page appears.

3. In the Options drop-down menu, click Manage ARCs.

The Manage Assurance Report Cards page appears.

4. In the row for the ARC, click the menu.

The actions menu appears.

5. Click Delete.

A confirmation window appears.

6. Click Delete.

Tenable Security Center deletes the ARC.
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Assurance Report Card Options

You can configure the following options for Assurance Report Cards (ARCs). For more information,

see Assurance Report Cards.

l Assurance Report Card Options

l Policy Statement Options

Assurance Report Card Options

Option Description

General

Name The name of the ARC.

Description (Optional) A description for the ARC.

Schedule Specifies how often the ARC polls data sources to obtain updates.

l Daily (default) —The ARC polls data sources every 1-20 days at the spe-

cified time.

l Weekly —The ARC polls data sources every 1-20 weeks at the specified

time and day of the week.

l Monthly —The ARC polls data sources every 1-20 months at the spe-

cified time and day of the month.

For example, Every 2 months on the fourth Thursday at 15:00 -4:00 indicates

the ARC will poll data sources to obtain updates every two months, on the

fourth Thursday of the month, at 15:00 in the America/New York timezone.

Policy Statements

Add Policy

Statement

Click to add a custom policy statement to the ARC. For more information,

see Policy Statement Options.

Focus

Targets Specifies the target hosts for the ARC to analyze:
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Option Description

l All Systems —Targets all available hosts.

l Assets —Targets the specified assets. For more information, see

Assets.

Tip: Use NOT, OR, and AND operators to exclude unwanted assets from the
view.

l IPs —Targets the specified IP addresses. You can specify single

addresses, IP addresses in CIDR notation, and IP ranges.

l Repositories —Targets the specified repositories. For more inform-

ation, see Repositories.

If you want to match the specified assets or IP addresses against one or

more repositories, select the repositories you want to match against.

Note: If an IP address you specified appears in two or more repositories you
selected, the duplicated IP address negatively skews the ARC results.

Policy Statement Options

Option Description

Basic

Statement Specifies pass/ fail criteria for the policy statement.

Display Specifies how the ARC displays the policy statement: Ratio (x/y), Percentage

(%), or Compliant/Non-Compliant.

Advanced

Data Type The type of data you want the ARC to analyze: Vulnerabilities or Events.

Base Filters The filters used as the basis for data analysis.

l If the Data Type is Vulnerabilities, you can select from the list of vul-

nerability analysis filter components.
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Option Description

l If the Data Type is Events, you can select from a list of event analysis fil-

ter components.

Compliant Fil-

ters

The filters used to determine the compliance condit ions for the data analysis.

For more information, see Vulnerability Analysis and Event Analysis.

l If the Data Type is Vulnerabilities, you can select from the list of vul-

nerability analysis filter components.

l If the Data Type is Events, you can select from a list of event analysis fil-

ter components.

Note: Filters set in Base Filters are not present in Compliant Filters, with excep-
tion of the Assets and Plugin IDs. All f ilters set in Base Filters are carried over into
Compliant Filters.

Compliant

Condition

Specifies the condit ions to match for determining compliance. For more

information, see Vulnerability Analysis and Event Analysis.

Specify a quantity: All, No, Any, > (greater than), < (less than), >= (greater than

or equal to), and <= (less than or equal to).

Specify hosts: Hosts, Vulnerabilities, and Ports.

Drilldown Fil-

ters

The filters to apply when clicking on the ARC policy statement for more

details. For more information, see Vulnerability Analysis and Event Analysis.

l If the Data Type is Vulnerabilities, you can select from the list of vul-

nerability analysis filter components.

l If the Data Type is Events, you can select from a list of event analysis fil-

ter components.
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Filters

You can apply filters on many pages of the Tenable Security Center web interface to filter the data

displayed on the page.

You can build filters using one or more f ilter components with defined f ilter component criteria. Fil-

ter components are types of data (e.g., CVE ID or Severity). After you select a filter component, you

specify the filter component criteria (e.g., a specific CVE ID or a specific severity level).

If you want to save a filter for repeated use, create a query, as described in Queries.

For more information, see:

l Apply a Filter

l Filter Components

l Vulnerability Analysis Filter Components

l Event Analysis Filter Components

l Mobile Analysis Filter Components
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Apply a Filter

Required User Role: Any

You can use filters to narrow the data displayed on specific pages.

Each filterable page in Tenable Security Center has a different set of filter components. On the Vul-

nerability Analysis, Event Analysis, and Mobile Analysis pages, you can add and remove filter com-

ponents.

For more information, see Filters and Filter Components.

To filter data:

1. Log in to Tenable Security Center via the user interface.

2. Navigate to any page that supports filtering.

3. On the left side of the page, click the filter icon ( ).

The filter panel appears.

4. (Optional) To customize the filter components on an analysis page, do the following:

a. Click Customize.

The filter components selection window appears.

b. Select one or more filter component check boxes. For more information about the com-

ponents supported for your analysis view, see Vulnerability Analysis Filter Components,

Event Analysis Filter Components, and Mobile Analysis Filter Components.

c. Click Apply.

The filter panel updates to show the filter components you selected.

5. To modify the criteria for a filter component, click the box for the filter component.

The filter component criteria selection window appears.

6. Modify the filter component criteria.

7. Click OK.
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The filter panel updates to show the filter component criteria you modified.

8. Click Apply.

The page updates to reflect the filter you applied.

What to do next:

l (Optional) Save a filter on the Vulnerability Analysis page, Event Analysis page, and Mobile Ana-

lysis page as a reusable query, as described in Add or Save a Query.
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Filter Components

For general information about using filters, see Filters.

Filter Com-

ponent
Description

Access The level of object access to include in the filter:

l Manageable —Shows the objects your user account can modify.

For example, set the filter to show only the credentials you can edit.

l Usable —Shows the objects your user account can view or use.

For example, set the filter to show only the credentials you can use in

a scan.

Actions The alert actions to include in the filter: Email, Notify, Report, Scan,

SysLog, or Ticket. For more information, see Alerts and Alert Actions.

Agent Scanner The agent scanners to include in the filter. For more information, see Agent

Scanning.

Assignee The ticket assignees to include in the filter. For more information, see Tick-

ets.

Authorized The Log Correlation Engine Client authorization status to include in the

filter: yes or no.

Client IP The Log Correlation Engine Client IP addresses to include in the filter. For

more information, see Tenable Log Correlation Engine Clients.

Completion

Time

The date range for scan results to include in the filter:

l Explicit —Choose start and end dates and times to filter for a specific

date range.

l Last x Minutes —Filter for the last 15, 20, or 30 minutes.

l Last x Hours —Filter for the last 1, 2, 4, 6, 12, 24, 48, or 72 hours.

l Last x Days —Filter for the last 5, 7, 15, 25, 30, 60, 90, 120, or 180 days.
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Filter Com-

ponent
Description

l Last 12 Months —Filter for the last year.

l All —Show all results.

Creator The ticket creators to include in the filter. For more information, see Tick-

ets.

Data Type The repository data type to include in the filter: Agent, IPv4, IPv6, or Mobile.

For more information, see Repositories.

Date The date range to include in the system log filter (for example, Oct 2021).

For more information, see System Logs.

Filter By The type of plugin data to include in the plugin filter. For more information,

see Vulnerability Analysis Filter Components.

Finish Time The date range for report results to include in the filter:

l Explicit —Choose start and end dates and times to filter for a specific

date range.

l Last x Minutes —Filter for the last 15, 20, or 30 minutes.

l Last x Hours —Filter for the last 1, 2, 4, 6, 12, 24, 48, or 72 hours.

l Last x Days —Filter for the last 5, 7, 15, 25, 30, 60, 90, 120, or 180 days.

l Last 12 Months —Filter for the last year.

l All —Show all results.

Group The groups to include in the filter. For more information, see Groups.

Host The name of the host to include in the filter. For more information, see

Host.

Initiator The username for a user who init iated a job to include in the filter. For more

information, see Job Queue Events.

Keywords The keywords to include in the system logs filter (for example, login). For
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Filter Com-

ponent
Description

more information, see System Logs.

Log Correlation

Engine Server

The Log Correlation Engine servers to include in the filter. For more inform-

ation, see Tenable Log Correlation Engines.

Module The type of logs to include in the system logs filter. For more information,

see System Logs.

Name The name of the object or user to include in the filter. For example, the

name of a Tenable Nessus scanner or the name of a repository.

Organization The organization to include in the filter. For more information, see Organ-

izations.

OS The operating systems to include in the filter. For more information, see

Tenable Log Correlation Engine Clients and Tenable Log Correlation Engine

Client Policies.

Owner The object owners to include in the filter. The object owner is the user who

created an object or inherited objects from a deleted user.

Plugin The plugin IDs to include in the filter.

Plugin Family The plugin family to include in the plugin filter.

Repositories The repositories to include in the filter. For more information, see Repos-

itories.

Repository The repository to include in the filter. For more information, see Repos-

itories.

Role The user roles to include in the filter. For more information, see User Roles.

Scan Policy The scan policies to include in the filter. For more information, see Scan

Policies.

Schedule The schedules to include in the filter. For more information, see Active

Scan Settings, Agent Scan Settings, Agent Synchronization Job Settings,
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Filter Com-

ponent
Description

and Report Options.

Severity The severity to include in the filter. For more information, see CVSS vs.

VPR.

State The Log Correlation Engine Client state to include in the filter: Alive or

Dead. For more information, see Tenable Log Correlation Engine Clients.

Status The statuses to include in the filter.

Tags The tags to include in the filter. For more information, see Tags.

Timeframe The date range to include in the notif ication filter: Last 24 Hours, Last 7

Days, or Last 30 Days.

Type The object type (for example, Active or Agent scan results).

Username The username to include in the filter. For more information, see User

Account Options.

Version The Log Correlation Engine version to include in the filter. For more inform-

ation, see Tenable Log Correlation Engines.
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Queries

The Queries page displays a list of queries available for use. The information on this page includes

Name, Type, Group, Owner, and the Last Modified t ime. You can use a filter to narrow the list by any

of the columns (except Last Modified). For more information, see Filters.

For more information about queries, see:

l Add or Save a Query

l Load a Query

l Query Options

l Edit a Query
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Add or Save a Query

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can add queries from the Queries page or from the Vulnerability Analysis page, Event Analysis

page, or Mobile Analysis page. For more information about query options, see Queries.

Note: If you want to create a mitigated vulnerabilit ies query, you must add the query from the Vulnerability
AnalysisVulnerabilities page.

To add a query from the Queries page:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Queries.

The Queries page appears.

3. Click Add.

4. Type a Name and Description.

5. (Optional) If you want to add a tag, type select a Tag from the drop-down. For more inform-

ation, see Tags.

6. Select a Type.

The Tool drop-down updates with options for that type.

7. Select a Tool.

8. Click Add Filter.

The Filters section expands. For more information, see Filters.

9. Select a filter component from the Select a Filter drop-down.

The filter component criteria box appears.

10. In the filter component criteria box, type or select filter component criteria.

11. Click the button.
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Tenable Security Center adds the filter component.

12. (Optional) To add other filter components, repeat step 8.

13. Click Submit.

Tenable Security Center saves your configuration.

To save a query from an analysis page:

1. Log in to Tenable Security Center via the user interface.

2. Do one of the following to navigate to an analysis page:

l Click Analysis > Vulnerabilities

l Click Analysis > Events

l Click Analysis > Mobile

The analysis page appears.

3. Apply a filter for the query, as described in Apply a Filter.

The page updates to reflect the filter you applied.

4. In the Options drop-down box, click Save Query..

The Save Query panel appears.

5. In the Name box, type a name for the query.

6. In the Description box, type a description for the query.

7. (Optional) If you want to add a tag, type or select a Tag from the drop-down. For more inform-

ation, see Tags.

8. Click Submit.

Tenable Security Center saves your configuration.
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Load a Query

Required User Role: Any

You can load queries from any page that supports filtering. For more information, see Queries and

Filters.

To load a query:

1. Log in to Tenable Security Center via the user interface.

2. Navigate to any page that supports filtering.

3. On the left side of the page, click the filter icon ( ).

The filter panel appears.

4. Click Load Query.

5. Select the query you want to load.

6. Click Apply.

The page updates, filtered by the query you selected.
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Query Options

Queries provide the ability to save custom views of vulnerability, event, t icket, user, and alert data

for repeated access.

Option Description

Name A name for the query.

Description A description for the query.

Tag A tag for the query. For more information, see Tags.

Type The type of data you want the query to use.

For more information about the filter components for Vulnerability, Event,

and Mobile data types, see Vulnerability Analysis Filter Components, Event

Analysis Filter Components, and Mobile Analysis.

For more information about the filter components for Ticket, User, and Alert

data types, see Ticket-Specific Query Options, User-Specific Query Options,

and Alert-Specific Query Options.

Tool Chooses the analysis tool used by the query.

Ticket-Specific Query Options

Ticket queries are a useful way of determining what tickets to alert against. For example, if you

want to be alerted when a specific user receives a ticket, you could create a query with a ticket fil-

ter where the Assignee value is the user's name. You could then create an alert to email you when

the user receives a ticket. The table below contains a list of the ticket query options.

Option Description

Name Ticket name to filter against

Status Ticket status to filter against.

Classification The ticket classification to filter against.

Owner The manager (owner) of the ticket assignee.
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Option Description

Assignee The ticket assignee to filter against.

Created Time-

frame

Ticket creation date/ t ime to filter against. Either specify an explicit t ime-

frame, including the start and end time or choose one of the predefined

periods (e.g., last 15 minutes, last hour, etc.)

Assigned Time-

frame

Ticket assigned date/ t ime to filter against. Either specify an explicit t ime-

frame, including the start and end time or choose one of the predefined

periods (e.g., last 15 minutes, last hour, etc.)

Modified Time-

frame

Ticket modified date/ t ime to filter against. Either specify an explicit t ime-

frame, including the start and end time or choose one of the predefined

periods (e.g., last 15 minutes, last hour, etc.)

Resolved Time-

frame

Ticket resolution date/ t ime to filter against. Either specify an explicit t ime-

frame, including the start and end time or choose one of the predefined

periods (e.g., last 15 minutes, last hour, etc.)

Closed Time-

frame

Ticket closed date/ t ime to filter against. Either specify an explicit t ime-

frame, including the start and end time or choose one of the predefined

periods (e.g., last 15 minutes, last hour, etc.)

User-Specific Query Options

User queries are useful for reporting, dashboards and alerts based on user actions. For example,

they can track user logins and locked accounts. They can also track user logins from accounts not

authorized on the monitored systems.

Option Description

First Name User first name to filter against.

Last Name User last name to filter against.

Username Actual username to filter against.

Group Filter against the group the user(s) belong to.
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Option Description

Role Filters against users who have the specified role.

Email Filters against users based on their email address.

Last Login

Timeframe

Filters against users whose last login was that the timeframe specified.

Either specify an explicit t imeframe, including the start and end time or

choose one of the predefined periods (e.g., last 15 minutes, last hour, etc.).

Account State Filters against the user account state (locked vs. unlocked).

Alert-Specific Query Options

The alert query is useful for reporting, dashboards and alert ing when an alert has triggered. This is

useful for situations where you want a report, dashboard element, or condit ional alert after the spe-

cified alert filter condit ions have been met. For example, you can schedule a daily report containing

a query of all active alerts and their details.

Option Description

Name Filter against alerts with the specified name.

Description Filter against alerts with the specified description.

State Choose from All, Triggered, or Not Triggered.

Created Time-

frame

Filters against the alert creation timeframe specified. Either specify an expli-

cit t imeframe, including the start and end time or choose one of the pre-

defined periods (e.g., last 15 minutes, last hour, etc.).

Modified Time-

frame

Filters against the most recent alert modification timeframe specified.

Either specify an explicit t imeframe, including the start and end time or

choose one of the predefined periods (e.g., last 15 minutes, last hour, etc.).

Last Triggered

Timeframe

Filters against the most recent alert trigger timeframe specified. Either spe-

cify an explicit t imeframe, including the start and end time or choose one of

the predefined periods (e.g., last 15 minutes, last hour, etc.).

Last Evaluated

Timeframe

Filters against the most recent alert evaluation timeframe specified. Either

specify an explicit t imeframe, including the start and end time or choose one

of the predefined periods (e.g., last 15 minutes, last hour, etc.).
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Edit a Query

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Query Options.

To edit a query:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Queries.

The Queries page appears.

3. In the row for the query you want to edit, click the menu.

The actions menu appears.

4. Click Edit.

The Edit Query page appears.

5. Modify the query options.

6. Click Submit.

Tenable Security Center saves the modified query.
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Workflow Actions

Workflow actions allow organizational users to configure and manage alert ing, t icketing, and accept

risk or recast risk rules. These functions allow the user to be notified of and properly handle vul-

nerabilit ies and events as they come in.

For more information, see Alerts, Tickets, Accept Risk Rules, and Recast Risk Rules.
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Alerts

Tenable Security Center can be configured to perform actions, such as email alerts, for select vul-

nerability or alert occurrences to various users regardless of whether the events correlate to a local

vulnerability or not. Other alert actions include UI notif ications, creating or assigning tickets, remedi-

ation scans, launching a report, email notif ications, and syslog alert ing. Mult iple actions can be

assigned for each ticket.

For more information, see:

l Alert Actions

l Add an Alert

l View Alert Details

l Alert Options

l Edit an Alert

l Evaluate an Alert

l Delete an Alert
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Alert Actions

Tenable Security Center automatically performs alert actions when an alert triggers. You can con-

figure the following types of alert actions:

l Assign Ticket

l Email

l Generate Syslog

l Launch Scan

l Launch Report

l Notify Users

Tip: Use email alerts to interface with third-party ticketing systems by adding variables in the message
option.

For more information, see Alerts.

Assign Ticket

When the alert triggers, Tenable Security Center creates a ticket and assigns the ticket to a user.

For more information, see Tickets.

Option Description Default

Name (Required) The name of the ticket. Ticket opened by alert

Description A description for the ticket. --

Assignee (Required) The user who receives the ticket. --

Email

When the alert triggers, Tenable Security Center sends an email.

Option Description Default

Email
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Subject The alert email subject line. Email Alert

Message The body of the email message. You can include the fol-

lowing variables to customize the email:

l Alert ID —Designated with the variable: %alertID%,

this specifies the unique identif ication number

assigned to the alert by Tenable Security Center.

l Alert name —Designated with the variable: %aler-

tName%, this specifies the name assigned to the

alert (for example, “Test email alert”).

l Trigger Name —Designated with the variable: %trig-

gerName%, this specifies if the trigger is IP address

count, Vulnerability count, or Port count.

l Trigger Operator —Designated with the variable:

%triggerOperator%, this specifies the operator used

for the count: >=, =, >= or !=

l Trigger value —Designated with the variable: %trig-

gerValue%, this specifies the specific threshold

value set that triggers the alert.

l Calculated value —Designated with the variable:

%calculatedValue%, this specifies the actual value

that triggered the alert.

l Alert Name —Designated with the variable: %aler-

tName%, this specifies the name given to the alert

within Tenable Security Center.

l Alert owner —Designated with the variable:

%owner%, this specifies the user that created the

alert.

l Tenable Security Center URL —Designated with the

variable: %url%, this specifies the URL that you use

(see descrip-

t ion)

- 794 -



to access Tenable Security Center. This is useful

where the URL that users use to access Tenable

Security Center differs from the URL known by Ten-

able Security Center.

The following sample email alert contains some of these

keywords embedded into an HTML email:

Alert <strong>%alertName%</strong> (id
#%alertID%) has triggered.

<strong>Alert Definition:</strong> %triggerName%
%triggerOperator% %triggerValue%
<strong>Calculated Value:</strong>
%calculatedValue%

Please visit your Tenable Security Center (<a
href="%url%">%url%</a>) for more information.
This e-mail was automatically generated by
Tenable Security Center as a result of alert
<strong>%alertName%</strong> owned by
<strong>%owner%</strong>.

If you do not wish to receive this email, contact
the alert owner.

Include Res-

ults

When enabled, Tenable Security Center includes the query

results that triggered the alert (maximum of 500).

Disabled

Recipients

Users The users who receive the alert email.

Tip: If you delete a user who receives alert emails, the action
option for the alert turns red and Tenable Security Center
displays a notif ication to the new alert owner with the new
alert status. To resolve this, update the list of users in the
alert email.

--
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Email

Addresses

Specifies addit ional email addresses to include in the alert

email. For mult iple recipients, add one email address per

line or use a comma-separated list.

--

Generate Syslog

When the alert triggers, Tenable Security Center sends a custom message to a syslog server.

Option Description Default

Host (Required) The host that receives the syslog alert. --

Port The UDP port used by the remote syslog server. 514

Severity The severity level of the syslog messages (Critical, Notice, or

Warning).

Crit ical

Message (Required) The message Tenable Security Center sends with the

syslog alert.

--

Launch Scan

When the alert triggers, Tenable Security Center launches an active scan from an existing active

scan template. The active scan Schedule must be On Demand. For more information, see Active

Scans and Active Scan Settings.

Option Description Default

Scan (Required) The scan template Tenable Security Center uses for the

alert scan.

Note: Tenable Security Center scans the host that triggered the scan,
not the host within the scan template. Tenable Security Center uses
the top 100 IP results from the alert query for the scan targets.

--

Launch Report

When the alert triggers, Tenable Security Center generates a report from an existing report tem-

plate. For more information, see Reports.
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Option Description Default

Report Tem-

plate

(Required) The report template Tenable Security Center uses to

generate a report based on the triggered alert data.

--

Notify Users

When the alert triggers, Tenable Security Center displays a notif ication to the specified users.

Option Description Default

Message (Required) The notification message Tenable Security Center

sends when the alert triggers.

--

Users (Required) The users who receive the notif ication message. --
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Add an Alert

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can configure Tenable Security Center to send alerts for vulnerability occurrences.

For more information about the available options for alerts, see Alert Options.

To add an alert:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Alerts.

The Alerts page appears.

3. Click Add.

The Add Alert page appears.

4. In the Name box, type a name.

5. (Optional) In the Description box, type a description.

6. (Optional) Click the Schedule f ield to select the frequency of alerts, t ime, t imezone, and

whether to repeat sending alerts at the specified time.

7. (Optional) In the Behavior drop-down box, select the condit ion you want to trigger the alert.

The default is Perform actions only on first trigger.

8. (Optional) In the Type drop-down box, select the data type for the condit ion.

9. In the Trigger drop-down box, select the trigger for the alerts.

10. (Optional) In the Query drop-down box, select the dataset to compare with the trigger con-

dit ion.

11. (Optional) Click Add Filterand provide the details of the selected filter.

12. Click Add Actions to specify an action that occurs when the alert triggers. For more inform-

ation, see Alert Actions.

13. Click Submit.

Tenable Security Center creates the alert.
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View Alert Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can view the summary details of an alert with the name, behavior, condit ion applied, status, cre-

ated date, owner, and ID.

To view the details of an alert:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Alerts.

The Alerts page appears.

3. In the row for the alert you want to view, click the menu.

The actions menu appears.

4. Click View.

The View Alert page appears. For more information about the following fields, see Alert

Options.

Section Action

Options

drop-down

box

l To edit the alert, click Edit. For more information, see Edit an Alert.

l To delete the alert, click Delete. For more information, see Delete

an Alert.

General View general information about the alert.

l Name —Alert name.

l Description —Descriptive text for the alert.

l Schedule —The schedule for how often the alert checks for match-

ing condit ions.

l Behavior —The sett ing for how the alert behaves once it is

triggered.
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Section Action

l Last Evaluated —The date on which the alert was last evaluated.

l Last Triggered —The date on which the alert was last triggered.

l Status —The status of the alert.

l Created —The date on which the alert was created.

l Last Modified —The date on which the alert was last modified.

l Owner —The user who created or owns the alert.

l Group —The group associated with the Owner.

l ID —The unique identif ier of the alert.

Condition View the condit ions specified for the alert:

l Type —The type of the alert. For example, vulnerability, event, or

t icket.

l Trigger —The condit ion that triggers the alert. For example, IP

count, unique vulnerability/event count, or port count.

l Query —The dataset to which the trigger condit ion is compared.

l Filters —The filters added for vulnerability or event data.

Actions The actions performed once the alert is triggered.
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Alert Options

The following options are available when you create or edit an alert in Tenable Security Center.

Option Description

General

Name The name of the alert.

Description A description for the alert.

Schedule Specifies how often the alert checks for the condit ions to be matched:

Minutely, Hourly, Daily, Weekly, Monthly, or Never.

Select Never to create an alert that you trigger manually on demand.

Behavior Specifies how many times Tenable Security Center performs the alert

actions:

l Perform actions only on first trigger —Tenable Security Center per-

forms the alert actions only the first t ime the alert condit ions match

the trigger configuration.

l Perform action on every trigger —Tenable Security Center performs

the alert actions every time the alert condit ions match the trigger con-

figuration.

Condition

Type The type of data to use for the condit ion: Vulnerability, Event, or Ticket.

Trigger l IP Count —Trigger on vulnerabilit ies or events whose IP address count

matches the given parameters.

l Unique Vulnerability Count —Trigger an alert when the unique vul-

nerability count matches the given parameters. This option appears

when you select Vulnerability for the Type option.

l Event Count —Trigger an alert when the event count matches the

given parameters. This option appears when you select Event for the

Type option.
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Option Description

General

l Port Count —Trigger an alert when the events or vulnerabilit ies using a

certain port number match the given parameters.

Query The dataset Tenable Security Center uses to determine if trigger condit ions

have been met.

Filters Apply advanced filters to the vulnerability or event data. For more inform-

ation, see Filters.

Actions

Add Actions Specifies the actions that occur when the alter triggers: Assign Ticket,

Email, Generate Syslog, Launch Scan, Launch Report, or Notify Users. For

more information, see Alert Actions.
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Edit an Alert

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

For more information, see Alert Options.

To edit an alert:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Alerts.

The Alerts page appears.

3. In the row for the alert you want to edit, click the menu.

The actions menu appears.

4. Click Edit.

The Edit Alert page appears.

5. Modify the alert options.

6. Click Submit.

Tenable Security Center saves the modified alert.
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Evaluate an Alert

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can submit an alert for evaluation to test whether the alert has met the configured time criteria

or not.

To evaluate an alert:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Alerts.

The Alerts page appears.

3. In the row for the alert you want to evaluate, click the menu.

The actions menu appears.

4. Click Evaluate.

The alert is submitted for evaluation.

Tenable Security Center returns the evaluation results for the alert.
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Delete an Alert

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

To delete an alert:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Alerts.

The Alerts page appears.

3. In the row for the alert you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the alert.
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Tickets

In Tenable Security Center, you can create tickets manually or automatically using the Alerts fea-

ture. This section describes how to manage your tickets.

For more information, see:

l Open a Ticket

l View Ticket Details

l Ticket Options

l Edit a Ticket

l Resolve and Close a Ticket
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Open a Ticket

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can use tickets within Tenable Security Center to coordinate the assessment and remediation

of vulnerabilit ies and security events.

You can configure a ticket from an analysis page, or from the Tickets page. For more information

about the options to configure, see Tickets.

To open a ticket from an analysis page:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities or Analysis > Events.

The Vulnerability Analysisor Event Analysis page appears.

3. In the upper-right corner, click the Options drop-down box.

4. Click Open Ticket.

5. In the Name box, type a name.

6. (Optional) In the Description box, type a description.

7. (Optional) In the Notes box, type a note to the assignee.

8. In the Assignee drop-down box, select an assignee.

9. In the Classification drop-down box, select a classification.

10. Click Submit.

Tenable Security Centercreates the ticket.

To open a ticket from the Tickets page:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Tickets.

The Tickets page appears.
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3. Click Add.

4. In the Name box, type a name.

5. (Optional) In the Description box, type a description.

6. (Optional) In the Notes box, type a note to the assignee.

7. In the Assignee drop-down box, select an assignee.

8. In the Classification drop-down box, select a classification.

9. (Optional) Click Add Query View.

10. Click Submit.

Tenable Security Center creates the ticket.
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View Ticket Details

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

You can view the summary details of a ticket with the name, status, creator, assignee, history, quer-

ies, description, and ticket notes.

Before you begin:

l Add a ticket, as described in Open a Ticket.

To edit a ticket:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Tickets.

The Tickets page appears.

3. In the row for the ticket you want to view, click the menu.

The actions menu appears.

4. Click View.

The View Ticket page appears. For more information, see Ticket Options.

Section Action

Options drop-down

box

l To edit the ticket, click Edit. For more information, see Edit

a Ticket.

General View general information about the ticket.

l Name —The ticket name.

l Description —The ticket description.

l Notes —The notes added for the ticket.

l Status —The status of the ticket.

l Assignee —The user assigned to the ticket.
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Section Action

l Classification —The classification selected for the ticket.

l Created —The date on which the ticket was created.

l Last Modified —The date on which the ticket was last mod-

ified.

l Owner —The user who created or owns the ticket.

l Group —The group associated with the Owner.

l ID —The unique identif ier of the ticket.

Query Views The query added to help provide context for coming up with a res-

olution.
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Ticket Options

The following options are available when you create or edit a ticket in Tenable Security Center.

Option Description

General

Name Name assigned to the ticket.

Description Descriptive text for the ticket.

Notes Notes for the ticket assignee.

Assignee User that the ticket is assigned to.

Note: If the ticket assignee is deleted, the ticket is automatically reassigned to
the assignee’s owner along with a notif ication message indicating that the
ticket has been reassigned.

Status (Available

during edit)

The following ticket statuses become available after a ticket has been cre-

ated and are available from the Edit Ticket page:

l Assigned

l Resolved

l More Information

l Not Applicable

l Duplicate

l Closed

Classification The ticket classification: Information, Configuration, Patch, Disable, Fire-

wall, Schedule, IDS, Accept Risk, Recast Risk, Re-scan Request, False Pos-

itive, System Probe, External Probe, Investigation Needed, Compromised

System, Virus Incident, Bad Credentials, Unauthorized Software, Unau-

thorized System, Unauthorized User, and Other.

Query Views
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Option Description

Add Query View Click to choose a query for the ticket assignee to help provide context for

coming up with a resolution.
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Edit a Ticket

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

Before you begin:

l Add a ticket, as described in Open a Ticket.

To edit a ticket:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Tickets.

The Tickets page appears.

3. In the row for the ticket you want to edit, click the menu.

The actions menu appears.

4. Click Edit.

The Edit Ticket page appears.

5. Modify the ticket options. For more information, see Ticket Options.

6. Click Submit.

Tenable Security Center saves your configuration.
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Resolve and Close a Ticket

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

When a ticket is mit igated, you can change the ticket status to Resolved. Once the ticket is

resolved, you can change the status to Closed. Tickets in the Resolved or Closed state can always

be reopened as needed.

Before you begin:

l Add a ticket, as described in Open a Ticket.

To resolve a ticket:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Tickets.

The Tickets page appears.

3. In the row for the ticket you want to resolve, click the menu.

The actions menu appears.

4. Click Resolve.

The Resolve Ticket page appears.

5. Change the status to Resolved. Optionally, you can add notes to provide details of the res-

olution.

6. Click Submit.

7. To close the ticket, click the resolved ticket name and change the status to Closed.

Tenable Security Center updates the ticket status. Resolved tickets still show up in your ticket

queue with an Active status. Closing a ticket removes the ticket from the Active status filter view,

but does not provide the option to add notes similar to edit ing a ticket.
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Accept Risk Rules

The Accept Risk Rules page displays a list of accept risk rules configured in Tenable Security

Center. Organizational users must add accept risk rules before the rules appear on this page. For

more information, see Add an Accept Risk Rule.

Adding a rule moves vulnerabilit ies from the unfiltered cumulative database view. These vul-

nerabilit ies are not deleted, but only display in the cumulative database vulnerability view if the

Accepted Risk f ilter option is checked. For more information, see Filters.

Administrator and organizational users can manage accept risk rules. You can access information

on what particular vulnerabilit ies or hosts have been declared to be accepted and, if noted in the

comments, the reason.

To view details for a rule, click the row. To delete a rule, see Delete an Accept Risk Rule.
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Add an Accept Risk Rule

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

If you create an accept risk rule, Tenable Security Center automatically accepts the risk associated

with any vulnerabilit ies that match the rule. Risk-accepted vulnerabilit ies do not appear in a vul-

nerability search if your filter excludes Accepted Risk vulnerabilit ies.

For more information, see Accept Risk Rules.

To add an accept risk rule:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the analysis tools drop-down box, select Vulnerability Detail List, Vulnerability List, or Vul-

nerability Summary.

The page refreshes to show the analysis tool view you selected.

4. In the row for the vulnerability for which you want to accept risk, click the menu.

The actions menu appears.

5. Click Accept Risk.

6. (Optional) In the Comment box, add a comment.

7. (Optional) In the Expires box, select the date you want the accept risk rule to expire.

8. In the Repository section, select one or more repositories where you want to apply the rule.

9. Click Submit.

Tenable Security Center saves your configuration.

Note: There can be a short delay between clicking on Submit and vulnerabilit ies showing the new
risk acceptance. You may need to reload the filters to view the applied changes.
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Delete an Accept Risk Rule

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can delete an accept risk rule to stop accepting the risk associated with a vulnerability.

To delete an accept risk rule:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Accept Risk Rules (Organizational users) or Repositories > Accept Risk Rules

(Administrator users).

The Accept Risk Rules page appears.

3. In the row for the rule you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the rule.

6. Click Apply Rules.

Tenable Security Center stops accepting the risk associated with the vulnerability.
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Recast Risk Rules

A list of recast rules configured in Tenable Security Center appears on the Recast Risk Rules page.

Organizational users must add recast risk rules before the rules appear on this page. For more

information, see Add a Recast Risk Rule.

Administrator and organizational users can manage recast risk rules. You can access information on

what particular vulnerabilit ies or hosts have had risk levels recast, their new severity level and, if

noted in the comments, the reason for the severity change. You can search for rules by Plugin ID or

Repository.

To view details for a rule, click the row. To delete a rule, see Delete a Recast Risk Rule.
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Add a Recast Risk Rule

Required User Role: Organizational user with appropriate permissions. For more information, see User

Roles.

If you create a recast risk rule, Tenable Security Center automatically updates the severity for any

vulnerabilit ies that match the rule to the severity you specified in the rule.

For more information, see Recast Risk Rules.

To add a recast risk rule:

1. Log in to Tenable Security Center via the user interface.

2. Click Analysis > Vulnerabilities.

The Vulnerability Analysis page appears.

3. In the analysis tools drop-down box, select Vulnerability Detail List, Vulnerability List, or Vul-

nerability Summary.

The page refreshes to show the analysis tool view you selected.

4. In the row for the vulnerability you want to recast, click the menu.

The actions menu appears.

5. Click Recast Risk.

6. In the New Severity drop-down box, select a new severity for the vulnerability.

7. (Optional) In the Comment box, add a comment.

8. In the Repository section, select one or more repositories where you want to apply the rule.

9. Click Submit.

Tenable Security Center saves your configuration.

Note: There can be a short delay between clicking on Submit and vulnerabilit ies showing the new
risk. It may be necessary to reload the filters to view the applied changes.
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Delete a Recast Risk Rule

Required User Role: Administrator or organizational user with appropriate permissions. For more inform-
ation, see User Roles.

You can delete a recast risk rule to remove your custom severity for a vulnerability. Then, if Tenable

Security Center sees the vulnerability again, the vulnerability receives the severity currently asso-

ciated with the plugin.

To delete a recast risk rule and remove your custom severity:

1. Log in to Tenable Security Center via the user interface.

2. Click Workflow > Recast Risk Rules (Organizational users) or Repositories > Recast Risk Rules

(Administrator users).

The Recast Risk Rules page appears.

3. In the row for the rule you want to delete, click the menu.

The actions menu appears.

4. Click Delete.

A confirmation window appears.

5. Click Delete.

Tenable Security Center deletes the rule.

6. Click Apply Rules.

If Tenable Security Center sees the vulnerability again, the vulnerability receives the severity

currently associated with the plugin.
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Additional Resources

The topics in this section offer guidance in areas related to Tenable Security Center.

l Start, Stop, or Restart Tenable Security Center

l License Declarations

l Encryption Strength

l File and Process Allow List

l Manual Log Correlation Engine Key Exchange

l Manual Tenable Nessus SSL Certif icate Exchange

l Offline Tenable Security Center Plugin and Feed Updates

l Troubleshooting
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Start, Stop, or Restart Tenable Security Center

Required User Role: Root user

When Tenable Security Center is installed, the required services are started by default.

To change the status of Tenable Security Center:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. In the CLI in Tenable Security Center, run the following command to check the status of your

Tenable Security Center:

# service SecurityCenter status

The system indicates whether Tenable Security Center is running or stopped.

3. Run one of the following commands to change the status of your Tenable Security Center:

l To start Tenable Security Center, run:

# /bin/systemctl start SecurityCenter

l To stop Tenable Security Center, run:

# /bin/systemctl stop SecurityCenter

l To restart Tenable Security Center, run:

# /bin/systemctl restart SecurityCenter
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License Declarations

Tenable Security Center’s Software License Agreement can be found on Tenable Security Center in

the /opt/sc/docs directory.

For a list of third-party software packages that Tenable utilizes with Tenable Security Center, see

Tenable Third-Party License Declarations.
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Encryption Strength

Tenable Security Center uses the following default encryption for storage and communications.

Function Encryption

Storing TNS user

account passwords

SHA-512 and the PBKDF2 function

Storing user and service

accounts for scan cre-

dentials, as described in

Credentials.

AES-256-CBC

Storing scan data, as

described in Repos-

itories.

None

Communications

between Tenable Secur-

ity Center and clients

(Tenable Security

Center users).

SSL/TLS 1.2 with the strongest encryption method supported by

Tenable Security Center Apache and your browser, CLI program, or

API program: EECDH+AESGCM, EDH+AESGCM, AES256+EECDH, or

AES256+EDH.

For more information about strong encryption, see Configure

SSL/TLS Strong Encryption.

Communications

between Tenable Secur-

ity Center and the Ten-

able product

registration server.

SSL/TLS 1.2 with ECDHE-RSA-AES256-GCM-SHA384

Communications

between Tenable Secur-

ity Center and the Ten-

able plugin update

server.

SSL/TLS 1.2 with ECDHE-RSA-AES256-GCM-SHA384

Communications SSL/TLS 1.2 with the strongest encryption method supported by
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Function Encryption

between Tenable Secur-

ity Center and:

l Tenable Nessus or

Tenable Nessus

Manager

l Tenable Vul-

nerability Man-

agement

l Tenable Nessus

Network Monitor

l Tenable Log Cor-

relation Engine

Tenable Security Center Apache and your browser, CLI program, or

API program: ECDHE-RSA-AES128-SHA256, ECDHE-RSA-AES128-

GCM-SHA256, ECDHE-RSA-AES256-SHA384, or ECDHE-RSA-

AES256-GCM-SHA384.

Synchronizations

between Tenable Secur-

ity Center and Tenable

Vulnerability Man-

agement for Tenable

Lumin.

SSL/TLS 1.2
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Configure SSL/TLS Strong Encryption

You can configure SSL/TLS strong encryption for Tenable Security Center-client communications

to meet the security needs of your organization. For more information about Tenable Security

Center encryption, see Encryption Strength.

To configure SSL/TLS strong encryptions for Tenable Security Center communications:

1. Open the /opt/sc/support/conf/sslciphers.conf f ile in a text editor.

2. Add the following content at the end of the file:

SSLCipherSuite <cipher you want to use for SSL/TLS encryption>

For example:

# SSL Ciphers
SSLProtocol ALL -SSLv2 -SSLv3
SSLHonorCipherOrder On
SSLCompression off
SSLCipherSuite ECDHE-RSA-AES128-SHA256:ECDHE-RSA-AES128-GCM-SHA256:ECDHE-RSA-
AES256-SHA384:ECDHE-RSA-AES256-GCM-SHA384

3. Restart Tenable Security Center, as described in Start, Stop, or Restart Tenable Security

Center.

Tenable Security Center restarts.

4. In /opt/sc/support/logs, open ssl_request_log.

The log file text appears.

5. Verify the configuration in ssl_request_log matches the cipher you specified. If the con-

figuration and cipher do not match, investigate the following:

l Confirm that you provided the cipher using correct syntax.

l Confirm that your browser supports the cipher you provided.
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l Confirm that you do not have other applications installed that redirect or layer addit ional

encryption for SSL traffic.
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Configure Tenable Security Center for NIAP Compliance

If your organization requires that your instance of Tenable Security Center meets National Inform-

ation Assurance Partnership (NIAP) standards, you can configure relevant sett ings to be compliant

with NIAP standards.

You must run Tenable Security Center 5.15.0 or later to fully configure Tenable Security Center for

NIAP compliance. If you are running Tenable Security Center 5.15.0, you must install a patch to con-

figure Tenable Security Center for NIAP compliance. Contact Tenable Support for assistance with

the required patch. For more information about upgrading Tenable Security Center, see Before You

Upgrade and Upgrade Tenable Security Center.

For more information about Tenable Security Center storage and communications encryption, see

Encryption Strength.

Before you begin:

l If you are running Tenable Security Center 5.15.0, contact Tenable Support for assistance with

the required patch.

l If you are using SSL certif icates to log in to Tenable Security Center, ensure your server and

client cert if icates are NIAP-compliant. For more information about cert if icate authentication,

see Certif icate Authentication.

l Confirm you have enabled the full disk encryption capabilit ies provided by the operating sys-

tem on the host running Tenable Security Center.

To configure Tenable Security Center for NIAP compliance:

1. Log in to Tenable Security Center via the command line interface (CLI).

2. In the CLI in Tenable Security Center, as the root or tns user, run the following commands to

configure strong SSL/TLS encryption for Tenable Security Center communications:

# /opt/sc/support/bin/sqlite3 /opt/sc/application.db "INSERT INTO Configuration ( 
type,name,value,visible,editable ) VALUES ( 64, 'SSLVersion', 'TLSv1_2', 'false',
'false' )"
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# /opt/sc/support/bin/sqlite3 /opt/sc/application.db "INSERT INTO Configuration ( 
type,name,value,visible,editable ) VALUES ( 64, 'SSLCipherList', 'ECDHE-RSA-
AES128-SHA256:ECDHE-RSA-AES128-GCM-SHA256:ECDHE-RSA-AES256-SHA384:ECDHE-RSA-
AES256-GCM-SHA384', 'false', 'false' )"

3. Configure the Tenable Security Center web server to use strong encryption for storage and

communications, as described in Configure SSL/TLS Strong Encryption.

Note: For NIAP compliance, you must configure TLS 1.2 encryption with any of the following ciphers:
ECDHE-RSA-AES128-SHA256, ECDHE-RSA-AES128-GCM-SHA256, ECDHE-RSA-AES256-SHA384, or
ECDHE-RSA-AES256-GCM-SHA384.

4. If you connect Tenable Security Center to Tenable Nessus, Tenable Nessus Manager, Tenable

Nessus Network Monitor, or Tenable Log Correlation Engine, you must use certif icates to

authenticate the connection. For more information, see Manual Tenable Nessus SSL Cer-

t if icate Exchange and Manual Log Correlation Engine Key Exchange.
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File and Process Allow List

If you use third-party endpoint security products such as anti-virus applications and host-based

intrusion and prevention systems, Tenable recommends adding Tenable Security Center to the

allow list.

If you configured supporting resources for Tenable Security Center, see the product documentation

for each resource you added for more file and process allow list information. For more information

about supporting resources in Tenable Security Center, see Resources.

Tenable recommends allowing the following Tenable Security Center files and processes.

Allow List

Files

/opt/sc/ *

Processes

/opt/sc/bin/ *

/opt/sc/src/ *

/opt/sc/support/bin/ *

/opt/sc/www/*
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Manual Log Correlation Engine Key Exchange

Required User Role: Administrator

You are not normally required to make a manual key exchange between Tenable Security Center and

the Log Correlation Engine; however, in some cases where you are prohibited from remote root

login or required to do key exchange debugging, you must manually exchange the keys.

For the remote Log Correlation Engine to recognize Tenable Security Center, copy the SSH public

key of Tenable Security Center and append it to the /opt/lce/.ssh/authorized_keys f ile.

The /opt/lce/daemons/lce-install-key.sh script performs this function.

Note: The Log Correlation Engine server must have a valid license key installed and the Log Correlation
Engine daemon must be running before you perform the steps below.

To perform manual Log Correlation Engine key exchange:

1. Log in to Tenable Security Center via the user interface.

2. Download the Tenable Security Center key, as described in Download the Tenable Security

Center SSH Key.

3. Save the file locally as SSHKey.pub.

Caution: Do not edit the file or save it to any specific file type.

4. From the workstation where you downloaded the key file, use a secure copy program (e.g.,

WinSCP) to copy the SSHKey.pub f ile to the Log Correlation Engine system.

Note: You must have the credentials of an authorized user on the Log Correlation Engine server to
perform this step.

For example, if you have a user username configured on the Log Correlation Engine server

(hostname lceserver) whose home directory is /home/username, the command on a Unix sys-

tem is as follows:

# scp SSHKey.pub username@lceserver:/home/username
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5. After you copy the file to the Log Correlation Engine server, in the CLI, run the following com-

mand to move the file to /opt/lce/daemons:

# mv /home/username/SSHKey.pub /opt/lce/daemons

6. On the Log Correlation Engine server, as the root user, run the following command to change

the ownership of the SSH key file to lce:

# chown lce /opt/lce/daemons/SSHKey.pub

7. Run the following command to append the SSH public key to the /opt/ lce/ .ssh/authorized_

keys f ile:

# su lce
# /opt/lce/daemons/lce-install-key.sh /opt/lce/daemons/SSHKey.pub

8. To test the communication, as the user tns on the Tenable Security Center system, attempt

to run the id command:

# su tns
# ssh -C -o PreferredAuthentications=publickey lce@<LCE-IP> id

If you have not previously established a connection, a warning appears that is similar to the

following:

The authenticity of host '198.51.100.28 (198.51.100.28)' can't be established.
RSA key fingerprint is 86:63:b6:c3:b4:3b:ba:96:5c:b6:d4:42:b5:45:37:7f.
Are you sure you want to continue connecting (yes/no)?

9. Answer yes to this prompt.

If the key exchange worked correctly, a message similar to the following appears:

# uid=251(lce) gid=251(lce) groups=251(lce)
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10. You can add the IP address of Tenable Security Center to the Log Correlation Engine system’s

/etc/hosts f ile. This prevents the SSH daemon from performing a DNS lookup that can add

seconds to your query times.

11. You can add the Log Correlation Engine to Tenable Security Center via the normal admin-

istrator process, described in Log Correlation Engines.
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Manual Tenable Nessus SSL Certificate Exchange

If you want to use self-signed certif icates for the Tenable Security Center-Tenable Nessus con-

nection, you can perform manual Tenable Nessus SSL certif icate exchange.

Caution: Please note that users should be familiar with PKI deployments and it is not recommended that
the Nessus server be used as the site’s PKI system. The method described here is intended to assist in
testing the functionality of the certif icate exchange to assist users in the incorporation of the certif icates
into their current PKI system. In this method, the same key is shared between multiple servers. This may
not be acceptable in some installat ions.

l Overview of Tenable Nessus SSL Certif icates and Keys

l Tenable Nessus Certif icate Configuration for Unix

l Tenable Nessus Certif icate Configuration for Windows

- 834 -



Overview of Tenable Nessus SSL Certificates and Keys

Nessus supports authentication protocols based on the OpenSSL toolkit (for more information

about the toolkit, see http:/ /www.openssl.org/ ). This provides cryptographic protection and secure

authentication.

In the example described in this document, there are three key system components: the certif icate

authority, the Nessus server and the Nessus client (Tenable Security Center). It is necessary to gen-

erate the keys required for the SSL communication and copy them to the appropriate directories.

Certif icate Authority

The certif icate authority (CA) ensures that the certif icate holder is authentic and not an imper-

sonator. The CA holds a copy of the certif icates for registered users to certify that the certif icate is

genuine. When the CA receives a certif icate signing request (CSR), it validates and signs the cer-

t if icate.

In the example provided in this document, the CA resides on the Nessus server (which is not the

recommended method for a production environment). In a proper PKI deployment, the CA would be

a separate system or entity, such as Thawte or Verisign.

Nessus Server

In the example described in this document, the Nessus server is the same physical system that

holds the CA, but this will not likely be the case in a production environment. The Nessus server is

the target of the secure communication and its keys must be generated locally and copied to the

systems that will need to communicate with it using the SSL protocol. The Nessus server has users

defined that authenticate to it either by simple login and password or via SSL. These users will also

have keys associated with them.

Nessus Client (Tenable Security Center)

The Nessus client, Tenable Security Center, communicates with the Nessus server via SSL. It uses

keys generated for a Nessus client and stores these keys and the certif icate for the CA in the /op-
t/sc/daemons directory. These keys must be owned by the “tns” userid.
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Tenable Nessus Certificate Configuration for Unix

The following topic describes the commands and relevant files involved in the Nessus SSL process

on a Red Hat Linux system. This process creates the following files:

File Name Created Purpose Where to Copy to

/opt/nessus/com/nessus/CA/cacert.pem This is the

certif icate

for the Cer-

t if icate

Authority. If

using an

existing PKI,

this will be

provided to

you by the

PKI and

must be

copied to

this location.

/opt/nessus/com/nessus/CA

on the init ial Nessus server

and any addit ional Nessus

servers that need to authen-

ticate using SSL.

/op-

t/nessus/com/nessus/CA/servercert.pem

This is the

public cer-

t if icate for

the Nessus

server that

is sent in

response to

a CSR.

/opt/nessus/com/nessus/CA

on any addit ional Nessus serv-

ers that need to authenticate

using SSL.

/opt/nessus/var/nessus/CA/cakey.pem This is the

private key

of the Cer-

t if icate

Authority. It

/opt/nessus/var/nessus/CA

on any addit ional Nessus serv-

ers that need to authenticate

using SSL.
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File Name Created Purpose Where to Copy to

may or may

not be

provided by

the Cer-

t if icate

Authority,

depending

on if they

allow the cre-

ation of sub

users.

/opt/nessus/var/nessus/CA/serverkey.pem This is the

private key

of the Nes-

sus server.

/opt/nessus/var/nessus/CA

on any addit ional Nessus serv-

ers that need to authenticate

using SSL.

Create Nessus Client Keys

The Nessus user, in this case the user ID that Tenable Security Center uses to communicate with

the Nessus server, is created by the following command:

# /opt/nessus/sbin/nessuscli mkcert-client

This command creates the keys for the Nessus clients and optionally registers them appropriately

with the Nessus server by associating a distinguished name (dname) with the user ID. It is important

to respond y (yes) when prompted to register the user with the Nessus server for this to take effect.

The user name may vary and is referred to here as user.

The certif icate filename is a concatenation of cert_, the user name you entered and .pem. Addi-

t ionally, the key filename is a concatenation of key_, the user name you entered and .pem.

If the user was previously added via the /opt/nessus/sbin/nessuscli adduser command, you

will st ill need to run this program to register the user. If you have not previously created the user, it
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is not necessary to also run the nessuscli adduser command; the user is created if it does not

already exist. The following files are created by this command:

File Name Created Purpose

/ tmp/nessus-xxxxxxxx/cert_{user-

}.pem

This is the public cert if icate for the specified user.

/ tmp/nessus-xxxxxxxx/key_{user-

}.pem

This is the private key for the specified user.

/opt/nessus/var/nessus/users/

{user}/auth/dname

This is the distinguished name to be associated with this

user. The distinguished name consists of a number of

options separated by commas in the following format:

/C={country}/ST={state}/L={location}/OU={organizational

unit}/O={organization/CN={common name}

Create and Deploy SSL Authentication for Nessus

An example SSL Certif icate configuration for Nessus to Tenable Security Center authentication is

included below:

In the example described here, Tenable Security Center and the Nessus scanner are defined as fol-

lows. Your configuration varies:

Tenable Security Center:

IP: 192.0.2.50

OS: Red Hat ES 5

Nessus Scanner:

IP: 192.0.2.202

OS: Red Hat ES 5

Create Keys and User on Nessus Server

Log in to the Nessus scanner and use the su command to become the root user. Create the Cer-

t if icate Authority and Nessus server cert if icate as follows:
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# /opt/nessus/sbin/nessuscli mkcert
--------------------------------------------------------------------------

Creation of the Nessus SSL Certificate
--------------------------------------------------------------------------

This script will now ask you the relevant information to create the SSL
certificate of Nessus. Note that this information will *NOT* be sent to
anybody (everything stays local), but anyone with the ability to connect to your Nessus
daemon will be able to retrieve this information.

CA certificate life time in days [1460]:
Server certificate life time in days [365]:
Your country (two letter code) [US]:
Your state or province name [NY]:
Your location (e.g. town) [New York]:
Your organization [Nessus Users United]: Tenable Network Security
This host name [Nessus4_2]:

Congratulations. Your server certificate was properly created.

The following files were created :

. Certification authority :

Certificate = /opt/nessus//com/nessus/CA/cacert.pem
Private key = /opt/nessus//var/nessus/CA/cakey.pem

. Nessus Server :
Certificate = /opt/nessus//com/nessus/CA/servercert.pem
Private key = /opt/nessus//var/nessus/CA/serverkey.pem

Next, create the user ID for the Nessus client, which is Tenable Security Center in this case, to log

in to the Nessus server with, key and certif icate. This is done with the command /op-
t/nessus/sbin/nessuscli mkcert-client. If the user does not exist in the Nessus user data-

base, it is created. If it does exist, it is registered to the Nessus server and have a distinguished

name (dname) associated with it. It is important to respond y (yes) when prompted to register the

user with the Nessus server for this to take effect. The user must be a Nessus admin, so answer y

when asked. The following example shows the prompts and typical answers:
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# /opt/nessus/sbin/nessuscli mkcert-client
Do you want to register the users in the Nessus server
as soon as you create their certificates ? [n]: y

--------------------------------------------------------------------------
Creation Nessus SSL client Certificate

--------------------------------------------------------------------------

This script will now ask you the relevant information to create the SSL
client certificates for Nessus.
Client certificate life time in days [365]:
Your country (two letter code) [FR]: US
Your state or province name []: MD
Your location (e.g. town) [Paris]: Columbia
Your organization []: Tenable Network Security
Your organizational unit []:
**********
We are going to ask you some question for each client certificate
If some question have a default answer, you can force an empty answer by
entering a single dot '.'
*********
User #1 name (e.g. Nessus username) []: paul
User paul already exists
Do you want to go on and overwrite the credentials?  [y]: y
Should this user be administrator?  [n]: y
Country (two letter code) [US]:
State or province name [MD]:
Location (e.g. town) [Columbia]:
Organization [Tenable Network Security]:
Organizational unit []:
e-mail []:

User rules
----------
nessusd has a rules system which allows you to restrict the hosts
that $login has the right to test. For instance, you may want
him to be able to scan his own host only.
Please see the nessus-adduser(8) man page for the rules syntax

Type the rules for this user, and enter a BLANK LINE once you are done:
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(the user can have an empty rules set)

User added to Nessus.
Another client certificate?  [n]: n
Your client certificates are in /tmp/nessus-043c22b5
You will have to copy them by hand
#

The certif icates created contain the username entered previously, in this case paul, and are located

in the directory as listed in the example above (e.g., / tmp/nessus-043c22b5).

Create the nessuscert.pem Key

In the above specified tmp directory, the certif icate and key files in this example are named cert_
paul.pem and key_paul.pem. These files must be concatenated to create nessuscert.pem as fol-

lows:

# cd /tmp/nessus-043c22b5
# cat cert_paul.pem key_paul.pem > nessuscert.pem

Note: The nessuscert.pem f ile is used when configuring the Nessus scanner on Tenable Security Center.
This file needs to be copied to somewhere accessible for selection from your web browser during the Nes-
sus configuration.

Configure Nessus Daemons

To enable certif icate authentication on the Nessus server, the force_pubkey_auth sett ing must be

enabled. Once enabled, log in to the Nessus server may only be completed by SSL certif icates. User-

name and password login are disabled. As the root (or equivalent) user on the Nessus server, run

the following command:

# /opt/nessus/sbin/nessuscli fix --set force_pubkey_auth=yes

Restart the Nessus daemons with the appropriate command for your system. The example here is

for Red Hat:
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# /sbin/service nessusd restart

Change the Nessus Mode of Authentication

In Tenable Security Center, update your Tenable Nessus scanner configuration to use SSL cer-

t if icate-based authentication. For more information, see Add a Tenable Nessus Scanner.

Considerations for Custom Certif icates

During an upgrade, Tenable Security Center will check for the presence of custom SSL certif icates.

If cert if icates are found and the owner is not Tenable, any newly generated certif icates will be

named with a .new extension and placed in the /opt/sc/support/conf directory to avoid over-

writ ing existing files.

Deploy to Other Nessus Scanners

After you configure authentication on one Tenable Nessus scanner, you can use the same

SSL certif icates and user names to authenticate other Tenable Nessus scanners.
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Before you begin:

l Set up and configure all of your Tenable Nessus scanners.

l Add your Tenable Nessus scanners to Tenable Security Center, as described in Add a Tenable

Nessus Scanner.

To duplicate the same authentication configuration on other Tenable Nessus scanners:

1. In the command line interface (CLI) on another Tenable Nessus server, run the following com-

mand to copy the certif icate files onto your other Tenable Nessus server:

# cd /opt/nessus/var/nessus/CA
# scp cakey.pem serverkey.pem root@nessusIP:/opt/nessus/var/nessus/CA
# cd /opt/nessus/com/nessus/CA
# scp cacert.pem servercert.pem root@nessusIP:/opt/nessus/com/nessus/CA

2. Run the following command to create a user directory on your second Tenable Nessus server,

using the same name as the user you created on the first Tenable Nessus server. Replace

admin with the user's name:

/opt/nessus/sbin/nessuscli adduser admin

A confirmation prompt appears.

3. Press y to confirm you want the user to have system administrator privileges.

Tenable Nessus creates the user.

4. Run the following command to copy the the user you created on the first Tenable Nessus

server to the directory you created in step 2. Replace admin with the user’s name:

# cd /opt/nessus/var/nessus/users
# tar –zcvf – admin | ssh –C root@nessusIP "tar –zxvf - -C
/opt/nessus/var/nessus/users"

5. Run the following command to force Tenable Nessus to authenticate via certif icate:

/opt/nessus/sbin/nessuscli fix --set force_pubkey_auth=yes
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6. Restart the Nessus service on all the Nessus servers with the appropriate command for your

system. This example is for Red Hat:

# /sbin/service nessusd restart

7. In Tenable Security Center, update all of your Tenable Nessus scanner configurations to use

SSL certif icate-based authentication. For more information, see Add a Tenable Nessus Scan-

ner.
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Tenable Nessus Certificate Configuration for Windows

Commands and Relevant Files

The following section describes the commands and relevant files involved in the Nessus SSL pro-

cess on a Windows system.

Certif icate Authority and Nessus Server Certif icate

The command C:\Program Files\Tenable\Nessus\nessuscli mkcert creates the Certif icate

Authority and generates the server cert if icate. This command creates the following files:

File Name Created Purpose Where to Copy to

C:\Program Files\Ten-

able\Nessus\nessus\CA\cacert.pem

This is the

certif icate

for the Cer-

t if icate

Authority.

If using an

existing

PKI, this

will be

provided to

you by the

PKI and

must be

copied to

this loc-

ation.

C:\Program Files\Ten-

able\Nessus\nessus\CA\ on

any addit ional Nessus servers

that need to authenticate using

SSL.

C:\Program Files\Ten-

able\Nessus\nessus\CA\servercert.pem

This is the

public cer-

t if icate for

the Nessus

server that

is sent in

C:\Program Files\Ten-

able\Nessus\nessus\CA\ on

any addit ional Nessus servers

that need to authenticate using

SSL.
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File Name Created Purpose Where to Copy to

response

to a CSR.

C:\Program Files\Ten-

able\Nessus\nessus\CA\cakey.pem

This is the

private key

of the Cer-

t if icate

Authority.

It may or

may not be

provided by

the Cer-

t if icate

Authority,

depending

on if they

allow the

creation of

sub users.

C:\Program Files\Ten-

able\Nessus\nessus\CA\ on

any addit ional Nessus servers

that need to authenticate using

SSL.

C:\Program Files\Ten-

able\Nessus\nessus\CA\serverkey.pem

This is the

private key

of the Nes-

sus server.

C:\Program Files\Ten-

able\Nessus\nessus\CA\ on

any addit ional Nessus servers

that need to authenticate using

SSL.

Nessus Client Keys

The Nessus user, which in this case is the user ID that Tenable Security Center uses to com-

municate with the Nessus server, is created by the command C:\Program Files\Ten-
able\Nessus\nessuscli mkcert-client.

This command creates the keys for the Nessus clients and optionally registers them appropriately

with the Nessus server by associating a distinguished name (dname) with the user ID. It is important
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to respond y (yes) when prompted to register the user with the Nessus server for this to take effect.

The user name may vary and is referred to here as user.

The certif icate filename is a concatenation of cert_, the user name you entered and .pem. Addi-

t ionally, the key filename is a concatenation of key_, the user name you entered and .pem.

The following files are created by this command:

File Name Created Purpose

C:\Documents and Set-

t ings\<UserAccount>\Local Set-

t ings\Temp\nessus-xxxxxxxx\cert_<user>.pem

This is the public cert if icate for the spe-

cified user.

C:\Documents and Set-

t ings\<UserAccount>\Local Set-

t ings\Temp\nessus-xxxxxxxx\key_<user>.pem

This is the private key for the specified user.

C:\Program Files\Ten-

able\Nessus\nessus\users\<user_name>\au-

th\dname

This is the distinguished name to be asso-

ciated with this user. The distinguished

name consists of a number of options sep-

arated by commas in the following format:

"/C={country}/ST={state}/L={location}/OU=

{organizational

unit}/O={organization/CN={common name}"

Creating and Deploying SSL Authentication for Nessus

Create Keys and User on Nessus Server

To create the keys and user:

1. Create the Certif icate Authority and Nessus server cert if icate using the command C:\Pro-
gram Files\Tenable\Nessus\nessuscli mkcert

2. Provide the requested information.
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Caution: Crit ical: Any Nessus Scanner that has previously processed scans will not init ially accept
these keys as a policy.db will have already been created on the Nessus Scanner. Remove the
policies.db from the Nessus Scanner to ensure the deployment finishes successfully.

3. To remove the policies.db on a Linux system issue this command as root:

rm /opt/nessus/var/nessus/users/<UserName>/policies.db

4. To remove the policies.db on a Windows system, navigate to the C:\Program Files\Ten-
able\Nessus folder and remove the policies.db file. The actual location of the policies.db
differs depending on the version of Windows that is running.

5. Create the user ID for the Nessus client, which is Tenable Security Center in this case, to log

in to the Nessus server with, key and certif icate using the following command:

C:\Program Files\Tenable\Nessus\nessuscli mkcert-client

If the user does not exist in the Nessus user database, it is created. If it does exist, it is

registered to the Nessus server and have a distinguished name (dname) associated with it. It

is important to respond y (yes) when prompted to register the user with the Nessus server for

this to take effect. The user must be a Nessus admin, so answer y when asked.

The certif icates created contain the username entered previously, in this case admin, and are loc-

ated in the directory as listed in the example above (e.g., C:\Documents and Set-

t ings\<UserAccount>\Local Sett ings\Temp\nessus-00007fb1). In the specified directory, the

certif icate and key files in this example are named cert_admin.pem and key_admin.pem.

Transfer Certif icates and Keys to Tenable Security Center

Transfer the cert_admin.pem and key_admin.pem f iles to a desired location on Tenable Security

Center, change into that directory and concatenate them as follows:

# cat cert_admin.pem key_admin.pem > nessuscert.pem

Note: The nessuscert.pem f ile will be used when configuring the Nessus scanner on Tenable Security
Center. This file needs to be copied to somewhere accessible for selection from your web browser during
the Nessus configuration.

Configure Nessus Daemons
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To enable certif icate authentication on the Nessus server, the force_pubkey_auth sett ing must be

enabled. Once enabled, log in to the Nessus server may only be completed by SSL certif icates. User-

name and password login are disabled. As the root (or equivalent) user on the Nessus server, run

the following command:

C:\Program Files\Tenable\Nessus\nessuscli fix --set force_pubkey_auth=yes

Open the Nessus Server Manager GUI, click Stop Nessus Server and then click Start Nessus Server.

Change the Nessus Mode of Authentication

In Tenable Security Center, update your Tenable Nessus scanner configuration to use SSL cer-

t if icate-based authentication. For more information, see Add a Tenable Nessus Scanner.

- 849 -



Offline Tenable Security Center Plugin and Feed Updates

You can perform offline plugin updates and feed updates in air-gapped Tenable Security Center

environments.

l Perform an Offline Nessus Plugin Update

l Perform an Offline Tenable Nessus Network Monitor Plugin Update

l Perform an Offline Tenable Security Center Feed Update

Note:Tenable Security Center does not manage plugins for Log Correlation Engine. However, Log Cor-
relation Engine plugins are required for event analysis.

For general information about best practices in air-gapped environments, see Considerations for

Air-Gapped Environments.
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Perform an Offline Nessus Plugin Update

Required User Role: Administrator

Before you begin:

l If you installed Tenable Security Center in an environment other than Tenable Core, install a

temporary Tenable Nessus scanner on the same host as Tenable Security Center. You will use

this temporary Tenable Nessus scanner to generate a challenge code for offline Tenable

Security Center registration. Do not start or otherwise configure the temporary Tenable Nes-

sus scanner.

To perform an offline Tenable Nessus plugin update:

1. In the command line interface (CLI), run the following command to prevent the Tenable Nes-

sus scanner from start ing automatically upon restart ing the system:

/usr/bin/systemctl disable nessusd

2. Run the following command and save the challenge string that is displayed:

# /opt/nessus/sbin/nessuscli fetch --challenge

3. In your browser, navigate to https:/ /plugins.nessus.org/offline.php.

Note: Do not click here, even if you have a newer version of Tenable Nessus installed. You cannot
use the https:/ /plugins.nessus.org/v2/offline.php page for Tenable Security Center downloads.

4. Paste the challenge string from Step 3 and your Activation Code in the appropriate boxes on

the web page.

5. Click Submit.

6. On the next page, copy the link that starts with https:/ /plugins.nessus.org/get.php... and save

it as a favorite. Within the saved link change all-2.0.tar.gz to sc-plugins-diff.tar.gz. This link

will be needed for future use.

Caution: Do not click the link for nessus-fetch.rc.

- 851-

https://plugins.nessus.org/offline.php
https://plugins.nessus.org/v2/offline.php


7. Go to the favorite you created.

The page prompts you to download a file.

8. Download the file, which is called sc-plugins-diff.tar.gz.

9. Verify the file using the MD5 checksum, as described in the knowledge base article.

10. Save the sc-plugins-diff.tar.gz on the system used to access your Tenable Security

Center web interface.

11. Log in to Tenable Security Center via the user interface.

12. Click System > Configuration.

The Configuration page appears.

13. Click Plugins/Feed.

The Plugins/Feed Configuration page appears.

14. In the Schedules section, expand the Active Plugins options.

15. Click Choose File and browse to the saved sc-plugins-diff.tar.gz f ile.

16. Click Submit.

After several minutes, the plugin update finishes and the page updates the Last Updated date

and time.

What to do next:

l If you installed a temporary Tenable Nessus scanner on the same host as Tenable Security

Center, uninstall the Tenable Nessus scanner.
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Perform an Offline Tenable Nessus Network Monitor Plugin Update

Required User Role: Administrator

Before you begin:

l If you installed Tenable Security Center in an environment other than Tenable Core, install a

temporary Tenable Nessus scanner on the same host as Tenable Security Center. You will use

this temporary Tenable Nessus scanner to generate a challenge code for offline Tenable

Security Center registration. Do not start or otherwise configure the temporary Tenable Nes-

sus scanner.

To perform an offline Tenable Nessus Network Monitor plugin update:

1. In the command line interface (CLI), run the following command to prevent the Tenable Nes-

sus Network Monitor scanner from start ing automatically upon restart ing the system:

/usr/bin/systemctl disable nnm

2. Run the following command and save the challenge string that is displayed:

# /opt/nnm/bin/nnm --challenge

3. In your browser, navigate to the Tenable Nessus Network Monitor plugins page.

4. Paste the challenge string from Step 3 and your Activation Code in the appropriate boxes on

the web page.

5. Click Submit.

6. On the next page, copy the link that starts with https:/ /plugins.nessus.org/v2/ ... and book-

mark it in your browser. The other information on the page is not relevant for use with Ten-

able Security Center.

7. Click the bookmarked link.

The page prompts you to download a file.

8. Download the file, which is called sc-passive.tar.gz.
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9. Verify the file using the MD5 checksum, as described in the knowledge base article.

10. Save the sc-passive.tar.gz on the system used to access your Tenable Security Center

GUI.

Note: Access the Tenable Nessus Network Monitor feed sett ing and change the activation from off-
line to Tenable Security Center.

11. Log in to Tenable Security Center via the user interface.

12. Click System > Configuration.

The Configuration page appears.

13. Click Plugins/Feed.

The Plugins/Feed Configuration page appears.

14. In the Schedules section, expand the Passive Plugins options.

15. Click Choose File and browse to the saved sc-passive.tar.gz f ile.

16. Click Submit.

After several minutes, the plugin update finishes and the page updates the Last Updated date

and time.

What to do next:

l If you installed a temporary Tenable Nessus scanner on the same host as Tenable Security

Center, uninstall the Tenable Nessus scanner.
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Perform an Offline Tenable Security Center Feed Update

Required User Role: Administrator

Note: If you already performed a Tenable Nessus offline plugin update, start at step 7.

Before you begin:

l If you installed Tenable Security Center in an environment other than Tenable Core, install a

temporary Tenable Nessus scanner on the same host as Tenable Security Center. You will use

this temporary Tenable Nessus scanner to generate a challenge code for offline Tenable

Security Center registration. Do not start or otherwise configure the temporary Tenable Nes-

sus scanner.

To perform an offline Tenable Security Center feed update:

1. In the command line interface (CLI), run the following command to prevent the Tenable Nes-

sus scanner from start ing automatically upon restart ing the system:

/usr/bin/systemctl disable nessusd

2. To obtain the challenge code for an offline Tenable Security Center registration, do one of the

following:

l If you deployed Tenable Security Center + Tenable Core, navigate to the Tenable Secur-

ity Center tab in Tenable Core and save the challenge code.

l If you installed Tenable Security Center in an environment other than Tenable Core, run

the following command and save the challenge code:

# /opt/nessus/sbin/nessuscli fetch --challenge

3. In your browser, navigate to https:/ /plugins-customers.nessus.org/offline.php.

4. Paste the challenge code from Step 2 and your Activation Code in the appropriate boxes on

the web page.

5. Click Submit.
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6. On the next page, copy the link that starts with https:/ /plugins.nessus.org/get.php... and save

it as a favorite.

7. Within the saved link change all-2.0.tar.gz to SecurityCenterFeed48.tar.gz. This link is needed

for future use.

Caution: Do not click the link for nessus-fetch.rc as it is not needed.

8. Go to the favorite link you created.

The page prompts you to download a file.

9. Download the file, which will be called SecurityCenterFeed48.tar.gz.

10. Verify the file using the MD5 checksum, as described in the knowledge base article.

11. Save the SecurityCenterFeed48.tar.gz on the system used to access your Tenable Secur-

ity Center GUI.

12. Log in to Tenable Security Center via the user interface.

13. Click System > Configuration.

The Configuration page appears.

14. Click Plugins/Feed.

The Plugins/Feed Configuration page appears.

15. In the Schedules section, expand the Tenable.sc Feed options.

16. Click Choose File and browse to the saved SecurityCenterFeed48.tar.gz f ile.

17. Click Submit.

After several minutes, the plugin update finishes and the page updates the Last Updated date

and time.

What to do next:

l If you installed a temporary Tenable Nessus scanner on the same host as Tenable Security

Center, uninstall the Tenable Nessus scanner.
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Troubleshooting

This troubleshooting section covers some of the common issues encountered with Tenable Security

Center.

l General Tenable Security Center Troubleshooting

l Tenable Log Correlation Engine Troubleshooting

l Tenable Nessus Troubleshooting

l Tenable Nessus Network Monitor Troubleshooting

l Troubleshooting Issues with the custom_CA.inc File
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General Tenable Security Center Troubleshooting

Tenable Security Center does not appear to be operational

1. If a login page does not appear, close and reopen the web browser.

2. Ensure that the remote httpd service is running on the Tenable Security Center host:

# ps ax | grep httpd
1990 ?        Ss     0:01 /opt/sc/support/bin/httpd -k start

3. Ensure that sufficient drive space exists on the Tenable Security Center host:

# df

Filesystem                         1K-
blocks     Used       Available     Use%     Mounted on
/dev/mapper/VolGroup00-LogVol00    8506784      
8506784    0             100%     /
/dev/sda1                          101086        24455      71412         26%
     /boot
tmpfs                              1037732       0         
1037732       0%       /dev/shm

4. If there is not enough drive space, recover sufficient space and restart the Tenable Security

Center service:

# df

Filesystem                         1K-blocks    
Used       Available    Use%     Mounted on
/dev/mapper/VolGroup00-LogVol00    8506784       6816420    1251276   
  85%      /
/dev/sda1                         
101086        24455      71412        26%      /boot
tmpfs                              1037732       0          1037732      0%      
/dev/shm
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# service SecurityCenter restart

Shutting down SecurityCenter services:                     [  OK  ]
Starting SecurityCenter services:                          [  OK  ]
#

Locked out of all Tenable Security Center user accounts

Contact Tenable Support.

Invalid license error

If you receive an invalid license error while attempting to log in as a security manager or lower

organizational user, an administrator user must log in and upload a new valid license key. A user

with access to the host OS and valid permissions can also check that an up-to-date license exists in

/opt/sc/daemons. Obtain a license from Tenable and copy it to the daemons directory as the tns
user.

-rw-r--r-- 1 tns tns    1942 Oct 29 12:14 license.key

Reporting does not work

Check your Java version. The system only supports OpenJDK and Oracle JRE. The existence of

another type of Java on the system will likely break reporting.
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Tenable Log Correlation Engine Troubleshooting

Tenable Log Correlation Engine server does not appear to be operational

1. Confirm that the Tenable Log Correlation Engine server state is Working along with all

attached Tenable Log Correlation Engine clients.

2. Check that you can SSH from the Tenable Security Center host to the Tenable Log Correlation

Engine host.

3. Check that the Tenable Log Correlation Engine daemon is running on its host and listening on

the configured port (TCP port 31300 by default):

# ss -pan | grep lced

tcp        0      0 0.0.0.0:31300   0.0.0.0:*     LISTEN      30339/lced

4. Check that the listening ports can be reached from the network and are not blocked by a fire-

wall.

5. If the Tenable Log Correlation Engine server is not operational, attempt to start the service:

# service lce start

Starting Log Correlation EngineLCE Daemon Configuration
LICENSE: Tenable Log Correlation Engine 3-Silo Key for [user]
EXPIRE: 11-10-2011
REMAIN: 30 days

MESSAGE: LCE (3-silo license)
MESSAGE: Valid authorization
--------------------------------------------------------

[  OK  ]

No events from an attached Tenable Log Correlation Engineserver
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1. Confirm that theTenable Log Correlation Engine server state is Working along with all

attached Tenable Log Correlation Engine clients.

2. Confirm connectivity by checking that heartbeat events show up in the Tenable Security

Center UI.

3. Check the Tenable Log Correlation Engine configuration sett ings in accordance with the Ten-

able Log Correlation Engine documentation.

4. Check the individual Tenable Log Correlation Engine client configuration and authorization. If

syslog is being used to collect information and events, ensure that the syslog service is run-

ning and configured correctly on the target syslog server in accordance with Tenable Log Cor-

relation Engine documentation.

5. Check for NTP time synchronization between the Tenable Security Center, Tenable Log Cor-

relation Engine, and Tenable Log Correlation Engine clients.

Invalid Tenable Log Correlation Engine license

1. Check that an up-to-date license exists on the Tenable Log Correlation Engine server.

Tenable Log Correlation Engine plugins fail to update

1. Manually test a plugin update under Plugins with Update Plugins. If successful, the line

Passive Plugins Last Updated will update to the current date and time.

2. Ensure that the Tenable Security Center host is allowed outbound HTTPS connectivity to the

Tenable Log Correlation Engine Plugin Update Site.

3. For all other Tenable Log Correlation Engine plugin update issues, contact Tenable Support.
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Tenable Nessus Troubleshooting

Tenable Nessus server does not appear to be operational

1. Verify that the Tenable Nessus scanner Status is Unable to Connect.

2. SSH to the remote Tenable Nessus host to make sure the underlying operating system is oper-

ational.

3. Confirm that the Tenable Nessus daemon is running (Linux example below):

# service nessusd status
nessusd (pid 3853) is running...

4. If the Tenable Nessus service is not running, start the service:

# service nessusd start
Starting Nessus services:
# ps -ef | grep nessusd
root      8201  8200 60 11:41 pts/2    00:00:05 nessusd –q
root      8206  7842  0 11:41 pts/2    00:00:00 grep nessusd
#

Cannot add a Tenable Nessus server

1. Make sure the Tenable Nessus daemon was registered using the Tenable Security Center

option for registration.

2. Check connectivity from Tenable Security Center to the port the Tenable Nessus system is

running on (e.g., 8834). For example, run:

curl -k https://<scannerIPaddress>:<port>

Tenable Nessus scans fail to complete
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1. Ensure that the Tenable Nessus service is running on the Tenable Nessus host.

2. Ensure that Tenable Nessus scanner is listed in Tenable Security Center under Resources >

Nessus Scanners and that the status of the Tenable Nessus scanner is listed as Working. For

more information, see Tenable Nessus Scanner Statuses.

3. Click Edit to ensure that the IP address or hostname, port, username, password, and selected

repositories for the Tenable Nessus scanner are all correct.

4. Edit any incorrect entries to their correct state.

5. Click Submit to attempt to reinit ialize the Tenable Nessus scanning interface.

6. Right click the scan results and click Scan Details to obtain a more detailed description of the

error.

If the scan details indicate a Blocking error, this is indicative of a license IP address count

that has reached the limit. Either remove a repository to free up IP addresses or obtain a

license for more IP addresses.

7. Ensure that scan targets are permitted within the configured scan zones.

8. Ensure the Tenable Nessus scanner is running a supported Tenable Nessus version. For min-

imum Tenable Nessus scanner version requirements, see the Tenable Security Center Release

Notes for your version.

Tenable Nessus plugins fail to update

1. Click System > Configuration.

The Configuration page appears.

2. Click License and ensure that the Tenable Nessus Activation Code is marked as Valid.

3. Ensure the Tenable Nessus scanner is running a supported Tenable Nessus version. For min-

imum Tenable Nessus scanner version requirements, see the Tenable Security Center Release

Notes for your version.

4. Ensure that the user used to connect to the Tenable Nessus server is a Tenable Nessus admin-

istrator.
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5. Ensure that the Tenable Security Center system is allowed outbound HTTPS connectivity to

the Tenable Nessus Plugin Update Site.

6. Under System, Configuration, and Update in Tenable Security Center, ensure that Active Plu-

gins is not set to Never.

7. Manually test a plugin update under Plugins with Update Plugins.

If successful, the line Active Plugins Last Updated updates to the current date and time.

8. For all other Tenable Nessus plugin update issues, contact Tenable Support.
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Tenable Nessus Network Monitor Troubleshooting

Tenable Nessus Network Monitor server does not appear to be operational

1. Verify that the Tenable Nessus Network Monitor server appears as Unable to Connect under

Status.

2. SSH to the remote Tenable Nessus Network Monitor host to make sure the underlying oper-

ating system is operational.

3. Confirm that the Tenable Nessus Network Monitor is running (Linux example below):

# service pvs status

NNM is stopped
NNM Proxy (pid 3142) is running
#

4. If the Tenable Nessus Network Monitor service is not running, start the service:

# service nnm start
Starting NNM Proxy                                         [  OK  ]
Starting NNM                                              [  OK  ]
#

Cannot add a Tenable Nessus Network Monitor server

1. Confirm that the Tenable Nessus Network Monitor proxy is listening on the same port as Ten-

able Security Center (port 8835 by default):

# ss -pan | grep 8835
tcp        0      0 0.0.0.0:8835    0.0.0.0:*     LISTEN      406/pvs

2. Check connectivity by telnett ing from the Tenable Security Center console into the Tenable

Nessus Network Monitor server on port 8835 (the Tenable Nessus Network Monitor listening

port). If successful, the response includes: Escape character is '̂ ] '.
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No vulnerabilit ies are being received from the Tenable Nessus Network Mon-

itor server

1. Ensure that the Tenable Nessus Network Monitor service is running on the Tenable Nessus

Network Monitor host.

2. Ensure that the Tenable Nessus Network Monitor appears in Tenable Security Center under

Resources > Tenable Nessus Network Monitors and that the status of the Tenable Nessus Net-

work Monitor appears as Working.

3. Click Edit to ensure that the IP address or hostname, port, username, password, and selected

repositories for the Tenable Nessus Network Monitor are correct.

4. Edit any incorrect entries to their correct state.

5. Click Submit to attempt to reinit ialize the Tenable Nessus Network Monitor scanning inter-

face.

Tenable Nessus Network Monitor plugins fail to update

1. Manually test a plugin update under Plugins with Update Plugins.

If successful, Passive Plugins Last Updated updates to the current date and time.

2. Ensure that the Tenable Security Center host allows outbound HTTPS connectivity to the Ten-

able Nessus Network Monitor Plugin Update Site.

3. For all other Tenable Nessus Network Monitor plugin update issues, contact Tenable Support.
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Error Messages

For Tenable Security Center API status codes, see the Tenable Security Center API Guide.

Note: Some errors are dependent on internal processes. If the error code you received is not listed, it may
not indicate a specific Tenable Security Center error.

Scanning

For more information about creating, modifying, and launching scans, see Configure Scans.

For more information about statuses, see Tenable Nessus Scanner Statuses, Scan Result Statuses,

and View Your Scan Zones.

Code Message Recommended Action

14 Progress handler has died. Your system processes may be overloaded during

the scan. Confirm your available system resources

and re-run the scan.

14 Error creating Email noti-

fying User '<username'> of

Scan launch.

Do any of the following:

l Confirm the alert specifies one or more valid

email addresses. For more information, see

Email.

l Confirm the job queue database is not locked.

14 Error creating Email noti-

fying User '<username>' of

Scan completion.

Do any of the following:

l Confirm the alert specifies one or more valid

email addresses. For more information, see

Email.

l Confirm the job queue database is not locked.

60 Available Zones do not

cover any accessible Scan

IPs for Scan job

#<jobIDorPID> ('<scanDefin-

For troubleshooting assistance, see the knowledge

base article.
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Code Message Recommended Action

it ionName>' - #<scanDefin-

it ionID>).

62 No scanners ready to scan The scan may be using incorrect or insufficient cre-

dentials, or another issue is blocking the scan. For

troubleshooting assistance, see the knowledge

base article.

64 Scan #<scanDefinit ionID> is

disabled.

You may have insufficient permissions to run the

scan. For troubleshooting assistance, see the know-

ledge base article.

64 Scan Policy #<scanPoli-

cyID> in Scan #<scanDefin-

it ionID> is disabled.

You may have insufficient permissions to run the

scan. For troubleshooting assistance, see the know-

ledge base article.

70 Unable to launch Scan pro-

gress process

Tenable Security Center is unable to fork the run-

ning scan process. You may need to raise the stack

size for the tns user. Contact your system admin-

istrator for assistance.

102 Could not open '<nes-

susFile>' for writ ing.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Error gett ing contents of

AuditFile '<auditFileName>'

for Scan job #<scanJobID>.

Tenable Security Center cannot access the audit

file definit ion. Do any of the following: 

l Verify the specified audit file is valid.

l Create a new audit file to use with the scan.

For more information, see Audit Files.

106 Error creating temp SCAP

directory '<scapDir>'.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.
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Code Message Recommended Action

106 Error creating temp OVAL

directory '<ovalDir>'.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Error creating temp dir-

ectory '<tempDir>'.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Error untaring SCAP results

file '<file>' (rc = $rc).

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Error moving <type> result

file '<curFile>' to '<newFile>'.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Unable to get current work-

ing directory.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Failed to change to the

SCAP directory for zipping.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Error building SCAP results

file '<scapFile>' (rc =

<zipReturnCode>).

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Failed to change back to ori-

ginating directory.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Unable to get current work-

ing directory.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Failed to change to the Tenable Security Center may have insufficient disk
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Code Message Recommended Action

OVAL directory for zipping. space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Error building OVAL results

file '$ovalFile' (rc = $rc).

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 Failed to change back to ori-

ginating directory.

Tenable Security Center may have insufficient disk

space. Free up disk space in Tenable Security

Center, as described in the knowledge base article.

106 No results file found for

Scan job #<jobIDorPID>

('<scanDefinit ionName>' -

#<scanDefinit ionID>).

Tenable Security Center cannot locate /op-
t/sc/data/scans/#jobID/results.xml. Verify

the following:

l /op-

t/sc/data/scans/#jobID/results.xml is

in the correct directory.

l The tns user can access the file and dir-

ectory.

106 Error creating new VDB dir-

ectory for Scan job

#<jobIDorPID> ('<scanDefin-

it ionName>' - #<scanDefin-

it ionID>).

Verify the tns user can access the following dir-

ectory: /op-
t/sc/orgs/#orgID/VDB/#dateOfScan/.

106 Error moving results for

Scan job #<jobIDorPID>

('<scanDefinit ionName>' -

#<scanDefinit ionID>).

Verify the tns user can access the following dir-

ectory: /op-
t/sc/orgs/#orgID/VDB/#dateOfScan/.

145 Error reading AuditFile '' for

Scan job #<scanJobID>.

Unable to retrieve AuditFile

#<auditFileID>"

Add an audit file to the scan policy, then re-run the

scan. For more information, see Audit Files and

Scan Policies.
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Code Message Recommended Action

146 Unable to find template

maps for Policy template

#<policyTemplateID>.

Check for any errors with the last plugin update. If

needed perform another plugin update. For more

information, see Offline Tenable Security Center

Plugin and Feed Updates.

146 Diagnostic target is outside

IPs of original Scan.

The scan target is not included in the scan con-

figuration. If you want to include the target in the

scan, update the scan sett ings and then re-run the

scan.

146 Diagnostic target is not a

single host.

The target of the diagnostic scan must be a single

IP or FQDN. Update the scan configuration, then re-

run the scan.

146 Zone Selection is locked

but no Zone is specified.

You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge

base article.

146 Zone Selection is selectable

but no Zone is specified.

You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge

base article.

146 Entered IPs and Assets are

empty.

One or more scan targets do not exist in the selec-

ted import repository. For troubleshooting assist-

ance, see the knowledge base article.

146 Scan IPs are restricted. You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge
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Code Message Recommended Action

base article.

146 Scan IPs are not within your

accessible range.

You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge

base article.

146 The number of Scan IPs is

too large (more than 2^24

unique IPs).

Reduce the number of scan targets and re-run the

scan.

147 Job #<scanJobID> not

found.

Confirm the job queue database is not locked, then

re-run the scan.

201 Error Sett ing up Scan data-

base. <details>

Do any of the following, then re-run the scan:

l Confirm you have adequate disk space

l Confirm the tns user can access /op-
t/sc/data/scans/#jobID/

201 Error creating Scan data-

base tables. <details>

Do any of the following, then re-run the scan:

l Confirm you have adequate disk space

l Confirm the tns user can access /op-
t/sc/data/scans/#jobID/

l Confirm there are no corrupted databases

202 Error message varies. Your system processes may be overloaded during

the scan. Confirm your available system resources

and re-run the scan. If the error persists, contact

your Tenable representative.

400 Scan job #<scanJobID>

stopped due to scanner

inactivity.

Your system processes may be overloaded during

the scan. Confirm your available system resources

and re-run the scan.
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Code Message Recommended Action

65536 Failed to resolve

<numFailed> scan target

hostnames in Scan #job

#<jobIDorPID> ('<scanDefin-

it ionName>' - #<s-

canDefinit ionID>)."

Tenable Security Center cannot resolve the spe-

cified scan target hostnames. For troubleshooting

assistance, see the knowledge base article.

65536 Unable to scan

<numRestrictedTargets>

Restricted target<plural> in

Scan job #<jobIDorPID>

('<scanDefinit ionName>' -

#<scanDefinit ionID>).

You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge

base article.

65536 Unable to scan <numIn-

accessibleTargets> target

(s) outside your accessible

ranges in Scan #job

#<jobIDorPID> ('<scanDefin-

it ionName>' - #<scanDefin-

it ionID>).

You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge

base article.

65536 Usable Zones fail to cover

<unscannableCount>

accessible Scan IP<plural>

for Scan job #<jobIDorPID>

('<scanDefinit ionName>' -

#<scanDefinit ionID>).

You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge

base article.

65536 Available Zones do not

cover accessible Scan IPs

for Scan job #<jobIDorPID>

('<scanDefinit ionName>' -

#<scanDefinit ionID>).

You may have insufficient permissions to run the

scan, or you may need to adjust your scan con-

figuration.

For troubleshooting assistance, see the knowledge

base article.
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